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METTLER TOLEDO Service

Congratulations on choosing the quality and precision of METTLER TOLEDO. Proper use of your new equipment
according to this Manual and regular calibration and mainfenance by our factory-trained service team ensures
dependable and accurafe operation, profecting your investment. Contact us about a service agreement tailored
to your needs and budget. Further information is available at p www.mt.com/service.

There are several important ways fo ensure you maximize the performance of your investment:

1 Register your product: \We invite you to register your product af www.mt.com/productregistration
S0 we can contact you about enhancements, updafes and important nofifications concerning your product.

2 Contact METTLER TOLEDO for service: The value of a measurement is proportional to its accuracy — an out
of specification scale can diminish quality, reduce profits and increase liability. Timely service from
METTLER TOLEDO will ensure accuracy and optimize uptime and equipment life.

= Installation, Configuration, Integration and Training: Our service representatives are factory-frained
weighing equipment experts. We make certain that your weighing equipment is ready for production in a
cost effective and timely fashion and that personnel are trained for success.

= Initial Calibration Documentation: The installation environment and application requirements are
unique for every industrial scale so performance must be tested and certified. Our calibration services
and certificates document accuracy fo ensure production quality and provide a quality system record of
performance.

= Periodic Calibration Maintenance: A Calibration Service Agreement provides on-going confidence in
your weighing process and documentation of compliance with requirements. \We offer a variety of
service plans that are scheduled to meetf your needs and designed to fit your budget.


http://www.mt.com/service
http://www.mt.com/productregistration

Safety Instructions

Compliance information

National approval documents, e.g. the FCC Supplier Declaration of Conformity, are available online and/or
included in the packaging.

www.mt.com/ComplianceSearch

Manuals download
Please scan the QR code below and download from p www.mt.com/IND700-downloads.

A\
A
L
A
A
A\

/\ WARNING

Use the device only for weighing in accordance with its corresponding user
manual. Any other type of use and operation beyond the limits of technical
specifications is considered as not intended.

/\ WARNING

Only permit qualified personnel to service the equipment. Exercise care when
making checks, tests and adjustments that must be made with power on.
Failure to observe this precaution could result in bodily harm and/ or property
damage.

/\ WARNING

Keep the equipment away from processes that generate high charging potential
such as electrostatic coating, rapid transfer of non-conductive materials, rapid
air jets, and high pressure aerosols.

/\ WARNING

Avoid plastic covers over the equipment. The protection cover used must be
officially approved by METTLER TOLEDO.

/\ WARNING

Ensure proper equipotential grounding of the equipment, mounting accessories,
and the scale base.

/\ WARNING

If the keyboard, display lens or enclosure is damaged, the defective component
must be repaired immediately. Remove power immediately and do not reapply
power until the display lens, keyboard or enclosure has been repaired or
replaced by qualified service personnel. Failure to do so could result in bodily
harm and/or property damage.
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/\ WARNING

Only the components specified in the user manual can be used in this device.
All equipment must be installed in accordance with the installation instructions
detailed in the user manual. Incorrect or substitute components and/or
deviation from these instructions can impair the instrinsic safety of the
equipment and could result in bodily injury and/or property damage.

/\ WARNING

For continued protection against shock hazard, connect to properly grounded
power source only. Do not remove the grounding connection.

/\ WARNING

When this equipment is included as a component part of a system, the resulting
design must be reviewed by qualified personnel who are familiar with the
construction and operation of all components in the system and the potential
hazards involved. Failure to observe this precaution could result in bodily harm
and/ or property damage.

/\ WARNING

All equipment must be installed in accordance with the installation instructions
detailed in its corresponding user manual. Deviation from the instructions can
impair the intrinsic safety of the equipment and void the agency approval.

/\ WARNING

Before connecting/disconnecting any internal electronic components or inter-
connecting wiring between electronic equipment always remove power and wait
at least thirty (30) seconds before any connections or disconnections are made.
Failure to observe these precautions could result in damage to or destruction of
the equipment and/or bodily harm.

/\ WARNING

Replacing equipment components with non-original parts can lead to
performance losses and property damage. Use only original or compatible
spare parts and accessories from METTLER TOLEDO.

/\ WARNING

Be certain that the communication circuits are wired exactly as shown in the
installation section of its corresponding user manual. If the wires are not
connected correctly, the equipment or interface board may be damaged.

/\ WARNING

Observe precautions for handling electrostatic sensitive devices.



Avoid direct exposure to sunlight.

/N\

The mains connection of the power supply unit must be made by a professional
electrician authorized by the owner and in accordance with the respective
terminal diagram, the accompanying installation instructions as well as the
country-specific regulations.

Before service, disconnect power from this device.

> PP

The protective ground connection must be checked after service work is
performed. Perform the check between the protective ground contact on the
power plug and the housing. This test must be documented in the service
report.

>

Equipment (WEEE) this device may not be disposed of in domestic waste. This also applies
fo countries outside the EU, per their specific requirements.

Please dispose of this product in accordance with local regulations at the collecting point ]
specified for electrical and electronic equipment. If you have any questions, please contact

the responsible authority or the distributor from which you purchased this device. Should this

device be passed on to other parties, the content of this regulation must also be related.

In conformance with the European Directive 2012/19/EU on Waste Electrical and Electronic K
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1.1

Introduction

The IND700 is a PC-based weighing terminal with a color touchscreen. It represents the latest weighing

technology from METTLER TOLEDO and is the most versatile weighing terminal for multi-scale non-hazardous
area applications.

The ferminal is a high-performance single- or multiple-range weighing indicator designed for use with High
Speed Analog Load Cells, digital POWERCELL/PowerDeck networks, and Precision scale bases. Precision

measurement data from milligrams to tons is provided by a single cost-effective package that easily integrates
into existing systems.

The internal power supply connects fo line-level AC voltage using a standard power cord appropriate for the
region in which it is used.

Enhanced Industrial Network and PC communication interfaces are available, and discrete /0 options are
included provide control for process applications such as filling. The versatile IND700 can be upgraded with a
variety of special application software packages that add performance features where needed. These features
make the terminal a perfect match for nearly any weighing application in many industries, including:

e Pharmaceuticals  Petrochemicals e Refining

e Milling e Agriculture e Cosmetics and Fragrance
» Specialty Chemical e (Coatings and Inks

IND700 Overview

Mechanical

e Two types of enclosure to suif different uses and locations
— Harsh environment (desk/wall mounted) terminal with M12 connectors
- Harsh environment (desk/wall mounted) terminal with cable glands
— Wedge ferminal with M12 connectors
- \Wedge ferminal for hygienic application

Figure 1: Harsh Environment (rear) and Wedge (front) IND700 Enclosures

e Type 304 stainless steel enclosure

e 7" TFT color display, touch screen (800 x 480)

 Intuitive color touchscreen user interface

» Capacitative fouch funtion keys with backlight feedback -- Clear, Tare, Zero, Transfer

Infroduction
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Interface

Connect one or two scale bases using High Speed Analog, POWERCELL®, PowerDeck™, or Precision
interface

Scale interface boards add options:

— High Speed Analog interface with 2 in/2 out DIO inferface

— POWERCELL/PowerDeck scale inferface with 2 in/2 out DIO

— Precision scale inferface with 2 in/2 out DIO and COMx (RS232/RS422/RS485)
Several communication interface options, including serial ports and Digital Input/Output:

— Standard Tx COM1 (RS232/RS422/RS485), 1 x Ethernet 1000 Base-T Protocol, 1 x USB 3.0, T x USB
2.0, 1 x Discrete 1/0 (21/20)

— Optional RS232/RS422/RS485 serial port
Support for the following Industrial Network inferfaces:
— PROFINET

— EtherNet/IP

Function

Basic weighing including zero, tare, and data transfer

Real-time clock with battery backup

Alibi memory storage for up to 100,000 records

Unit switching befween three different units, including custom units (Not supported in phase 1.)
Ten customizable templates to support production and transfer of reports

CalFREE™ calibration without test weights

Up to four logical scales with POWERCELL scale inferface

Application

Standard Application capability: ID Forms

The following Application Software Modules, enabled by ProWorks Mulfi-Tools license:
— Counting

— Manual Target - Classification

— Manual Target - Filling

— Manual Target - Over/Under

— Totalization

Note: Totalization and Counting can be combined with any of the manual target applications.

1.2 Specifications IND700

Specifications

Infroduction

Enclosure Type Type 304 stainless steel enclosure

Dimensions Refer to [Physical Dimensions » Page 10]

Shipping Weight e Wedge: 3.6 kg
e Harsh environment: 3.8 kg

Environment Protection Wedge: IP68; Harsh environment: IP69K

Environment Conditions For indoor or outdoor use (Type 4)

Altitude Up to 5000 meter above sea level

Operating Environment -10° 10 40° C (14° to 104°F), 10% fo 95% relative humidity, non-
condensing.

Pollution Degree 2

Power 100 — 240 VAC, -15% 10 +10%, 50 - 60 Hz, 6560 — 275 mA

Overvoltage Category I

Display 17.75 cm (7") TFT color display, touch screen (800 x 480)

IND700




Specifications

Weight Display HSALC display resolution: 7-digits
POWERCELL®, PowerMount™, PowerDeck™, or Precision bases (PBD,
PBK, PFK) display resolution: determined by specific base in use

Scale Types Analog, POWERCELL, PowerMount, PowerDeck, Precision

Number of Analog Cells

Up to 8 x 350 Ohms, 2 or 3 mV/V

Analog/Digital Update Rates

HSALC option: infernal analog 1,000 Hz, target comparison 1,000 Hz
POWERCELL option: 100 Hz per scale, 50 Hz dual scales, 25 Hz four

scales

Precision bases: determined by base
Analog Load Cell Excitation 10 VDC
Voltage
Keypad 4 keys: Clear, Tare, Zero, Transfer

Communications

Standard Interfaces:

One COMT (RS-232/RS-422/RS-485), 2400 fo 115,200 baud
Ethernet 1000 Base-T Protocol

USB 3.0

USB 2.0

Discrete 10 (2120)

Optional Interfaces:

HSALC*

POWERCELL/PowerDeck*

Precision**

PROFINET or EtherNet/IP

Serial port, RS232/422/485

COMx serial port on Precision option board, RS232/422/485

* Scale interfaces also include Discrete 10, 2 in/2 out

** Scale interface also includes COMx (RS232/RS422/RS485) serial port
and Discrete 10, 21/20

Protocols

Serial Inputs: SICS (most level O and level T commands, select advanced
commands from levels 2 and 3), Transfer

Serial Outputs: Demand with up to fen configurable templates or SICS
host protocol; interface with up fo 8 ARM100 Input/Output modules

Approvals

Weights and Measures

USA: NTEP - No. 22-083

— Class Il 100,000d

— Class IlI, 1L 10,000d

Canada: MC - AM-6203

— Class 11 100,000d

— Class Il 10,000d, and Class IIHD 10, 000d
Europe: TC11060

— Class Il, approved divisions determined by platform
— Class IlI, Ill, HSALC 6,000e; POWERCELL 10,000e

Product Safety

CSA

1.3 Operating Environment

» Use the weighing terminal only when electrostatic processes leading to propagation brush discharge is

impossible.

IND700
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«  Keep the ferminal away from processes that generate high charging pofential such as electrostatic coating,
rapid transfer of non-conductive materials, rapid air jefs, and high pressure aerosols.

¢ Choose a stable, vibration-free surface o mount the terminal.

« Ensure there are no excessive fluctuations in temperature and no direct exposure to sunlight.
« Avoid drafts on the weighing platform (for example, from open windows or air conditioning).
 Calibrate the terminal affer any major change of geographical location.

1.3.1 Temperature and Humidity

The terminal can be sfored and operated af temperatures and relative humidity conditions as listed in Specifi-
cations old

1.3.2 Environmental Protection

The terminal has environment protection as listed in [Specifications IND700 » Page 8].

1.4 Inspection and Contents Checklist

Verify the contents and inspect the package immediately upon delivery. If the shipping container is damaged,
check for internal damage and file a freight claim with the carrier if necessary. If the confainer is not damaged,
remove the product from its protective package, noting how it was packed, and inspect each component for
damage.

If shipping the product is required, it is best to use the original shipping container. The product must be packed
correctly to ensure ifs safe transportation.

The product package should include the below items but may vary by region:
e IND700 terminal * Bag of miscellaneous parts
 Safety Instructions

1.5 Physical Dimensions

Dimensions of the two versions of the IND700 enclosure are given in mm and inches.

1.5.1 Enclosure for Harsh Environments

. 260 mm/10.24" .

&

METTLER TOLEDO IND700
— = Y e

Max10 kg d =1g

7.000..

0.250 kg PT NET

124 mm / 4.88"

B g
231.2mm/9.1"

Figure 2: Front View
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170 mm / 6.69"

»

130 mm/b.12"

Figure 3: Side View

Figure 4: Bottom View, Showing Mounting Holes
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1.5.2 Wedge Enclosure
260 mm/ 10.24"

»

79.4mm/3.13"

231 mm/9.1"

Figure 5: Front View

170 mm/6.7" —

132.5 mm/5.22"
Figure 6: Side View

Figure 7: Bottom View, Showing Mounting Holes
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1.6 Date of Manufacture

A terminal's date of manufacture is available to MT technicians in an infernal databases.

1.7 Model Identification
Refer to the following chart fo confirm the model and configuration of the IND700 terminal.

r Product Type

— Model Number

— Version

— Enclosure/Display/Primary Connector Type

—Interface 1 or Slot 1

— Interface 2 or Slot 2

— Interface 3 or Slot 3

r Interface 4 or Slot 4

—Communication 1 or Slot 5

|—Communicotion 2 or Slot 6
—Connectivity

— Software Application License
’» Software Add-On License

Power
Approval
( [P

[T]700/ 0] 0 [0]o]ololololo]lololol1]o0

L LO = None
1 = AC Power

0 = None
— 0 = ProWorks
1 = ProWorks Multi-Tools
2 = ProWorks Studio
3 = ProWorks Studio & Mulfi-Tools
-0 = None
E = EtherNet/IP (M12 x 2)
T = PROFINET (M12 x 2)
—0 = None
E = Standard Ethernet Connector (M12)
U = Standard USB Host Connector (M12)

0 = None

2 = COMx Optional Serial Port - M12 Connector Only (RS232/422/485)
D = Standard DIO1 Connector (M12)

3 = Standard DIO2 Connector (M12)

U = Standard USB Host Connector (M12)

0 = None
C = COMT1 Standard Serial Port - M12 Connector (RS232-422-485)
D = Standard DIO Connectfor (M12)

—None

— 0 = None
1 = High Speed Analog (cable gland)
5 = PowerDeck (M12)
6 = POWERCELL PDX and PowerMount (PDX cable gland)
8 = Precision (SICSPro M12)
B = Optional Serial Port (R§232/422/485)
2 = COMx Optional Serial Port - M12 Connector only (RS232/422/485)
D = Standard DIO1 Connector (M12)
— 0 =None
1 = High Speed Analog (cable gland)
5 = PowerDeck (M12)
6 = POWERCELL PDX and PowerMount (PDX cable gland)
8 = Precision (SICSPro M12)
B = Optional Serial Port (RS232/422/485)
 C = \Wedge, 7" Display, M12 Connectors
S = Wedge Hygienic, 7" Display, M12 Connectors, GoreTex Vent, NSF Glands for power cord and HSALC
G = Harsh, 7" Display, Cable Glands
M = Harsh, 7" Display, M12 Connecfors
— 00 = Standard/Non-hazardous areas

— 700
— Terminal

Figure 8: IND700 Model Identification

Infroduction
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Touchscreen
Main screen — Main Screen View
1 2 3 4 5
15..; @ 25,Aug_2220:2:
1213 1+2 Max 560 kgd=20g — 1 6
74. 5 8 kg | 7
- 8
] ]—-M 1 Max500kgd=20g m 2 Max 60 kgd =10 g

70.00kg 4.58kg
1OI‘C Tlo | mlerm[o[n Bo

Figure 9: Elements of the Main Screen

1 Menu button 7 Weight display with unit

2 Message box 8 Status line

3 Access level 9 To next softkey ribbon

4 Language selection 10 Softkey line

5 Time and dafe 11 Number of the active scale
6 Mefrological information, alternating with 12 Sum Scale indicator

the permissible temperature range

Main screen — Application View

When an application is active, the screen is divided info the weight display (top) and the applicafion display
(bottom).

7 08:55
é:%\ @ 26.Jan.2024

K& 1 -10.0°C/ +40.0°C

2.750

2.750 kg PT

Material ID Material Name Under Tol. Target _— ) )
1 | 15k 35 k Application configuration
HENOIT SR g information
Over Tol.
+#3 kg
| v L4 _
—— Bargraph display
PT | [ @
Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res Id}gﬁmm Material Table Target
Figure 10: Application View Example
13 Application information
14 Application display elements -- e.g. piece counting information, bar graph for Filling and

Over/Under applications

IND700
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Menu button
Touching 5 opens the following menu:

' @ Terminal 3
2] Login/Logout
{3y Enter Setup

l
Main Screen View

() Power N

Figure 11: Top Menu

* Note that the Power item only appears if the login level if Supervisor or Admin.

e Terminal — Shows the terminal's IP address, defailed metrology information and detailed terminal infor-
mation. Refer to [Accessing Terminal Information » Page 45].

» Login/Logout- refer to [Logging In and Logging Out » Page 32].
e Enter Setup — Enfer IND700 setup. Refer to Operating the setup.
» Switch between Application View and Main Screen View:

Example: Counting is active and simple weighing is needed to weigh another sample. Switch to Main
Screen View, perform the simple weighing operation, then fouch the menu item again to return to Appli-
cation View.

» Exit application (supervisor or administrator level only) — Exit the IND700 application. The Windows
desktop will appear.

Message box

» The message box status icon varies depending on the last logged message.
* Messages are classified with the same icons.

Severe error

Warning

Information

No new message since the message box was last viewed

I3
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Sample of message box contents:

==

@ Scale 2 not responding.
A Scale not calibrated
@ Scale 2 not responding.
A Scale not calibrated
@ Scale 2 not responding.
a Scale not calibrated

ﬁ Scale 2 not responding.

23/Feb/2021 9:09 AM
23/Feb/2021 9:08 AM
22/Feb/2021 10:16 AM
22/Feb/2021 10:16 AM
22/Feb/2021 10:11 AM
22/Feb/2021 10:10 AM

22/Feb/2021 10:07 AM

@) init zero could not be done  22/Feb/2021 10:07 AM

Access level display

The IND700 offers three access levels. The current level is indicated by the small squares included in the

operafor symbol on the system bar:

Operator Supervisor Administrator
mOO ERO EEN
Operation level only, no setup rights|  Full rights, except approval and | Full rights, including approval and
calibration rights calibration rights

For user setup, refer fo [User Security » Page 29].
All access levels can change the ferminal language by touching the globe icon: @.

Setup Access

Note that if the current Access Level is changed to a higher or lower level while Setup is
displayed, changes to access to configuration parameters will not be changed until setup is
closed and re-opened. Thus, if an Admin login is replaced by an Operator login while a
configuration screen is displayed, the terminal system line will indicate an Operator login
level but will grant Admin level access.

Status line

The status line can display the following symbols:

>0< Set to zero x.xxx kg T |Current tare weight
B/G Gross weight x.xxx kg PT  Current tare preset
NET Net weight X.xxx kg M |Tare weight with net sign correction
(Memory), POWERCELL/PowerDeck
scales only
MinWeigh function active MinWeigh error
>l1l<, >12l<, |Current weighing range, mulfiple e Stability monitor
>13l< range/interval scales only

IND700
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Softkeys

The following softkeys are available, separated in up fo 3 softkey ribbons. Note that some of these softkeys
display when an application is in use, and do not appear in the [Softkey Ribbon Editor » Page 197].

C  Clear (17 Transfer data
J«  Tare PT PresefTare
Qe Zero View Tare table
AA  Switch scale Higher resolution -- foggles befween
standard and high resolution weight
displays
Switch units Target

View Alibi memory

View Transaction Table

Fix reference number

View Identification form (ID Form)

D E

Home

and Main Screen View

Repeat Tr.

&  Switch weight display between weight Variable reference number
Switch weight Value and number of pieces
+ Add to total Ti-&  Switch weight display befween weight
switch weight| ValUe and number of pieces inactive
_9 Input Template -- displays pop-up list of S Call up / clear total
et empiate || AVOIlADIE templates. Softkey will appear
only if af least one tfemplate is assigned to
a [Connection » Page 215], and the
connection is configured with Selectable
by Softkey enabled.
EEE Apps -- toggle between Application View ] Repeat Transaction (reprint)

Data entry can carried out either by connecting an external keyboard and mouse, or by using the system's
keypads. Refer to [Data Enfry » Page 43] for defails on the use of these screens.

Infroduction
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1.9 Main PCB Connections, Ports and Switches

Connectors and other features on the IND700 main PCB are indicated in the illustration below.

Infroduction

1 12 13 14 15 16
Figure 12: IND700 Main PCB Connections and Switches
1 Discrete 1/0 2 COM1 (RS232/422/485)
3 SW2 4 SD Card Slot (not used)
5 USB 3.0 6 USB 2.0
7 1000Base-T LAN 8 Slot 1
9 Slot 2 10 |Industrial Network
11 12 VDC input 12 | Fan connector
13  |HMl interface 14 |SWI
15 | Debug (do not use) 16 |USB extension connector

IND700
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1.10 Scale Interfaces and Option Boards

The IND700 terminal provides the following optfion boards for connection of different types of scales, and for
Industrial Network communication. The figure below indicates locations for these options.

High Speed Analog Precision POWERCELL® /  Industrial Network
Load Cell Scale PowerDeck™  PROFINET, EtherNet/IP
v
IO Scale ®
| / \ _ |

ul
- _ -

hi

\ /
\

J —o
/ : 4
,_ @\ \ O\ﬁ/ ; @ @771
| h —comt (188'3.0—)000base-T1L

RS232/52/485 SITJ USB 2.0

S
strial

MI.

= &
uuuuuuuuu

Figure 13: IND700 Interface and Optfion Installation Locations

Scale interface option boards are mounted in either Slot 1 or Slot 2. The Industrial Network interface board
mounts fo the connector indicated in the figure above.
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High Speed Analog (HSALC) Scale Interface Board

The HSALC board, part number 30554297, allows connection of analog load cells. Each HSALC inferface is

able to drive up to eight 350 ohm analog load cells. The board also provides 2 discrete inputs and 2 discrete
outputs.

0200 €000

Figure 14: HSALC Scale Board
POWERCELL® Scale Interface Board

The POWERCELL scale inferface board, part number 30521649, is used with METTLER TOLEDO POWERCELL

PDX/PowerMount load cells, installed in large tank and vehicle weighing systems, or with PowerDeck scales.
The board also provides two discrefe inputs and two discrete outputs.

T o TZio g

+24V_IN

+24V_OUT |
GND

g +12v_0uT

CANL
N.C.

CANH

(DDA

Figure 15: POWERCELL Board
Precision Scale Interface Board

The Precision scale interface board, part number 30529386, supplies 12 VDC for precision weighing platorms.
This option board has two additional features -- an interface for two discrefe inputs and two discrefe outputs,

and an additional RS232/RS422/RS485 serial port named COMX. The 7-pin serial port on the inferface board
does not provide +5V and GND connections.

20 | Infroduction IND700



Figure 16: Precision Scale Board

Industrial Network Option Board

4,‘.‘-
%
L)
=
S
«
=N

The Industrial Network option board can be configured for PROFINET (part number 30529337) or EtherNet/IP

(part number 30708327). The dual RJ45 ports (Port A and Port B) enable the Media Redundancy Protocol
(MRP) or Device Level Ring (DLR).

Figure 17: Industrial Network Option Board
Industrial Ethernet Update Rates
Industrial Ethernet Option Update rates

System Configuration PROFINET EtherNet/IP
HSALC, 1 scale 66 Hz 64 Hz
HSALC, 2 scales 50 Hz 49 Hz
POWERCELL, 4 scales 156 Hz 14 Hz

1.11 Connections

Connections are made using the openings on the rear of the IND700 enclosures. Openings are assigned as

indicated below.

IND700
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1.11.1 IND700 Wedge Model

Infroduction

Figure 18: IND700 Wedge Model with Cable Openings

Wedge Model Cable Opening Assignments

Position Connector Size Cable Function
Diameter
1 M12 x 1.5 connector - e Ethernet
e USB
2 M12 x 1.5 connector - e USB
e DIOT (all 10 from main board and Scale 1),
e DIO2 on Scale 2 (b-pin)
e COMx
3 Depends on scale - e Scale 2
interface
M12 x 1.5 connector |- e Serial M12 connector only for COMx (7-pin)
e DIOT (all 10 from main board and scale 1, 12-pin)
4 M12 x 1.5 connector - e Opfional COM
Scale 1
M16 x 1.5 gland 5-10mm e Scale 1, if High Speed Analog Load Cell (HSALC)
5 M12 x 1.5 connector |- e DIOT (all 10 from main board and Scale 1)
COM 1 from main board
6 M16 x 1.5 gland 5-10mm * Power
7 M12 vent - e GORE-TEX vent; not standard for wedge model
Notes

e COMx in position 2 uses a cable harness with an M12 connector. This assignment is possible only if a
Precision inferface is installed as Scale 1

M12 connectors are used in all locations unless otherwise required by the scale interface
¢ The wedge model does not support Industrial Network options
e The GORE-TEX vent (7) is optional, and is not included in the default configuration
* Due fo the physical layout and length of internal harnesses, only the following connector locations are

possible:
DIO M12 Positions 2, 3 or 5
USB M12 Positions 1 or 2
Ethernet M12 Position 1
CcoM1 M12 Position 5

COMx M12 (Precision Scale)

Positions 2 or 3

IND700




1.11.2 IND700 Wedge Model, Hygienic Option

IND700

Figure 19: IND700 Wedge Model (Hygienic Option) with Cable Openings
Wedge Model (Hygienic Option) Cable Opening Assignments

Position |Connector Size Cable Diameter Function
1 M12 x 1.5 connector |- e Ethernet
e USB
2 M12 x 1.5 connector |- * USB
e Sfandard DIO1 on main board, or scale 1 (12-
pin)

e DIO2 on scale 2 (5-pin)
e Serial M12 connector only for COMx (7-pin)

3 See position 4 for scale Scale 2 (see position 4 for scale connectors fo
connectors use)

M12 x 1.5 connector Serial M12 connector only for COMx (7-pin)
e Sfandard DIOT on main board, or scale 1 (12-

pin)
4 M12 x 1.5 connector - *  POWERCELL/PowerDeck
e Precision
e Optional serial port M12 (7-pin) (RS232/RS422/
RS485)
M16 x 1.5 NSF gland  5.5-7mm or * High Speed Analog Load Cell (HSALC)
7-10mm
5 M12 x 1.5 connector |- e Standard COM1 M12 connector only (RS232/
RS422/RS485)
e Sfandard DIOT on main board, or scale 1 (12-
pin)
6 M16 x 1.5 NSF gland  5.5-7mm e Power
7 M12 x 1.5 Vent - e GORE-TEX vent; nof insfalled at factory but
included in instfallation kit, noted as "NOT NSF" in
documentation
Note
» The wedge model does not support Industrial Network options
Notes

e Special NSF glands are used for the HSALC and power connectors
e A GORE-TEX vent is included in the installation kit. This vent is not NSF approved
e PET cover is added in fouch panel

Infroduction
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Figure 20: GORE-TEX Vent in side of Wedge Model

1.11.3 IND700 Harsh Environment 7" Model, M12 Option

Figure 21: IND700 Harsh Environment 7" Model (M12 Option) with Cable Openings
Harsh Environment 7" Model (M12 Option) Cable Opening Assignments

Position Size Cable Diameter Function
1 M12 x 1.5 connector - e M12 cable for Industrial Network
2 M12 x 1.5 connector - e MT12 cable for Industrial Network
3 Reserved - -
4 M12 x 1.5 connector - e Scale 1: PowerDeck
e Scale 1: Precision
e Optional serial port M12 (7-pin) (RS232/
RS422/RS485)
M16 x 1.5 gland 5-10mm e Scale 1: High Speed Analog Load Cell
(HSALC)
M16 x 1.5 PDX gland 5-10mm e Scale 1: POWERCELL (Vehicle)
5 M12 x 1.5 connector - e DIO2 on scale 2 (5-pin)
e Serial M12 connector only for COMx (7-pin)
-- only if Scale 1 is a Precision interface
6 M12 x 1.5 connector - e DIO (all 10 from main board and scale 1,
12-pin)
7 M12 x 1.5 connector - e Ethernet
8 M12 x 1.5 connector - * USB
Introduction IND700



1.11.4 IND700 Harsh Environment 7" Model, Gland Option

IND700

9 M12 x 1.5 connector - e Scale 2: PowerDeck
e Scale 2: Precision
e Scale 2: Serial (RS232/RS422/RS485)
M16 x 1.5 connector 5-10mm e Scale 2: High Speed Analog Load Cell
(HSALC)
M16 x 1.5 connector - e Scale 2: POWERCELL (Vehicle)
10 M12 x 1.5 connector - e COM1 Serial (RS232/RS422/RS485) M12
(8-pin)
11 M16 x 1.5 connector 5-10mm e Power
Notes

e M12 connectors are used in all locations except for the power cord and HSALC, which always use cable

glands

e M12 connectors for USB, Ethernet, COM1 and standard DIO are all included. There is no need to select
them in the SCK

* M12 connectors for COM2 and DIO2 are not included. There is no need to select them in the SCK

e The M12 connector can support up to 12 fotal DIO. If a second scale is installed, the ferminal will be
configured with all DIO connected except for INPUT 2 on the second scale board.

e All Harsh environment 7" versions support only M12 cable for the EtherNet/IP and PROFINET opfions

Figure 22: IND700 Harsh Environment 7" Version (Gland Option) with Cable Openings

Harsh Environment 7" Model (Gland Option) Cable Opening Assignments

Position Size Cable Diameter Function
1 M12 x 1.5 connector - e MT12 cable for Industrial Network
2 M12 x 1.5 connector - e M12 cable for Industrial Network
3 M25 x 1.5 gland 13-18mm; requires |« USB
a 1- and 2-hole o Ethernet
grommet
4 M12 x 1.5 connector - e Scale 1: PowerDeck
e Scale 1: Precision
M16 x 1.5 gland 5-10mm e Scale 1: High Speed Analog Load Cell
(HSALC)
e QOptional Serial port (RS232/RS422/RS485)
M16 x 1.5 PDX gland 5-10mm e Scale 1: POWERCELL (Vehicle)
5 M16 x 1.5 gland 5-10 mm e DIO2 on scale 2

Infroduction
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6 M16 x 1.5 connector 5-10 mm e DIOT (all IO from on main board and scale
1, 12-pin)
7 Reserved: M16 plug - -
8 M16 x 1.5 connector 5-10mm e COM2 from Precision scale, if installed as
Scale 2
9 M12 x 1.5 connector - For optional second slof:
e Scale 2: PowerDeck
e Scale 2: Precision
M16 x 1.5 connector 5-10mm e Scale 2: High Speed Analog Load Cell
(HSALC)
» Optional serial port (RS232/RS422/RS485)
« Additional DIO option board
M16 x 1.5 gland 5-10mm e Scale 2: POWERCELL
10 M16 x 1.5 connector 5-10mm e COMI
11 M16 x 1.5 connector 5-10mm * Power
Notes

The harsh environment 7" version with cable glands uses only cable glands for connections except for the
Precision scale, PowerDeck scale, and PLC option, which always use M12 connectors

In the harsh environment 7" version with cable glands, the M25 gland is installed with single- and double-
hole grommets, available in the installation kit for the USB and Ethernet options. Cable glands are also
included for COM1, COM2 and the standard DIOT and DIOZ2; it is not necessary to select these in the SCK

All harsh environment 7" versions support only M12 cable for the EtherNet/IP and PROFINET options.
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2 Operation

This section provides information about navigating the Human-Machine Interface, and basic features and
functions of the IND700.

Specific operation of each IND700 ferminal depends on enabled functions and parameters that are configured
in setup. These setup parameters are described in [Configuration » Page 72]. The configuration and operation
of optional Applications are described in the IND700 ProWorks Multi-Tools User's Manual (30753893).

2.1 Non-Weighing Operation

2.1.1 Turning the Terminal On and Off
Turning the Terminal On

If the ferminal is not connected to power, plugging it in will initiate the starf-up process. The function key
highlights will flash, and a start-up screen will display. When the star-up process is complete, the home
screen will appear.

Figure 23: Connect Terminal fo Power

METTLER TOLEDO

Figure 24 Startup Screen
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If the ferminal is off, but already plugged in, touch the Power butfon fo initiate starfup. The same start-up
sequence will begin.

Figure 25: Start-up Using Power Butfon

Shutting Down

To shut down the ferminal, either fouch the Power button on the fascia, or access the menu E5 and touch
Power | Shut Down. Note that shut-down from the menu is only possible with a Admin level login.

© Terminal > Sz
2] Login/Logout

Sy Enter Setup

App Screen View
D.0°C ¢ +a0.0°C | 2
O Power > | X Exit Application
0 ‘ () Reboot
[ ]
() Shut Down

Figure 26: Shutdown from Menu
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In either case, a confirmation message will display.
— D ;1‘ @ 13:26
— wno 26.0ct.2022

AA 1 Max10kad=1g
Shut Down

A Do you want to
shut down? O k
X

.PTE},.

Figure 27: Shutdown Confirmation

Touch the check mark to complete the shut-down procedure.

,ﬂ, @ 13:26
=05 26.0ct.2022

AR 1 Max10kgd=1g

5 vk e, O kg

B/G

.PT

Figure 28: Shutdown in Progress

2.1.2 User Security

IND700

Terminal Access

When the terminal is in its factory defaulf state, no passwords are set for users at any login
level. It is strongly recommended that the ferminal's configuration be profected by setting a
password for the Admin user, as described below.

s [ slajola] [

Operation
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For an overview of User Security, refer o [Touchscreen » Page 16].

Access level control is important for safeguarding the ferminal's configuration and weighing datfa. This control
may also be due fo legal regulations or fo customer preference. Some installations operate in a "trusted"
environment, where security is managed within the scope of the operation perimeter and no additional security
is required from the weighing ferminal. The opposife extreme may be found in highly-regulated industries where
every operation must be recorded and authorized by signature or login.

The terminal allows the creation of three types of user -- Operator, Supervisor and Admin. These are configured
in Setup af Terminal > Users.

An Operator can operate the ferminal and view fables, but cannot change the configuration or add fable
records. An Operator login may or may nof be password-protected, and it is possible to configure many
different Operators. By default, the terminal has one Operator login configured, with the user name Operator
and no password.

A Supervisor can add or modify table records (including Users at Supervisor or Operator level), but cannot
enable or disable tables.

An Admin user has complete access to, and can modify, all terminal configuration screens and tables. By
default, the terminal has one Admin operator configured, with the user name Admin and password. It is recom-
mended that a password be assigned to profect administrative functions and configurations from being alfered
without authorization.

Password Management

When setting a password for a user, be sure fo remember it and protect it from access by
unauthorized personnel. If the password is changed or forgotten, access fo the setup menu
and some terminal functions will be lost. To regain access and functionality, a master reset
of the terminal must be performed. This will reset all user names and passwords, but will
also remove any custom configuration. Note that configurations can be backed up from,
and restored fo, the terminal, to recover custom settings.

User Management
To manage terminal users, access Setup > Terminal > Users. The Users list will display.

{ Users + &

User Name Access Level Default User
Admin Administrator

Operator Operator Ve

Jean Administrator

Figure 29: User's List
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To select a user, touch the fable row. A popup will appear.

o+ ./ v

Figure 30: Table Record Management Popup

The options are delete [l or modify./ the selected user, or create+ a new user.
If Delete is fouched, a warning will display. Touch the checkmark to confinue, or the X to cancel the deletion.

Warning

Delete User

X

Figure 31: Delete User Warning

If Add is touched, and the current login level is Supervisor or Admin, the Add User screen will display.

< Add User

User Name

Password Confirm Password

Access Level

Administrator N

Default User

Figure 32: New User Screen
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Here, a new user's name, password and access level can be configured. If the current login is Admin, the
Default User slider will be acfive. The login dialog for the default user will display automatically at system start-
up or, if no password is assigned (for an Operator, for instance), the ferminal will start up with that user logged
in by default.

If Modify is touched, the Edit User screen will display with the same configuration options as the Add User
screen.

£ Edit User

User Name

Jean

Password Confirm Password

Access Level

Administrator N

Default User

Figure 33: Edit User Screen
The Access Level opfions dropdown list is shown below.
Access Level

Administrator v

Administrator

Supervisor

Operator

Figure 34: Access Level Options

When user configuration is complete, fouch the Back arrow fo return to the Setup > Terminal menu.

Logging In and Logging Out

User Configuration

This section assumes that users have been configured with names and, as required,
passwords, in Setup at Terminal > Users. Refer to [Users » Page 190] for details.

The user login screen can be accessed either by fouching the Login/Logout item from the main menu s or
by touching the user icon llin the system line. In either case, the user account screen will display.

When the terminal is turned on, the login status shows the user configured as Default User. Typically, the
default user will be an Operator-level login, and the initial user account screen will appear as shown below. The
User Name drop-down list will contain all configured users, but will always include the default users Admin
and Operator. In this case, Operator 1 is the default user and is currently logged-in.
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( User Account

User Name

Operator 1

Figure 35: User Account Screen - No Password Configured

Note that, because the currently logged-in user is displayed, the password field is blank, and the logout icon is
not shown.

In the example shown below, the default Admin user has been selected from the User Name dropdown list.
The Password field is displayed and, if a password is configured for Admin, must be completed before touching
the OK & icon.

< User Account

User Name

Admin

Password

Figure 36: User Account Screen with Logout Butfton

Operation
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< Password

Figure 37: Password Entry Screen

Note that the password characters are not displayed in the entry field.

< Password

1 7] 2 A = [ 7 Q (o] n
Figure 38: Password Enfered, not Displayed

When the password has been entered, press + tfo confirm it. If the password is correct, the User Account
screen appears with the Password field populated.

< User Account

User Name

Admin

Password

Figure 39: User Account Screen Complefed

Touch the check button to complete the login, or the logout button to exit the screen the leave the login status
as it was before.
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If a password is not entered, or is enfered incorrectly, an Error message will display:

Invalid Password

Figure 40: User Account - Invalid Password Message

To change users, fouch the User Name field to display a list of existing users.

< User Account

User Name

Admin

Admin
Operator 1

Super

Operator 2

<]

Figure 41: User Name Dropdown List

With the exception of the default Operator user, the currently logged-in user can be logged out by touching the
log-out icon €I. The system then reverts fo the default login.

2.1.4 Changing language temporarily

You can change the ferminal's display language temporarily, as required.

Terminal Language Selection
The ferminal's default language is configured in Setup at Terminal > Region > Language.
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Touch the globe [&] on the system bar. A list of available languages is displayed.

- aHt..

+/ English (English)
French (francais)
German (Deutsch) k(
Italian (italiano) ‘

Spanish (espariol) lme

Chinese (Simplified, PRC) (A3 (R E))

Figure 42: Temporary Language Selection Drop-Down List

Touch the required language to select it. The language will remain selected until it is changed from this drop-
down list, or the terminal is restarted.

2.1.5 Understanding the HMI (Human-Machine Interface)

The following are used fo navigafe within applications and to configure the terminal:
 Softkeys on the fouchscreen

¢ On-screen data entry fields (alphanumeric or numeric) on the touchscreen
« Scale Function keys on the terminal's fascia

METTLER TOLEDO IND700
= 2 R B soenrone

Max10kgd=1g

7.000.

>0< B/G

PT | B |G | B | @

Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. ID Form

Figure 43: IND700 Fascia and Touchscreen
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Scale Function Keys

Clear |In net weight mode, clears the current fare value; the display will revert fo B/
G mode.

In data entry mode, functions as backspace/delete or escape.

Tare | When fouched, weighs container on scale, switches display to NET mode,
and displays zero weight.

Zero | Captures a new gross zero reference point. Function depends on seftings
configured for each scale inferface at [Scale Setup » Page 73].

Transfer | Transmits dafa from the terminal to a printer or external storage, or registers
a fransaction. [Connections » Page 215] must be correctly configured.
[Output templafes » Page 2277 can be used to format the exported infor-
mation.

Highlight \When a scale function key is touched a highlight appears briefly fo confirm
the operation.

Power |Switches the terminal on and off.

Screen Areas

The following images identify the main components of the fouchscreen interface, in sequence from top fo
bottom.

IND700 Operation | 37



38

Operation

The system bar includes access to the main menu B, a messages inbox M, a current user display B, a
language selection icon [@), and the time and dafe (if the [display » Page 188] is configured fo show them).

;?\‘ @ 12:20
woo 05.0ct.2023

Figure 44: System Bar
The messages inbox displays information, warnings and cautions detailing the state of the terminal.

R @ 13:26
mod 26.0ct.2022

Figure 45: Messages Display
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Metrological information, including capacity and increment, appears just under the menu bar.

Max10kgd =1g

Figure 46: Metrology Display Area
In a ferminal with a single scale, the weight display area occupies the middle of the screen.

Figure 47: Weight Display
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When a tare has been taken, its value is displayed below the main weight display, and the B/G indications
changes to NET.

0.250 kg PT

Figure 48: Tare

The legend area displays information about items such as MinWeigh, scale motion, when the scale is af zero,
the currently operative range, and the net/gross idnciation.

>0< >|1|< B/G

Figure 49: Legend Area
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The softkey display will vary depending on the application in use, and on [terminal configuration » Page 197].

PT | @ | G

Preset Tare Tare Table Switch Units | Alibi Memory

Higher Res. ID Form Material Table
Figure 50: Softkeys

Target

2.1.5.1 Switching from multi-scale to single-scale view

Including Sum Scale, the IND700 HMI may display as many as three weight display areas. The image below
shows a display from a terminal configured with fwo HSALC inferfaces and a Sum Scale display.

£ 08:41
sai
é.-.lu (l:;'} 01.Aug.2023

Max 120kgd=20g

0.00 kg

YA
JF A\J

2 1+2 CALC

m"] Max60kgd=20g AR 2

Max 60 kgd=20g

0.00 0.00

PT | b |5 | G | R | @B |0

Preset Tare Tare Table Switch Scale | Switch Units | Alibi Memory | Higher Res. 1D Form Material Table
Figure 51: IND700 Displaying Two HSALC Scales and a Sum Scale
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2.1.5.2

Operation

Any scale can be selected for full-screen display simply by double-tapping on its display area. In the image
below, the Sum Scale has been selected. This format provides maximum readability in cases where the focus is
a single scale.

| 2 142 CALC Max 120 kgd =20 g

) kg

Figure 52: IND700 Focused on One of Three Weight Display Areas

Note that, in this display mode, the softkey ribbon is not available.
To return to the multi-scale display, simply double tap the screen again.

Weight Display Only Mode

It is possible to display weight information for the currently-selected scale as a window against the Windows
desktop, as in the example below.

Figure 53: Weight Display Only Mode, Example

The size and behavior of this window is configured in setup at [Application mode » Page 205]. Configuration
of this behavior must be performed by a user with the necessary access rights to modify setup parameters.
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2.1.6 Data Entry

When an input of numbers or text is required, touch the corresponding input field. Depending on the required
input type, one of the two keypads shown below will display on the screen.

Alphanumeric Data Entry

< Name

Figure 54: Alphanumeric Keyboard, Default (Lower Case) Display

1 A small triangle at the top right corner of a key indicates that special characters are available. To access
these, fouch and hold the character.

2 For example, when "s" is touched and held, a pop-up displays showing the available variants.
3 Touch the desired variant fo add the lefter or symbol fo the text entry field.

Touch the shiff key to display the letfers in upper case. Note that when it is touched, the key is colored blue to
indicate that it is active.

< Name

Figure 55: Alphanumeric Keyboard, Upper Case Displayed

Error Correction and Cursor Control

Nofe that when an entry has been made, an X < appears at the right of the entry field. Touch this X to clear the
field's contents completely.
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If an error is made in the entry, two methods are available to make a correction:
e Use the delefe key <XIfo backspace through the entry to the point where the error was made, deleting
characters.

 Use the cursor left and right keys < > fo position the cursor af the error, and then add or delefe characters
to make the correction.

( | Name
Prduct| < > (7
| 1 | | 2 | A = | = | =7 o | N n
| ( | Name
prduct > &
< Name
prduct <>
| 1 . ian | 2 | A | - | =7 o | 9] N
‘ ( _Name

pocut. X I

Figure 56: Correction of Erroneous Entry

Numeric Data Entry
When the user touches an entry field for a numeric value, the numeric keypad displays.

Figure 57: Numeric Datfa Entry Keypad
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When an entry has been made, nofe the X which appears in the enfry field. Touch this X to clear the entry.

-7 (9] N V£V |
Figure 58: Numeric Enfry in Keypad

2.1.7 Accessing Terminal Information

Information about the terminal and its configuration can be viewed by touching the menu access iconE and
selecting Terminal.

© Terminal S 192.168.86.222

<] Login/Logout Metrology

{0} Enter Setup © Terminal Information

— ~ M-
Figure 59: Terminal Information Menu

The options on the sub-menu include information about the terminal's network configuration, metrology, and
hard and software characteristics.

2.1.7.1 IP

The sub-menu shows the terminal's IP address; touch the address shown in the Terminal Information Menu fo
display a screen showing more detail about the connection.

4 Ethernet Information

Name Details

MAC Address 00-E0-4B-73-A7-31
IP Address 192.168.86.222
Subnet Mask 255.255.255.0
Gateway Address 192.168.86.1
DHCP Enabled

Figure 60: Terminal Network Information

Touch the Back arrow fo return fo the home screen.
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2.1.7.2 Metrology

Touch Metrology fo view the W&M Information screen.

46 | Operation

{  W&M Information O A e [

Status Log Time Name Version Serial I
Boot Service Version 5.41.150
Boot Service Thumbprint ID B827409295
Scale Server 5.41.150
Scale Lock V1.0.40

A 26.Jan.2024 Scale Module 1 - HSAL (1.0.40)  V1.0.40

A 26.Jan.2024 Scale Module 2 - HSAL (1.0.40) V1.0.40 87654:
Scale Module 3
Scale Module 4

A Scale Module 5 - Sum Scale

Figure 61: W&M Information Screen

Touch the back arrow to return fo the W&M Information screen. Note the icons in the W&M Information screen
header row; a number of functions can be performed from here:

Pairing History
Touch &to display the Pairing History screen.

< Pairing History File

ID* LogTime Terminal Serial No. Pairing Information

1 18.Jan.2024 10:53 69569416D7Z S1(, 355C4524)

2 18.Jan.2024 11:47 £9569416DZ S1(, 98BEBE37)
18.Jan.2024 11:47 S1(, 98BEBE37)

3 6956941602
19.Jan.2024 12:18 52(8765431, F293E1A5)
26.Jan.2024 08:37 51(, A593598F)

4 69569416DZ
26.Jan.2024 08:37 52(8765431, 1A37B7A0)
26.Jan.2024 08:38 51(, 4D370F8A)

5 69569416DZ
26.Jan.2024 08:37 S52(8765431, 1A37B7A0)
26.Jan.2024 08:38 S1(, 4D370F8A)

6 6956941602
26.Jan.2024 08:39 5$2(8765431, 88C82ED5)

Figure 62: Pairing History File

This file shows pairing information for each installed scale, together with the terminal's serial identifier.

Touch the back arrow fo return to the W&M Information screen.
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Scale Log Table
Touch & to display the Scale Log table.

{  Scale Log Table

Date and Time Version Version Index

11/17/2023 10:00:00 AM 4.0.102

Figure 63: Scale Log Table

Touch the back arrow fo return to the W&M Information screen.
Calibration Test

The Calibration Test &« is not currently implemented in the IND700.

Alibi Table

Touch A to display the Alibi Table view. The Search and Export functions work in the same way as described
in [Table Functions: Filter, Export, Import, Clear » Page 307].

<  Alibi Table

=
[

Log Transaction Scale Gross Net
Time Counter # Weight Weight

27.Feb.2023 04:04:18 1 3.2 3.2
27.Feb.2023 04:03:24 1 3.4 34
27.Feb.2023 04:03:15 2.8 2.8

=
o,
=

27.Feb.2023 04:02:48 52 5.2
27.Feb.2023 04:01:50 3.8 3.8
27.Feb.2023 04:01:37 3.6 3.6
27.Feb.2023 04:01:03 5.8 5.8
27.Feb.2023 04:00:35 4.2 4.2
27.Feb.2023 03:51:38 3.2

oo ololo o ololo

AT Fmle AN NI ANTT [ |
1 —

2

Figure 64: Alibi Table View
Touch the back arrow to return fo the W&M Information screen.
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2.1.7.3 Terminal Information

Touch Terminal Information to display the terminal's hardware configuration, together with software version
numbers where applicable:

<  Terminal Information

Slot Description Part Number Software Version
Slot 1 HSAL (HSAL ) 30726006 V1.0.40

Slot 2 HSAL (Analog ) 30726006 V1.0.40

0S Windows 10 1809 IoT Enterprise V2.6.30/2024-01-16 1
BIOS Kontron MTsXA4R_1.1_BETA1:Z
APP Supervisor 5.41.150-freeze.2+02.
APP Client. MTApp 5.41.150-freeze.2+02.
APP Engine 5.41.150-freeze.2+02,
Legal www.mt.com/legal

Figure 65: Terminal Information Screen

2.1.8 Table Functions: Filter, Export, Import, Clear

Enabled tables include a number of functions, accessed by fouching an icon in the table's header row.

The Alibi Table is read-only, and its contents can be Y filtered and ™1 exported. Alibi data cannot be imported
41, records cannot be delefed, and the table cannot be cleared . Once the Alibi Table has reached its
maximum capacity, the terminal begins to overwrite the oldest data. To avoid loss of Alibi Table dafa, it is
recommended that an export schedule be implemented.

The contents of the Material Table and Tare Table can be filtered, exported to a file, imported from a file, and
cleared. The import function permits table contents to be configured outside the ferminal, or shared between
terminals performing the same function.

The contentsof the Transaction Table can be filtered, exported and cleared.

Exported table contfents are sfored on the terminal in the C:\Export folder. Dafa to be imported must be placed
in the C:\Import folder. For details on file transfers in and out of the ferminal, refer to [File Transfer »
Page 348].

2.1.8.1 Filter

For an account of the filter eniry methods, refer to [Data Entry » Page 43].

Because it accumulates many records, the Alibi Table has a Filter function Y which filters the visible records
depending on up fo three conditions.
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Search Condition

The Search Condition fields permit the definition of three search criteria. The three filters screens are shown
below. Note the screen indicafor dots and up/down arrows at left.

< Filter
#1
Field Operator
Log Time W4 is equal W

. First Parameter

26.Jan.2024 00:00:00

Figure 66: First Table Filter Screen

The second and third Filter screens are shown with no Field selected. Filter #2 is shown enabled but not
configured. Filter #3 is shown disabled. The other filter options -- Operator and Parameter -- are not
accessible until a Filter Field is selected.

Figure 67: Second Table Filter Screen
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4 Filter

#3

Figure 68: Third Table Filter Screen

Field opfions are:

« None (filter not operational)

« ID

¢ Log Time

« Transaction Counter

e Scale #

e Tare Type

e Unit

The options provided by the Parameter value depend on the Field type selected. For example, if Scale # is
chosen, the Parameter field is a drop-down list of all available scales plus Sum Scale.

When a filter Field has been selected, the Operator field and a Parameter field becomes available -- two
Parameter fields, if in the range is selected as the Operator. Touch the Parameter field fo display its
associated enfry method. ([Data Entry » Page 431). The Parameter entry dialog shown below is for a numeric
parameter, in this case ID.

First Parameter

Figure 69: Example Filter Parameter Entry
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2.1.8.2

IND700

Other Field types are associated with other entry types. For example, if Log Time is selected under Field, the

Parameter field will display a calendar and Hour : Minufe input dialog.

4 February 2024

Su Mo Tu We Th

28 29 30 31 g
4 5 6 7 8
1M 12 13 14 15
18 19 20 21 22
25 26 27 28

3 4 5 6 7

Hour : Minute

0

Figure 70: Calendar Dialog for Log Time Field Parameter
Parameter options are:

e isequal

o freater

e greater or equal

* less than

e inthe range

<  Filter
#1
Field Operator
D N/ is equal
. First Parameter is equal
= 0
N reater
& ?
greater or equal
r/-_- 3
/
~ less than

Figure 71: Filter Condition Operators

Export

All tables permit the export th of data. The export screen requires the selection of a File Type, and the choice of

a File Name. The default form of the filename has the form [terminal]_[Year_Month_Day]_[time]_[Table
name], but this can be modified by touching the File Name field fo display an alphanumeric entry screen

([Data Entry » Page 437).
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{  Table Data Export

Directory
Internal Eile v C\Export\69569416DZ
File Type
Csv XML
File Name

IND700_2024 02_09_0813_Tare

Figure 72: Table Data Export Screen

Touch the blue check mark |v] to confirm the export and return to the Table view screen.

2.1.8.3 Import

The Material and Tare fables both permit data to be imported. Data for import fo a table must be contained in a

file of the appropriate format, either .csv or .xml. Touch the Import icon th fo display the Table Data Import
screen.

{  Table Data Import

Import Directory

Internal File s C\Import

IND700_2024 02 09 _0813_Tare.csv N

Figure 73: Table Data Import Screen

Touch the blue check mark |v| to confirm the import. The Table view screen will appear, with the new data
displayed.

2.1.8.4 Clear

To manage space in the terminal's memory, it may be necessary to clear a table. Before clearing a table, it is
recommended that a table export be performed. The dafa can be stored outside the terminal. This will prevent
unwanted data loss.
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2.1.9.1

2.1.9.2

2.1.9.3

IND700

When the clear icon @ is touched, a warning displays indicating that the entire table will be cleared.

Warning

Clear Entire Table?

X v/

Figure 74: Table Clear Warning
Touch the check mark fo confirm the deletfion, or the X to return to the table view.

Transferring Data

The print function (demand output) can be initiated by:
* Pressing the TRANSFER function key

e Through the automatic transfer function

Demand output of data may also be initiated as part of a particular sequence of operation or special application
software.

A system message appears for 3 seconds when the terminal is carrying out a demand output command.

Enabling Data Transfer

To execufe a data fransfer successfully, a serial, USB or Ethernet connection must be configured with a Demand
Output assignment and linked to a template and trigger associated with the selected serial or Ethernet port. If a
fransfer command fails because a Demand Outfput assignment is not programmed on any port, the
synchronous error message “Print Failed-No Demand Output” is displayed.

Transfer Interlock

A Transfer Interlock can be configured in sefup af [Log or Transfer » Page 161]. It is designed to enforce a
single demand output per transaction. The Interlock function can be disabled or enabled. If it is enabled, the
fransfer command is ignored until the measured gross weight exceeds the interlock threshold. After the first
tfransfer command is executed, subsequent transfer commands are ignored unfil the gross weight indication
falls below the interlock reset threshold.

If a transfer command is blocked by the Inferlock function, a synchronous “Print Not Ready” error is generafed.

Repeat Transfer

The Repeat Tr. softkey 2. permits the data output of the most recent demand output to be transferred again with
a DUPLICATE header or footer fo distinguish it from the original transfer. To enable the Repeat Transfer function,
simply add the softkey to the Home Page softkey ribbon, in setup at [Softkeys » Page 197]. Pressing this
softkey will initiafe a repeat transfer of the last Demand Output connection listed in the assignments found in
Connections.

The repeat output femplate can be flagged with a “DUPLICATE” header or foofer to indicate that the data in the
output femplate was generated as a repeat of a previous communication.
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2.1.9.4

2.1.9.5

2.1.10

2.1.11
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Auto Transfer

Automatic initiation of a demand output occurs affer the gross weight exceeds the minimum threshold and there
is no motion on the scale. After inifiation, the gross weight must return below the reset threshold before the next
automatic transfer can occur.

Auto Transfer may be disabled or enabled. It can be triggered and reset by weight exceeding set thresholds, or
by weight deviation from a previously stable reading.

Report Transfer

The IND700 does not include any standard Report formats. However, when a [Connection » Page 215] is
configured with the Assignment Transfer, and a Template is configured for use with the connection, the selected
template can be configured ([Output Templates » Page 227]) to include whatever data the report requires.

Selecting an Input Template

Different data inputs require differently configured input templates. For example, the inpuf from a barcode reader
will differ from the input from a keyboard. The IND700 allows up to ten input templates to be configured. The
basic method for selecting a template to use is fo access [Setup > Communication > Connections »

Page 215], and configure a connection with the required femplate associated with it. However, there is a
simpler and more direct way fo switch between input femplates, using a softkey in the ribbon on the screen.
Follow these steps to configure quick access fo input templates:

1. First, ensure that each of the input templates to be used is [configured » Page 238], and associated with a
connection.

2. In setup, access [Terminal > Softkeys » Page 197].
3. Drag the Input Template softkey ®to the ribbon.

4. Return fo the weighing screen. If at least one input template is properly configured, the softkey will now
show it as currently selected -- .2...

5. To switch between input femplates, as well as between the configured connections, fouch the Input
Template softkey to display a list of available templates.

Template 1

Template 2

o .

+
Template 1
Figure 75: Input Template Softkey Pop-Up List

Automatic Standard (Output) Template

For details on configuring femplates, refer to [Output Templates » Page 227] and [Input Template »

Page 238].

During weighing operations, Output Template 1 provides a powerful and convenient tool. This femplate is
aufomatically configured, in real fime, to adjust its contents to capture information displayed on the main
screen. This information includes basic weighing data, application parameters, and the labels and confents of
any ID forms in use. If the femplate is assigned to a [Connection » Page 215], a Transfer operation will
produce output in the format specified by the template. This functionality means that it is not necessary fo look
up the relevant Shared Dafa variables and enter template elements manually.

However, different weighing operations will require different output confent. The Automatic Standard Template
provides a simple way to reflect these differences in fransferred data, and fo switch quickly between output
formats.

Follow these steps:

1. Configure the terminal as appropriate for one type of weighing operation. This will set Output Template 1 to
capture the data generated by this operation.

2. Enfer Sefup and access Communication > Output Templates.
3. From the menu, select Template 1 in order to view its content.
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2.1.12

2.1.12.1

IND700

4. Touch the Duplicafe icon © in the menu bar. The Copy Template screen will display. In the example
shown below, the To field template selection list has been expanded.

{  Copy Template

From

1

Figure 76: Copy Templafe Screen
5. The current template, Template 1, will be shown in the From field. Touch the To field and select an unused
template, then touch the RUN icon » af lower right.

6. Touch the BACK arrow twice fo return to the setup menu view, and access Connections. Either create or edit
a connection so that its Assignment is Transfer, with the newly-configured Output Template named in the
Template field.

7. Select Exit Setup &:from the dropdown menu at upper left.

8. Configure the terminal for a second type of weighing operation, then repeat steps 2 to 7, again copying
Output Templafe 1 to an unused femplate (e.g. Template 3).

9. Assign the newly-created Template to another Connection.
10. Repeat these steps until all required types of weigh operation are represented by one Output Template.

Alibi Memory Direct Access

The Alibi Memory stores individual fransaction data that can be retrieved for verification purposes. Information
stored in the Alibi Memory includes:
» Transaction counter value

* Date and time of fransaction
e (Gross, nef, and fare weights including units of measure

If the IND700 terminal has been programmed as “approved”, Alibi memory
enabling or disabling is only accessible if the security switch (SW1-1) is in the
OFF position.

The Alibi memory can not be cleared unless a Factory Reset is implement.
Refer to PCB Switch Settings for more information on Factory Reset.

Creating an Alibi Memory Record

Alibi memory records can be created automatically or manually:
» Auto Transfer: Through an automatic initiation of a demand output print request

* Semi-automatic Transfer - Pushbutton: By pressing the Transfer scale key .
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« Semi-automatic Transfer - Remote: Through a fransfer command initiated via a discrefe input, an ASCII P
serial command or an Industrial Network interface.

2.1.12.2 View, Search and Transfer Alibi Memory

1 Press the ALIBI TABLE softkey [Al.
= The Alibi screen displays.

< AlibiTable Y M

Log Transaction Scale Gross Net Ta
Time Counter # Weight Weight Wi

28.5ep.2022 09:38:15 | 1.595 0.845
28.5ep.2022 09:37:34 1 1.395 0.645
28.5ep.2022 09:34:52 1.395 0.645
28.5ep.2022 09:33:46 1.395 0.645
28.Sep.2022 09:29:45 1.395 0.645
28.5ep.2022 09:29:14 0.710 0.710
30.Nov.2022 23:40:29 0.000 0.000
30.Nov.2022 23:40:28 0.000 0.000
30.Nov.2022 23:40:27 0.000 0.000

2N Al s s TIATTY DL AN AW aTalal [aWalalal

Figure 77: Alibi Table View

2 Touch the FILTER softkey Y.

3 Use the selection boxes and dafa entry fields fo enfer specific search information fo limit the search, or do
not enter any search limits fo view all Alibi Memory Table information.

{ Search Condition

Search Condition

Field Operator First Parameter

Log Time v = ¥ 28.5ep.2022

Sort Condition

Field Sort Direction

ID ¥ | Ascending

Figure 78: Sefting Alibi Table Search Conditions
4 Press the OK softkey .
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= The filtered search results are shown. Records are ordered by dafe and fime with the most recent record
shown last.

Alibi Table O Y

Log Transaction Scale Gross Net
Time Counter # Weight Weight

28.5ep.2022 09:29:14 1 0.710 0.710
28.5ep.2022 09:29:45 1 1.395 0.645

28.5ep.2022 09:33:46 1.395 0.645

28.5ep.2022 09:34:52 1.295 0.645
28.5ep.2022 09:37:34 1.395 0.645
28.5ep.2022 09:38:15 1.595 0.845

Figure 79: Alibi Table Search Results

5 Use the navigation keys to view the records: Date, Time, Transaction, Gross Weight, Net Weight, Tare
Weight, Calculafed, Tare Type, and Unit. Note: In the Tare Type column, "PT" is shown if the fransaction
uses a presef fare.

In this screen, fouch the Filter softkey Y, which is filled o indicate that a search has been carried out, to
renew the search information, or press the Filter Clear softkey ) fo clear the search information.

6 To ouput the entire Alibi Table, or a filtered part of it, touch the TRANSFER softkey th on this screen.
< Export

Target For Export

Internal File

Type For Export
XML

Export File Name
IND700_69569326D7_2023_04_17_1033

Export Directory
CA\Export

Figure 80: Alibi Table Export
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2.1.13 Quick Access to Input Templates by Softkey

2.2

2.2.1

58 | Operation

When a Connection is defined with an Input Template Assignment, the Selectable by Softkey slider will
display.

< Add Connection

Port Input Template
Ethernet N/ Template 1 N
Erharaat Selectable by Softkey

Assignment
Input Template Y

Ethernet Connection
Server N
Ethernet Port

1701

O Vv

Figure 81: New Connection, Inpuf Template Assignment

When at least one connection has been assigned to an inpuf template, the Template softkey ® can be seen in
the softkey ribbon, if it has been added in sefup at [Terminal > Softkeys » Page 197].When it appears on the
home screen, this softkey displays Template 1 by default: .2. When multiple femplates are configured and
assigned fo connections, touching the softkey will display a confext menu, listing all available femplates:
hovy

Template 1
Template 2
Template 3

&)

5 Ternplate 1
Figure 82: Templates Softkey with Context Menu

Touch the desired template fo load it. The softkey will show the number of the currently selecfed template: 2.

Basic Weighing Operation

This section provides information about the basic weighing functionality of the IND700 terminal. For defails on
the use of Applications, refer to the ProWorks Multi-Tools User's Manual.

Simple weighing

In its most basic form, the weighing operatfion consists of the following:
1. Zero the scale.

2. Place the item to be weighed on the scale.

3. Wait for the instability indication === fo disappear from the display.
4. Read the resulf of the weighment from the screen.
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2.2.2

IND700

The illustrafion shows the resulf of a simple weighing operation in a terminal configured with fwo analog
(HSALC) scales installed and configured fo provide a Sum Scale display.

11:09
03.Apr.2023

4.94 kg

2 1+2 CALC Max 2.06 td =0.2 kg
7000
M ~ | Max10kgd=320g M 2 10.0°C / +40.0°C

1.98 kg

A%

Switch Scale

(3

Switch Units | Alibi Memog

@

Higher Res.

ID Form

Material Table

PT

Preset Tare

Tare Table

Figure 83: Example Simple Weighing Display
The digit size of the weight display adjusts dynamically depending on the resolution of the scale.
Simplified Large Weight Display

Any of the scales displayed on screen can be viewed in a larger, simplified format by double-tapping anywhere
within the desired scale's display area. The larger display will appear:

09:32
26.Jan.2024

5 ®

> 1+2 CALCSu...

13740,

B/G

PT

Preset Tare

Figure 84: Simplified Large Weight Display

A%

Switch Scale

A

Alibi Memory

Higher Res.

ID Form

Tare Table

(3

Switch Units

To return to the standard weight display, simply double-tap anywhere on the screen.

Zero

Before performing a weighment, it is important that the scale or scales be precisely af their zero point. If the
weight value has deviated from zero, it can be restored fo zero by either of two methods:

1. Touch the Zero function keyf#ll on the terminal's fascia. The key's surround will illuminate briefly fo confirm
the action N

2. Touch the Zero softkey icon *Q, if it is configured to display in the softkey ribbon.
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2.2.2.2

2.2.2.3

2.2.3
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The Zero operation functions depending on the parameters configured in sefup af Scales > Scale © > ASM >
Zero. If the current scale weight is outside the range set there, the Zero operation will fail. Refer to [POWERCELL
- Zero » Page 124] for details on these settings for the various scale types used with the IND700.

Automatic Zero Maintenance

Automatic Zero Maintenance (AZM) enables the terminal to compensate for the buildup of small amounts of
weight and frack itself back to the center of zero. Within the AZM operating range (programmable from 0.00 fo
10.00 divisions), when the terminal is in a no motion condition, it makes small adjustments to the current zero
reading to drive the weight reading toward the true center-of-zero. When the weight is outside of the
programmed AZM range, this feafure is not functional.

Power-Up Zero

Power-Up Zero enables the terminal fo capture a new zero reference point after power is applied. If the terminal
detects motion during a power-up zero capture function, it will confinue fo check for a no-motion condition until
zero is captured. Power-up zero can be disabled or enabled, and the acceptable range above and below
calibrated zero configured. The range is programmable from 0% to 100% of capacity and can include a
positive range and also a range below calibrated zero.

Pushbutton Zero

The pushbutton (semi-automatic) zero function can be accomplished by:

« Pressing the ZERO scale function key 8 or the ZERO softkey *Qv, if configured.
e Programming a discrete inpuf for zero and then activating this discrete input
 Industrial Network command to the terminal

¢ Serial command (SICS or CTPZ protocols)

e A custom application

The range for all types of pushbutton zero is selectable (0% o 100%) plus or minus from either the calibrafed
zero point (if power-up zero is disabled) or from the initial zero seffing point (if power-up zero is enabled).

Remote initiation of the pushbutfton zero command is possible via a discrefe input, an ASCIlI 'Z” command sent
serially (CPTZ and SICS), a command initiated by the Industrial Network inferface, or from an application.

Tare

The use of a tare value switches the terminal's weight display from Gross mode, in which the absolute weight
on the scale is displayed, to Net mode, in which the displayed weight accounts for the weight of a contfainer, for
example, and shows only the weight of material or items added to the container.

When a tare is loaded, the weight display's indication changes from B/G (gross weight display) o NET, the
weight display shows zero weight on the scale, and a tare indication af lower left of the main screen shows the
tare value and its type (T or PT).

A Tare value can be loaded in several different ways:

¢ Manually, from the terminal's function bufton or from a softkey in the softkey ribbon
Manually, by enfering a Preset Tare value

e Manually, by selecting a Tare record from the Tare Table
Automatically

Similarly, a tare can be cleared by:

* Touching the terminal's Clear function key
Automatically

See also
& Data Eniry » Page 43

IND700



2.2.3.1

2.2.3.2

IND700

Pushbutton Tare

The simplest way to take a tare is to place an empty container on the scale

}1. @ 12:45
& 03.Apr.2023

Mg -10.0°C / +40.0°C

070 kg

Figure 85: Weight Display in Gross Mode
With the container on the scale, touch either the terminal's Tare function key @K or the Tare softkey *1+, if it is
configured fo display in the softkey ribbon.

The display will change from gross weight on the scale fo net mode, and display a tare indication with T,
showing that the fare was taken by pushbution

é:.L. @ 03,Apr.122t;:2

AR 1 -10.0°C / +40.0°C

0.00 kg

Figure 86: Weight Display in Net Mode, with T Indication

Keyboard Tare

A Keyboard tare, also called a preset tare, is a numeric tare value that is entered manually through the numeric
keypad, received serially or via Ethernet from a peripheral device, or refrieved from the Tare Table memory. The
preset tare value cannot exceed the capacity of the scale. A manually enfered Tare value is interpreted to have
the same units as the current displayed value. Motion does not impact the entry of preset tare values.

Keyboard tare can be configured in Setup as enabled or disabled. When disabled, the numeric keypad and the
TARE scale function key @k cannot be used fo obtain a fare.

— To enter a keyboard tare or preset tare value manually, use the numeric keypad or external fo enter the fare
value (data entered will display just above the softkeys with a “Data:” label) and press the TARE scale
function key 3R .

If configured in Setup, remofe equipment can enter a Keyboard Tare or Preset Tare value using a serial
command or Industrial Network command (refer fo [Industrial Network » Page 220] and [Communication
Setup » Page 2087).

If the Keyboard Tare or Presetf Tare is successful, the display changes fo a net weight indication, and the
entered preset tare value is stored as the tare value in the active tare register. If Tare display is enabled, the
pushbutton tare value will be shown with a PT label.

Several conditions could inhibit the keyboard tare or preset fare function:

Keyboard Tare Disabled If keyboard tare is disabled in setup, the numeric keypad and the TARE scale
function key @R cannot be used fo obtain a fare.

Over-Capacity or Under- Preset tare is nof allowed when the weight display indicates over capacity or

Zero Conditions under zero conditions. Any preset tare attempted when the scale is over capacity
is ignored and a “Tare Failed—Over Capacity” error displays. Any preset tare
attempted when the weight display indicafes a blanked under zero condition is
ignored and a “Tare Failed—Below Zero” error displays.
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Preset tare can be enfered in free format. If the entered value does not match the displayed weight decimal point
location or display inferval, the entered tare value is rounded fo the nearest display interval and the decimal
point adjusted fo match the gross weight. The rounding method is that 0.5 or more of a display inferval (d) is
increased to the next display interval and 0.49 or less of a display interval is decreased to the next lower
display interval.

When entering a preset tare value less than 1.0, the operator can enter the data without the leading zero (left of
the decimal point), but all subsequent display, sforage, or printing of this value will include the leading zero.
For example, a preset tare entry of .05 will display as 0.05.

If a preset tare has already been established and another preset tare is entered, the second preset tare replaces

the previous value (it does not add to the previous value). The replacement tare can be larger or smaller than
the original fare value.

2.2.3.3 Auto Tare

The terminal can be configured so that tare is automatically taken (auto tare) affer the weight on the scale
exceeds a programmed fare threshold weight. Auto fare can be configured in Setup as enabled or disabled.
When auto fare is enabled, the display changes to a zero net weight indication after the weight exceeds the
threshold value. The previous weight on the scale is stored in the fare register as the tare value.

Auto tare operations involve:
Tare Threshold Weight ~ \When weight on the scale platform exceeds the tare threshold value, the terminal
aufomatically tares.

Reset Threshold Weight  The reset threshold weight must be less than the fare threshold weight. When the
weight on the scale platform falls below the reset threshold value, such as when a
load has been removed, the terminal automatically resets the aufo tare trigger.

Motion Check A motion check is provided fo confrol the re-arming of the auto tare function. If
disabled, the auto tare trigger will be reset as soon as the weight falls below the
reset value. If enabled, the weight must seftle fo no-motion below the reset
threshold before the next auto tare can be inifiated.

Several conditions could prevent the auto tare function from working:

Motion Auto tare cannot be taken when the scale is in motion. If motion is defected after
the weight on the scale exceeds a preset tare threshold weight, the terminal will
wait for a no-motion condition. If a stable (no motion) weight condition occurs
within 3 sceonds, the auto tare command is executed.

Auto Tare Disabled Aufo tare can be configured in Sefup as enabled or disabled.

2.2.3.4 Special Tare Operation in Multi-interval Scale Applications

When the terminal is configured for mulfi-inferval operation (refer to # Ranges/Intervals), the terminal only
permits a preset tare fo be taken in interval # 1. A preset tare, including the recall of a stored tare from the Tare
Table (refer to [Tare Table » Page 172]) must be a value in inferval # 1 as well. If a tare is atfempted with a
weight value found in inferval 2 or 3, a “Tare Failed — Over Range” error is given.

Note: Because of the way the terminal manages the tare, it is required that the final weighing system has
a label displayed that indicates the maximum tare value within the capacity of interval # 1: T = nnn,
where nnn is the capacity of interval 1.

The requirements for this marking are as follows:

¢ Required only for OIML approved ferminals that are programmed for multi-interval (not multiple range).
« The descriptive markings shall be indelible and of a size, shape and clarity allowing easy reading.
It shall be located in a clearly visible place on a sticker fixed permanently to the instrument.

* In case the sticker is not destroyed when removed, a means of securing shall be provided, e.g. a control
mark that can be applied
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2.2.3.5 Using the Tare Table

2.2.3.5.1

IND700

Tare Table Records

Tare records can be added, modified and deleted in the Tare Table view whether it is
accessed via the softkey or in setup at Application > Memory > Tare Table, butf only if the
user's login level permits.

If tare records have been stored in the Tare Table, they can be recalled by fouching the Tare Table softkey
and selecting a tare record from the list which appears.

Tare Table

Name A Lescription Value Unit Low Limit

Sandbag

125 kg

BB box Box for counting ball bearings 0.15 kg

Figure 87: Tare Table with Record Selected

Touch the check mark to load the fare and refurn to the weighing screen, now in NET mode with a PT (preset

tare) indication.

Loading Records from the Tare Table

The TARE MEMORY softkey can be used in two ways to active records from the Tare Table.

Quick Access to Records \When the ID of the Tare Table record fo be used is known, use the Quick Recall
method. Entfer the ID using the numeric keypad and then press the TARE MEMORY
softkey [r to load the record info the active Tare register/memory. If the record is
available, the data is loaded. If the record is not found, an “ID not found” error
displays.

List Selection When the ID of the Tare Table record is unknown, use the List Selection method.
To use the List Selection mode:

1

Press the TARE MEMORY softkey [x] without any preceding data entry. The Tare
Search screen displays.

Enter any search restrictions required or leave selections as they are to retrieve
all records.

Press the SEARCH softkey Q 1o view the selected records in the fable.

Use the UP and DOWN navigation keys to scroll through the list until the
desired record is highlighted.

Press the OK softkey + 1o load the selected record from the list

Press the EXIT softkey <= to return fo the weighing operation screen without
loading the record.
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2.2.3.6

2.2.3.6.1

2.2.3.6.2

2.2.3.7
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Clearing a Tare

Clearing Tare Manually

To clear a tare and return the terminal to B/G (gross) mode, either touch the Clear function key [, or the Clear
softkey T+, if it is configured fo appear in the softkey ribbon.

The weight display will refurn to gross mode, and display the weight of the container as a positive value .

Clearing Tare Automatically

If Auto clear tare is configured in Setup at Scales > Scale n > ASM > Tare, the terminal will refurn to gross
mode and display zero as soon as the container is removed from the scale. The Auto clear tare threshold
must be lower than the weight of the container.

Manual Clear

Press the CLEAR function key [&l when the terminal is in the net mode and has completed the weighing
operafion. Motion on the scale will not impact a manual clear.

Auto Clear

The ferminal can be configured to clear tare automatically when the weight refurns fo a value below a
programmable threshold, or when a print command is issued. Once the fare is cleared, the display refurns to
the gross weighing mode.

Auto clear is disabled or enabled in Setup. If auto clear is enabled the following parameters, configured in

Setup, affect the auto clear operation:

Clear Threshold Weight  The clear threshold weight is the gross weight value below which the terminal will
automatically clear a tare affer seftling to a value above this threshold value.

Motion Check A motion check is provided to control the automatic clearing of fare. If the motion
check is disabled, the tare value is cleared as soon as the weight drops below the
threshold weight (auto clear threshold), regardless of the motion status.

If the motion check is enabled, after meeting the requirements for weight value
above and then below the threshold weight (auto clear threshold), the IND700
waits for a no motion condition before automatically clearing the fare.

Clear After Transfer If enabled, tare is automatically cleared and the scale refurned fo the gross mode
after data has been fransmitted by pressing the TRANSFER scale function key
or from a remofe source.

Clear With Zero If enabled, pressing the ZERO scale function key g& will first clear the tare then
issue a zero command.

Refer to Aufo Tare for further information about configuring auto clear.

Checking a Container Tare

This function automatically detects and identifies different sizes of container by weight, using the Lower Limit
and Upper Limit defined in the Tare Table record. Note that a tare record can either specify an absolute Tare
Value or these limit values.

To use the checking function:
1. Place the empty container on the scale.
2. Touch the Tare Table softkey and load the required record ([Using the Tare Table » Page 637).

3. If the weight of the container falls within the range specified by the record, an automatic tare operation is
performed.

4. If the weight of the container is not within the range, the terminal will remain in gross mode and an error
message will display:

IND700
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Container tare check
@ failed. Weight is not in

corresponding limits.

Figure 88: Container Tare Weight Outside Limits

2.2.3.8 Chain Tare

For analog (HSALC) scales only, when Chain Tare is enabled in sefup if is possible fo tare several times
sequentially. This is useful, for instance, when mulfiple ifems are to be weighed, and are placed in a single
confainer. Each item can be compared to the same tare without resetting the loaded tare value.

In the following example of a chain tare operation, a box is placed on the scale, and items added to it with
packaging material between each item. The nef weight of each of the added items is fo be determined:

1. Place the container on the scale and touch Tare (function key or softkey).

2. The package weight is stored as the tare weight, and the NET mode display appears showing zero weight.
The status line shows a tare value with the T indication.

3. Load the first item, and read or fransfer (print) the resulting weight.

4. Place packing material in the container, to protect the first item, and fouch Tare again. The fotal scale
weight is saved as the new fare value (the status line tare value increases), and the display shows zero
NET weight.

5. Load the second ifem, and read or transfer the resulting weight.
6. Repeat the process for the remaining packing materials and items.

2.2.4 Switching units

If a second unit is defined for the scale (in Setup af Scales > Scale < > ASM > Units), the display can be
switched from the primary fo the secondary unit and, if configured, a third unit, and back by touching {3 When
the unit is switched, the capacity and increment display is also updated fo reflect the change.

03.Apr.2023

Max 10kgd=20g

0.00 kg

D
| [ |

D/\a

Figure 89: Example Primary Unit Display
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}1. (15 10:56
& 03.Apr.2023

Max 25Ibd=0.051b

0.00 i

Figure 90: Example Secondary Unit Display

When switching units, the capacity of the converted units is dictated by the original number of divisions estab-
lished in Capacity and Increments, in setup. In some situations, this may reduce the capacity of the terminal
when converting fo second or third units.

e Possible unifts depend on the active scale and the local Weight and Measures regulations.

e When in Counting mode, use the o softkey fo switch the display between weight and number of
pieces.

PowerDeck scales
In the factory sefting, the device offers the display unit kg. A second and third display unit can be defined in the
Scales setup. Then it is possible fo switch between weight units.
1 Touch{i.
= The weight value is displayed in the second unit.
2 Touch £ again.
= The weight value is displayed in the third unit, if defined.
» Possible units depend on the active scale and the local Weight and Measures regulations.
» To switch between weight unit and number of pieces, use the o softkey.

2.2.5 Higher Resolution

The Higher Res. softkey €3 is used fo increase the selected weight display resolution by one additional digit.
For example, a weight display of 40.96 could increase by one additional digit to display as 40.958. To
indicate this increased resolution mode onscreen, the weight display digits turn orange, and an asterisk (*) is
shown at the end of the weight value.

R @ 09:37
th 1 26.Jan.2024

AA 1 Max 66.59 kg d =1g

1.000.,

B/G

@ .
: i i ibi i 1D Form Material Table

Figure 91: Standard Weight Display
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2.2.6 Loading Alert (PowerDeck Platforms Only)

IND700

09:38

26.Jan.2024

AA 1 -10.0°C / +40.0°C

1.0004.

B/G

PT B | Q& | A | @ | [ @

Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. 1D Form Material Table Target
Figure 92: Higher Resolution Weight Display

Touch the Higher Res. softkey@ again to refurn to normal weight display.

Approved Scales

When the terminal is programmed as Approved with the metrology switch (SW1-1) ON, the Higher Resolufion
mode is displayed for five seconds, then automatically returns fo normal resolution. The transfer of data is
disabled when the weight is expanded and the terminal is approved.

Figure 93: IND700 Displaying Loading Alert Screen

For accurate weighing, loads should be placed so that their cenfer of gravity is near the geometric center of the
plafform's load cell arrangement. This is particularly important in cases where the platform is flush with the
floor, and it is possible for parf of the load to overhand the platform and be supported by the floor, reducing the
measured weight.
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When a PowerDeck platform is connected fo the ferminal, an additional operational feature is available to assist
a user in centering the load on the platform. Once enabled and configured in Setup, whenever the center of
gravity of the load is outside of the user configured "OK" Zone, a Loading Alert screen is shown.

The Loading Alert displays as a rectangle representing the scale base, keyed with load cell numbers 1 through
4. The acceptable zone, relatfive to the cenfer of the scale, is indicated by a light blue box. If an off-cenfer
condition is defected, the loading alert displays with a dot indicating the quadrant experiencing the most
extreme deviation, and an arrow indicating the direction in which the load should be moved. The operator
should visibly inspect the load to make sure it is completely on the platform and if not, fake steps to properly
center the load or container for which a weight is fo be captured.

Depending on how the Loading Alert feature is [configured » Page 138], the loading alert display can either be

dismissed by

* Removing the load from the scale.

* Repositioning the load within the OK zone.

« Pressing the left arrow <. to dismiss the alert. This option may be suppressed, so that the alert will
continue to display unfil the load is removed or its position is corrected.

Two example screens are shown below, one for a square platform, one for a rectangular platform. In both
cases, the alert indicates the position of the load's center of gravity on the platform, and the direction in which
the load should be moved for accurate weighing.

3 Please check loading
or move container into
center to continue

Follow instructions:

)’

Pl (v k hsh:ih; T4

recAe (O La ner NS
CRNDEr T OALInUE.

Follow INgorucons:

=

Figure 95: Loading Alert Display, Rectangular Platform

2.2.7 Run Flat Operation (POWERCELL Only)

When Run Flat is configured in setup (at [ASM > Maintenance > Predictive Maintenance » Page 132]), when a
load cell fails the system will temporarily compensate for the failure by estimating the total load on the scale
based on the readings provided by the good load cells. When Run Flaf is in operation, the weight display will
show E after its last digit, indicating that the displayed value is estimated, and an alert message will appear in
the Message area of the menu bar -- Scale n Build adjustment needed.
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2.2.8

2.2.9

2.2.10

2.3

2.3.1

IND700

Transfer/Export

To print the results of a weighing operation, or to export them to an external storage location, the following
must be true:

» An appropriate connection is defined in sefup
» Atemplate is associated with the connection
e The terminal is connected fo a printer or fo a network

If these conditions are fulfilled, touching the Transfer function key [Ed will cause the terminal to fransfer the infor-
mation to the configured destination. The function key surround will illuminate briefly, and a message Trans-
ferring will appear at upper right on the screen.

An alternative way to export weighing dafa is fo access the Alibi Memory Table [A). If this fable is enabled in
setup, a new record is created each fime a weighing operation is fransferred. The whole contents of this fable
can be fransferred, or a selection of records defined by using the table's Search Condition options.

Refer to [Transferring Data » Page 53] for further defails.

Setting Region, Time and Date

Location information for the terminal, including its dafe and time settings, are configured in the Terminal branch
of setup at [Region » Page 194]. Local preferences such as date order and time delimiter can be selected, in
addition fo sefting the current time and date. Time and date values can be set automatically if the terminal is
connected fo a network and Enable NTP Network Time Protocol is enabled.

Target Entry

Target operations are available only in IND700 terminals licensed to run the ProWorks Multi-Tools Applications.

Refer to the ProWorks Multi-Tools User's Manual (30753893), which details the configuration and operation
of the applications.

Applications

For details concerning IND700 applications, please refer to the IND700 ProWorks Multi-Tools User's Manual
(30753893), which details the configuration and operation of the applications.

ID Forms

ID forms are an easy way to associate a weighment with specific data such as Product, Batch, Lot No., efc.
The fields included in an ID Form are defined in setup at [Application > ID Form » Page 175], where up fo 10
values can be enabled and named. Data entered in an ID form and associated with a weighing operation is
available in the Transaction Table, and can be fransferred using a properly-configured output template.

Operation
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The illustration below shows the ID Form which displays when the ID Form softkey [5 is fouched. In this case,
five fields are configured.

T ID Form

Product

Operator ID

Figure 96: ID Form Example

Each field in the ID form can be configured either to preserve the previously entered value (useful when a series
of similar items is weighed, each with a different serial number, or when a series of weighments is associated
with a specific Operator), or to clear its value on each use.

Even if the previous value is preserved, fouching the relevant field will allow it to be edited using either an
[alphanumeric entry or a numeric enfry keypad » Page 43]. The type of entry keypad displayed depends on
whether or not the field is configured (in sefup af [Application > ID Form > Edit ID » Page 175]) to accept only
numeric data.

L Operator ID

| < >

Figure 97: Alphanumeric Entry fo ID Form Field

Fields in the ID form can also be defined as Numeric Only, in cases where an alphanumeric character would
be an incorrect entry.
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Transaction Table Display of ID Form Data

The Transaction Table records a number of items of data for each transaction; touch the screen and swipe left
to show further columns, and swipe down fo scroll through the rows.

<  Transaction Table

Gross
Weight

Net
Weight

Tare
Weight

Preset Material Mat
Tare ID Nan

4.38
9.28
10.04
9.88
6.22
6.26
0.00
0.00
3.2

DA

1.70
8.02
4.98
5.02
4.96
5.00
0.00
0.00

3.2

2.68
1.26
5.06
4.86
1.26
1.26
0.00
0.00

0.0

il Sant
Pl Sant
Sant
Sant
Sant

Sant

Figure 98: Transaction Table, Example of Initial View

{ Transaction Table m M
Material Lot Operator
Name Product Batch No. Shift 1D APW pcs Ta
Sand 5 55 3 2 Halliday
Sand

Figure 99: Transaction Table Scrolled fo Show ID Form Data
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3 Configuration

Overview

Access to the terminal's setup, or configuration, menus is provided in the drop-down list af top right of the
home screen

& @ 2E,Jan?‘290:‘;i

© Terminal >

&] Login/Logout

{G} Enter Setup
App Screen View
() Power > k
> o g

Max 66.59kgd=1g

PT ¥ @
Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. 1D Form Material Table Target

Figure 100: Home Screen with Drop-Down Menu

Touch Enter Setup o access the menu system. The main setup menu screen appears.

4:(.1 @ ESAug:}_ZSI;;g?

Setup

Scales

Application

Terminal

Communication

Maintenance

Figure 101: Main Setup Menu
Touch any of the setup ifems fo access ifs options.

Data Entry in Configuration Screens

Various parameters require the entry of numeric or alphanumeric dafa. Refer to [Data Entry » Page 43] for
details on how to enter data using the IND700 HMI.
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3.1

3.1.1

3.1.1.1

IND700

Confirming or Reverting Changes

When changes are made to a configuration screen, in most instances the terminal offers an option o confirm
the changes by selecting a check mark, or revert them by selecting a circular arrow.

O Vv

Figure 102: Change Confirmation/Reversion Icons

Scale Setup

The options available in the Scale Setup menu differ depending on the type of scale/s connected. The ferminal
supports one or two scales, which can be of a different types, and Sum Scale which fotals the weight values
from all included scales. Scale Sefup is performed using the ASM (Advanced Setup Mode) embedded in the
scale.

The main Scale setup menu includes Scale 1, Scale 2 (if installed), and Sum Scale.

= 5 ®

Setup > Scales

09:50
26.Jan.2024

Scales Scale 1
Application Scale 2
Terminal Sum Scale

Communication

Maintenance

|
Figure 103: Setup Menu - Scales

In each of the setup screens, access the previous screen by touching the left arrow at upper left of the screen, or
by touching the 'breadcrumbs' at the top of the menu. For example, in the screen shown above, touch Setup to

close the Scale options view and return o the main setup view.
High Speed Analog Load Cell

Scale n

The Scales branch of the setup menu displays options for each scale (1 or 2, depending on how many
inferfaces are installed in the ferminal) and for a Sum Scale.
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When either scale is selected, two further opfions appear -- ASM, which provides access to all the scale config-
uration menus, and Log or Transfer, which determines whether and how each weighing operation is recorded
or exported.

}_;L. @ 1 Apr121022

Seup > Scales > Scale 1

Scales Scale 1 ASM
Application Scale 2 Log or Transfer |
Terminal Sum Scale

Communication

Maintenance

Figure 104: Scale n Menus, HSALC

3.1.1.1.1 ASM
The ASM (Advanced Setup Mode) menu includes the items show in the figure below.

.!L @ 25.Aug.?:-.!?;;?

... > ASM
Metrology Units MinWeigh
Identification Zero Reset
Capacity &
pacity Tare Maintenance
Increments
Linearization & ,
. . Filter
Calibration
Control mode Stability

Figure 105: HSALC ASM Menus

The ASM system runs on the scale interface, and is separafe from the terminal's own firmware which runs on
the terminal's CPU.

Metrology

74 | Configuration IND700



IND700

The Metrology screen allows the configuration of per-scale approvals and GEO values, as well as lower and
upper operating Temperature Limits.

{  Metrology

Approval

Not approved

Not approved
OIML
NTEP

Lower temperature limit (°C)

-10

Upper temperature limit (°C)

40

Figure 106: ASM - Metrology Screen
When an approval (OIML or NTEP) is selected, additional options are displayed.

<{  Metrology

Approval Lower temperature limit (*C)
OIML LV -10

Country Upper temperature limit (°C)
Global AV 40

GEO value
20

Verification Class

Class 11 N/

Verification Interval

e=d W4

Figure 107: Approval Options

In addition to the GEO and temperature values, an approval requires the selection of Country and Verification
Class values.

For both OIML and NTEP approvals, the Country options are Global [default], Argentina, Australia, Korea,
Thailand, and the Verification Class options are Class Il, Class Ill, Class IlIL, Class IIIHD and Class llil.

When the device has been set as Approved -- either OIML or NTEP -- and the metrological sealing screw has
been installed, the fields on this page are greyed out and cannot be modified.
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Identification

The Identification screen allows the scale's Serial number, Scale model and Scale location to be defined. It
also provides an additional Scale Identification field. For analog scales, these fields are optional and must be
complefed manually. Touching any of the fields opens an alphanumeric entry dialog.

< Identification

Serial number

Scale model

Scale location

Scale identification

Figure 108: Idenfification

HSALC: Capacity and Increments

Capacity and increment values allow the weighing parameters to be set for each of a series of scale setups,
depending on the # ranges value:

e Single range
e 2 multi inferval
e 2 mulii range
e 3 multi inferval
e 3 mulii range
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The figure below shows the default Single range selecfed.

{ Capacity & Increments

# ranges
Single range

Primary unit
kg

Capacity 1
500

Resolution 1

0.02

Blank over capacity (d)

5

Figure 109: ASM - Capacity and Increment

If either mulfi inferval or multi range is selected, additional Capacity and Resolution fields display. The Blank
over capacity field is always displayed last, and defermines the weight value beyond scale capacity, measured
in display increments, at which the terminal blanks the weight display..

{ Capacity & Increments

# ranges Resolution 2
3 multi range 0.02

Primary unit Capacity 3
kg 250

Capacity 1 Resolution 3

20 0.1

Resolution 1 Blank over capacity (d)

0.01 5

Capacity 2

100

Figure 110: Capacity and Increment - Multi Range Example
If 3 multi interval or 3 multi range is selected, two sets of capacity and resolution fields are added.

Multi-Range and Multi-Interval Weighing

Precision Scales and Multi-Range, Multi-Interval Operation

PBK and FPK scale plafforms support both multi-range and multi-interval operation. PDB
platforms support only multi-range operation.
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Both Multi-Range and Multi-Interval settings allow a scale to be used to weigh two or more types of item
which differ significantly in weight. Each weight range can have its own Capacity and Resolution values, so
that one scale can behave like fwo or more different scales.

For instance, for small and light items a finer resolution might be required, while for large and heavy items a
coarser resolufion is adequate. The scale changes the display increment size at the Capacity points defined in
this screen. In the example shown here, three ranges are defined -- up to 50 kg, up to 500 kg, and up fo
1,000 kg.

< Capacity & Increments
# ranges Resolution 2
3 multi range N 0.5 a4
Primary unit Capacity 3
kg /| 1000
Capacity 1 Resolution 3
50 1 AV
Resolution 1 Blank over capacity (d)
0.05 N 5
Capacity 2
500

I |
Figure 111: Capacity & Increments Screen Configured for Three Ranges

In Multi-Range mode, the range currently in use appears on screen beside the weigh mode (B/G or Net)

indicator -- >11l<, >l2l<, >13l< -- depending on how many ranges are configured.

The increment sizes, or Resolutions, are set fo 0.01, 0.5 and 1, respectively. Thus, for items weighing up fo

50 kg, the weight display will increment in 100 gram steps; befween 50 kg and 500 kg of scale weight, the

display will increment in half-kilogram steps; and for items weighing over 500 kg the resolution is reduced by a

factor of 10 compared fo the lowest range, and increases in 1 kg sfeps.

There is one significant difference between Multi-Range and Multi-Interval configurations, affecting how the

terminal behaves as scale weight is reduced:

e Multi-Range: When scale weight is reduced, the terminal continues to display the Resolution size for the
largest configured range.

e Multi-Interval: When scale weight is reduced, the display conforms fo the configured intervals and shows
Resolution sizes corresponding to current scale weight

In both cases, the terminal resets the display to the Resolution fo the lowest range when the weight falls fo
zZero.

Display
The two modes also differ in the way the IND700 indicatfes the capacity and increment seftings for the

displayed scale.

e Multi-Range: The ferminal's metrology line cycles through a display of both capacity and increment for each
Configured ronge in sequence -- W1 Max50kgd=01kg ~W2Max500kgd=05kg =~ W3Max1td=1kg

¢ Multi-Interval: The terminal's metrology line cycles through a display of capacities for each configured
range, and then increments for each -- Maxso/s00/1t  d=2/500/1000g
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Example

The following diagram illustrafes the distinction between Multi-Range and Multi-Interval modes, showing the
behavior of the terminal configured as in the screen shown above, during one weighing operation:

Scale Status Display Status

Figure 112: Multi-Range vs Mulfi-Interval

Resolution,
Multi-Range

0.002 kg
>| 1<

0.002 kg
>|1l<

0.05 kg
>[2]<

1 kg
>|3l<

0.002 kg

>|21<

0.002 kg
>|1l<

Resolution,
Multi-Interval

0.002 kg

0.002 kg

0.05kg

1 kg

1 kg

0.002 kg

Scales with Multiple Ranges or Multiple Intervals have specific Approval

requirements.
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HSALC: Linearization and Calibration

The Linearization and Calibration menu offers four sub-menus.

’F 2317
3 ®
T L 25.Aug.2021

... > ASM > Linearization & Calibration

Metrology Units MinWeigh Calibration
Identification Zero Reset Span adjustment
Capacity & . . .

pacity Tare Maintenance Step calibration
Increments

Linearization &

. . Filter CalFree
Calibration

Control mode Stability

Figure 113: ASM - Linearization and Calibration

Calibration

The seftings available in this screen will change depending on the [Linearity » Page 827 setting selected. The
default screen is shown below, and then a screen showing additional fields used to capture linearization.

4 Calibration
Calibration unit
kg
Linearity Adjustment

Disabled

Test load 1

500

Gain jumper

2 mvVirv

CALIBRATE

Figure 114: ASM - Linearization - Calibration

If [Linearity Adjustment » Page 82] is enabled (i.e., notf set to Disabled), additional Test load fields (2, 3 and
4, depending on the number of points selecfed) display. Nofe that when hysteresis is specified, affer the
highpoint is captured the calibration sequence includes unloading the scale to an intermediate test weight.
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£ Calibration

Calibration unit Test load 4

kg 250

Linearity Adjustment Gain jumper

5 point with hysteresis 2 mvViiv

Test load 1

1

Test load 2

10

Test load 3
100 CALIBRATE

Figure 115: Calibration with Five-Point Linearization and Hysteresis

The Calibration unit is defermined by the Primary Unit selected in [Capacity and Increments » Page 114].
The [Gain Jumper » Page 82] setting applies only to analog load cells

When the linearity seftings have been enfered, touch the CALIBRATE button o begin the calibration sequence.
The sequence prompts for the placement and removal of the various test weights, depending on the Linearity
Adjustment selected. A message will indicate when a calibrafion is missed.

Calibrate

Error
Failed to execute PROC Command: PROC E 114 "Insufficient test load"

X

Figure 116: Calibration Error Message
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When the calibration sequence is completed successfully, a message displays:

Calibrate

Finished

Figure 117: Calibration Complefe Message

Linearity

Linearity Adjustment is used to adjust the maximum deviation between the scale indication and the linear value
from zero to max. capacity. linearity adjustment with hysteresis compensation is recommended for better
linearity in applications involving discharge or loss-in-weight,

The menu settings noted affect the calibration steps.

Disabled [default]

Use only zero and one span point (test load #1)

3 point Use zero, midpoint (fest load #1), and highpoint (fest load #2)

4 point Use zero, lowpoint (test load #1), midpoint (test load #2), and highpoint
(fest load #3)

5 point Use zero, lowpoint (fest load #1), midpoint (fest load #2), mid-highpoint

(fest load #3), and highpoint (fest load #4)

3 point with Hysteresis

Use zero, midpoint (fest load #1), and highpoint (fest load #2), then unload
to midpoint (fest load #1)

4 point with Hysteresis

Use zero, lowpoint (fest load #1), midpoint (fest load #2), and highpoint
(fest load #3), then unload fo midpoint (test load #2) and lowpoint (fest load
#1)

5 point with Hysteresis

Use zero, lowpoint (fest load #1), midpoint (fest load #2), mid-highpoint
(fest load #3), and highpoint (test load #4), then unload to mid-highpoint
(fest load #3), midpoint (fest load #2), and lowpoint (test load #1)

Analog Gain Jumper

The analog gain jumper setting on the Main PCB can be either 2 mV/V or 3 mV/V. The ferminal is shipped from

the factory in the 3 mv/V setting.

In order for the CalFreel feature to operate properly, the selected parameter

must indicafe the physical position of the jumper on the Main board.

The jumper settings are:
Analog Gain Jumper Settings

2 mVNV

Jumper installed on both pins

3 mV/ [default]

Jumper installed on only one pin
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Span Adjustment

The Span adjustment screen permits the scale's whole span to be defined. The units used for the parameters
entered here are the Primary Unit set on the Capacity and Increments page.

<  Span adjustment

Test weight (kg)
60

Displayed weight (kg)
60

Control mode

0.000 kg

ADJUST

Figure 118: ASM - Linearization and Calibration - Span Adjust

Enter the calibration fest weight value in the Test weight field.

Enter the current weight reading from the scale, as shown in the Control mode display, in this field. The
terminal will account for any difference between the fest weight and the weight shown on screen, and adjust the
displayed weight accordingly. Perform this adjustment before carrying out the linearity adjustments from the
[Calibration » Page 80] screen.

Note that the Control mode field is read-only, and displays the current scale weight.

To perform the span adjustment, place the test weight on the scale and fouch Adjust. A message will appear fo
indicate that the adjustment is complete, and the Control mode will change to reflect the offset, displaying a
corrected value.

See also
& HSALC: Capacity and Increments » Page 76
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Step Calibration

L Step calibration

Test load (kg)

2

CALIBRATE

Figure 119: Step Calibration Screen

Step Calibration provides a way fo calibrate fanks and hoppers with a "build up" method. In this procedure, the
same amount of weight is added fo the scale af each step of the procdure untfil the weight specified in the Test
Load field is reached.

The Test load units are defermined by Primary Unit set in [Capacity and Increments » Page 114].

Step Calibration Procedure
Nofte that test weight values in the images below are for illustration only, and do not correspond to values for a
typical POWERCELL system.

The procedure involves placing and removing test weights of the size specified, and filling the tank or hopper to
intermediate target weights. The sequence is prompted by messages on-screen, as shown here. When a
prompted action is complete, touch the next icon to :

1 Set the zero value. At each screen, the procedure can be continued P, or cancelled X fo complete the
procedure at the current step. Note that the current scale weight is shown as the first line in the screen.

Calibrate

0.00 kg
Empty scale

2 Place the first test load.

Calibrate

Testload 2.00 kg
Place test load
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3 Remove the first fest load. The current scale weight is displayed again.

Calibrate

2.00 kg
Target 2.00 kg
Remove test load
Fill to target

X »

4 Fill the vessel to the indicated farget.

Calibrate

2.00 kg
Target 4.00 kg
Testload 2.00 kg
Place test load

X

Follow the steps indicated until the required span is reached, then touch the X (close) butfon. The Step

calibration screen will display.

CalFree

The terminal provides a method fo calibrate a scale without using fest weights. This is based on manual entry
of capacity and performance data from the load cell or load cell platform. This method of calibration can be

used for initial check-out and festing of systems or when a large structure is used as the weighing vessel and it

is not possible to apply fest weights fo the structure.

The analog gain jumper (refer to [Calibration » Page 807]) must be set correctly
for the cell type in use, or CalFree will not produce an accurate result.
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£ CalFree

Cell capacity
0
Cell unit
kg
Rated cell output (mV/V)

3

Use zero

Calibrated

CALIBRATE

Figure 120: ASM - Linearization and Calibration - CalFree
For Cell capacity, the fotal load cell capacity should be entered. For example, for a tank with three 5000 kg
cells, cell capacity would be 3 x 5000, or 15000 kg.

If Use zero is sef to Estimated, enter an estimated value. The value entered here will be included in the
terminal's calculation for analog load cell saturation. If this value is unknown, leave this field blank. This
preload value is used only to determine overload conditions and is not used as a zero reference point.

Touch the CALIBRATE button to perform the procedure. If calibration succeeds, a message will appear o
indicate this. Otherwise, an error message will display.

See also
& HSALC: Linearization and Calibration » Page 80

Control Mode
The Control Mode screen shows the current scale weight. This is useful for viewing the weight reading during
setup and diagnostics without leaving the setup menu sysfem.

4 Control mode

0.000 kg

Figure 121: Confrol Mode Screen
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HSALC: Units

< Units

Secondary unit
None

Host / auxiliary unit
kg

Startup unit

Primary

Figure 122: ASM - Units
Units Settings

Parameter Options Function

Secondary unit |g, kg, 1, Ib, oz, fon Sefs the Secondary unit.
Host / auxiliary |g, kg, 1, Ib, 0z, ton Sefs unit type for Host / auxiliary unit.
unit

Startup unit Primary [default], Restart | Determines whether, when the terminal is restarted, the units
revert to the Primary unit defined in [Capacity and Increments »
Page 114], or remain as modified by the selection made from
the home screen by touching Switch Units {3

HSALC: Zero

{ Zero

Startup zero Push button zero -range (%)

Use last 2

Auto zero tracking Push button zero +range (%)

On 2

Auto zero range (d)

0.5

Blank under zero (d)

20

Push button zero

On SET ZERO

Figure 123: ASM - Zero
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Zero Settings

Parameter

Options

Function

Startup zero

Use last [default], Use
calibrated, Capture new

Determines how the scale defines zero when it is
restarted.

Power up zero -range (%)

Opens a numeric entry
dialog; default value is
2%

Power up zero +range

(%)

Opens a numeric entry
dialog; default value is
18%

These parameters appear if Startup zero is set fo
Capture new.

Values define the range within which the ferminal, af
power up, will automatically zero the scale. If scale
weight is outside the configured range, Startup zero
will not execute.

Auto zero fracking

On [default], Off

Aufo zero tracking is an automatic zero maintenance
function which fracks zero when the scale is empty,
and compensates for conditions such as terminal or
load cell drift, or slow debris buildup on a scale
platform.

Auto zero range (d)

Opens a numeric entry
dialog; default value is 0.5

Parameter appears if Auto zero tracking is set to On.

Determines the range, in scale display units, within
which Auto zero will be applied.

Blank under zero (d)

Opens a numeric entry
dialog; default value is 20

Determines the sub-zero point, in scale display units,
at which the terminal will blank its weight display.

Push button zero

On [default], Off

When On, the terminal's zero softkey can be used fo
set the terminal to zero, if the current scale weight
value is within the range defined by the -range and
+range values.

The push button zero softkey is visible if at least one
connected scale has push button zero active. If push
button zero is not activated for a scale, the Zero
softkey will display greyed out when that scale is
selected.

If the Zero scale function key is fouched when Push
button zero is off for the selected scale, an error
message will display indicating that Push button Zero
is disabled.

Push button zero -range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.

Push Butfon zero +range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.
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HSALC: Tare

The fields visible in this screen vary depending on the seftings for Auto tare mode, Auto tare reset threshold
and Auto clear tare. Each of these requires additional paramefer settings

< Tare

Startup tare

Use last

Auto tare mode

Off

Chain tare mode

Off

Auto clear tare

On

Auto clear tare threshold (kg)

0.5

Figure 124: Tare Settings

Push button tare

On

Keyboard tare

Oon

Clear with zero

Oon

Parameter

Options

Function

Startup tare

Use last [default], Clear

Determines whether an existing tare value is preserved
at system restart, or cleared.

Auto tare mode

Off [default], On

Determines whether the terminal will automatically
take a fare once the Auto tare threshold value is
exceeded. An auto tare is cleared once the weight
value falls below the Auto tare reset threshold.

Aufo tare threshold (kg)

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Auto tare reset threshold
k@)

Displays a numeric enfry
dialog. Default is O.

Refer to Auto tare mode, above.

Chain tare mode

Off [default], On

When Chain tare mode is ON, it is possible fo take
multiple tares in sequence by touching the Tare softkey
— for example, when filling mulfiple similar containers
on a pallet. Once one container is filled, touch Tare
again to reset the scale to Net zero.

Auto clear tare

Off [default], On

Determines whether the terminal will preserve a fare
value when scale weight returns to zero, or aufomat-
ically clear it when the weight value falls below the
Auto clear tare threshold.

Auto clear tare threshold

(kg(

Displays a numeric entry
dialog. Default is O.

Refer to Auto clear tare, above.
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Pushbutton tare On [default], Off When Push button tare is On, the Tare softkey on the
home screen is functional. Touch this softkey to create
a tare value based on an empty container on the
scale. The terminal then shows a zero weight and
indicates that it is Net mode. When the container is
filled, the terminal shows the net weight of the
contents.

The Tare softkey is visible if af least one connected
scale has push button tare active. If push butfon tare
is not activated for a scale, the Tare softkey will
display greyed out when that scale is selected.

If the Tare scale function key is fouched when Push
button tare is off for the selected scale, an error
message will display indicating that Push button Tare
is disabled.

Keyboard tare On [default], Off When Keyboard tare is On, the known value for the
empty weight of a container (fare) can be entered
manually. The terminal will then display the net weight
of the contents of the container. Keyboard tares are
automatically rounded to the closest display division.

Clear with zero On [default], Off When On, a scale zero command, issued by a softkey
or any other input, will clear any stored fare value.

HSALC: Filter

4 Filter

Low pass filter
Medium

Stability filter

Off

Figure 125: Filter Settings

The IND700 has a low-pass, multi-pole vibration filter that can be set for several conditions when using analog
load cells. The heavier the filtering, the slower the display settling fime will be.

Parameter Options Function
Low pass filter Very light, Light, Medium |Determines how strongly the low pass filter is applied.
[default], Heavy, Very The low pass frequency is the frequency above which
heavy all disturbances are filtered outf. The heavier the low
pass filter, the better the disturbance rejection, but the
longer the settling fime required for the scale.
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Stability filter

Off [default], On The stability filter works in conjunction with the
standard low pass filter o provide a more stable final
weight reading. The stability filter should only be used
in transaction weighing applications, since the
nonlinear action of the filter switching may cause
inaccurate cufoffs in batching or filling applications.
Stability settings are made on the [Stability »

Page 128] screen.

Stability

<{  Stability

Motion range (d)

0.5

No motion interval (seconds)

0.3

Timeout (seconds)

3

Figure 126: HSALC Stability

The Stability parameters defermine how the terminal responds to mofion on the scale.
HSALC Stability Parameters

Parameter

Function

Motion range (d)

Sets the motion range to the weight value in divisions that the weight is permitted
to fluctuate and still have a no-motion condition. Values from 0.1 fo 99.9 are
possible with the defaulf value being 1.0 d.

No motion interval
(seconds)

The no motion interval defines the amount of time in seconds that the scale weight
must be within the motion range to have a no-motion condition. Values from 0.0
(motion defection disabled) to 2.0 are possible, the default value being 0.3
seconds. A shorter interval means that a no-motion condition is more likely, but
may make weight measurement less precise.

Timeout (seconds)

Defines the period in seconds affer which the terminal stops attempting to perform
a function that requires a no-motion condition (such as a zero, fare or transfer
command) and aborts the function. This timeout is used regardless of the source
of the command such as the keypad, discrete input, Industrial Network or SICS.
Values from O to 99 are possible with the default value being 3 seconds. A
smaller value means that less time will be used to check for no-motion before
aborting a command. When a value of O is entered, there must be no-motion
when a command is given or it will fail immediately. A value of 99 is a special
condition which permits the terminal to wait indefinitely for a no-motion condition -

a command would never be aborted.

IND700
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MinWeigh

Certain industries such as pharmaceuticals and food processing require a guarantee that the weighing
equipment selected for a particular measurement is adequate for the task. One way fo ensure that appropriate
weighing equipment is selected is by the creation and use of a minimum weighment value (MinWeigh), below
which a particular piece of weighing equipment cannot be used.

The MinWeigh function compares the current weight with the programmed MinWeigh value. In the configuration
screen shown below, MinWeigh has been enabled and its value set to 1 kg.

<

Figure 127: MinWeigh Setup Screen

MinWeigh

MinWeigh mode

On

MinWeigh value (kg)

Parameter

Options

Function

MinWeigh
Mode

On [default],
Off

If the displayed weight (B/G or NET) is greater than or equal to the
MinWeigh value, the MinWeigh symbol appears below the weight display,
to the right of the tare display. All terminal functions behave normally.

KA 2 Max10kgd=20g

116 kg

When the absolute value of the net weight is less than the MinWeigh value,
the MinWeigh symbol flashes in red &.

MinWeigh
value (kg)

Displays a
numeric entry
dialog. Default
value is 0

This field displays if MinWeigh mode is set to On. The unit is the default unit
set

Reset

Scale Branch Reset

Note that this Reset function refers only fo parameters configured in the currently selected
setup branch. For general Terminal reset options, refer fo [Reset » Page 264].
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Figure 128: Scale Reset Options

This screen allows the user fo reset either calibration data or seftings. If settings is selected, calibration data are

RESET CALIBRATION
DATA

RESET SETTINGS

preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 129: Reset Confirmation Dialog

See also
& Reset » Page 264
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HSALC: Maintenance

i 23:25
3 ®
T 1 25.Aug.2021

... > ASM > Maintenance

Metrology Units MinWeigh Cell counts
Identification Zero Reset Calibration values
Capacity & .

pacily Tare Maintenance
Increments

Linearization &

. . Filter
Calibration

Control mode Stability

Figure 130: ASM - Maintenance Menu
Touch the Cell counts button fo display a screen showing the scale's current reading in raw counts.

£ Cell counts

Cell counts
209585

Figure 131: Cell Counts Screen
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Touch the Calibration Values bufion fo display raw count values for a variety of calibration seftings. The
number of load fields displayed will vary depending on the Linearity Adjustment selected af [Linearization and
Calibration > Calibration » Page 80].

Calibration values

Zero

1253

Load 1 (kg)
60000

Counts 1

9433825

Figure 132: Calibratfion Values Screen

When touched, each of the fields displayed on this screen opens a numeric entry dialog. The values displayed
in the fields represent current settings; these seftings can be over-ridden by direct entry.

3.1.1.1.2 Log or Transfer

The Log or Transfer menu sets the conditions which determine how and when a demand output is friggered.
Normal demand mode transfer occurs whenever a transfer request is made , depending on the options selected
here, and providing the scale is within the acceptable range configured in [Stability » Page 128], and the
weight is above gross zero (a negative gross weight will not be printed).

Data is sent to:
e Interfaces for which the Connection has been defined as Transfer

* The Alibi Table
* The Transaction Table
Weight values shown on this screen are gross weights in primary units.
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When Log or Transfer is selected from the Scale n menu options, a default configuration screen appears, with
no options selected.

< Logor Transfer

Minimum Weight (kg)

0

Interlock

Auto Transfer

Figure 133: Log or Transfer Screen, Default View

Additional fields appear depending on the initial selections for Interlock and Auto Transfer. The follow illus-
fration shows the menu with all options selected.

< Logor Transfer

Minimum Weight (kg) Auto Transfer

0 (L) with first stable value

'L:,'i' After last stable value
Interlock

Active

Auto Transfer .
() Only if scale is selected

Reset Trigger () Always

Threshold Weight “ Reset Threshold (kg)

Motion Check 0

Figure 134: Log or Transfer, All Options Selected
Note that some of the Auto Transfer and Active sub-sections appear only if Auto Transfer is enabled.

Log or Transfer Options

Option Settings

Minimum Weight (kg) This value defermines the minimum scale weight required to trigger the
Interlock and/or Aufo Transfer actions. The weight unit for this and the other
fields on this screen is defermined by the Primary Unit set in ASM at Capacity
and Increments.
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3.1.2

3.1.2.1

IND700

Option

Seftings

Interlock

When enabled, the Interlock option responds to scale data to determine when
a log action is performed. This prevents repeat logging of the same weighing
operation.

When enabled, this inferlock requires that the live weight reading be reset
according to the Reset Trigger paramefer sefting (see below). The live weight
must then seftle to a weight greater than the Minimum Weight value (see
above) before the ferminal will respond to the next log or fransfer request.

If Interlock is enabled, or Auto

Transfer and With first stable value is selected

Reset Trigger

The Reset Trigger action can be performed in response to Threshold Weight
[default] or Deviation This frigger is defined either by an absolute value
(Threshold Weight) or by a minimum change in weight (Deviation).

If either Interlock or Auto Transfer is enabled

Resetf Threshold (kg) or Reset
Deviatfion (kg)

The weight value which triggers a reset and indicafes the start of a new
weighing operation and a new log entry.

Auto Transfer

When enabled, Auto Transfer causes data about each weighing operation to be
sent to the destination defined in the [Communication » Page 208] section of
sefup, depending on the parameters selected in Auto Transfer and Active.

If Auto Transfer is Enabled

Auto Transfer

When enabled, the trigger conditions defined by the Interlock settings will
automatically export data about each weighing operation either With first
stable value or After last stable value.

With first stable value: data is sent when the first stable weight is captured,
even if the weight changes afterward. This selection would typically be used for
static weighing.

After last stable value: dafa is sent based on the last stable weight captured.

This selection might be used for manual filling, where the scale weight will
briefly be unstable affer the last material is added.

This selection determines whether the Reset Trigger option appears.

Active

The options fo activate the Aufo Transfer function are Only if scale is selected
and Always.

Motion Check

When enabled, the Motion Check prevents the inferlock from friggering a log or
transfer action until scale weight display is within the parameters defined as
stable af [ASM > Stability » Page 128].

See also

¢ Communication Sefup » Page 208

& Stability » Page 128
POWERCELL

Scale n

The Scales branch of the setup menu displays options for each scale (1 or 2, depending on how many
interfaces are installed in the terminal) and for a Sum Scale.

When either scale is selected, two further options appear -- ASM, which provides access to all the scale config-

uration menus, and Log or Transfer, which determines whether and how each weighing operation is recorded
or exported. For PowerDeck scale systems, two additional items appear: Loading Alert and Leveling

Guidance.
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;.?.‘. @ 15. May_120;;§

Setup > Scales > Scale 1

Scales Scale 1 ASM

Application Sum Scale Log or Transfer
Terminal Loading Alert
Communication Leveling Guidance

Maintenance

Figure 135: Scale n Menus, POWERCELL

3.1.2.1.1 ASM
The POWERCELL ASM screen shows the following menus:

p\. @ 10:47
L 15.May.2023

... > ASM
Metrology Control mode Stability
Identification Units MinWeigh
I
Load Cell Zero Reset
|
| Capacit
pacity & Tare Maintenance
Increments
!
Linearization & :
Filter

|
| Calibration
|

Figure 136: POWERCELL ASM Menus

The ASM system runs on the scale interface, and is separafe from the terminal's own firmware which runs on its
CPU.

Metrology
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The Metrology screen allows the configuration of per-scale approvals and GEO values, as well as lower and
upper operating Temperature Limits.

{  Metrology

Approval

Not approved

Not approved
OIML
NTEP

Lower temperature limit (°C)

-10

Upper temperature limit (°C)

40

Figure 137: ASM - Metrology Screen
When an approval (OIML or NTEP) is selected, additional options are displayed.

{  Metrology

Approval Lower temperature limit (°C)

OIML -10

Country Upper temperature limit (°C)

Global 40

GEOQ value

16

Verification Class

Class III

Verification Interval

e=d

Figure 138: Approval Options
In addition to the GEO and temperature values, an approval requires the selection of Country and Verification
values.

For both OIML and NTEP approvals, the Country options are Global [default], Argenfina, Australia, Koreq,
Thailand, and the Verification Class options are Class Il, Class Ill, Class IlIL, Class IIHD and Class III.

When the device has been set as Approved -- either OIML or NTEP -- and the metrological sealing screw has
been installed, the fields on this page are greyed out and cannot be modified.
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Identification

The Identification screen allows the scale's Serial number, Scale model and Scale location to be defined. It
also provides an additional Scale Identification field. For analog scales, these fields are optional and must be
complefed manually. Touching any of the fields opens an alphanumeric entry dialog.

< Identification

Serial number

Scale model

Scale location

Scale identification

Figure 139: Idenfification

Load Cell

p @ 13:59
N 09.5ep.2021

... > ASM > Load Cell

Metrology Control mode Stability System
|
Identification Units MinWeigh Single cell address
Load Cell Zero Reset Manual address
Capacity & . . .
pacity Tare Maintenance Shift adjust scale
Increments
Linearization & . Shift adjust a cell/
: : Filter .
| Calibration pair |

I EEERRRRRRRREBRRZ==RNSRSSNSN——————N———————wmwmh——=sss

Figure 140: Load Cell Menu

The POWERCELL Load Cell menu
includes the following five items:
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System

< System

Application
Wehicle

Number of load cells
4

Address range
01-24

Number of logical scales

1

Figure 141: POWERCELL Load Cell - System

The Application opfions are Floor, Tank / Hopper and Vehicle.
Touch the Number of load cells field fo display a numeric entry dialog.
Available Address ranges are 01-24, 31-54, 61-84 and 91-114.

By default the Number of logical scales is 1. However, when using a POWERCELL multi-scale inferface, from
1 fo 4 logical scales can be configured. Refer to [POWERCELL Mulfi-Scale Capability » Page 1101].

Single cell address

< Single cell address

0

Value is out of range 1 - 114,

FIND CELL

Figure 142: POWERCELL - Single cell address

When the Single cell address screen is first displayed, the Serial number and Node fields appear as above.
Touch FIND CELL to start the addressing process. A confirmation dialog will display, indicafing that the search
has completed; touch «/ to refurn fo the Single cell address screen, which will now display a node number
and the serial number of the cell at that node.
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£ Single cell address

Serial number

728647E549

Node
1

Figure 143: POWERCELL - Single cell address, cell found

Single Cell Address - detail

Single cell addressing can be performed manually or automatically af power-up, as required. In either case, the
procedure cannot be performed if the terminal is in Weights and Measures Approved mode.

Manual Cell Address

4 Manual address

Serial number

DISCOVER CELLS

Figure 144: POWERCELL - Manual Address Screen
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The Manual Address screen initially displays the connected cells' Serial numbers and Node numbers. Touch
the DISCOVER CELLS button to begin discovery. If discovery is successful, a confirmation dialog will appear.

Discover cells

Finished

Figure 145: Cell Discovery Confirmation Dialog

Touch the check mark acknowledge the confirmation. The original screen will reappear with an EDIT ./ button
in place of the DISCOVER CELLS button.

£ Manual address

Serial number
7290311478
729027H521
728913D525
729030Q752

Figure 146: Cells Discovered
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Node Address Editing
Touch a row to highlight a cell.

4 Manual address

Serial number
729031L478
729027H521
728913D525
729030Q752

Figure 147: Cells Discovered, Node Selected
With the cell highlighted, touch the EDIT butfon to display the address Edit screen.

<  Edit

729031L478

Node

1

Figure 148: Cell Address Edit Dialog
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Touch the Node field to display a numeric keypad. Enter the desired node address.

Figure 149: Node Address Entry

Finally, touch the Back arrow at upper left fo refurn to the Manual address screen. In the example below, Node
1 from the discovery step above has been readdressed as Node 4, and the original Node 4 is now Node 1.

4 Manual address

Serial number Node
729030Q752 1
729027H521 2
728913D525 3
7290310478 4

Figure 150: Node 1 Readdressed as Node 4
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Manual address

< Manual address

Serial number
728647E549
7286485108
728647G122
728647F845

DISCOVER CELLS

Figure 151: POWERCELL - Manual address

The Manual address screen initially displays the connected cells' Serial numbers and Node numbers. Touch a
row fo highlight it:

< Manual address

Serial number
728647E549
7286485108
728647G122

728647F845

DISCOVER CELLS

Figure 152: POWERCELL - Manual address, node selected
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Touch the DISCOVER CELLS butfon to begin discovery. A confirmation dialog will appear; when it is dismissed,
the original screen reappears with an edit butfon in place of the DISCOVER CELLS button.

< Manual address

Serial number
728647E549
7286485108
728647G122
728647F845

Figure 153: POWERCELL - Manual address, cells discovered

Touch the Edit button .« to display the screen shown below. Here, the Node number can be changed by
touching the field to display a numeric entry dialog.

< Edit

7286485108

Node

2

Figure 154: POWERCELL - Manual address, edit screen

Shift adjust scale

Small mismatches in mechanical and electronic gain of the load sensing paths can cause the same test weight
to produce slightly different readings, depending on the location of the test weight on the scale. The IND700
provides two types of adjustment — adjustment by individual cells or adjustment by pairs of cells.

The Shift Adjust by Cell or Pair parameter is preset to Cell and cannot be changed when a single load cell is
used.
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Adjust by Cell

Adjustment by Cell adds a factor to each load cell output to compensate for the slight differences between them.
The scale will then output the same weight value regardless of the physical location of the weight on the scale.

Adjust by Pair

Adjustment by Pair ensures a constant reading from the scale regardless of where the load is placed on the
long axis between pairs of cells — for instance, in vehicle weighing applicafions. Before beginning the shift
adjustment procedure, select whether the adjustment will be done by cell or by pair. The procedure for shift
adjusting by pair of cells is listed below. The procedure for shift adjusting by individual cell follows the same
sequence, but cells are read and adjusted one at a time.

< Shift adjust scale

Shift adjust by

Cell

ADJUST

Figure 155: POWERCELL - Shift adjust scale

From the Shift adjust by drop-down list, select either Cell or Pair, then touch the Adjust butfon fo begin the
process. The Adjust dialog will appear.

Adjust

X »

Figure 156: Shift Adjust - Ready to Execute
Touch P> to start the process, or X to return to the Shift adjust scale screen.
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The dialog will indicate the progress of the capture and, when the process has completed, the dialog will

confirm capture.

Adjust

Capture complete

Figure 157: Shift Adjust, Capture Complete

Touch X to return fo the Shift adjust scale screen.

See also
& Shift adjust a cell/pair » Page 109

Shift adjust a cell/pair

< Shift adjust a cell/pair

Adjust cell/pair
1

2

3

ADJUST

Figure 158: POWERCELL - Shift Adjust a Cell

The illustration above shows the options available in the Adjust cell/pair dropdown list on this page, when

[Shift adjust scale » Page 107] is setf to Cell.

< shift values

Node Coefficient
1&2 0.990182
384 0.996145

Figure 159: POWERCELL - Shiff Adjust a Pair

When [Shift adjust scale » Page 1077 is set fo Pair, the options become 1&2 and 3&4.
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Once an option is selected from the dropdown list, fouch ADJUST to execute the adjustment. A confirmation
dialog will appear:

Adjust

X »

Figure 160: Shift Adjust Confirmation Dialog

Once the process has completed, touch X to return fo the Shift adjust a cell/pair screen.

POWERCELL Multi-Scale Capability

The IND700 POWERCELL interface can support a network of up to 14 load cells (up fo 24, with an external
power supply). These load cells can be grouped into 2, 3, 4 or four logical scales. The number of logical
scales is configured on the [Load Cells > System » Page 101] page. In the examples shown in this secfion, a
simple four-cell network is used to illustrafe this functionality.

Logical Scale Configuration

When a single, mulfi-cell scale is divided info multiple logical scales, each logical scale will
show the same configuration paramefers as the original scale. However, each logical scale
can be configured separately as required.

To confirm that the terminal has this capability, visif the [Terminal Information » Page 45] screen.

<  Terminal Information

Slot Description Part Number Software Version
Slot 1 MultiscalePowercell (Powercell3) 30726003 V4.0.12
0s Windows 10 1809 IoT Enterprise V2.6.30/2024-01-16 1

Kontron MTsXA4R_1.1_BETA1:
Supervisor 5.41.150-freeze.2+02
Client. MTApp 5.41.150-freeze.2+02
Engine 5.41.150-freeze.2+02

www.mt.com/legal

Figure 161: Terminal Information Showing Multi-Scale Capability

110 | Configuration IND700



IND700

Configuring the System with Multiple Logical Scales

Before mulfiple scales are configured, the POWERCELL Scale Setup menu looks like this, with a single scale:

B Q@ e

Setup > Scales > Scale 1

Scales Scale 1 ASM
Application Sum Scale Log or Transfer
Terminal

Communication

Maintenance

Figure 162: Scale Sefup Menu

To create a system with multiple logical scales, the first step is to visit Scale 1 > ASM > Load Cell > Sysfem,
and select 4 Logical scales.

4 System
Application
Wehicle

Number of load cells

4

Address range

01-24

Number of logical scales

4

Figure 163: Load Cell System Screen, 4 Logical Scales Selected

Note that the Address range paramefer indicates the addresses that can be assigned to this scale's load cells.
Once multiple logical scales have been configured, each scale's Load Cell > System page will offer a different
range of addresses.
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Touching the BACK arrow at upper left will cause the terminal fo display a message:

< Warning

Number of scales
A changed. Restart

required.

Figure 164: Reboot Warning
The terminal will aufomatically reboot. Once this process has completed the scale sefup menu will show four

scales:
08:19
21.5ep.2023
Setup > Scales
|
Scales Scale 1
Application Scale 2
Terminal Scale 3
Communication Scale 4
Maintenance Sum Scale

Figure 165: Scale Setup with Four Logical Scales Displayed
The [Sum Scale » Page 113] can now be configured to display any or all of these logical scales.
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Sum Scale in a System with Multiple Logical Scales

When multiple logical scales are configured, this is reflected in the options in the Sum Scale Settings page:

{  Settings

Sum Component Scales

Enable Sum Scale
Scale 1

Scale Identification Scale 2

Vehicle
Scale 3

Sum Type
Display Weights Scale 4

High Resolution Weights

Figure 166: Sum Scale Seftings with Multiple Logical Scales

As usual, a descriptive name can be included for the Sum Scale. In the configuration shown above, all logical
scales are selected for display, and the weighing screen will appear like this:

(}:)-‘u @ 'IQSEPE;};;

> 1+2+3+4 CALC Vehicle Max 2400 kg d = 1 kg
O kg
AR 1FL Max 600 kg d =1kg ER 2FR Max 600 kg d = 1 kg
O kg O kg
KR 3RL Max 600 kg d = 1 kg ER 4RR Max 600 kg d = 1 kg
O kg O kg

PT B | A2 | & | A | @ | B | B

Preset Tare Tare Table Switch Scale Switch Units | Alibi Memory Higher Res. ID Ferm Material Table

Figure 167: Weight Display - Four Scales and Sum Scale
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Note that any of the displayed scales, including the Sum Scale, can be viewed in a larger simplified format by
double-tapping on the screen within the desired scale's weight information area:

> 1+2+3+4 CALC...

kg

Figure 168: Sum Scale Large Format View

M 1 FL Max 600 kg d = 1 kg

kg

Figure 169: Single Scale Large Format View

To return to the normal display, double fap anywhere on the screen.

POWERCELL - Capacity and Increments

Capacity and increment values allow the weighing parameters to be sef for each of a series of scale setups,
depending on the # ranges value:

e Single range

e 2 mulfi inferval

e 2 mulfi range

¢ 3 mulfi inferval

e 3 mulfi range
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The figure below shows the default Single range selecfed.

< Capacity & Increments

# ranges
Single range

Primary unit
kg

Capacity 1
5000

Resolution 1

1

Blank over capacity (d)

98

Figure 170: ASM - Capacity & Increments

If either mulfi inferval or multi range is selected, additional Capacity and Resolution fields display. The Blank
over capacity field is always displayed last, and determines the weight value beyond scale capacity, measured
in display increments (d), at which the ferminal blanks the weight display.

{ Capacity & Increments

# ranges Resolution 2
3 multi range 0.02

Primary unit Capacity 3
kg 250

Capacity 1 Resolution 3

20 0.1

Resolution 1 Blank over capacity (d)

0.01 5

Capacity 2

100

Figure 171: Capacity and Increment - Multi Range Example
If 3 multi interval or 3 multi range is selected, two sets of capacity and resolution fields are added.

Multi-Range and Multi-Interval Weighing

Precision Scales and Multi-Range, Multi-Interval Operation

PBK and FPK scale platforms support both multi-range and multi-interval operation. PDB
platforms support only mulfi-range operation.

Configuration

1156



Both Multi-Range and Multi-Increment setftings allow a scale fo be used to weigh two or more types of item
which differ significantly in weight. Each weight range can have its own Capacity and Resolution values, so
that one scale can behave like fwo or more different scales.

For instance, for small and light items a finer resolution might be required, while for large and heavy items a
coarser resolufion is adequate. The scale changes the display increment size at the Capacity points defined in
this screen. In the example shown here, three ranges are defined -- up to 50 kg, up to 500 kg, and up fo
1,000 kg.

< Capacity & Increments
# ranges Resolution 2
3 multi range N 0.5 a4
Primary unit Capacity 3
kg /| 1000
Capacity 1 Resolution 3
50 1 AV
Resolution 1 Blank over capacity (d)
0.05 N 5
Capacity 2
500

I |
Figure 172: Capacity & Increments Screen Configured for Three Ranges

In Multi-Range mode, the range currently in use appears on screen beside the weigh mode (B/G or Net)

indicator -- >11l<, >l2l<, >13l< -- depending on how many ranges are configured.

The increment sizes, or Resolutions, are set fo 0.01, 0.5 and 1, respectively. Thus, for items weighing up fo

50 kg, the weight display will increment in 100 gram steps; befween 50 kg and 500 kg of scale weight, the

display will increment in half-kilogram steps; and for items weighing over 500 kg the resolution is reduced by a

factor of 10 compared fo the lowest range, and increases in 1 kg sfeps.

There is one significant difference between Multi-Range and Multi-Interval configurations, affecting how the

terminal behaves as scale weight is reduced:

e Multi-Range: When scale weight is reduced, the terminal continues to display the Resolution size for the
largest configured range.

e Multi-Interval: When scale weight is reduced, the display conforms fo the configured intervals and shows
Resolution sizes corresponding to current scale weight

In both cases, the terminal resets the display to the Resolution fo the lowest range when the weight falls fo
zZero.

Display
The two modes also differ in the way the IND700 indicatfes the capacity and increment seftings for the

displayed scale.

e Multi-Range: The ferminal's metrology line cycles through a display of both capacity and increment for each
Configured ronge in sequence -- W1 Max50kgd=01kg ~W2Max500kgd=05kg =~ W3Max1td=1kg

¢ Multi-Interval: The terminal's metrology line cycles through a display of capacities for each configured
range, and then increments for each -- Maxso/s00/1t  d=2/500/1000g
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Example

The following diagram illustrafes the distinction between Multi-Range and Multi-Increment modes, showing the
behavior of the terminal configured as in the screen shown above, during one weighing operation:

Scale Status Display Status

Figure 173: Multi-Range vs Mulfi-Interval

Resolution,
Multi-Range

0.002 kg
>| 1<

0.002 kg
>|1l<

0.05 kg
>[2]<

1 kg
>|3l<

0.002 kg

>|21<

0.002 kg
>|1l<

Resolution,
Multi-Interval

0.002 kg

0.002 kg

0.05kg

1 kg

1 kg

0.002 kg

Scales with Multiple Ranges or Multiple Intervals have specific Approval

requirements.
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Linearization & Calibration

;A @ 11:00
ZF 31.Aug.2021

... > ASM > Linearization & Calibration

Metrology Control mode Stability Calibration
Identification Units MinWeigh Span adjustment
Load Cell Zero Reset Step calibration
Capacity & Tare Maintenance CalFree
Increments

Linearization &

Calibration FRet

Figure 174: POWERCELL - Linearization and Calibration Menu

Calibration

< Calibration
Calibration unit
kg
Linearity Adjustment

Disabled

Test load 1

60

CALIBRATE

Figure 175: POWERCELL - Linearization and Calibration - Calibration
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Figure 176: Linearity Adjustment Options

Linearity Adjustment

Disabled

3 point
4 point
5 point
3 point with hysteresis
4 point with hysteresis
5 point with hysteresis

Linearization allows the terminal to account for variations in accuracy over the whole capacity of a scale, by
calibrafing performance af three or more points in the span. The fields displayed in the Calibration sub-menu
vary depending on the Linearity Adjustment sefting. Options are:

Disabled [Default]

3 point

4 point

5 point

3 point with hysteresis
4 point with hysteresis
5 point with hysferesis

The number of points selected determines the number of calibrations taken between the scale's zero and span
(highpoint) values. Depending on this sefting, linearization may require as many as four intermediate
measurements.

When linearization is enabled, additional fields are displayed, permitting the infermediafe calibration poinfs fo
be defined.

Figure 177: POWERCELL Linearization - 5 Points with Hysteresis

< Calibration

Calibration unit
kg
Linearity Adjustment
5 point with hysteresis
Test load 1

20

Test load 2

50

Test load 3

100

Test load 4

500

CALIBRATE
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Span Adjustment

The Span adjustment screen permits the scale's whole span to be defined. The units used for the parameters
enfered here are the Primary Unit set on the Capacity and Increments page.

<  Span adjustment

Test weight (kg)
60

Displayed weight (kg)
60

Control mode

0.000 kg

ADJUST

Figure 178: ASM - Linearization and Calibration - Span Adjust

Enter the calibrafion fest weight value in the Test weight field.

Enter the current weight reading from the scale, as shown in the Control mode display, in this field. The
terminal will account for any difference between the fest weight and the weight shown on screen, and adjust the
displayed weight accordingly. Perform this adjustment before carrying out the linearity adjustments from the
[Calibration » Page 80] screen.

Note that the Control mode field is read-only, and displays the current scale weight.

To perform the span adjustment, place the test weight on the scale and fouch Adjust. A message will appear fo
indicate that the adjustment is complete, and the Control mode will change to reflect the offset, displaying a
corrected value.

See also
& HSALC: Capacity and Increments » Page 76
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Step Calibration

L Step calibration

Test load (kg)

2

CALIBRATE

Figure 179: Step Calibration Screen

Step Calibration provides a way fo calibrate fanks and hoppers with a "build up" method. In this procedure, the
same amount of weight is added fo the scale af each step of the procdure untfil the weight specified in the Test
Load field is reached.

The Test load units are determined by Primary Unit set in [Capacity and Increments » Page 1147].

Step Calibration Procedure

Note that test weight values in the images below are for illustration only, and do not correspond to values for a
typical POWERCELL system.

The procedure involves placing and removing test weights of the size specified, and filling the tank or hopper to
intermediate target weights. The sequence is prompted by messages on-screen, as shown here. When a
prompted action is complete, touch the next icon to :

1 Set the zero value. At each screen, the procedure can be continued P, or cancelled X fo complete the
procedure at the current step. Note that the current scale weight is shown as the first line in the screen.

Calibrate

0.00 kg
Empty scale

2 Place the first test load.

Calibrate

Testload 2.00 kg
Place test load
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3 Remove the first test load. The current scale weight is displayed again.

Calibrate

2.00kg
Target 2.00kg
Remove test load
Fill to target

X »

4 Fill the vessel to the indicated farget.

Calibrate

2.00 kg
Target 4.00 kg
Testload 2.00 kg
Place test load

X

Follow the steps indicated until the required span is reached, then touch the X (close) button. The Step
calibration screen will display.

CalFree

4 CalFree

Use zero

Calibrated

CALIBRATE

Figure 180: POWERCELL - Linearization and Calibration - CalFree
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The Zero selection can be either Calibrated [default], in which case the scale's currently calibrated zero is
used, or Estimated. If Estimated is selected, additional fields display.

< CalFree

Use zero

Estimated

Estimated preload

0

Preload unit

kg

CALIBRATE

Figure 181: CalFree with Estimated Zero

Touch the Estimated preload field to open a numeric enfry dialog and define a value, and select a Preload
unit from the dropdown list.

Control Mode
The Control Mode screen shows the current scale weight. This is useful for viewing the weight reading during
setup and diagnostics without leaving the setup menu system.

£ Control mode

0.000 kg

Figure 182: Confrol Mode Screen
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POWERCELL Units

< Units

Secondary unit
None

Host / auxiliary unit
kg

Startup unit

Primary

Figure 183: ASM - Units
Units Settings

Parameter Options Function
Secondary unit g, kg, t, Ib, 0z, ton | Sets the Secondary unit.
Host / auxiliary unit |g, kg, t, Ib, oz, fon  |Sefs unit type for Host / auxiliary unit. The Host / auxiliary unit
Startup unit Primary [default], | Determines whether, when the terminal is restarfed, the units
Restart revert fo the Primary unit defined in [Capacity and Increments »
Page 1147, or remain as modified by the selection made from
the home screen by fouching Switch Units £

POWERCELL - Zero

< Zero

Startup zero Push button zero -range (%)

Use last 2

Auto zero tracking Push button zero +range (%)

On 2

Auto zero range (d)

0.5

Blank under zero (d)

20

Push button zero

On SET ZERO

Figure 184: ASM - Zero
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Zero Settings

Parameter Options

Function

Startup zero Use last [default], Use

calibrated, Capture new

Determines how the scale defines zero when it is
restarted.

Auto zero tracking On [default], Off

Auto zero range (d) Opens a numeric entry

dialog; default value is 0.5

When Auto fracking is On, the scale will aufomatically
display zero, if the weight deviation does not exceed
the Auto zero range value, measured in increments
)}

Blank under zero (d) Opens a numeric entry

dialog; default value is 20

Determines the sub-zero point, in increments (d), at
which the terminal will blank its weight display.

Push button zero On [default], Off

Push button zero -range  |Opens a numeric entry

(%) dialog; default value is 2.
Push Butfon zero +range |Opens a numeric entry
(%) dialog; default value is 2.

When On, the terminal's zero softkey can be used fo
set the terminal to zero, if the current scale weight
value is within the range defined by the -range and
+range values.

The push button zero softkey is visible if af least one
connected scale has push button zero active. If push
button zero is nof activated for a scale, the Zero
softkey will display greyed out when that scale is
selected.

If the Zero scale function key is touched when Push
bufton zero is off for the selected scale, an error
message will display indicating that Push button Zero
is disabled.

POWERCELL - Tare

The fields visible in this screen vary depending on the seftings for Auto tare mode, Auto tare reset threshold
and Auto clear tare. Each of these requires additional parameter settings

{ Tare

Startup tare

Use last

Auto tare mode

On

Auto tare threshold (kg)

0

Auto tare reset threshold (kg)

0

Chain tare mode

On

Figure 185: Tare Settings

Auto clear tare

On

Auto clear tare threshold (kg)

0

Push button tare

On

Keyboard tare

On

Clear with zero

On

Parameter Options

Function

Startup tare Use last [default], Clear

Determines whether an existing tare value is preserved
at system restart, or cleared.
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Auto tare mode

Off [default], On

Determines whether the terminal will automatically
take a fare once the Auto tare threshold value is
exceeded. An auto tare is cleared once the weight
value falls below the Auto tare reset threshold.

Aufo tare threshold (kg)

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Auto tare reset threshold
ka)

Displays a numeric enfry
dialog. Default is O.

Refer to Auto tare mode, above.

Chain tare mode

Off [default], On

When Chain tare mode is ON, it is possible fo take
multiple tares in sequence by touching the Tare softkey
— for example, when filling mulfiple similar containers
on a pallet. Once one container is filled, touch Tare
again to reset the scale to Net zero.

Auto clear tare

Off [default], On

Determines whether the terminal will preserve a tare
value when scale weight returns to zero, or aufomat-
ically clear it when the weight value falls below the
Auto clear tare threshold.

Auto clear fare threshold
(kg(

Displays a numeric entry
dialog. Default is O.

Refer to Auto clear tare, above.

Pushbutton fare

On [default], Off

When Push button tare is On, the Tare softkey on the
home screen is functional. Touch this softkey to create
a tare value based on an empty container on the
scale. The terminal then shows a zero weight and
indicates that it is Net mode. When the container is
filled, the terminal shows the net weight of the
confents.

The Tare softkey is visible if at least one connected
scale has push button fare active. If push button tare
is not activated for a scale, the Tare softkey will
display greyed out when that scale is selected.

If the Tare scale function key is touched when Push
button tare is off for the selected scale, an error
message will display indicating that Push button Tare
is disabled.

Keyboard tare

On [default], Off

When Keyboard tare is On, the known value for the
empty weight of a container (tare) can be entered
manually. The terminal will then display the net weight
of the contents of the container. Keyboard tares are
automatically rounded to the closest display division.

Clear with zero

On [default], Off

When On, a scale zero command, issued by a softkey
or any other input, will clear any stored tare value.
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POWERCELL - Filter

< Filter

Low pass filter
Medium

Stability filter

On

Figure 186: POWERCELL ASM - Filter

The IND700 has a low-pass, multi-pole vibration filter that can be set for several conditions when using analog

load cells. The heavier the filtering, the slower the display settling fime will be.

Parameter

Options

Function

Low pass filter

Very light, Light, Medium
[default], Heavy, Very
heavy

Determines how strongly the low pass filter is applied.

The low pass frequency is the frequency above which
all disturbances are filtered out. The heavier the low
pass filter, the better the disturbance rejection, but the
longer the settling fime required for the scale.

Stability filter

Off [default], On

The stability filter works in conjunction with the
standard low pass filter to provide a more stable final
weight reading. The stability filter should only be used
in fransaction weighing applications, since the
nonlinear action of the filter switching may cause
inaccurate cufoffs in batching or filling applications.
Stability settings are made on the [Stability »

Page 128] screen.
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Stability

< Stability

Motion range (d)

0.5

No motion interval (seconds)

0.3

Timeout (seconds)

3

Figure 187: Stability Settings

Parameter Options

Function

Motion range (d) Displays a numeric entry

dialog. Default is 0.5

Set the Motion range fo the weight value (in divisions)
within which the weight is permitted to fluctuate and
still have a no-motion condition.

No motion interval
(seconds)

Displays a numeric entry
dialog. Default is 0.3

Defines the amount of time in seconds during which
the scale weight must be within the mofion range, for
the scale fo have a no-mofion condition.

Timeout (seconds) Displays a numeric entry

dialog. Default is 3

Defines the period (in seconds) after which the
terminal stops aftempting to perform a function that
requires a no-motion condition (such as a zero, tare
or prinf command) and aborts the function. This
timeout is used regardless of the source of the
command, such as the keypad, discrete input,
Industrial Network or serial input. Values from O to 99
are possible, the default value being 3. A smaller
value means that less time will be spent checking for
no-motion before the command is aborfed.

MinWeigh

Certain industries such as pharmaceuticals and food processing require a guarantee that the weighing

equipment selected for a particular measurement is adequate for the task. One way to ensure that appropriate
weighing equipment is selected is by the creation and use of a minimum weighment value (MinWeigh), below
which a particular piece of weighing equipment cannot be used.
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The MinWeigh function compares the current weight with the programmed MinWeigh value. In the configuration
screen shown below, MinWeigh has been enabled and its value set to 1 kg.

< MinWeigh

MinWeigh mode

On

MinWeigh value (kg)

1

Figure 188: MinWeigh Setup Screen

Parameter Options Function

MinWeigh On [default], |If the displayed weight (B/G or NET) is greater than or equal to the

Mode Off MinWeigh value, the MinWeigh symbol appears below the weight display,
to the right of the tare display. All terminal functions behave normally.
KA 2 Max 10kgd=20g

116 kg

When the absolute value of the nef weight is less than the MinWeigh value,
the MinWeigh symbol flashes in red &.

MinWeigh Displays a This field displays if MinWeigh mode is set to On. The unit is the default unit

value (kg) numeric enfry | set
dialog. Default
value is 0

Reset

Scale Branch Reset

Note that this Reset function refers only fo parameters configured in the currently selected
setup branch. For general Terminal reset options, refer fo [Reset » Page 264].
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RESET CALIBRATION
DATA

RESET SETTINGS

Figure 189: Scale Reset Options

This screen allows the user fo reset either calibration data or seftings. If settings is selected, calibration data are
preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 190: Reset Confirmation Dialog
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POWERCELL - Maintenance

The POWERCELL ASM Maintenance option provides access fo the menus shown below.

11:12

15.May.2023

... » ASM > Maintenance

Metrology Control mode Stability Cell counts

Predictive

Identification Units MinWeigh .
maintenance

Load Cell Zero Reset Zero & overload
!
I i ity &
apacit
i pacity Tare Maintenance Calibration values
| Increments

Linearization &

, . Filter Shift values
Calibration

Figure 191: POWERCELL Maintenance Menus

Cell counts

The Cell counfs maintenance screen displays current cell counts for each load cell in the scale system,
providing a useful diagnostic fool.

< Cell counts

Cell counts
8036
8977
8377

9612

Figure 192: POWERCELL Maintenance - Cell Counts
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Predictive maintenance

By default, the Predictive maintenance screen opens with Symmetry monitor set fo Off, in which case no
further fields are visible.

4 Predictive maintenance

Symmetry monitor

Off

Figure 193: POWERCELL Maintenance - Predictive Maintenance, Default View

Radial symmetry should be used on any system where all the cells see almost identical loads (such as a cylin-
drical tank or hopper scale). Setting Symmetry monitor fo Radial displays the fields shown below.

4 Predictive maintenance

Symmetry monitor

Radial

Start threshold (%)

10

Difference threshold (%)

10

Time interval (seconds)

0

On failure

Alarm only

Figure 194: POWERCELL Maintenance - Predictive Maintenance
When Symmetry monitor is set o Radial, Run flat can be set to Manual or Automatic.

Symmetry Monitor Settings

To prevent a false trigger of a symmetry error due to light loads, the ferminal allows for a symmetry check Start
threshold value. This value is entered as a percentage of the calibrated scale capacity. The default value is
0%. Symmetry checking will be triggered only if the load on the scale exceeds the start threshold value.
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In the Difference threshold field, enfer the maximum permissible percent deviation in span between
symmefrical cells. The defaulf value is 0%. Execution of radial symmetry checking is based upon a
comparison between the current distribution of values between load cells and the distribution at calibration. A
symmetry error is triggered if the change in load distribution exceeds the Difference Threshold value.

The Time Interval defermines how long the system will wait affer a “no-motion” condition is achieved, before it
can trigger a symmetry error. The alarm is triggered if the symmetry error occurs after the timer has expired. The
time is measured in seconds, and valid values are from O to 120. O is the default setting, and means that the
timer is disabled.

Set the On failure option to determine the alarm level when a possible failure is defected. The options are:
e Alarm only
e Disable and alarm

The [Maintenance Log » Page 2447 must be enabled for Alarms to be recorded. For Alarm Only conditions, the
alarm message will remain on the display untfil the values fall to 90% of the parameters specified in sefup. If
the scale has been disabled, Symmetry Monitoring must be turned off or changed to Alarm Only (and the
values fall fo 90% of the parameters specified in Set Up), and the home screen displayed before the error will
clear.

Run Flat

If the ferminal determines that a load cell is operating out of tolerance or fails to detect communication with a
single load cell, it can invoke the Run Flat algorithm fo compensate for the cell’s questionable readings until the
cell can be replaced. Load cell symmetry monitoring is required for the algorithm to run properly. There are 3
options for Run Flat

» Off: Run Flat does not function
e Manual: The user selects which cell to replace
e Automatic: The Run Flaf algorithm uses threshold settings to determine which cell to replace

The Manual mode of Run flat requires the entry of a node to ignore in the run flat calculation. This is used to
exclude a failed POWERCELL, pending replacement.

Run flat

Manual ¥

Run flat node

0

Value is out of range 1 - 4.

Figure 195: Run Flat Mode - Manual

Click on the Run flat node field fo display a numeric entry dialog which is used fo designafe the failed node.

When Run flat is sef to Automatic, and Temp. trigger run flat is On, the function is set to frigger automatically
when a failed cell is defected.

Run flat

Automatic ¥

Temp. trigger run flat

On v

Figure 196: Run Flat Mode - Automatic
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Zero and overload

< Zero & overload

Zero drift check

Alarm only

Zero threshold (%)

50

QOverload threshold (%)

100

Figure 197: POWERCELL Mainfenance - Zero and Overload

Parameter Options

Function

Zero drift check Alarm only [default], No
action, Disable & Alarm

Determines what the ferminal does when a zero drift
condition (defined by the Zero threshold parameter) is
detected. By default, the terminal issues an alarm, but it can
also be set fo disable the scale.

Zero threshold (%) | When clicked, displays a
numeric entry dialog.

Defines the value, expressed as a percentage of the
configured [Auto Zero range » Page 1247, at which a
deviation from zero is considered a drift.

Overload threshold | When clicked, displays a
(%) numeric eniry dialog.

Defines the value, expressed as a percentage of the
configured [Span Adjustment » Page 83], af which a value
exceeding the scale capacity is considered an overload.
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Calibration values

< Calibration values

Zero

0

Load 1 (kg)
20

Counts 1

800000

Figure 198: POWERCELL Maintenance - Calibration Values
This screen allows each of the values fo be entered manually, using a numeric entry dialog.

Shift values

< Shift values

Coefficient
1.000000
1.000000
1.000000

1.000000

Figure 199: POWERCELL Mainfenance - Shiff Values
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To modify a cell's shift value, select the appropriafe row, then click on the Edit icon at lower right.

1

Coefficient

1

Figure 200: POWERCELL Mainfenance - Edit Shift Value

The screen displays the number of the selected node; this value cannot be edited. Click the Coefficient field to
display a numeric entry dialog where the value can be modified.

3.1.2.1.2 Log or Transfer

The Log or Transfer menu sefs the conditions which determine how and when a demand outfput is triggered.
Normal demand mode transfer occurs whenever a transfer request is made , depending on the options selected
here, and providing there is no motion on the scale and the weight is above gross zero (a negative gross
weight will not be printed).

Data is sent fo:
* Interfaces for which the Connection has been defined as Transfer

« The Alibi Table
e The Transaction Table
Weight values shown on this screen are gross weights in primary units.
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When Log or Transfer is selected from the Scale n menu options, a default configuration screen appears, with

no options selected.

< Logor Transfer

Minimum Weight (kg)

0

Interlock

Auto Transfer

Figure 201: Log or Transfer Screen, Default View

Additional fields appear depending on the initial selections for Interlock and Auto Transfer. The follow illus-

tration shows the menu with all options selected.

< Logor Transfer

Minimum Weight (kg) Auto Transfer

0 (L) With first stable value

'L:j' After last stable value
Interlock

Active

Auto Transfer .
() Only if scale is selected

Reset Trigger () Always

Threshold Weight “ Reset Threshold (kg)

Motion Check 0

Figure 202: Log or Transfer, All Options Selected

Note that some the Auto Transfer and Active sub-sections appear only if Auto Transfer is enabled.

Log or Transfer Options

Option Seftings

Minimum Weight (kg) This value defermines the minimum scale weight required to trigger the

and Increments.

Interlock and/or Auto Transfer actions. The weight unit for this and the other
fields on this screen is defermined by the Primary Unit set in ASM at Capacity
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3.1.2.1.3

Option

Settings

Interlock

When enabled, the Interlock option responds to scale data to determine when
a log action is performed. This prevents repeat logging of the same weighing
operation.

When enabled, this inferlock requires that the live weight reading be reset
according to the Reset Trigger paramefer sefting (see below). The live weight
must then settle to a weight greater than the Minimum Weight value (see
above) before the ferminal will respond to the next log or fransfer request.

If Interlock is enabled, or Auto

Transfer and With first stable value is selected

Reset Trigger

The Reset Trigger action can be performed in response to Threshold Weight
[default] or Deviation This frigger is defined either by an absolute value
(Threshold Weight) or by a minimum change in weight (Deviation).

If either Interlock or Auto Transfer is enabled

Resetf Threshold (kg) or Reset
Deviatfion (kg)

The weight value which triggers a reset and indicafes the start of a new
weighing operation and a new log entry.

Auto Transfer

When enabled, Auto Transfer causes data about each weighing operation to be
sent to the destination defined in the [Communication » Page 2087 section of
setup, depending on the parameters selected in Auto Transfer and Active.

If Auto Transfer is Enabled

Auto Transfer

When enabled, the trigger conditions defined by the Interlock settings will
automatically export data about each weighing operation either With first
stable value or After last stable value.

With first stable value: data is sent when the first stable weight is captured,
even if the weight changes afterward. This selection would typically be used for
static weighing.

After last stable value: dafa is sent based on the last stable weight captured.
This selection might be used for manual filling, where the scale weight will
briefly be unstable after the last material is added.

This selection determines whether the Reset Trigger option appears.

Active

The options fo activate the Aufo Transfer function are Only if scale is selected
and Always.

Motion Check

When enabled, the Motion Check prevents the inferlock from friggering a log or
transfer action until scale weight is within the paramefers defined as stable at
[ASM > Stability » Page 128].

See also

¢ Communication Sefup » Page 208

& Stability » Page 128

Loading Alert

When the IND700 is connected fo a PowerDeck floor scale, the system can be configured to provide a loading
alert. This alert appears on the weighing screen as a graphical warning, and offers guidance to the operator for
correct loading. Weighing is most accurate when the load is placed in the center of the platform.
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This branch of the scale setup menu system allows the configuration of the loading alert. By default, loading
alert is disabled. The screen below shows the Loading Alert enabled.

{ Loading Alert

Enable Loading Alert Cancel and Continue

OK Range (%)

30

Platform shape
(L) square
(_J rectangular

Threshold Weight (Ib)

0

Value '0" exceeds its li

Orientation

0

mits. Current limits are from '250' to '5000'.

Figure 203: Loading Alert Enabled

The following parameters must be configured for the loading alert:

Loading Alert Parameters

Parameter

Settings

Enable Loading Alert

When enabled, the loading alerf will function during weighing operations. By
default, Loading Alert is disabled.

OK Range (%)

The range sets the positioning folerance, and represents the relationship between
the cenfer of gravity of the load and the center of the scale. The value is expressed
as a percentage of the distance between load cells. Valid range values are from
5% fo 50%. The default value is 30%. The loading alert graphic shows the OK
zone as a light blue rectangle, and the center of gravity of the load as a dark blue
dot. The on-screen size of the light blue rectangle indicates the relationship
between the OK zone and the overall distance between load cells.

When a load is placed on the scale outside the OK range, the loading alert will
display.

Threshold Weight
el

If the weight on the scale is below this threshold value, the loading alert will not
frigger. The value selected should represent 5% of the scale capacity; this value is
shown by default. The unit shown is the Primary Unit selected in ASM at [Capacity
& Increment » Page 1141].

Cancel and Confinue

If Loading Alert is enabled, and this option is selected, the operator can cancel the
loading alert and continue working.

If the option is not enabled, the <. in the loading alert display is hidden, and the
alert cannot be dismissed until the load is removed or properly centered.

Plafform shape

Select either square or rectangular to define the platform shape. The selection
made will modify the loading alert graphic.

Configuration

139



Parameter

Seftings

Orientation

Rotafe the scale image on-screen by the selected angle.

Scale orientation on-screen should provide the operator with an intuitive under-
standing of the relationship between the loading alert display and the scale
platform. E.g., if the #1 load cell is on the operator's side, and to the left, the
correct selection is 0.

Touch the information icon @ to display an explanation of this function. In each
case, the blue triangle labeled 1 represents the first load cell in the PowerDeck

platform.
30 Ta) g
0 90 180 270 et
Threshold
0
Value '0" exceed

Orientation o

The following images show how the Orientation selection adjusts the Loading Alert
display:

Loading Alert

Please check loading or
. manve container into
canter to continue.

Followy instructions:

)"

Loading Alert

1 ' . #lease check loading or
mowe container into
center to continue,

Enllowd iNSLrUCLinns:

" 4
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Parameter Settings

180

Loading Alert

Please check leading or
rmene corlziner into
cenler to cantinue.

Follow insoructions:

270

Loading Alert

VR

Flezse check loading or
move container into
center o continue,

Falkowy instructions:

o

3.1.2.1.4 Leveling Guidance

IND700

The Leveling Guidance screen provides a real-time readout of count values for each load cell in the PowerDeck

scale system. Values shown in the images below capture raw count values for scale platforms at Zero. In each

case, the load cell with the lowest count is highlighted in cyan.
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< Leveling Guidance

Figure 204: Leveling Guidance Screen, 4 Cells

< Leveling Guidance

Figure 205: Leveling Guidance Screen, 6 Cells

The information presented here allows the scale platform fo be leveled more precisely than by traditional
means. Shims may be used fo level the scale so that the values shown on this screen are as close as possible
to equal. The cyan highlight is used fo determine which cell to shim first.

For further information about the use of this feature, refer to Service and Maintenance, [Leveling Guidance »
Page 283].

3.1.3 Precision Scale

3.1.3.1 Scalen

The Scales branch of the setup menu displays options for each scale (1 or 2, depending on how many
interfaces are installed in the terminal) and for a Sum Scale.

142 | Configuration IND700



When either scale is selected, two further opfions appear -- ASM, which provides access fo all the scale config-
uration menus, and Log or Transfer, which determines whether and how each weighing operation is recorded
or exported.

(:':.l. @ 1?.Apr:lz?;::

Setup > Scales > Scale 1

Scales Scale 1 ASM
Application Sum Scale Log or Transfer
I
I
Terminal

Communication

Maintenance

Figure 206: Scale n Menus, Precision

3.1.3.1.1 ASM

The Precision scale ASM shows the following menus:

R 15:32
7 15.May.2023

... > ASM

Metrology Control mode Stability

I

|
Ramp Units MinWeigh
Identification Zero Reset
Capacity & ; ;

pacty Tare Diagnostics

Increments

Linearization &

, . Filter
Calibration

Figure 207: Precision Scale ASM Menus

Unlike HSALC and POWERCELL scale interfaces, the settings found in the Precision Scale ASM system are
provided by, and configured on, the scale platform in use. Precision scales offer slightly different options from
the other scale interfaces, and there are differences between different Precision platforms. The menu system
shown here, and the settings described in this section, should be taken as examples.
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Metrology

The Metrology screen allows the configuration of per-scale approvals and GEO values, as well as lower and
upper operating Temperature Limits.

{  Metrology

Approval

Not approved

Not approved
OIML
NTEP

Lower temperature limit (°C)

-10

Upper temperature limit (°C)

40

Figure 208: ASM - Metrology Screen
When an approval (OIML or NTEP) is selected, additional options are displayed.

{  Metrology

Approval Lower temperature limit (°C)

OIML -10

Country Upper temperature limit (°C)

Global 40

GEOQ value

16

Verification Class

Class III

Verification Interval

e=d

Figure 209: Approval Options
In addition to the GEO and temperature values, an approval requires the selection of Country and Verification
values.

For both OIML and NTEP approvals, the Country options are Global [default], Argentina, Australia, Koreq,
Thailand, and the Verification Class options are Class Il, Class Ill, Class llIL, Class IIIHD and Class IIl.

When the device has been set as Approved -- either OIML or NTEP -- and the metrological sealing screw has
been installed, the fields on this page are greyed out and cannot be modified.
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Precision Scale: Ramp

Ramp is the output of the load cell installed in the scale platform. The value shown is a percentage of the load
cell's output in the scale system. If the ramp value shows an increase, this means that the load cell is detecting
force on the scale. This value is used fo adjust the load cell parameters as part of the whole platform. This
information is available in METTLER TOLEDO PBK and PBD platforms.

< Ramp

Ramp

53.2

Figure 210: Ramp Screen

Identification

The Identification screen allows the scale's Serial number, Scale model and Scale location to be defined. It
also provides an additional Scale Identification field. For analog scales, these fields are optional and must be
completed manually. Touching any of the fields opens an alphanumeric entry dialog.

< Identification

Serial number

Scale model

Scale location

Scale identification

Figure 211: Idenfification

Configuration

145



Precision Scale: Capacity and Increments

Capacity and increment values allow the weighing parameters to be sef for each of a series of scale setups,
depending on the # ranges value:

¢ Single range

e 2 mulii interval

e 2 mulfi range

e 3 multi interval

e 3 mulfi range

The value selected here will affect the function of the Linearization and Calibration screens.

The figure below shows the default Single range selected.

4 Capacity & Increments

# ranges Capacity conversion

Single range Fixed number of increments
Primary unit

kg
Capacity 1

10

Resolution 1

0.005

Blank over capacity (d)

9

Figure 212: Precision Scale ASM - Capacity and Increments Screen

If either mulfi inferval or multi range is selected, additional Capacity and Resolution fields display. The Blank
over capacity field is always displayed last, and determines the weight value beyond scale capacity, measured
in display increments, at which the ferminal blanks the weight display..
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£ Capacity & Increments

# ranges Resolution 2
3 multi range 0.005

Primary unit Capacity 3
kg 12.03

Capacity 1 Resolution 3

10 0.01

Resolution 1 Blank over capacity (d)
0.005 9
Capacity 2 Capacity conversion

12 Fixed number of increments

Figure 213: Precision Scale ASM - Capacity and Increments Screen with Multi-Range Fields Displayed

If 3 multi interval or 3 multi range is selected, two sets of capacity and resolution fields are added.

Capacity conversion is used in Precision scales with NTEP approval, when metric and avoirdupoids units are
used in parallel.

The following options are available from the drop-down list:

Capacity conversion

Fixed number of increments v

Fixed number of increments

Fixed factor

MNone

Figure 214: Capacity Conversion Options

Capacity Conversion Parameters

Setting Purpose
Fixed number of increments A'legacy mode, not used in the IND700 terminal.
Fixed factor The Weights and Measures line on the main screen

displays Cap and d in the same unit as the weight
value unit. Conversions are performed by the aftached
scale.

None Used for non-approved systems. The Weights and
Measures line on the main screen displays the unit
configured as primary. Overload and range change
occur at the same actual load on the scale.

Multi-Range and Multi-Interval Weighing

Precision Scales and Multi-Range, Multi-Interval Operation

PBK and FPK scale plafforms support both multi-range and multi-interval operation. PDB
platforms support only multi-range operation.
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Both Multi-Range and Multi-Increment setftings allow a scale fo be used to weigh two or more types of item
which differ significantly in weight. Each weight range can have its own Capacity and Resolution values, so
that one scale can behave like fwo or more different scales.

For instance, for small and light items a finer resolution might be required, while for large and heavy items a
coarser resolufion is adequate. The scale changes the display increment size at the Capacity points defined in
this screen. In the example shown here, three ranges are defined -- up to 50 kg, up to 500 kg, and up fo
1,000 kg.

< Capacity & Increments
# ranges Resolution 2
3 multi range N 0.5 a4
Primary unit Capacity 3
kg /| 1000
Capacity 1 Resolution 3
50 1 AV
Resolution 1 Blank over capacity (d)
0.05 N 5
Capacity 2
500

I |
Figure 215: Capacity & Increments Screen Configured for Three Ranges

In Multi-Range mode, the range currently in use appears on screen beside the weigh mode (B/G or Net)

indicator -- >11l<, >l2l<, >13l< -- depending on how many ranges are configured.

The increment sizes, or Resolutions, are set fo 0.01, 0.5 and 1, respectively. Thus, for items weighing up fo

50 kg, the weight display will increment in 100 gram steps; befween 50 kg and 500 kg of scale weight, the

display will increment in half-kilogram steps; and for items weighing over 500 kg the resolution is reduced by a

factor of 10 compared fo the lowest range, and increases in 1 kg sfeps.

There is one significant difference between Multi-Range and Multi-Interval configurations, affecting how the

terminal behaves as scale weight is reduced:

e Multi-Range: When scale weight is reduced, the terminal continues to display the Resolution size for the
largest configured range.

e Multi-Interval: When scale weight is reduced, the display conforms fo the configured intervals and shows
Resolution sizes corresponding to current scale weight

In both cases, the terminal resets the display to the Resolution fo the lowest range when the weight falls fo
zZero.

Display
The two modes also differ in the way the IND700 indicatfes the capacity and increment seftings for the

displayed scale.

e Multi-Range: The ferminal's metrology line cycles through a display of both capacity and increment for each
Configured ronge in sequence -- W1 Max50kgd=01kg ~W2Max500kgd=05kg =~ W3Max1td=1kg

¢ Multi-Interval: The terminal's metrology line cycles through a display of capacities for each configured
range, and then increments for each -- Maxso/s00/1t  d=2/500/1000g
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Example

The following diagram illustrafes the distinction between Multi-Range and Multi-Increment modes, showing the
behavior of the terminal configured as in the screen shown above, during one weighing operation:

Scale Status Display Status

Figure 216: Multi-Range vs Mulfi-Interval

Resolution,
Multi-Range

0.002 kg
>| 1<

0.002 kg
>|1l<

0.05 kg
>[2]<

1 kg
>|3l<

0.002 kg

>|21<

0.002 kg
>|1l<

Resolution,
Multi-Interval

0.002 kg

0.002 kg

0.05kg

1 kg

1 kg

0.002 kg

Scales with Multiple Ranges or Multiple Intervals have specific Approval

requirements.
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Precision Scale: Linearization and Calibration

The Linearization and Calibration menu offers five sub-menus.

11:00

... » ASM > Linearization & Calibration

Metrology Control mode Stability
Ramp Units MinWeigh
Identification Zero Reset
Capacity & Tare Diagnostics
Increments

Linearization &

Calibration ERiEc

Figure 217: Precision Linearization and Calibration Menus

Autoprint Calibration

{  Autoprint calibration

Autoprint calibration

On

Figure 218: Autoprint Calibration Screen
Autprint calibration can se On [default] or Off. FUNCTION??
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External Calibration

The Precision Scale External calibration screen allows a standard calibration roufine using test weights to be
performed.

< External calibration

EXTERNAL
CALIBRATION

Figure 219: Precision Linearization and Calibration External Calibration Screen

Touch the EXTERNAL CALIBRATION button to start running the calibration routine. The number of steps
performed during this process depends on the number of infervals or ranges specified in the [Capacity and
Increments » Page 1467 screen.

External calibration

Test Load (kg)
0.000

Empty Scale

Figure 220: Precision External Calibration in Progress - Example Screen
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3- and 5-Point Linearization and Calibration

The number of points selected determines the number of calibrations taken between the scale's zero and span
(highpoint) values. Depending on this sefting, linearization may require as many as four intermediate
measurements.

< 3-point lin&cal

POINT LIN&CAL-3

Figure 221: 3-Point Linearization and Calibration Screen

4 5-point lin&cal

POINT LIN&CAL-5

Figure 222: 5-Point Linearization and Calibration Screen

Touch the bufton at lower right to start the linearization and calibration process. The number of steps varies
depending on how many intermediate measurements are required for lineariafion.

See also
& Precision Scale: Capacity and Increments » Page 146
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Span Adjustment

The Span adjustment screen permits the scale's whole span to be defined. The units used for the parameters
entered here are the Primary Unit set on the Capacity and Increments page.

<  Span adjustment

Test weight (kg)
60

Displayed weight (kg)
60

Control mode

0.000 kg

ADJUST

Figure 223: ASM - Linearization and Calibration - Span Adjust

Enter the calibration fest weight value in the Test weight field.

Enter the current weight reading from the scale, as shown in the Control mode display, in this field. The
terminal will account for any difference between the fest weight and the weight shown on screen, and adjust the
displayed weight accordingly. Perform this adjustment before carrying out the linearity adjustments from the
[Calibration » Page 80] screen.

Note that the Control mode field is read-only, and displays the current scale weight.

To perform the span adjustment, place the test weight on the scale and fouch Adjust. A message will appear fo
indicate that the adjustment is complete, and the Control mode will change to reflect the offset, displaying a
corrected value.

See also
& Precision Scale: Capacity and Increments » Page 146
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Control Mode

The Control mode screen shows the current scale weight. This is useful for viewing the weight reading during
setup and diagnostics without leaving the setup menu system.

£ Control mode

1.0005 kg

Figure 224: Control Mode Screen

Precision Scale: Units

£ Units

Secondary unit

Nane

Host / auxiliary unit

Mone

Startup unit

Primary

Legacy mode

Off

Figure 225: Precision Scale Units Screen

Units Settings

Parameter Options Function
Secondary unit g, kg, t, Ib, oz, fon | Sets the Secondary unit.
Host / auxiliary unit | g, kg, t, Ib, oz, fon  |Sefs unit type for Host / auxiliary unit. The Host / auxiliary unit
Startup unit Primary [default], |Determines whether, when the terminal is restarted, the weight is
Use Last displayed using the Primary unit, or in the unit most recently
selected (e.g. secondary unit).
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Legacy mode Off [default], This parameter is not used in IND700

Version 2
Legacy mode
Off M
off |
Version 2 I

Figure 226: Precision Scale Units: Legacy Mode Options

Precision Scale: Zero

< Zero

Startup zero Auto zero tracking

Capture new On

Power up zero -range (%) Auto zero range (d)

2 0.5

Power up zero +range (%) Blank under zero (d)

18 20

Center of zero Push button zero

On On

Center of zero for net weight

Off SET ZERO

Figure 227: Precision Scale Zero Screen, Page 1
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<

Zero

Push button zero -range (%)

2

Push button zero +range (%)

Figure 228: Precision Scale Zero Screen, Page 2

Zero Settings

SET ZERO

Parameter

Options

Function

Startup zero

Capture new [default],
Use last

Determines how the scale handles zero when it is
restarted.

Power up zero -range (%)

Opens a numeric entry
dialog; default value is
2%

Power up zero +range

(%)

Opens a numeric entry
dialog; default value is
18%

These parameters appear if Startup zero is set fo
Capture new. Values define the range within which the
terminal, at power up, will aufomatically zero the
scale. If scale weight is outside the configured range,
Startup zero will not execute.

Center of zero

Off [default], On

When enabled, the >0< indicator will appear on
screen when the scale gross weight is af zero.

Center of zero for net
weight

On [defaul], Off

\When enabled, the >0< indicator will appear on
screen when the scale nef weight is at zero.

Auto zero fracking

On [default], Off

Auto zero fracking is an automatic zero maintenance
function which fracks zero when the scale is empty,
and compensates for conditions such as terminal or
load cell drift, or slow debris buildup on a scale
platform.

Auto zero range (d)

Opens a numeric entry
dialog; default value is 0.5

Defermines the range, in scale display units, within
which Auto zero will be active.

Blank under zero (d)

Opens a numeric entry
dialog; default value is 20

Determines the sub-zero point, in scale display units,
at which the terminal will blank its weight display.

Push button zero

On [default], Off

When On, the ferminal's zero softkey can be used to
set the terminal to zero, if the current scale weight
value is within the range defined by the -range and
+range values.

Push button zero -range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.

Push Button zero +range
(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.
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Precision scale: Tare

The parameters available on this screen change depending on the Auto tare mode, Auto tare reset mode and
Auto clear tare seftings. The screen below shows these parameters all set fo On.

{ Tare

Startup tare

Clear

Auto tare mode

On

Auto tare threshold

0.01

Auto tare reset mode

On

Auto tare reset threshold

0.01

Figure 229: Precision Scale Tare Screen

Auto clear tare

On

Auto clear tare threshold

0.01

Push button tare

On

Keyboard tare

On

Parameter

Options

Function

Startup tare

Use last [default], Clear

Determines whether an existing tare value is preserved
at system restart, or cleared.

Auto tare mode

off [default], On

Determines whether the terminal will automatically
take a fare once the Auto tare threshold value is
exceeded. An aufo tare is cleared once the weight
value falls below the Auto tare reset threshold.

Auto tare threshold (kg) [if
Auto tare mode = On]

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Aufo tare reset mode [if
Auto tare mode = On]

Off [default], On

Determines whether tare is reset according to the value
defined in Auto tare reset threshold.

Auto tare reset threshold
(k) [if Auto fare reset
mode = 0n]

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Chain tare mode

Off [default], On

\When Chain tare mode is ON, it is possible fo take
mulfiple tares in sequence by touching the Tare softkey
— for example, when filling multiple similar containers
on a pallet. Once one container is filled, fouch Tare
again fo reset the scale to Net zero.

Auto clear tare

Off [default], On

Determines whether the terminal will preserve a fare
value when scale weight returns to zero, or aufomat-
ically clear it when the weight value falls below the
Auto clear tare threshold.

Auto clear fare threshold
(k@) [if Auto clear tare =
0On]

Displays a numeric entry
dialog. Default is O.

Refer to Auto clear tare, above.
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Push button fare

On[default], Off

\When Push button tare is On, the Tare softkey on the
home screen is functional. Touch this softkey to create
a tare value based on an empty container on the
scale. The terminal then shows a zero weight and
indicates that it is Net mode. When the container is
filled, the terminal shows the net weight of the
contents.

Precision Scale: Filter

4 Filter

Vibration filter

Standard

Process filter

Universal

Figure 230: Precision Scale Filter Screen

Parameter Options

Function

Vibration filter

Standard

Vibration filter

Stable

Standard

Unstable

By default, the Vibration filter is sef fo Standard. This
parameter is used fo adapt the scale to ambient conditions.
This setting determines how rapidly the scale will settle on a
weight value when vibration is present.

Stable: the scale works very rapidly, but its accuracy is
extremely sensitive to external influences.

Unstable: the scale works slowly, but its accuracy is
relafively unaffected by external influences.

Process filter

Process filter

Universal

Universal

Absolute

This parameter allows the scale fo adapt to the weighing
process in use.

Universal: this seffting is used for normal, transaction
weighing.

Absolute (Dosing): This setting is used for extreme
condifions, such as when extreme vibration is present, or
when the scale is measuring a filling process.

See also

& Precision Scale: Stability » Page 159
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Precision Scale: Stability

<

Figure 231: Precision Scale Stability Screen

Stability

Stability detection

Standard

Parameter

Options

Function

Stability
detection

Stability detection

Standard

Fast

Standard

Precise

The stability defection parameters determine the
update rate of the displayed weight value. The appro-
priate update rate is relafed to the scale's stability. A
Precise update rafe will reflect smaller effects on scale
stability, while a Fast rafe will ignore small fluctu-
ations and permit a fransaction fo proceed. For
environments where external facfors such as floor
vibration do not disturb the scale, the Precise opfion
can be selected. In noisy environments the Fast option
ensures that the weighing process can continue
despite some scale instability. In most circumstances,
the Standard option is appropriate, unless scale insta-
bility interrupts the ability fo perform a transaction.
Note that this parameter does not [filter » Page 158]

vibration; it simply decides how the terminal's display
responds to the vibration.

MinWeigh

Certain industries such as pharmaceuticals and food processing require a guarantee that the weighing
equipment selected for a particular measurement is adequate for the task. One way fo ensure that appropriate
weighing equipment is selected is by the creation and use of a minimum weighment value (MinWeigh), below
which a particular piece of weighing equipment cannot be used.
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The MinWeigh function compares the current weight with the programmed MinWeigh value. In the configuration
screen shown below, MinWeigh has been enabled and its value set to 1 kg.

<

Figure 232: MinWeigh Setup Screen

MinWeigh

MinWeigh mode

On

MinWeigh value (kg)

Parameter

Options

Function

MinWeigh
Mode

On [default],
Off

If the displayed weight (B/G or NET) is greater than or equal to the
MinWeigh value, the MinWeigh symbol appears below the weight display,
to the right of the tare display. All terminal functions behave normally.

KA 2 Max10kgd=20g

116 kg

When the absolute value of the net weight is less than the MinWeigh value,
the MinWeigh symbol flashes in red &.

MinWeigh
value (kg)

Displays a
numeric entry
dialog. Default
value is 0

This field displays if MinWeigh mode is sef to On. The unit is the default unit
sef

Reset

Scale Branch Reset

Note that this Reset function refers only fo parameters configured in the currently selected
setup branch. For general Terminal reset options, refer fo [Reset » Page 264].

160 | Configuration

IND700



RESET CALIBRATION

DATA RESET SETTINGS

Figure 233: Scale Reset Options

This screen allows the user fo reset either calibration data or seftings. If settings is selected, calibration data are
preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 234: Reset Confirmation Dialog

3.1.3.1.2 Log or Transfer

The Log or Transfer menu sets the conditions which determine how and when a demand output is friggered.
Normal demand mode transfer occurs whenever a transfer request is made , depending on the options selected
here, and providing there is no motion on the scale and the weight is above gross zero (a negative gross
weight will not be printed).

Data is sent fo:

 Interfaces for which the Connection has been defined as Transfer
e The Alibi Table

» The Transaction Table
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Weight values shown on this screen are gross weights in primary units.

When Log or Transfer is selected from the Scale n menu options, a default configuration screen appears, with
no options selected.

< Log or Transfer

Minimum Weight (kg)

0

Interlock

Auto Transfer

Figure 235: Log or Transfer Screen, Default View

Additional fields appear depending on the initial selections for Interlock and Auto Transfer. The follow illus-
fration shows the menu with all options selected.

<  Logor Transfer

Minimum Weight (kg) Auto Transfer

0 (L) With first stable value

() After last stable value
Interlock

Active

Auto Transfer .
() Only if scale is selected

Reset Trigger () Always

Threshold Weight " Reset Threshold (kg)

Motion Check 0

Figure 236: Log or Transfer, All Options Selected
Note that some the Auto Transfer and Active sub-sections appear only if Auto Transfer is enabled.
Log or Transfer Options

Option Settings

Minimum Weight (kg) This value defermines the minimum scale weight required to frigger the
Interlock and/or Aufo Transfer actions. The weight unit for this and the other
fields on this screen is defermined by the Primary Unit set in ASM at Capacity
and Increments.
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Option

Seftings

Interlock

When enabled, the Interlock option responds to scale data to determine when
a log action is performed. This prevents repeat logging of the same weighing
operation.

When enabled, this inferlock requires that the live weight reading be reset
according to the Reset Trigger paramefer sefting (see below). The live weight
must then seftle to a weight greater than the Minimum Weight value (see
above) before the ferminal will respond to the next log or fransfer request.

If Interlock is enabled, or Auto

Transfer and With first stable value is selected

Reset Trigger

The Reset Trigger action can be performed in response to Threshold Weight
[default] or Deviation This frigger is defined either by an absolute value
(Threshold Weight) or by a minimum change in weight (Deviation).

If either Interlock or Auto Transfer is enabled

Resetf Threshold (kg) or Reset
Deviatfion (kg)

The weight value which triggers a reset and indicafes the start of a new
weighing operation and a new log entry.

Auto Transfer

When enabled, Auto Transfer causes data about each weighing operation to be
sent to the destination defined in the [Communication » Page 208] section of
sefup, depending on the parameters selected in Auto Transfer and Active.

If Auto Transfer is Enabled

Auto Transfer

When enabled, the trigger conditions defined by the Interlock settings will
automatically export data about each weighing operation either With first
stable value or After last stable value.

With first stable value: data is sent when the first stable weight is captured,
even if the weight changes afterward. This selection would typically be used for
static weighing.

After last stable value: dafa is sent based on the last stable weight captured.
This selection might be used for manual filling, where the scale weight will
briefly be unstable affer the last material is added.

This selection determines whether the Reset Trigger option appears.

Active

The options fo activate the Aufo Transfer function are Only if scale is selected
and Always.

Motion Check

When enabled, the Motion Check prevents the inferlock from friggering a log or
transfer action until scale weight is within the paramefers defined as stable af
[ASM > Stability » Page 128].

See also

¢ Communication Sefup » Page 208

& Stability » Page 128

Sum Scale

For terminals with multiple scales connected, a Sum Scale can be configured. When the Sum Scale is enabled,
a number of other screens become available, in which the Sum Scale parameters can be configured.
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Note that the Sum Scale calculation affects the terminal's status if it is in an Approved mode -- either OIML or
NTEP. This difference is reflected in the selectiosn offered by the [Metrology » Page 165] and [Capacity &

Increment » Page 166] screens.

! Setup > Scales > Sum Scale

Scales Scale 1
Application Scale 2

D
Terminal Sum Scale

Communication

Maintenance

Settings

Metrology

Capacity &
Increment

Units

Tare

P e
" 05.Feb.2024

Scale Reset

Figure 237: Sum Scale Menu System

3.1.4.1 Settings

The Identification screen is used fo enable or disable Sum Scale, and fo configure its name, component scales

and type of sum.

{ Settings

Enable Sum Scale

Scale Identification

SumScale

Sum Type
Display Weights

High Resolution Weights

Sum Component Scales

Scale 1

Scale 2

Figure 238: Sum Scale Seftings

Parameter Options

Function

Enable Sum Scale Enabled, Disabled [default]

\When Sum Scale is not enabled,
tfouch this button fo move the slider
butfton to Enable Sum Scale and
display the other items on this

page.
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Scale Identification

Sum Scale [default]

Touch the field fo display an
alphanumeric entry dialog,
permitting the sum scale to be
assigned a name other than the
default.

Sum Type

Display Weights, High Resolution
Weights

Choose the resolution of the Sum
Scale. High Resolution Weights
provides an arithmetic summation
based on the included scales’
internal fine resolution weight
values. Display Weights provides
an arithmetic summation based on
the included scales’ displayed gross
weight values.

Sum Component Scales

Sliders display, representing each
connected scale.

Determines which of the aftached
scales are included in the sum.

See also
& Scale Setup » Page 73

3.1.4.2 Metrology

The Metrology screen allows an approval to be set for the Sum Scale -- OIML or NTEP. This setting is
independent of the Metrology seftings for the component scales.

{  Metrology

Approval

Not approved

Not approved

OIML

NTEP

Figure 239: Sum Scale - Metrology

IND700
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Once an approval type is selected, the parameters configured for it in the scales' ASM screens are displayed,
but cannot be modified.

<  Metrology

Approval
OIML

Verification Class

ClassIII

Lower temperature limit (°C)

-10

Upper temperature limit (°C)

40

Figure 240: Sum Scale - Metrology: Approval Selected

3.1.4.3 Capacity & Increment

The Sum Scale's capacity and increment are configured in this screen.

{ Capacity & Increment

Primary Unit Preview

kg N 120020 kg
Capacity

120000

Incremental step

1

Increment

20

Figure 241: Sum Scale - Capacity & Increment

The Primary Unit and Capacity are set as for the component scales. In the screen shown above, the capacity
is the sum of two scales with a capacity of 60,000 kg each. An Incremental Step paramefer sefs the
magnitude of the differences between Sum Scale increments. In the example shown above, the step options are
1,3 and 5.
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If 1 is selected, the default Increment size is 10, and the dropdown list offers options from 0.01 fo 10000.

- asa ocidas

10

0.1

0.01

10 N

Figure 242: Drop-down List for Sum Scale Incremental Step 2

If 2 is selected, the default increment size is 20, and the dropdown list offers options from 0.02 fo 20000.
Similarly, selecting 5 offers options from 0.05 to 50000, with a default value of 50.

These incremental steps facilitate the sum scale calculation for Approved scales.

3.1.4.4 Units

The Sum Scale's Units screen displays the Primary Units selected in the Sum Scale [Capacity & Increment »
Page 166] screen -- which may differ from the Primary Units configured for the component scales. A
Secondary Unit can be selected here, from the usual set of unit types -- g, kg, 1, Ib, 0z, fon.

kg

Secondary Unit

g

Figure 243: Sum Scale - Units
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3.1.4.5

3.1.4.5.1

168 | Configuration

Tare

The Sum Scale's Tare options are configured in a series of screens, as seen in the image below.

| Setup > Scales > Sum Scale > Tare
Scale 1 Settings
Scale 2 Metrology
Sum Scale Capacty
Increment
i .
Units
Tare

Scale Reset

Types
Auto Tare
Auto Clear

Restart Tare

10:47

05.Feb.2024

Figure 244: Sum Scale - Tare: Menu System

Types

Pushbutton Tare can be enabled or disabled using the slider displayed on this page. By default, it is disabled!

{ Types

Pushbutton Tare

Figure 245: Sum Scale - Tare: Types

When Types is enabled, and Sum Scale is the active scale on the home screen, touching the Tare butfon gg or

the Tare sofktkey *T+ (if configured) will set the current scale weight as the Sum Scale's tare value.
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3.1.4.5.2 Auto Tare
By default, the Sum Scale - Auto Tare option is disabled. When it is enabled, additional fields appear.

<  Auto Tare

Auto Tare

Tare Threshold Wt. (kg)

0

Tare Reset Threshold Wt. (kg)
0

Tare Reset Motion Check

Figure 246: Sum Scale - Tare: Auto Tare Enabled

The threshold and reset threshold parameters are the same as those shown for the respective component
scales. The only additional option is a Tare Reset Motion Check. \When this is enabled, the terminal will check
for scale stability before clearing the tare affer a fransaction. This ensures thatf zero is captured correctly affer a
tared transaction complefes.

3.1.4.5.3 Auto Clear
Tare can be cleared automatically after each transaction by enabling this parameter.

Auto Clear

Auto Clear Tare

Clear Threshold Wt. (kg)

Clear Tare Motion Check

Figure 247: Sum Scale - Tare: Auto Clear

The threshold value functions in the same way as for the respective component scales and, like the [Auto Tare
» Page 169] option, Auto Clear includes an optional Clear Tare Motion Check, to ensure scale stability when

tare is automatically cleared.
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3.1.4.5.4 Restart Tare
The Restart Tare option...

<  Restart Tare

Restart Tare

Figure 248: Sum Scale - Tare: Restart Tare
When Restart Tare is enabled or disabled, an OK button || appears af lower right. Click this bufton fo confirm
the change.

3.1.4.6 Scale Reset

3.2 Application Setup

The Application menu offers four items, which control various applicafion-specific features of the terminal.

For setup and operation of the optional ProwWorks Mulfi-Tools applications, refer fo the ProWorks Multi-Tools
User's Manual, provided when the ProWorks license is purchased. The screen below shows the menu as it
appears in a ferminal without this license.

é?n @ 25.May_12?£;

Setup > Application

Scales Memory
Application ID Form
: Auto Start
Terminal e
Application
Communication Discrete l/O

Maintenance

Figure 249: Application Menu
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3.2.1 Memory
The Application > Memory menu offers the following options.

fé}n @ 25.May_122:;z§

Setup > Application > Memory
e
Scales Memory Alibi Enable
Application ID Form Alibi Table
Terminal Auto‘ Sta.rt Tare Table
Application
Communication Discrete I/O Transaction Table

Maintenance

Figure 250: Application Memory Menus

3.2.1.1 Alibi Enable

< Alibi Enable

Alibi Memory Table

Figure 251: Application - Memory - Alibi Enable Screen
This screen simply determines whether Alibi memory is enabled (storing data) or disabled.
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3.2.1.2 Alibi Table

< Alibi Table Y M
Log Transaction  Scale  Gross Net Tare
1D Time Counter # Weight Weight Weil
7 06.Feb.2024 09:39:08 1 2.139 1.989 0
6 06.Feb.2024 09:38:51 1 2.140 1.990 0
5 06.Feb.2024 09:38:46 1 2.140 1.990 0
4 06.Feb.2024 09:37:09 1 2.140 1.990 0
3 06.Feb.2024 09:36:52 1 2139 1.989 0
2 06.Feb.2024 09:36:11 1 2.212 2.06e2 0
1 01.Feb.2024 20:12:45 1 0.000 0.000 0
. _________________________________________________________________________]

Figure 252: Alibi Table View

This screen displays the current contents of the Alibi Table.

Alibi table dafa can be filtered and exported. For details on these functions, refer to [Table Functions: Filter,
Export, Import, Clear » Page 48].

3.2.1.3 Tare Table

Access the Tare Table screen to manage tare records. Records can be created, deleted, imported or exported
from this screen.

{ TareTable Y + [i'[ ['1] ﬁ
ID Name Description Value Unit Low Limit
1 RS-1 Sugar bin #1 1.5 kg
2 Aggregate hopper Medium container 15.0 kg
3 Sand, fine kg 9.
4 Cement, standard Wheeled bin kg g,
5 Gravel, medium Bedding gravel kg 4.7
6 Box, SS screws 2.0 kg
7 Cement, sp 10.0 kg
8 Box, medium Box for rubber balls 1.5 kg

. ______________________________________________________________________________________________________|]

| —
Figure 253: Tare Table
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3.2.14

IND700

< Add Tare

ID Tare Value Unit
9 0 kg v/
Invalid Value
Name Lower Limit
0
Invalid Value
Description Upper Limit
0
Invalid Value

Scale 1 (Gross Weight)

1.45 kg

Figure 254: Add New Tare Record

Parameter Setting

ID These three fields can be modified fo provide a user-friendly Name and functional

Name Description of the tare, fogether with a tare ID number. If a duplicate tare ID is enfered,

Description the ferminal will indicate this, and a different ID number must be entered.

Tare Value The tare can be given an absolute weight value. The associated unit is also configured

Unit here.

Lower Limit Instead of an absolute value, the tare record can have upper and lower limit values,

Upper Limit defining the acceptable range of variation in container weight. If the container's weight
does not fall within this range, the terminal will indicate a tare failure.

Scale e This field shows the current scale weight. When a container is on the scale, its weight
will be displayed here, permitting the absolute or limit values to be set.

’T‘ Touch this butfton to use the current scale weight in the Tare Value field.

E@ Touch this button to switch between available scales for the source of the fare value.

For further information on configuring tare records, refer to [Tare Table » Page 302] in [Table and Log File
Structure » Page 297].

For information on table operations, refer to [Table Functions: Filter, Export, Import, Clear » Page 48].

See also
& Tare Table » Page 172

Transaction Table

The Transaction Table is enabled by default, and cannot be disabled. Each transaction performed by the
terminal is stored here, with one transaction per row. Access the Transaction Table either at Setup > Appli-
cation > Memory > Transaction Table, or by fouching the Transaction Table softkey, which can be added to
the ribbon on the main screen at [Softkeys » Page 197].
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Transaction Table columns adapt to the terminal configuration dynamically, so that all available information is

represented in the table. The image below shows a Transaction Table with the default columns.

{ Transaction Table Y i
Log ” Transaction Scale Gross Net Tare
Time Counter # Weight Weight Weight
12.Feb.2024 08:11:24 4400 4400 00
12.Feb.2024 08:11:14 ¥ 10700 10700 00
12.Feb.2024 08:11:05 > 9750 9750 00
12.Feb.2024 08:10:58 > 9200 9200 00

Figure 255: Transaction Table with Default Columns

Table dafa can be exported and deleted, using the icons in the menu bar. Selecting delete displays a confir-

mation dialog:

Warning

Clear Entire Table?

X

Figure 256: Confirmation Dialog for Clearing Transaction Table
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The Export function displays the sfandard Table Data Export screen:

{  Table Data Export

Directory

Internal File v Ch\Export\e9569416DZ

File Type

Ccsv

File Name

IND700_2023_08_03_1246_Transaction

Figure 257: Table Data Export Screen

The type and name of the exported file can be changed; the Directory where the file is stored in the IND700
cannot be changed. Click the check icon at lower right to perform the export and return to the Transaction Table
view.

3.2.1.5 Clearing Tables

The contents of the Tare Table and Transaction Table can be cleared by touching the CLEAR M icon at upper
right in the table view screen. A confirmation dialog will display:

Warning

A Clear Entire Table?
X

Figure 258: Clear Table Confirmation Dialog

3.2.2 ID Form

The ID Form is configured by naming and enabling up to ten fields of data.
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To modify the form, access Setup > Application > ID Form. A list of ID Form fields will display, indicating the
name and configuration of each available field.

Fields will only appear in the ID Form accessed from the home screen by touching the ID Form softkey [ if the

Status column shows that it is Enabled.
To edit a field, touch ifs row in the table. An edit icon will appear.

ID Form

Name

Status

Numeric Only

Preserve Prev. Value

Product
Batch
Lot No.

ator ID

Ident F
Ident G
Ident H
Ident I
Ident |

Enabled
Enabled
Enabled
Enabled
Enabled
Disabled
Disabled
Disabled
Disabled
Disabled

Figure 259: ID Form Edit Icon Pop-Up

Touch the edit icon to open the Edit ID screen in its default state.

<

Edit ID

ID

6

Figure 260: Edit ID Screen
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Enabled
Enabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Enabled
Enabled
Enabled
Enabled
Enabled
Disabled
Disabled
Disabled
Disabled
Disabled

Status

Numeric Only

Preserve Prev. Value
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To give the field a descriptive name, fouch the Name field. An alphanumeric entry screen will display.

<{ Name

Carrier < > @
9 (| O

Figure 261: Naming the ID Form Field

Enter the name and touch the check mark to confirm the entry. The Edit ID screen will now show a check mark,

indicating that there are changes fo be saved.

< Edit ID

ID

Status
6

Name

Numeric Only
Carrier

Preserve Prev. Value

Figure 262: ID Field Named
The other fields in this screen are as follows.

Edit ID Options
Option Function
Status When active, this setting causes the ID field to appear in the ID Form.

Numeric Only |When active, this setting constraints the field's input options to a numeric value. This helps
ensure the correct type of enfry. When this setting is not actfive, field entry can be

alphanumeric.
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Option Function

Preserve Prev. |When this setting is not active, field entries made during a fransaction are cleared when a
Value new fransaction starts. In many cases, much of the ID Form content -- such as the name of
the operator or the product -- will remain constanf from one weighing operation to the next.
When this seffing is active, the fields remain filled-in. Each field can be modified as usual
from the ID Form screen, simply by touching the field and making the appropriate entry fo
overwrife or simply delete the existing content.

Touch the check mark to confirm the changes and refrurn to the Application > ID Form view.

3.2.3 Application-Specific Menus

In its default state, the Select Application menu shows only the standard application, [ID Form » Page 175].

A ProWorks Multi-Tools license is necessary to enable the other applications -- Counting, Classification,
Filling, Over/Under weighing and Totalization. For defails on the configuration and use of these applications,
refer to the ProWorks Multi-Tools User's Manual, which is provided when the application license is purchased.

3.2.4 Auto Start Application

<{  Auto Start Application

MT.Singularity.Platform.Client. MTApp

Figure 263: Application - Aufo Start Application

This screen displays a drop-down list which includes all installed applications. Select Applications from this list
to determine whether or not they start automatically when the terminal is started.
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3.2.5 Discrete I/0

Scales

Application

Terminal

Communication

Maintenance

Figure 264: Discrefe /0 Menus

Setup > Application > Discrete I7/0

Memory

ID Form

Auto Start
Application

Discrete I/O

Discrete Inputs

Discrete Outputs

Discrete Inputs and Discrefe Outputs are configured from the Discrete I/0 menus.

3.2.5.1 Discrete Inputs

IND700

rp 12:53
2eit 25.May.2023

The screen image below shows the Discrete Inpufs screen in its default state, with no inputs configured.

<{ Discrete Inputs

ID Name Type

Location

IP Address

Node

+

Position

4+  Add new discrete

Figure 265: Discrefe Inputs List

input
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To add a Discrefe Input, click on + in the list view. The following screen will appear:

Figure 266: Discrefe Inputs -- Add New

Add new discrete input

ID

1

Assignment

None

Polarity

4

<

Add new discrete input

ID

1

Name

Type

Scale Card

Location

Scale 1

Position

1

Assignment

None N
Polarity
+ ¥4

Figure 267: Discrefe Inputs -- Add New, Scale Card Type Selected

The fable below summarizes the options available in the Add new discrete input screen, which change

depending on the Type and Assignment selected.

Parameter

Settings

D

The Discrete Inpuf ID is automatically set and cannot be changed, except by deleting existing
inputs and re-creating them in the desired order.

Name

Touch the Name field to display an alphanumeric entry screen where a descriptive title for the
input should be entered.
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Parameter

Settings

Type

Select from the Type list to determine the location of the input -- either on the main PCB, or on
a scale inferface, or in an ARM100 Remote 1/0 module (if connected).

Type
MNone '

MNone
Scale Card
Main Board

Location

Determines which setf of DIO connections are to be used by this inpuf. If Main Board is
selected, this field does not appear. If Scale Card or ARM100 is selected, Location permits
the selection of one of the scale interfaces or modules.

Position

The Main Board and each of the scale inferface cards includes 2 digital inputs and 2 digital
outputs. Position refers fo these; 1 selects output 1, 2 output 2. ARM100 module output
addresses include a module designator.

Assignment

The input's Assignment can be selected from this dropdown list. The input will be triggered by
the selected assignment:

MNone

Blank Display
Tare

Clear
Transaction
Disable Setup

i e e

MNone W

Transaction
Disable Setup
Switch Units
Primary Unit
Secondary Unit
Zero

Mone AV

Channel

If the input’s Assignment is Tare, Switch Units, Primary Unit, Secondary Unit or Zero a
Channel field appears. Touch this field to display a drop-down list of available scale
channels, including Active Scale, Scales 1, 2, 3 and 4.

Polarity

Polarity can be either positive (+) or negative (-). This setting defermines which state of the
assigned frigger causes the input to be active.
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3.2.5.2 Discrete Outputs

The screen image below shows the Discrefe Outpufs screen in ifs default state, with no outpufs configured.

<{ Discrete Outputs -

ID Name Type Location IP Address Node Position

+ Add new discrete output

Figure 268: Discrefe Oufputs List
To add a Discrete Output, click on the + in the list view. The following screen will appear:

<{  Add new discrete output

ID Assignment

1 None a4
Name
Type

None N

Figure 269: Discrefe Oufputs -- Add New

182 | Configuration IND700



Once an Assignment and Type have been chosen, additional fields appear:

<  Add new discrete output

ID Assignment

2 Over Capacity

Channel

Active Scale

Figure 270: Discrefe Output Options, Assignment Selected

If the Assignment is Comparators, a Comparators field will display. Touch this screen to view the Discrete
Outputs list. Here, the output can be associated with a comparator so that the output is triggered when the
comparator's condition is satisfied. Note: Comparators are available in the IND700 only when the ProwWorks
Mulfi-Tools license is activated. Refer to the ProWorks Multi-Tools User's Manual for further details on
Comparators.

<  Edit
ID Assignment
1 Comparators ~
Name Comparators
Within target tolerance 1/ Within range &
Type
Main Board N

Position

1 v

Figure 271: Discrefe Output, Comparator Assignment
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Touch the Comparators field to display a list of available comparators.

{ Comparators

ID Name Data Source Channel Operator Lim

01 Within range Displayed Weight Scale 1 >_< 2,
02 Process underway Displayed Weight Scale 1 >

03

04

05

06

07

08

09

10

Figure 272: Comparators List

Touch the required comparator and select the check mark from the context menu which appears:

{ Comparators

ID Name

o1 |() # Ve

e |
02 Process underway

Figure 273: Comparatfor Selection Context Menu

The fable below indicates the function of each of these options.

Parameter Settings

ID The Discrete Output ID is automatically set and cannot be changed, except by deleting
existing oufputs and re-creating them in the desired order.
Name Touch the Name field fo display an alphanumeric entry screen where a descripfive title for the

output can be entered.
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Parameter Settings
Type Select from the Type list to determine the location of the output -- either on the main PCB or
on a scale interface, or in an ARMT00 Remote I/0 module (if connected).
Type
Virtual N/
None
Scale Card
Main Board
Virtual
Options are:
* None
e Scale Card
e Main Board
e Virtual
e ARMT10O (if connected)
Location Type = Scale Card: Scale 1, Scale 2
Type = Main Board: 1, 2
Type = Virtual: Virtual |0 Device
Type = ARM100: Up fo 8 modules
Note: The Virtual option is used for system diagnostics only; outputs triggered from the
Maintenace > Run > Diagnostics >[DIO Test » Page 262] do not affect attached devices.
Position If Type is set to Virtual or ARM100, a Position field displays, from which the address of the

output can be selected.
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Parameter

Settings

Assignment

The output's Assignment can be selected from this dropdown list. The oufput will be triggered
by the selected assignment:

None

Center Of Zero
Net

Motion

Over Capacity
Over Zone

£l i1 e

MNone

Assignment options are:

None

Center of Zero

Net

Motion

Over Capacity
Under Zero

Over Zone

Ok / Tolerance Zone
Under Zone

Classes 1 -8

Low Zone

High Zone
Comparators
System Error Alarm
System OK

Scale T - 4 selected
Sum Scale selected

If Assignment is set to a scale-related parameter (Center of Zero, Net, Notion, Over Capacity,
Under Zero), the Channel field appears. This drop-down lists offers the following options:

Active Scale
Scale 1 - Scale 4
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3.3 Terminal Setup

The Terminal branch includes the following menu options:

|

Setup > Terminal

Scales

Application

Terminal

Communication

Maintenance

Figure 274: Terminal Menus

3.3.1 Device

IND700

{ Device

Terminal ID #1

Terminal ID #2

Terminal ID #3

Device Softkeys

Display

Transaction

Security Options
Counter iy
Users Windows
Region Licensing

Terminal Serial Number

69565416DZ

Figure 275: Terminal - Device

Clear Messages

R @ 12:14
7 15.Auq.2023

Application mode

Parameter

Options

Function

Terminal ID #1, 2, 3

Displays an alphanumeric entry
dialog.

Three optional strings used to
identify the terminal. These could
include location, function, efc.

Terminal Serial Number

Displays a value.

This serial number is fixed and
cannot be modified.
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3.3.2

Serial Number Mismatch

If the Terminal Serial Number field is editable and shows a "Serial Number Mismatch" warning in red, click on
the field. If necessary, enter the correct serial number from the terminal's data plate, and then confirm the entry

in the alphanumeric entry kepad. Finally, click the check mark |v| which appears af lower right in the Device
screen. The serial number mismatch will be cancelled, and the serial number will no longer be editable.

Display

< Display

Backlight Timeout

Backlight (minutes)

30

Screen Saver

Figure 276: Terminal - Display

All Scale View
Auxiliary Display
Tare Active

Message Timeout (seconds)

3

Backlight (brightness)

50

Backlight Timeout and Screen Saver
Either the Backlight Timeout or the Screen Saver can be enabled, but not both af the same

time.
Parameter Options Function
Backlight Enabled, Disabled  Determines whether the backlight timer is operative.
Timeout
Backlight Displays numeric Determines how many minutes the terminal must be inactive before the
(minutes) entry dialog. Default |backlight is turned off.

is 30.

Screen Saver

Enabled, Disabled

Determines whether the screen saver is operative.

Screen Saver

Displays numeric

Determines how many minutes the terminal must be inactive before the

(minutes) entry dialog. Default | screen saver is invoked.
is 30.
All Scale View | Enabled, Disabled | Determines whether the main screen displays information for all scales
at once, or one at a time (using Scale Swifching to change between
Views).
Auxiliary Tare Active, Tare Determines when the tare display appears af lower left of the weight
Display Always. display window. By default, this display appears only when a tare

Auiliary Display

Tare Active v

Default is Tare
Always.

value is active and the terminal is in Net mode.
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Message
Timeout
(seconds)

Default is 3 seconds.

Determines how long to display the popup which appears when a
message arrives in the message area at fop left of the screen. The
maximum value is 30 seconds. A value of O prevents the message
alert from displaying, but messages stfill accumulate in the message
area.

Backlight
(brightness)

Default is 50.

The brightness of the backlight is configurable, so that the display can
be adapted to its environment. In a darker space, a lower number will
be adequate. The value is relative, where O represents no backlight,
and 100 represents the backlight's highest possible value.

3.3.3 Transaction Counter

<

Transaction Counter

Allow Counter Reset

Next Transaction Number

Figure 277: Transaction Counter
When the Transaction Counter is Enabled (the default is Disabled), an Allow Counter Reset option becomes

available; when this is Enabled, a field displays which, when touched, opens a numeric entry dialog permitting

Transaction Counter

a new fransaction count start number to be defined.

IND700
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3.3.4 Users

< Users

User Name Access Level Default User

Admin Administrator

Operator Operator

Figure 278: Users List
The Users list displays all currently configured users.

General Users Settings
Touch the Settings icon & to display the General Users Settings screen.

4 General Users Settings

Connect device to Domain Automatic logout

Logout time (min)

5

Domain User Login

Figure 279: General Users Settings Screen

Automatic Logout and its associafed Logout time (min) parameter can be disabled only when Connect
device to Domain and Domain User Login are disabled.
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Before enabling the Connect device to Domain function, make sure that the Unified Write Filter (UWF) is
disabled af [Security Options » Page 200]. Otherwise, an attempt fo make this setting will result in a warning:

< Warning

UWEF is enabled. Turn off UWF in
A setup > terminal > security options

and cycle power. Then retry.

Figure 280: UWF Warning Dialog

Nofe that disabled the UWF in the Security Options screen requires a terminal re-boot. When UWF is disabled,
touch the Connect device fo Domain slider to display fields used for domain access.

< General Users Settings

Connect device to Domain '.

Domain Name Logout time (min)

5

Service Account Name
Domain User Login

Service Account Password LDAP/LDAPS Access String

Computer Name

WIN-MUUPIHFGDEN

Figure 281: Device Access to Domain Parameters Displayed

When Domain User Login is enabled, a LDAP/LDAPs Access String field is displayed.

Domain User Login

LDAP/LDAPS Access String

Figure 282: LDAP/LDAPs Access String Field
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Touch this field to display an alphanumeric keypad for string entry.

< LDAP/LDAPS Access String

i) | v

Figure 283: Access String Enfry Dialog

Enter the required string and fouch the check mark fo connect fo the domain.

Adding, Editing and Deleting Users

Touch a row to display the options for that row; neither of the default users can be deleted, but can be edited.
Additional users of any access level can be created, edited and deleted.

To set a default user, click the Default User slider in the Edit screen. There can be only one default user. To

delete a default user, first visit the user Edit screen and sef the Default User slider to disabled. The user can
then be deleted from the Users list.

itnr
Figure 284: User Edit Options
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< Edit

User Name

Admin

Password

Access Level

Administrator

Default User

Figure 285: Admin User Edit Options

<  Edit User

User Name

Operator

Password

Access Level

Operator

Default User

Figure 286: Edit Standard User Opfions
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3.3.5 Region

;L @ oz.Augf;g:

Setup > Terminal > Region

Device

Display

Transaction
Counter

Users

Region

Figure 287: Region Menu

Softkeys

Clear Messages

Security Options

Windows

Licensing

The Region menu offers the three options listed below.

3.3.5.1 Language

{ Language

User Language Selection

Display Messages

English

On-Screen Keyboard

QWERTY

External Keyboard

Windows

Default

Figure 288: Region - Language

Application mode

The Language page allows a language to be defined for the following items.

Language |

Time and Date
Format

Set Time and Date

Messages.

Parameter Options Function
User Language Enabled [default], |When Enabled, the user can select a Display Messages language
Selection Disabled from the globe icon [@on the home screen. When User Language

Selection is Disabled, the globe icon is not displayed and the
terminal's language is fixed to the selection made in Display
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Display Messages

English [default],
Francais, Deutsch,
[taliano, Espaniol

Defermines the language in which displayed messages are
shown.

On-Screen Keyboard

QWERTY [default],
QWERTZ, AZERTY

Determines the keyboard layout for alphanumeric input screens.

External Keyboard

Windows Keyboard
[default], English
(United Stafes)-US,
German (Germany)-
German, French
(France)-French,
[talian (ltaly)-Italian,
Dufch (Netherlands)-
United Stafes-Inferna-
tional, Chinese
(Simplified, China)-
Chinese (Simplified)
- US, Spanish
(Spain, International
Sort)-Spain

Defermines the layout for an external (USB) keyboard.

3.3.5.2 Time and Date Format

< Time and Date Format

Preview of Time and Date

23:37

25.Aug.2021

Time Separator

Date Format

Day Month Year

Use 24 hour clock

Display Seconds

Show 2 Digit Month

Show 2 Digit Year

Figure 289: Time and Date Format Options

Date Separator

Parameter Options Function

Preview of Display only Shows how time and dafe are currently formatted.

Time and Date

Use 24 hour  |Enabled [default], |Selects a 12 or 24 hour clock display. If 12 is selected AM or PM is
clock Disabled appended fo the time display, depending on the current 12 hour period.
Display Enabled, Disabled | Seconds can be displayed or hidden.

Seconds [default]

Show 2 Digit  |Enabled, Disabled | The month is either displayed in abbreviated alphabetical form (e.g.
Month [default] Aug) or as two digits (e.g. 08).

Show 2 Digit  |Enabled, Disabled | The year is either displayed as four digits (e.g. 2021) or two (e.g. 21).
Year [default]

Time Separator . [default], , Determines the character used to separate elements of time display.

IND700
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Date Format

Day Month Year
[default], Month
Day Year, Year
Month Day

Determines the sequence of the dafe display.

Date Separator

None, (space),
Dash, .
[default], /, :

Determines the character used to separate elements of the dafe display.

3.3.5.3 Set Time and Date

{ SetTime and Date

Time Zone

(UTC-08:00) Pacific Time (US & Canada)

Daylight Savings Time

25.May.2023

Figure 290: Set Time and Date

NTP Network Time Protocol

NTP Server Address

time.windows.com

NTP Polling Interval (s)

3600

Last Sync

unspecified

By default, when the terminal is connected to a network the NTP Network Time Protocol option is selecfed, and
only the Daylight Savings Time slider remains acfive.

If the ferminal is not connected to a network, the fields on this screen can be used to set the appropriate time

and date.

Parameter

Options

Function

Time Zone

All time zones and regions from UTC-12 fo
UtC+14

Sefs local time zone.

Hour : Minute

Each field opens a numeric entry dialog.

Sefs the current time.

Daylight
Savings Time

Enabled [default], Disabled

Determines whether or not Daylight Savings
Time is observed.

Set Datfe

Displays a calendar screen

Current date can be selected from the

4 August 2021 »

Su Mo Tu We Th Fr Sa

25 26 27 28 29 30 31
1 2 3 4 5 6 7
8 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
29 30 31 1 2 3 4

calendar screen.
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NTP Network
Time Protocol

Enables or disables NTP.

If the terminal is connected to a domain
which provides its own rules, this toggle is
greyed outf and the data fields are
populated with information from the
Windows registry.

Otherwise, enabling NTP allows the
terminal to set ifs fime and date automat-
ically, by referring to the configured Server
Address.

NTP Server Default is time.windows.com.

Address

NTP Polling Determines the frequency of NTP polling. The By default, this value is read from the
Inferval (s) default value is 3600 seconds, or 1 hour. Windows registry.

Last Sync Displays the time sfamp of the last synchro- In a terminal that is not connected to a

nization with the NTP. Default is Not specified,
indicating that no synchronization has taken
place.

network, polling cannot fake place, and
this value will remain unspecified.

@

Synchronizes time and date with NTP server,
then exits to Setup > Terminal > Region menu
view.

3.3.6 Softkeys

The softkeys displayed in the ribbon on the IND700 home screen are configurable, and can be used fo access
various functions and features directly. By default, the Softkey Ribbon Editor screen appears as shown here:

IND700

<  Softkey Ribbon Editor

O ¥ Vv

PT

Preset Tare

C | 'T ik

Tare Transfer

iR || 0@

Switch Seale Switch Units Alibsi Memory

Transaction Tab

@ | K

Higher Res. Tare Table

e

Input Template

Drag and Drop Softkeys in and

out

Preset Tare

5g || O A

Switch Units Alibi Mermory

Tare Table Switch Scale

Higher Res.

ID Form Input Termplate

Figure 291: Softkey Ribbon Edifor: Softkeys Displayed with Labels -- Default
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To display softkeys without labels, touch the T.Z at upper right.

<{  Softkey Ribbon Editor O T

=)
®
)
=
[
)

Drag and Drop Softkeys in and out 115

Brejz|c|n|aln]|>

Figure 292: Softkeys Displayed Without Labels

Additional softkeys can be selected from the scrolling array at the bottom of the screen, and dragged to a
position in the editor. The predefined softkeys cannot be moved or deleted.

Touch the reset icon ©.at the top right fo reset the softkey ribbon to its default configuration. A confirmation
dialog will display:

Warning

Reset Softkeys to
default
configuration?

X

Figure 293: Reset Softkeys Confirmation Dialog
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3.3.7 Clear Messages

{ Clear Messages

Press Run to clear all messages from the system bar.

Figure 294: Clear Message

Touch the RUN arrow at lower right to clear all messages from the system bar on the home screen. A confir-
mation dialog will display:

< Messages have been deleted.

Figure 295: Clear Messages Confirmation Dialog
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3.3.8 Security Options

<  Security Options

Watchdog Timer (s)

Unified Write Filter
30

Keyboard Filter FTP Server (Port: 50001)

External Mass Storage Blocking sFTP Server (Port: 22)
Enable Windows Desktop

Remote Desktop Server

Firewall

Figure 296: Terminal Security Options

Parameter Options Function

Unified Write | Enabled The Unified Write Filter is a Windows feature that helps to protect drives by

Filter [default], infercepting and redirecting any writes to the drive (app installations, settings
Disabled changes, saved data) fo a virtual overlay. This virfual overlay is a temporary

location which is cleared during a reboot. For this reason, take care when
performing an installation: If UWF is set fo Enabled, the installation will be
lost when the terminal is rebooted. When installing software outside folders
excluded from UWF, first disable UWF. The following files, folders and
registry keys are excluded -- their contents will be preserved during a reboot:

Keyboard Filter | Disabled The Keyboard Filter suppresses undesirable key presses or key combi-

[default], nations -- for example, Cirl+Ali+Delefe, and the Windows key. Applying the
Enabled Keyboard Filter can block any key combination or system keys which would
allows the user to exit the application and access the Windows desktop. The
following keys and key combinations are suppressed by this filter:
Windows key Application key Function keys F1-F24
Security Keys Security Keys Shft-Cirl- | Accessibility Keys
Ctrl+Alt+Del Esc LShift+LAlt+PrntScr
Accessibility Keys Application Keys Alt+F4 |Applicafion Keyes
LShift+LAlt+NumLock Cirl+F4
Alt+Space Cirl+Esc Alt+Tabe
Ctrl+Tab LaunchMail LaunchMediaSelect
LaunchApp1 LaunchApp2 Microsoft Surface Key
F21
VolumeMute VolumeDown VolumeUp
External Mass | Disabled Introducing an unknown USB storage device into the system can cause
Storage [default], security issues. Removable storage media can be blocked from read/write
Blocking Enabled access. If this feature is Enabled, an external USB storage device will not be

defected and cannof be used. The USB storage device will be accessible only
if this feature is Disabled.
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Enable Enabled

To avoid changes in the Windows OS, access to the deskfop can be limited.

Windows [default], When this feature is Enabled, the Windows desktop will appear when the
Desktop Disabled user exits the Application. If it is Disabled, a black screen will appear when
the user exits the application. Remove and restore power to restart the
terminal with the application running.
Firewall Enabled The Windows Firewall can be Enabled or Disabled; by default, it is
[default], disabled.
Disabled
Watchdog 30 The Watchdog Timer monitors the function of the ferminal's CPU. If the CPU
Timer (s) is prevented from performing scale functions because it is executing a

Windows process, the watchdog will perform a system reset

Note: Setting a value of 10 or less for the Watchdog Timer will cause the
system to reboot confinuously.

FTP Server Disabled
(Port: 50001) |[default],
Enabled

If this feature is Enabled, files -- such as saved configuration files or log files
-- can be read from and written fo the ferminal using an FTP ufility.

SFTP Server Disabled
(Port: 22) [default],

A Secure File Transfer Protocol (sFTP) can be enabled for devices accessed
through a PC network. For access, the user name is @& Nl e and

Enabled password t-++i «1{-+ These settings cannot be changed. The sFTP server
connects fo the roof directory, C:\, on connection.
Remote Disabled When the Remote Desktop Server is Enabled, a remote connection can
Desktop Server |[default], view the ferminal's screen and control its function, including logging in and
Enabled modifying configuration and calibrafion values.

3.3.9 Windows

Scales

Application

Terminal

Communication

Maintenance

Device Softkeys

Display Clear Messages

F 23:40
5 ®
s 1 25.Aug.2021

Setup > Terminal > Windows

Activate Windows
Through Internet

Activate Windows
Through Phone

Transaction

Security Options License
Counter yop
Users Windows Update Now
Region Licensing

Figure 297: Windows Menu
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3.3.9.1 Activate Windows Through Internet

< Activate Windows Through Internet

After pressing the run button
please follow the instructions.

Figure 298: Windows Activatin by Internet

3.3.9.2 Activate Windows Through Phone
< Activate Windows Through Phone

After pressing the run button
please follow the instructions.

Figure 299: Windows Activation by Phone
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3.3.9.3 License

< License

Partial Product Key

Figure 300: Windows License

3.3.9.4 Update Now

{ Update Now

Target

Internal File

File

Directory @

...MT.Singularity.Platform.Client. MTApp\Temp

Figure 301: Windows Update

Parameter Options Function

Target Internal File [default], USB Determines where the terminal will
Memory look for the Windows update file.

File Dropdown list of available update | If no files are found, this list is
files. empty.

Directory Display only Directory location for update file.
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3.3.10 Licensing

+
For details on managing licenses, refer fo [Application Software Activation » Page 2691].

< License Manager

State Name License Key

4+ Add License

Figure 302: License Manager

The License Manager displays installed licenses, fogether with the key and the product to which they refer. In
an IND700 licensed to run the ProWorks Multi-Tools applications, this screen will appear as shown here:

{ License Manager + & M

State Name License Key Product
v ProWorks Multi-Tools IND700 Licel

Figure 303: License Manager Screen Showing ProWorks Multi-Tools License
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3.3.11 Application mode

IND700

The Application mode options determine how the IND700 will display its weight information. By default, the
terminal is set to display weight information in Full Screen mode:

< Application mode

Application mode

Full Screen

Figure 304: Application Mode, Default View
The Application mode dropdown list offers the following options:

Application mode

Full Screen v

Weight Window Only Mode

Full Screen

Figure 305: Application Mode Dropdown List Options

Weight Window Selection

The Weight Window Only Mode display shows weighing information for the scale currently
selected (showing a blue highlight: Tmz) when the configurafion is made. To change the
scale displayed, it is necessary to return fo setup, select Full Screen, exit sefup, select the
desired scale, and then reapply the appropriate Weight Window Only Mode seffings.
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When Weight Window Only Mode is selected, additional options become available:

< Application mode

Application mode Window Height
Weight Window Only Mode N 100

Docking Style

Block Drag and Dro
MNone g P

Top window position

0

Left window position

0

Window Width

350

Figure 306: Application Mode Options, Weight Window Only Mode Selected
The options shown above are defailed in the table below.
Application Mode Parameters and Settings

Parameter Seftings

Application mode The selection made here determines whether the other
paramefers are available. The default setting is Full
Screen. \When Weight Window Only Mode is
selected, additional parameters defermine the
appearance and behavior of the weight window.

Docking Style Options for Docking Style are None [default], Top,
and Boftom. If Top or Boftom is selected, the weight
display window will be aftached to the respective edge
of the screen, and the two position parameters will be

unavailable.

Top window position If Docking Style is None, the vertical window position
can be set here, measured in pixels from the top of the
IND700 display.

Left window position If Docking Style is None, the horizontal window

position can be set here, measured in pixels from the
left of the IND700 display.
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IND700

Parameter Seftings

Window Width Whichever Docking Style is selected, the window size

Window Height -- width and height in pixels -- can be set here. Default
values are 350 pixels wide by 100 pixels high.

When either of these fields is touched, a numeric entry
screen displays. If the entered value is outside the
permitted range, a message will display -- "Value
exceeds the limits from 'x' to 'y", where x and y are
the smallest and greafest permissible values:

4 Window Width

Yalue exceeds the limits from '330' to "800

50

—

Block Drag and Drop Whatever Docking Style is selected, the weight
display screen floats and can be moved by touching
the screen and dragging -- unless Block Drag and

Drop is enabled, to fix the window's screen position.

The figure below shows a Weight Window Only Mode display with the following parameters set:
* Docking Style: None

e Top window position: 260

e Left window position: 150

e Window Width: 500

e Window Height: 200

When Block Drag and Drop is not enabled, the window can be repositioned on screen by touching any part of
it and dragging:

Figure 307: Weight Display Only Mode on Windows Deskfop
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¥ 142 CALC Max 120kgd=20g

0.00 kg

Figure 308: Weight Display Only Mode Dragged to a Different Location

Exit Weight Window Only Mode

To exit the Weight Window Only Mode of display, a user with Sefup Menu access and configuration privileges
must touch the Menu icon E5, access Setup > Terminal > Application Mode, and change Application mode
to Full Screen Note thatf the User login icon is available in the menu bar of the weight window.

3.4 Communication Setup

The Communication menu allows access to configuration options for the following items. Note that Industrial
Network appears only if an Industrial Network option is installed.

l._‘.fr 13:11
2 @ 25.May.2023

Setup > Communication
. ____________________________________________________________________|

Scales Ethernet Input Template
Application Interfaces
Terminal Connections
Communication AR
Network
Maintenance Output Templates

Figure 309: Communication Menu
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3.4.1 Ethernet

{  Ethernet

MAC Address

00-E0-4B-70-49-2A 192.168.86.1

192.168.86.21

255.255.255.0

192.168.86.1

Figure 310: Ethernet Options, DHCP Enabled
When DHCP is disabled, the fields on the page become editable and fixed address parameters can be entfered.

{  Ethernet

MAC Address Preferred DNS Server

00-E0-4B-70-49-2A 192.168.86.1

Secondary DNS Server

IP Address

192.168.86.21

Subnet Mask

255.255.255.0

Gateway Address

192.168.86.1

Figure 311: Ethernet Options, DHCP Disabled
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3.4.2 Interfaces

The Interfaces screen shown below displays entries for an IND700 with two HSALC scale interfaces installed.

{ Interfaces

Port Hardware Status Baud Rate Data Bits
Mainboard Discrete I/O Enabled

Mainboard Serial Port Enabled
Slot 1 Scale Slot 1 Discrete I/O Enabled
Slot 2 Scale Slot 2 Discrete I/O Enabled

Figure 312: Interfaces

The Interfaces screen lists the terminal's configured interfaces. Touch a row to display the Edit icon.

< Interfaces

P ./ Hardware Status Baud Rate Data Bits
Mairboard Discrete I/O Enabled

Mainboard Serial Port Enabled
Slot 1 Scale Slot 1 Discrete I/O Enabled
Slot 2 Scale Slot 2 Discrete I/O Enabled

Figure 313: Edif Icon

Touch the Edit icon to access the interface's parameters. The contents of this screen vary depending on the type
of interface selected. In the screen shown below, the Mainboard DIO opfion can bee enabled or disabled. When

it is enabled, the inputs and outpufs on the main board can be configured with assignments from the
[Connections » Page 215] screen.
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IND700

Edit DIO Interface

4 Edit Interface

Port Location

Mainboard

Hardware

Discrete [/O

Figure 314: Edit Inferface - Discrete I/0

Parameter Options Function

Port Location Display only Indicates location of port. Not
editable.

Hardware Enabled, Disabled Allows the interface to be turned on
and off.

When a Serial Interface is selected for editing, a two-page configuration screen appears.

Edit Serial Interface

£ Edit Interface

Port Location

Mainboard

Hardware

Serial Port

Interface

R5232

Data Bits

Figure 315: Edit Inferface - Serial, Page 1

LV

Baud Rate

9600

Stop Bits

One

Custom Device

None
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Note that in the following image, the character sef change is disabled: | =

<  Edit Interface

String Frame Flow Control

CR MNone

LF

<STX=...<ETX=

. BCC

Figure 316: Edit Inferface - Serial, Page 2

When the character sef change icon is fouched to enable this function = ,the second page of the Edit Interface
screens appears like this:

£ Edit Interface

String Frame Flow Control

CR MNone

Character Set
LF

<STX>...<ETX>

BCC

Figure 317: Edit Inferface, Second Page with Character Set Option Enabled
Character Set options are as follows:

Parameter Options Function

Port Location Display only Indicates location of port. Not
editable.

Hardware Enabled, Disabled Allows the interface to be turned on
and off.

Interface RS232 [default], RS422, RS485 | Selects the serial inferface type.
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Data Bits 7, 8 [default] Sets the data bits for the serial

interface.
Parity None [default], Even, Odd Sefs the parity selection for the
serial interface.
Baud Rate 4800, 9600 [default], 19200, Sets the baud rafe at which the
38400, 57600, 115200 serial interface will operate.
Custom Device Drop-down, listing all custom Allows selection of a Custom Device
devices such as an ARM100 Remote 1/0
module.
Number of Remote I/0 Not accessible [default] This drop-down list becomes

available when at least one
ARMT100 Remote I/0 module is

connected.
String Frame - CR Enabled, Disabled When enabled, adds a Carriage
Return to the datfa string frame
String Frame - LF Enabled, Disabled \When enabled, adds a Line Feed to
the dafa string frame
<STX>...<ETC> Enabled, Disabled \When enabled, the communication

control characters STX and ETC are
used to ensure synchronization
between the IND700 and another
communicating device

BCC Enabled, Disabled \When enabled, a Block Check
character calculation is performed
Flow Control None, XON-XOFF Toggles between no flow control

and XON-XOFF flow control

3.4.2.1 ARM100 Interface Configuration

When a least one ARM100 remote /0 module is connected to the terminal, additional options appear in the
Edit Interface screen. First, access the screen by fouching a serial inferface, either on the mainboard or on the
Precision scale interface board:

{ Interfaces

Port Hardware Status Baud Rate Data Bits
Miﬁrd Discrete I/O Enabled
Mainooard Serial Port Enabled
Slot 1 SICSpro/Serial Enabled
Slot 1 Scale Slot 1 Discrete I/O Enabled

Figure 318: Accessing the Interface Edit Function

In addition to the standard serial port parameters, the Edit Interface screen will show an ARM100 option in the
Custom Device drop-down list, and the Number of Remote I/0 dropdown will be accessible. Note that with the
ARM100 selected, 8 Data Bits are configured.
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< Edit Interface

Port Location

Mainboard

Hardware

Serial Port

Interface

RS485

Data Bits

Figure 319: Edit Inferface Screen

Standard parameters for the ARM100 I/O are:

e Baud Rate: 115200
¢ Data bits: 8

e Parity: Even

e Stop bits: 1

¢ Flow Control: None
e Interface: RS-485

Baud Rate
57600

Stop Bits

One

Custom Device

ARM100

Number of Remote /O

1(4/6)

Touch the Number of Remote 1/0 field to display all the available I/0 opfions, including those in the ARM100
remote modules. Refer fo the Type, Location and Position fields in setup at Application > [Discrete 1/0 »
Page 179] configuration screens to associate a discrete input or oufput with an address either in the terminal

or in any of the attached ARM100 modules.

< Edit Interface

Port Location

Mainboard

Hardware

Serial Port

Interface

R5485

Data Bits

Figure 320: Edit Inferface Screen, Remote 1/O List expanded
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3.4.3 Connections

<  Connections

Port Hardware Assignment Trigger Template

-+ Add Connection

Figure 321: Connections List

When it is first displayed, the Connections list includes no items. Touch the + icon to add a new connection.
Once a connection has been defined, touching it in this list will display three icons -- delete, add and edit:

m+ 7/

Figure 322: Delete, Add, Edit Icons

< Add Connection

Part

None

None

Assignment

SICS

Trigger

Active Scale

Figure 323: Add Connection Screen
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The confents of the Add Connection screen vary depending on the selections made in the available fields. In
the image above, no Port assignment has been made. The image below shows options displayed when Port is
set to Mainboard.

<  Add Connection

Part

Mainboard

Serial Port

Assignment

SICS

Trigger

Active Scale

Figure 324: Add Connection - Mainboard Port Selected

When Port is set fo Ethernet, the screen appears as shown below.

{  Add Connection

Part Ethernet Port

Ethernet 1701

Ethernet

Assignment

SICS

Trigger

Active Scale

Ethernet Connection

Server

Figure 325: Add Connection - Ethernet Port Selected
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IND700

When Port is set fo File, the screen appears as shown below.

<  Add Connection

Part

File

File

Assignment

Trigger
Active Scale

File Name

Must be 1 to 200 characters

Figure 326: Add Connection - File Port Selected

Append to File

Each of the Port types has different parameters associated with it, as shown in the following tables.

Key to Connection Options and Parameters Table

APP: Append fo File

AS: Active Scale

ASG: Assignment

CO: Confinuous
Output

CS: With Checksum

CTPZ: CTPZ Input

ENC: Ethernet
Connection

ENP: Ethernet Port

FN: Filename

HW: Hardware

IPT: Input Template

KB: Keyboard

MB: Main Board

SD: Shared Data

SK: Selectable by
Softkey

SP: Serial Port SS: SICS Scale T: Template TG: Trigger TR: Transfer
Connection Options and Parameters
Pot HW ASG T Scale#IPT T  ENC |ENP N SK CS APP
None |HW SICS AS, 1-4

SD

None

TR AS, 1-4 1-10

IPT 1-10 Yes

co AS, 1-4 Yes |

CTPZ AS, 1-4

SS Scale

1-4

MB  SP SICS AS, 1-4

SD

None

Transfer |AS, 1-4 1-10

IPT 1-10 Yes

co AS, 1-4 Yes |

CTPZ AS, 1-4

SS Scale

1-4
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Pot HW ASG T  Scale#IPT T  ENC ENP FN SK CS APP
KB HW None

Input 1-10

Template

CTPZ AS, 1-4

Input
Slots 1 | SICSpro |SICS AS, 1-4
-2 /S 3D

None

TR AS, 1-4 1-10

IPT 1-10 Yes

co AS, 1-4 Yes |

CTPZ AS, 1-4

SS Scale

1-4

EN EN SICS AS, 1-4 Server |1701

SD Server 1701

None Server 1701

R AS, 1-4 1-10  |Server |1701

IPT 1-10 Server 1701

CO AS, 1-4 Server 1701

CTPZ AS, 1-4 Server |1701

SS Scale Server 1701

1-4
File HW None Free entry
field
TR AS, 1-4 1-10 Free entry Yes
field

Parameters and their Functions
Parameter Function
Port Sefs the physical hardware associated with the connection.
Hardware Display only; shows type of port installed

Port: None, Mainboard, Ethernet -
Assignment

Assigns the selected port to a type of data.

Port: File - Assignment

Sets the assignment of the File port.

Port: None, Mainboard, Ethernet,
File - Trigger

Sets a Trigger for the connection, which causes data to be fransmitted.

Assignment: Transfer - Template

When the Assignment is sef to Transfer, one of the IND700's fen
templafes can be specified as the destination for the transmitted datfa.

Assignment Transfer - File Name

When the Port type is File, and Assignment is Transfer, a name must
be specified for the file which will receive the dafa. Touch this field to
display an alphanumeric data entry dialog.

Assignment Transfer - Append To
File

This parameter determines whether new data are added fo a new file, or
appended to an existing one. The name of the file is specified in the File
Name field.

Port: Ethernet - Assignment: Input Template

Remote Server IP

Sets the IP of the remote Client.

Remote Server Port

Sets the port for the remote Client.

Ethernet Connection: Server
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Ethernet Port| When an Ethernet port is specified, the Ethernet Port is selected here.
The default porf is 1701, but touching this field displays a numeric entry
dialog permitting the definition of a different port number.

When changes are made to a connection, and the changes are saved, the terminal will restart the hardware
affected by the modification.

When connections have been defined, the Connections list will display them.

< Connections

Port Hardware Assignment Trigger Template
Slot1003 Serial Port Print Template 1
Slot1003 Serial Port SICS Active Scale

Figure 327: Connections List Showing New Connections

When a Connection is defined with an Input Template Assignment, the Selectable by Softkey slider will
display.

£ Add Connection

Port Input Template
Ethernet W Template 1 V4
Erbiaract Selectable by Softkey

Assignment
Input Template N

Ethernet Connection
Server N
Ethernet Port

1701

O Vv

Figure 328: New Connection, Input Template Assignment

When af least one connection has been assigned to an input templafe, the Template softkey ® can be seen in
the softkey ribbon, if it has been added in setup af [Terminal > Softkeys » Page 197].When it appears on the
home screen, this softkey displays Template 1 by default: .2, When multiple femplates are configured and
assigned fo connections, touching the softkey will display a context menu, listing all available femplates:
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3.4.4

hoy

Template 1
Template 2
Template 3

2

5 Template 1
Figure 329: Templafes Softkey with Context Menu

Touch the desired template fo load it. The softkey will show the number of the currently selected template: 2.

See also
& Softkeys » Page 197

Industrial Network

If an Industrial Ethernet option installed, the Communication > Industrial Network menu will appear. It
includes three sub-menus: Mode, a mode-specific format screen, and an inferface-specific configuration
screen.

Depending on the selection made in the Mode screen, the menus will include either an SAl or a Custom sub-
menu. By default, the SAI menu item is shown.

Depending on which type of option board is installed, the third menu will show either PROFINET or EtherNet/IP.

Setup > Communication > Industrial Network

Scales Ethernet Input Templates Mode
Application Interfaces SAI
Terminal Connections PROFINET
Communication sadustaal

Network
Maintenance Output Templates

Figure 330: Industrial Ethernet Menus, PROFINET Option Installed
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Setup > Communication > Industrial Network
_______________________________________________________________________________________________|

Scales Ethernet Input Templates Mode
Application Interfaces SAL
Terminal Connections EtherNet/IP
Communication sadista

Network
Maintenance Output Templates

Figure 331: Industrial Ethernet Menus, EtherNet/IP Option Installed

Setup > Communication > Industrial Network
_______________________________________________________________________________________________|

Scales Ethernet Input Templates Mode
Application Interfaces Custom
Terminal Connections EtherNet/IP
Communication Bdustng

Network
Maintenance Output Templates

Figure 332: Industrial Ethernet Menus, Custom Mode Selected

3.4.4.1 Mode

The Mode screen determines the form taken by Industrial Ethernet communication. The options, shown in the
the screen image below, are SAI and Custom. Depending on the selection made here, the second menu under
Industrial Ethernet will be SAl or Custom.
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<{ Mode

Mode

SAI

Custom
SAI

Figure 333: PLC - Mode
If Mode is set to Custom, the Mode screen changes to show a check mark.

{ Mode

Mode

Custom

Figure 334: Industrial Ethernet Mode Screen, Custom Selected

Click the check mark to display the [Custom » Page 2247 configuration screen.
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3.44.1.1 SAl
The METTLER TOLEDO Standard Application Interface (SAl) is the default mode for Industrial Network communi-

cation.

{ SAI

Format Byte Order

2 Block N Big Endian
1/0 Size (Bytes)

16/16

Figure 335: PLC Mode - SAI
SAl Mode Options

Parameter
Format

Settings
The Format options are shown below:

Format

2 Block "

2 Block
8 Block

Custom

The Byte Order options are shown below:
Byte Order

Byte Order

Big Endian v

Automatic

Little Endian
Byte Swap Only
Word Swap Cnly
Big Endian

This value is calculated and displayed depending on
the Format and Byte Order selections.

I/0 Size (Bytes)

See also
& Custom » Page 224
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3.4.4.1.2 Custom

If PLC Mode is set to Custom, the following screen is available:

{  Custom

Format

16 Bytes

Byte Order

Big Endian

Figure 336: PLC - Custom Mode
PLC Custom Mode Options

Parameter

Seftings

Format

The following Format options are available for the
Custom mode:

Format

16 Bytes N
2 Bytes

4 Bytes

8 Bytes

16 Bytes

32 Bytes

64 Bytes

Byte Order

The following Byte Order options are available for the
Custom mode:

Byte Order

Big Endian SN

Little Endian
Big Endian
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3.4.4.2 PROFINET

IND700

The PROFINET screen offers the following opfions:

< PROFINET

MAC Address
00-10-52-D5-8B-F9

Device Name

ind700

IP Address

000.000.000.000

Subnet Mask

000.000.000.000

Gateway Address

000.000.000.000

Figure 337: PROFINET Industrial Ethernet Inferface Configuration

PROFINET Configuration

Parameter Settings

MAC Address This value is display only, and cannot be modified.

Device name Touch this field to open an alphanumeric entry screen.
Enter a descriptive name for this IND700. This is the
name the IND700 will display in the PROFINET
network.

IP Address Touch each of these fields fo open a numeric entry

Subnet Mask screen, and enter the appropriafe information

Gateway Address

Configuration
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3.4.4.3 EtherNet/IP

The EtherNet/IP screen offers the following options:

{  EtherNet/IP

MAC Address

00-10-52-D5-5B-E5

000.000.000.000

000.000.000.000

000.000.000.000

Figure 338: EtherNet/IP Industrial Ethernet Interface Confiiguration

EtherNet/IP Configuration

Parameter Settings

MAC Address This value is display only, and cannot be modified.

DHCP By default, Dynamic Host Configuration Profocol
(DHCP) is Enabled, and the terminal automatically
acquires an IP address. This address can be viewed
from the main screen by fouching the Menu icon =5
and selecting Terminal.
If DHCP is Disabled, the IP Address parameters must
be sef manually.

IP Address With DHCP disabled, these fields can be edifed.

Subnet Mask Touch a field to display a numeric data entry keypad,

Gateway Address and enter the appropriate value.
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3.4.5 Output Templates

IND700

Output Templates are configured from the Output Templates menus, shown below.

& B smgrn |

. Setup > Communication > Output Templates
I ——

Ethernet Output Templates Template 1 Template 6

Interfaces lemplate 2 Template

Connections Template 3 Template &

| FTPSErVer lfemplate Template ©

Remote Desktop
' Server

Figure 339: Output Templates Menu

Touch a Templafe name to open its configuration page.

The Output Templates menu allows each of the fen available femplates to be viewed and edited. Only Template
1 is already configured.

Each element has a serial number, a Type, the Data it contains, an Alignment, a number of Characters, and a
Quantity (e.g. for mulfiple CR/LF elements). Touch the headline row fo sort the elements by any of these
atfributes.

Templates can be creafed in two ways: Manually, which involves looking up the SD codes and ensuring that all
the necessary formatting is included; or by using the ferminal's [Automatic Standard Template » Page 321],
which automates the process.

The content of a typical templafe is shown below in a series of images, followed by an image showing the
template's output. It will be noted that the template includes 54 rows; this is why the Automatic Standard
Template represents an extremely efficient, time-saving method of creating cusfomized output templates.
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{ Template 1 -« T O 4+ i1

Element Type Data Alignment # Chars Quantity
1 String Date: Left 6 1
2 SD Var xd0103 Exact - -
3 CR/LF - - - 1
4 String Time: Left 6 1
5 SD Var xd0104 Exact - -
6 CR/LF - - - 1
7 String User: Left 6 1
8 SD Var xd0171 Exact - -
9 CR/LF - - - 1
10 String Material Name: Left 15 1

Figure 340: Output Template Content, Page 1

{ Template 1 -« T O 4+ i3
Element Type Data Alignment # Chars Quantity
11 SD Var ma0002 Exact - -

12 CR/LF - - - 1
13 String APW: Left 5 1
14 SD Var cd0104 Exact - -
15 String Exact 1 1
16 SD Var wt0003 Exact - -
17 CR/LF - - B 1
18 String Weight: Left 8 1
19 SD Var wt0002 Exact - -
20 String Exact 1 1

Figure 341: Output Template Confent, Page 2
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IND700

=

{ Template 1 eee |._|j + E!;ﬂ
Element Type Data Alignment # Chars Quantity
21 SD Var wt0003 Exact - -

22 CR/LF - - - 1
23 SD Var pr0131 Left 13 -
24 String Exact 2 1
25 SD Var pa0101 Exact - -
26 CR/LF - = = 1
27 SD Var pr0132 Left 13 -
28 String Exact 2 1
29 SD Var pa0102 Exact - -
30 CR/LF - - - 1
Figure 342: Output Template Confent, Page 3

{ Template 1 vee ﬁ |._|j + EES_T]
Element Type Data Alignment # Chars Quantity
31 SD Var pr0133 Left 13 -

32 String Exact 2 1
33 SD Var pa0103 Exact - -
34 CR/LF - - - 1
35 String Scale: Left A 1
36 SD Var xt0107 Exact - -
37 CR/LF - - - 1
38 String Gross: Left 7 1
39 SD Var wt0001 Exact - -
40 String Exact 1 1

Figure 343: Output Template Confent, Page 4
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{ Template 1 -« M [0 4+ &

Element Type Data Alignment # Chars Quantity
45 String Exact 1 1
46 SD Var wt0003 Exact - -
47 String Exact 1 1
48 SD Var ws0009 Exact - -
49 CR/LF - - - il
50 String Net: Left 5 1
3| SD Var wt0002 Exact - -
52 String Exact 1 1
53 SD Var wt0003 Exact - -
54 CR/LF - - -~ 1

Figure 344: Output Templafe Confent, Page 5

Date: _27.Feb.2024
Time: _16:56

User: _Admin
Order____.___._:_0T-456

Batch_ID____._: _BT-700
Vendor__._._._._._:_Supplier_ABC
Scale: _1

Gross: . _.__._._.._._2840_g
Tare: _0_g._T._

T S S S T T S )

Figure 345: Output Template Output, as Configured Above

Template Fields

Columns available in the template configuration screen update as other changes are made
to the ferminal -- e.g. when an Application is enabled.

Automatic Standard Template

The IND700 features an AST (Automatic Standard Template) function which simplifies the preparation of
templates customized for particular uses and applications. Shared Data variables representing all available
information (which adds columns fo the [Transaction Table » Page 173]) are automatically added to Output
Template 1.

To create mulfiple Output Templates with different automatically-generated content, make the necessary
changes fo the terminal configuration, then access Setup > Communication > Output Templates > Template

1. Here, all the currently configured Transaction Table fields are automaticaly represenfed as rows in the table
(refer fo the five-screen example shown above).
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Select the Copy icon mat top left . From the Copy Template dialog, click the To dropdown list and select the
desired template.

<  Copy Template

From

1

Figure 346: Copy Template Dialog

Click the Run icon P at lower right to execute the copy, then use the left arrow af top leff twice fo refurn to the
Output Templates menu view. Templafe 2 is now shown as configured.

(F 11:29
®
e 03.Aug.2023

Setup > Communication > Output Templates

Scales Ethernet Template 1 Template 6
Application Interfaces Template 2 Template
Terminal Connections Template 3 Template 8
Communication Output Templates Template 4 Template 9
Maintenance Input Template Template 5 Template 10

Figure 347: Oufput Templafes Menu View, Template 2 Configured

This customized femplate -- in this case, Output Template 2 -- can now be used to determine the confent and
format of the output from a Connection. Multiple connections can be configured and use for different appli-
cations using other output templates.
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<  Edit Connection

Port Ethernet Connection
Ethernet Server
Ethernet Port
Ethernet 1701
Assignment
Transfer
Trigger
Active Scale
Template

Template 2

Figure 348: Connection Configuration Screen Showing Template 2 Selected
Template 1 will continue to reflect changes made to the configuration of the weight display. These can then
copied fo another femplate.

Remember that femplates can be Exported ™ and Importedth, so that they can be kept safely outside the
IND700, and restored fo the same ferminal or shared with other ferminals. This opfion makes it very easy to
standardize output data across multiple terminals.

To access these options in an Oufput template, click the ellipsis =< in the menu bar.

e @ @+ 6
#i} I'l'i Quantity

1

Figure 349: Output Templates Menu Bar, Import and Export Icons Displayed

Manual Template Editing

To configure a new template, or fo modify an existing one, first touch the templafe's name in the Templates
menu. If the templafe has not been configured, a blank template will display, with no elements defined and a +
icon fo add a new element. Otherwise, the existing femplate configuration will display. In either case adding,
removing and editing template elements use the same method.
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< Template 2 (]

ElementType Data Alignme # Chars Quantit

+ Add new template element

Figure 350: Undefined Template
When the + icon is touched, the template editor screen displays.

< Editor - Template 2

Element Alignment

1 Exact

Must be 1 to 256 characters

Quantity

1

Figure 351: Template Editor
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The fields available in the editor screen vary depending on the Type selected.
Type

String N

String
CR/LF
Special Character

Shared Data Variable
JOaETToy

Figure 352: Template Editor - Type Options
CR/LF Options

For example, if CR/LF (carriage return/line feed) is chosen, the editor screen appears like this:

< Editor - Template 7

Element

1

Type
CR/LF

Quantity
1

Figure 353: Template Editor, CR/LF Selected
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Special Character Options
If Special Character is the selected Type, a drop-down lists the opfions.

Editor - Template 7

Element

3

Type

Special Character

Data

Figure 354: Template Editor - Special Character Selections

Refer to [Control Characters » Page 356] for an explanation of these characters.

Shared Data Options

Commonly Used Shared Data Variables
A list of most commonly used Shared Data is included in the [Communication » Page 343]

section. For a complete account of available Shared Data in the IND700, refer to the
IND700 Shared Data Reference (30753890).
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For Shared Data variables, only the Data and Alignment fields are shown in addition to Type.

£ Editor - Template 7

Element

3

Type

Shared Data Variable

Data

Must be 1 to 256 characters
Alignment

Exact

Figure 355: Template Editor - Shared Data Variable Selected
Available Shared Data Variables are listed and explained in the IND700 Shared Data Reference.

Alphanumeric Data Entry
For String and Shared Data Variable fypes, fouching the Data field opens an alphanumeric dafa entry keypad.

< Data

:Shift1Summary < > @
9 0

1 21 314 |5|6]| 7|8

Figure 356: Template Editor - Alphanumeric Data Entry
Summary of Options

\ Element \Options Function \
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3.4.5.1

IND700

Element | Serial number of element; not editable Once elements are defined, fouching a row in the
Template screen displays a set of delete/add/edit
icons. If + (add) is selected, the new element is
assigned the number of the element initially
touched, and the element number of all
subsequent existing elements increases by one.

Type String [default], CR/LF, Special Character, The selection made here determines which other

Shared Data Variable editing opfions are offered.

Data Displays an alphanumeric entry screen Displayed if Type is String or Shared Data
Variable.

Data None [defaulf], 01 h -SOH, 02h - STX, 03h - Displayed if Type is Special Character

ETX, 04h - EQT, 05h - ENQ, 06h - ACK, O7h -
BEL, 08h - BS, 09h - HT, OAh - LF, OBh - VT,
OCh - FF, ODh - CR, OEh - SO, OFh - SI, 10h -
DLE, TTh - DC1, 12h - DC2, 13h - DC3, 14h -
DC4, 156h - NAK, 16h - SYN, 17h - ETB, 18h -
CAN, 19h - EM, 1Ah - SUB, 1Bh - ESC, 1Ch -
FS, 1Dh - GS, 1Eh - RS, TFh - US

Alignment | Exact [default], Left, Cenfer, Right Determines how the element will be aligned in
the template.

# Displays the count of characters in the Data field. Displays if Type is String.

Character

S

Format of Automatic Standard Output Template

The Automatic Standard Template includes a number of standard elements, together with elements derived from
the application screen seftings made in App Screen View page. Note that this page does not appear in the menu

system unless a ProWorks Multi-Tools license is activated. Refer to the ProWorks Multi-Tools User's Manual
for defails on the display of application-specific data.

Automatic Standard Template Contents

Type Data Alighnme # Comment
nt Cha

ract

ers
String "Date: " | Left 6
SDVar xd0103 |Exact Date
CR/LF Carriage return, line feed
String "Time: " | Leff 6
SDVar xd0104 |Exact Time (format as configured)
CR/LF
String "User: " Leff 6
SDvar xc0171 |Exact Logged-in user
CR/LF
CR/LF

All items form the App Screen View are added here, between the header and the weight data.
Below is an example for farget information in a manual filling application.

String "Upper Left 12
Tol.. "
SDvar sp0011 |Exact Upper tolerance (deviation or absolute); sp0014 if tolerance type is
percentage
String "Lower  Leff 7
Tol.: "
SDVar sp0012 Lower folerance (deviation or absolute); spO015 if folerance type is
percentage
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Type Data Alighnme # Comment
nt Cha

ract

ers
CR/LF
CR/LF
String "Scale: " | Leff 7
SDVar xt0101  |Exact Currently selected scale
CR/LF
String "Gross: " | Leff 7
SDVar witO00T  |Exact Gross weight, selected scale
String " Exact 1 Blank space
SDvar wi0003  Exact Unit, selected scale
CR/LF
String "Tare: " | Left 6
SDvar ws0002  Exact Tare weight, selected scale
String " Exact 1 Blank space
SDVar wt0003 Unit, selected scale
String " Exact 1 Blank space
SDVar ws0009 |Exact Tare type (T or PT)
CR/LF
String "Net: " Left 5
SDvar wt0002  Exact Net weight, selected scale
String " Exact 1 Blank space
SDvar wi0003  Exact Unit, selected scale
CR/LF

3.4.6 Input Template

When the Input Template menu option is first visited, it displays its default contents.

< Input Template 1: Template 1 .es @ |._|j [i‘[ ]'1]
Element Preamble Data Postamble Termination Timeout
1 0 1 0 CR ON

N

Figure 357: Input Template 1, Unconfigured
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To add template elements, select the existing element (the CR Termination character) and click the + in the
context menu which appears.

<  Input Template 1: Template 1 === {{3} |._|j |'i'| M
Element Preamble _I_ @ V4 Postamble Termination Timeout
1 0 A CR ON

Figure 358: Input Template Context Menu
The following screen will appear. Nofe that the menu bar shows Element 2.

4 Input Template 1 > Template 1 > Element 2

Preamble Length Assignment

0 Tare

Maximum Data Length

: With Unit

Postamble Length
0

Termination Char

\/CR

Timeout

Figure 359: Input Template Element Edit Screen, Page 1

< Input Template 1 > Template 1 > Element 2

Data Position Data Position
1 1

Editing Editing h
None N None Nl

Figure 360: Input Template Element Edit Screen, Page 2
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Existing elements can be edited in the same way, by selecting a row and clicking the edit icon ./ from the
context menu.

{ Input Template

Preamble Length Assignment

0 Tare

Data Length Termination Char

1 CR

Postamble Length
0

Timeout

Figure 361: Input Template - Edit an Existing Element
Input Template configuration

Parameter Settings

Preamble Length These parameters sef the expected length, in characters, of the incoming data. The pre-
Maximum Data and postamble lengths indicate the amount of data to be discarded from the start and
Length end of an incoming data sfring. Similarly, the payload data string length is determined

here. By default, the Pre- and Postamble length is 0, and the Data Length is 1.

These values must conform tfo those for the incoming data, or an error will be
generated.

Termination Char This dropdown list permits the selection of the character which indicafes the end of a
data string. The default value is CR (carriage return). Possible values are:

None, SOH, STX, ETX, EOT, ENQ, ACK, BEL, BS, HT, LF, VT, FF, CR, SO, SI, DLE, DCT,
DC2, DC3 DC4, NAK, SYN, TB, CAN, EM, SUB, ESC, FS, GS, RS, US.

Timeout When an input device — for example, a barcode scanner — is expected to send a specific
number of fields of data, each of a specific length, and the received data does not
correspond fo those specifications, the input process times out and an alarm is
generated.

By default, this opfion is enabled.

Postamble Length
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Parameter

Seftings

Assignment

The Assignment parameter defermines which function should be executed when the
template receives data. The defaulf value is Tare.

Assignment

Tare N
Application

Tare

Tare ID
Material ID
Keyboard

Tare N

Material 1D
Keyboard
ID Form

File

Possible values are Application, Tare, Tare ID, Material ID, Keyboard, ID Form, File.

With Unit

\When enabled, this switch automatically appends the appropriate unit fo any weight-
based element.

Data Position 1T and
2 / Editing 1 and 2

The options on the second page of the template element editing screens are used fo
Insert, Delete, or Move character strings within the element. Two such functions can be
performed at the same fime, each affecting a different Data Position. Refer to Modifying
a Template Element, below. The two actions are performed in sequence -- position 1

then position 2.

Modifying a Template Element

The options on the second page of the templafe element editing screens are used fo Insert, Delete, or Move
character strings within the selected femplate element. Two such functions can be performed at the same fime,
each affecting a different Data Position in the selected element.

Editing When Insert is selected as the Editing action, a
— — Characters to Insert field is displayed. Touch the field
to display an alphanumeric eniry screen. Characters
Characters To Insert entered here are inserted af the Data Position specified
for this editing action.
Editing When Delete is selected as the Editing action, a
i - Number of characters to Delete field is displayed.
Touch the field to display a numeric entry screen. The
Number of characters to Delete number of characters entered here are delefed starfing
1 at the Data Position specified for this editing action.

IND700
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When Move is selected as the Editing action, two
additional fields appear: Number of characters to
Mo b4 Move and Move to Target Position. In this case, the
Data Position parameter determines the starting
position of the characters to move; the other two fields
display a numeric entry screen, and are used to
determine how many characters to move, and where
to move them to.

Editing

Number of characters to Move

1

Move To Target Position

1

Once all the required seffings are made, fouch the OK buiton at bottom left.

General Template Settings
Touch the Setup softkey & fo display the General Template Settings screen.

< General Template Settings

Template Name

Template 1

Element Timeout

Figure 362: Input Resef Confirmation Dialog

When enabled, the Element Timeout option permits the template to continue fo the next element if an element
generates an error.

Resetting an Input Template to Default

To restore a template's default configuration, fouch the ellipses == in the menu bar and select the delete
icon from the context menu.

eee (O

=

Ter [l ation

=T

Figure 363: Input Template Reset Option

242 | Configuration IND700



A confirmation dialog will appear. Touch the check mark to confirm the operation.

<_ Warning

A

X

Figure 364: Input Templafe Reset Confirmation

3.5 Maintenance Setup

The Maintenance menu provides access to the following items:

IND700

Setup > Maintenance

Scales

Application

Terminal

Communication

Maintenance

Figure 365: Mainfenance Menus

Configure

Run

Diagnostics

Reset

Information

Reset template to default?
Delete with X

P 13:04
& 30.Aug.2023
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3.5.1 Configure

R @ 01:30
¥ 28.Aug.2021

| Setup > Maintenance > Configure
I ——

|
Scales Configure Enable Logs

Application Run View Change Log

View Maintenance

Terminal Diagnostics
Log

Communication Reset View Error Log

Maintenance Information

Figure 366: Mainfenance - Configure Menus
The Configure screens are used to determine the behavior of the Terminal's logs, and to view their contents.

3.5.1.1 Enable Logs

The following logs can be enabled in the IND700. Note that the POWERCELL log appears only in terminals with
at least one POWERCELL scale interface installed.

< Enable Logs
Change Log
Maintenance Log

Error Log

Powercell Log

Powercell Log Interval

24

Figure 367: Enable Logs Screen

Each of the logs -- Change, Maintenance, Error and POWERCELL -- can be Enabled or Disabled. By default,
both the Change Log and Error Log are enabled. Only enabled logs appear in the Configure menu.

When the POWERCELL Log is enabled, a polling inferval must be set. This is expressed in hours, and
defermines the frequency with which the log collects POWERCELL data. The default value is 24 hours.
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When one or more enabled logs is disabled from this screen, ifs contents will be cleared. When a change in
log configuration is made, a blue confirmation check mark |v] appears at bottom right.

<{  Enable Logs
Change Log
Maintenance Log
Error Log

Powercell Log

24

Figure 368: Logs Disabled, Confirmation Check Mark Displayed

Touching this check mark to confirm the changes will display one or more warning dialogs, one for each
newly-disabled log, requesting confirmation for clearing the confents of the log. These dialogs will display one
after the other, and each must be acknowledged to exit the screen.

Warning

A Delete all change log data

Figure 369: Clear Log Content Confirmation Dialog

IND700 Configuration | 245



3.5.1.2 View Change Log

View Change Log

Log Time ™ User Name Configure
26.Jan.2024 09:00:44 Admin sumb5
26.Jan.2024 09:00:44 Admin Sum5
26.Jan.2024 09:00:43 Admin Sumb5
26.)an.2024 09:00:43 Admin Sumb5
19.Jan.2024 09:42:58 Admin LicensingService
19Jan.2024 09:38:55 Admin LicensingService
18.)an.2024 11:55:07 Admin IND700
18.)an.2024 10:53:30 Admin IND700
18.)an.2024 10:36:47 Admin IND700
18.)an.2024 10:35:48 System Log Configuration

Figure 370: Change Log

When the log is enabled, entries are added automatically.

The Change Log can be filtered, searched, and exporfed. Refer fo [Table Functions: Filter, Export, Import, Clear
» Page 307].

3.5.1.3 View Maintenance Log

<{  View Maintenance Log

Log Time Username Channel Cell Event Description Status

+ Add Maintenance Log Record

Figure 371: Maintenance Log
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Entries to the Maintenance Log are made manually, by touching the + sign fo open the Add Maintenance Log
Record screen.

< Add Maintenance Log Record

Channel

Terminal

Event

MAINT. OPTION COMPONENT ADDED

Status

Figure 372: Mainfenance Log Record

Item Options Function
Channel | Terminal [default], Scale 1, Scale 2, Scale 3, Defines the affected component of the terminal,
Scale 4 or the ferminal itself.

Event MAINT. OPTION COMPONENT ADDED [default], | Defines the type of mainfenance action taken.
MAINT. OPTION COMPONENT REMOVED, MAINT.
OPTION COMPONENT REPLACED

Status Displays an alphanumeric entry dialog Text description of action taken, and any
maintenance notes.

The Mainfenance Log can be filtered and searched, and exported. Refer to [Table Functions: Filter, Export,
Import, Clear » Page 307].
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3.5.1.4 View Error Log

View Error Log ? |_'1‘|

Log Time~ Username Severity Error Code Scale
18.Jan.2024 10:38:58 Admin G A70008
18.Jan.2024 10:36:02 Admin € A70008

Figure 373: Error Log

Error Log entries are created automatically by the ferminal. Errors are described in more defail in
[Troubleshooting » Page 284].

The Error Log can be filtered, searched, and exporfed. Refer fo [Table Functions: Filter, Export, Import, Clear »
Page 307].

3.5.1.5 View POWERCELL Log

In IND700 terminals with at least one POWERCELL scale inferface installed, the POWERCELL Log displays a
selection of read-only data, including a time stamp and node number fo assist in diagnosing POWERCELL
problems. In its default state, the log is shown with the lock icon closed & .

<  View Powercell Log o

ID Log Time User Channel Node Serial Number Cell Col

Figure 374: POWERCELL Log View
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Touch the lock icon fo unlock the log. Additional options now appear.

<  View Powercell Log ons T [1'] (}.

ID Log Time User Channel Node Serial Number
24 29.Jan.2024 11:33:51 Admin Scale 1 4

23 29.Jan.2024 11:33:51 Admin Scale 1 3

22 29.)an.2024 11:33:51 Admin Scale 1 2

21 29.Jan.2024 11:33:51 Admin Scale 1 1

20 28.Jan.2024 11:33:52 Admin Scale 1 4

19 28.Jan.2024 11:33:52 Admin Scale 1 3

18 28.Jan.2024 11:33:52 Admin Scale 1 2

17 28.)an.2024 11:33:52 Admin Scale 1 1

16 27.)an.2024 11:33:51 Admin Scale 1 4

15 27.Jan.2024 11:33:51 Admin Scale 1
[ ]

Figure 375: POWERCELL Log Unlocked

In addition to the Filter Y and Export tfiicons, fouching the ellipsis = e« displays a Delete fl and an Add

=+ icon.

Touch the =+, either in the menu bar or from the record list, to display the Add POWERCELL Log Record

screen.

<

Add Powercell Log Record

Channel

Scale 1

Figure 376: Add POWERELL Log Record

Choose the scale for which a log record should be added, and touch the blue check mark fo confirm [v].

IND700
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Note that one new record is added for each of the scale's nodes.

View Powercell Log v« Y &

Log Time ™ Channel Node Serial Number

02.Feb.2024 09:24:30 Scale 1 4
02.Feb.2024 09:24:30 Scale 1 3
02.Feb.2024 09:24:30 Scale 1 2
02.Feb.2024 09:24:30 Scale 1

Figure 377: POWERCELL Log Records Added

3.5.2 Run

The current configuration of an IND700 can be backed up and saved, either within the terminal or on an
external USB device. The configuration backup file can then be stored safely in another location. Keeping a
current backup of the parameters configured in Setup ensures that the terminal's function can be restored if
necessary, without the user having to remember and enfer settings.

R @ 25.Aug.223;::

Setup > Maintenance > Run
Scales Configure Backup
Application Run Restore
Terminal Diagnostics Software Update
Communication Reset
Maintenance Information

Figure 378: Maintenance - Run Menus

The Run menu provides access fo the following items:
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3.5.2.1 Backup
The ferminal's backup function requires only a Target specification (Internal File [default] or USB Memory)

and a farget filename. The export directory is determined by the chosen targef.

{ Backup

Target for Backup

Internal File

File
IND700_69569446DZ_2024 01_29 1223

Directory
C:\Backup

Figure 379: Run - Backup Configuration, Internal File Target
If a USB device is connected to the terminal, it will appear as an option in the Target for Backup dropdown list.

{ Backup

Target for Backup

Internal File

USB Memory

Internal File

Directory
C:\Backup

Figure 380: Run - Backup Configuration, USB Memory Target
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The backup function saves the ferminal's configuration in an .mtbak file. A confirmation dialog indicates that
the process complefed successfully.

< Save Configuration Successful

Save the configuration to

C:\Backup
\IND700_69569446DZ_2024_01_29_

1223.mtbak

Figure 381: Backup Success Confirmation

3.5.2.2 Restore

When a configuration backup file is saved to the IND700 C:\Backup directory, the terminal automatically
defects it and asks the user fo confirm the resforation of seftings.

< Restore

Target for Restore
Internal File
File

IND700_69569446D7Z_2024_01_29_1223\/

Directory
C:\Backup

Figure 382: Run - Restore Configuration from File Stored in the Terminal

If the backup file is stored on an external USB device, or being fransferred from an external storage location
using a USB device, the device must be connected to the ferminal when the resfore process is begun. In this
case, the Target for Restore dropdown list will include the external device.
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< Restore

Target for Restore

Internal File

USB Memory

Internal File

Directory
C:\Backup

Figure 383: Run - Restore Configuration from External Device

Once the Target for Restore is defined (the file from which the restore will take place, either from an Internal
File [default] or from USB Memory), the File dropdown list will include all saved .mtbk configuration files in

that location. Select a file and fouch the RUN bufton at lower right. A warning dialog will display, allowing the
user either fo continue or stop the restore procedure.

Warning

Security changes
A require the terminal

to restart

X

Figure 384: Restore Caution Dialog
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3.5.2.3 Software Update

The Software Update menu includes three sub-menus -- Windows Servicing & Deployment, Scale Interface
and Load Cell.

rg:}n @ 25.May_12?£§

Setup > Maintenance > Run > Software Update

Windows
Scales Configure Backup Servicing &

Deployment
Application Run Restore Scale Interface
Terminal Diagnostics Software Update Load Cell

Communication Reset

Maintenance Information

Figure 385: Software Update

To run a Software Update, the update file must be saved in the terminal's C:\ToUpdate folder. Use an FTP
client or some other utility to copy tne necessary file/s info this location. This does not apply to Windows
Servicing & Deployment, for which other sources are used.

Once the Source is selected, the File dropdown list will show all available update files af that location. Select a
file and touch the RUN button » which will appear af lower right on the screen.

3.5.2.3.1 Windows Servicing & Deployment
The options provided on this page are shown below:

<  Windows Servicing & Deployment

Service / Deployment Type Installation Type

Offline N/ | OS & ProWorks AV
File Source

C\Service

Figure 386: Software Update - Windows Servicing & Deployment
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Select the Service / Deployment Type, then click the RUN button » at lower right. A message will appear:

Waiting for installation packages.

Figure 387: Message: Waiting for Insfallation Packages

Then a list of available Update Files will display.

<{  Update Files

File Name

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB502228€
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB502228¢
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB5027222
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB5027222
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProwWorks/MT.Sin

O|og|joyjo|oyo|o|o; o

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin

Figure 388: List of Update Files
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To see which type of file is in each row, scroll the screen to the right.

{  Update Files v

Updates/KB5022286/Windows10.0-KB5022286-x64.cab
Updates/KB5022286/Windows10.0-SSU-17763.3641-x64.cab
Updates/KB5027222/Windows10.0-KB5027222-x64.cab
Updates/KB5027222/Windows10.0-SSU-17763.4121-x64.cab

ns ProWorks/MT.Singularity.Platform.Client.4.0.13-g3ef26ee7c5.mtapp

ns ProWorks/MT.Singularity.Platform.Client. MTApp.3.0.5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.3.0.5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.4.0.13-g3ef26ee7c5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.Simulation.3.0.5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.Simulation.4.0.13-g3ef26ee7c5.mtapp

Figure 389: List of Update Files, Scrolled
Touch one or more check boxes fo select the desired file/s.

{  Update Files v

File Name

O

<

sftp://ftp-static. mt.com/PUB/IND-Update-Server/Windows Updates/KB502228¢

<]

sftp://ftp-static. mt.com/PUB/IND-Update-Server/Windows Updates/KB502228¢

O

sftp://ftp-static. nt.com/PUB/IND-Update-Server/Windows Updates/KB502722z

Figure 390: Update Files selected
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Once at least one file is checked, a check mark appears at the right of the menu bar. Touch this check mark to
initiate the update. A confirmation message will appear:

Information

Start update now?
Terminal will restart

X v/

Figure 391: Update Confirmation Message

The terminal will reboot, with the update installed.

Windows Servicing & Deployment Options

Parameter Options
Service\Deploy |The type options are:
ment Type

Service / Deployment Type

Offline N

Offline
Local

Online
All

In each case, if the necessary parameters are sef, touching the RUN button » will display a
list of update files.

Offline: A deployment file has been copied into the ferminal's C:\Service folder. If a valid file is
found, touching RUN will perform the update.

Local: A deployment file is available on the customer's local network. The login information
(FTP File Source, Anonymous Login, User Name and Password) are visible, but cannot be
changed. The customer's IT department must code these values in the Windows registry.
Online: A deployment file is available on an FTP server provided by METTLER TOLEDO. This
static IP is fixed -- sftp://anonymous@ft-static.mt.com/PUB/IND-Update-Server.

All: This option displays a list of files from all available deployment options.
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Parameter

Options

Installation
Type

Installation type options are:

Installation Type

05 & ProWorks N

0S & ProWorks
Operating System
ProWorks

Script

Windows Servicing & Deployment

The Secript ifem refers fo scripts used to update and/or customize specific functions such as
the Universal Writer Filter (UWF), Keyboard Filter, NTP - for example, to exclude a specific
folder from the UWF protection. Only signed MT scripts will be updated:

* UWF

* Keyboard filter

e NITP

e Production scripts

e Reset to factory default

e Join domain

e Change OS language

A script update is not a software update, but a list of parameters or aftributes used to change
the behavior of particular functions.

Select the type of installation required, then touch the RUN button. A list will appear,
containing only files of the selected type.

File Source

The default value is C:\Service. If a USB drive is attached to the terminal, it may be selected
as a local location.

3.5.2.3.2 Scale Interface

Scale Firmware Update Note
When more than one scale inferface is installed in a ferminal, each scale must be updated
separately.

To update the firmware on a scale interface board, the .mot update file must be saved to the ferminal's C:
\Service\ToUpgrade folder. If the correct file type is found, the updafe screen will appear as below, with the
most recent file already selected in the File field.
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<{  Update Scale Interface Firmware

Scale Channel Scale Interface Type
Slot 1 Powercell v Powercell V4.0.12
File
IND890PwcI3v4_0_12.mot

File Source

C:\Service\ToUpgrade\

Figure 392: Software Updafe - Scale Interface

To perform the upgrade, click the RUN button » at lower right. The terminal will reboot to the home screen
without further action from the user. When the reboot is complete, the firmware update is complete. The udpated
scale interface will retain ifts settings from before the update.

The update file will remain in the C:\Service\ToUpgrade folder, ready for use in updating a second scale
interface if one is installed.

See also
& Software Update » Page 281

3.5.2.3.3 Load Cell

£ Update Scale Load Cell Firmware

Scale Channel

No scale channel found

Figure 393: Software Update - Load Cell
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3.5.3 Diagnostics
The Diagnostics menu provides access to the following items:

r.s:; @ 30,Aug_123i}:lg;

Setup > Maintenance > Diagnostics

Scales Configure
Application Run
Terminal Diagnostics
Communication Reset
Maintenance Information

Figure 394: Maintenance - Diagnostics Menus

3.5.3.1 Network Test

{ Network Test

IP Address
192.168.86.24

Ping Response

Destination Host Unreachable

Figure 395: Network Test
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Touch the IP Address field to display an IP entry dialog and define the IP address.

< IP Address

Figure 396: IP Address Entry Dialog

Once the IP address is defined, fouch the +/ butfon in the dialog, then the RUN button at lower right. The
Terminal will ping that address and, if the test is successful, display the response time.

<  Network Test

IP Address

192.168.86.105

Ping Response

Success (0 ms)

Figure 397: Network Test - Success
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3.5.3.2 Serial Port Loopback Test

<{  Serial Port Loopback Test

Slot Mainboard (Serial Port)

Test Status

Figure 398: Serial Port Loopback Test
This test requires the installation of a loopback device on the terminal's serial port.

3.5.3.3 DIO Test

To facilitate testing and diagnostics, the DIO Test screen displays the status of the IND700 digital inputs and
outputs.

/\ WARNING

DIO Test and Device Control Power

Before running the DIO test, ensure that power is removed from all devices controlled by
oufputs. Injury or equipment damage can result from a failure to observe this precaution.
This precaution does not apply if Virtual 10 Device is selecfed under Port.

< DIO Test

'\ Remove output control power

Port

Mainboard v O Green indicates I/0 ON
Output @ @

Figure 399: DIO Test
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Select the inputs and outputs fo fest by making a Port selection.The list shows all insfalled DIO devices.

Port

Mainboard v ‘

Mainboard

Scale 1

Virtual IO Device

—

Figure 400: DIO Test Port Options

This screen allows each installed input and output to be fested, by fouching the Output indicafors. When an
Output indicator is fouched, it will turn green to indicate that that output is active. In the example shown below,
mainboard DIO inputs and outputs are represented.

< DIO Test

A Remove output control power

Port

Mainboard v O Green indicates I/O ON

fopge ©) e
output ©) ©

Figure 401: DIO Test, Output Active
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The Virtual 10 Device option is a diagnostic tool which represents a consolidated view of all available inputs
and outputs. This display is not connected to external hardware, and the state of ifs output bits does not affect
any exfernal device.

4 DIO Test

A Remove output control power

Port

Virtual 10 Device v O Green indicates I/O ON
- O O O 0
HONORIOBNONNONNO

Figure 402: DIO Test Screen, Virtual 10 Device Selected

3.5.4 Reset
{ Reset
Scales Interfaces
Terminal Master Reset
Application &

Communication

Maintenance

Figure 403: Mainfenance - Reset Opfions

The Reset screen allows any combination of menu branches and types of configuration data fo be reset. Once
at least one ifem is selected, a RUN butfon appears at lower right.

If a Master Reset is selected, only the Reset Calibration slider remains acfive. A Master Reset can include or
exclude the terminal's calibrafion data.

Main PCB Switch Settings and Master Reset

When the terminal is in Approved mode, SW1-1 must be ON and SW1-2 OFF. In this
condition, metrological data are protected and cannot be reset. Refer to PCB DIP Switch
Seftings.
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Touch the RUN button B to carry out the selected reset. Depending on which kind of reset is carried ouf,
different warning dialogs appear, allowing the user fo continue or abandon the reset.

Warning

Reset changes Configuration Settings to
ﬁ default values. Approved Scale Settings,

Table Data, Calibration Data and the serial
number won't be reset.

x

Figure 404: Reset Scale Menu Warning Dialog

Warning

Master Reset deletes all Configuration

including all Scale Settings and Table Data.
A Calibration Data, serial number not reset.

Security changes require the terminal to

restart!

x

Figure 405: Master Reset without Calibration Warning Dialog
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Warning

Master Reset with Calibration resets

terminal to factory defaults. All
A Configuration Settings, Table Data, and

Calibration will be deleted. Terminal Serial
number not reset.

x

Figure 406: Master Reset with Calibration Warning Dialog

3.5.5 Information

The Information screen provides information about many terminal configurations and parameters.

The Category selections are :

¢ CountingService, CurrentMaterialService, CurreniTareService, IDDataService, FillingService, OverUnder-
Service, Classification, TotalizationService, EngineModules, ClientModules, ScaleUpdateRate, OptionBoard-
Information, Hardwarelnformation, AllConfigured

An example of an Information screen is shown below. Category selections may or may not display any infor-
mation, depending on terminal configuration.

Some examples of these screens are shown below.

{ Information

Category

EngineModules

Name Value

Build Information Build on build server with commit

Module: ScaleIF.dll 5.41.150-freeze.0+9bd6c9163b

Module: FieldbusHilscher.dll 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Platform.Engine.Host 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Platform.Engine 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Platform 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Core 5.41.150-freeze.2+025150dad2

MAadiida: BAT Cilenmi il awitns Mok C A1 IO ACNA AT

Figure 407: Mainfenance - Information Screen: Engine Modules
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< Information M

Category

ClientModules N

Name Value i
Build Information Build on build server with commit
Module: ScaleIF.dll 5.41.150-freeze.0+9bd6c9163b

Module: MT.Singularity.Platform.Client. MTApp 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Platform.UL.Shel . WPF 5.41.150-freeze.2+025150dad2

Module: MT.Singularity.Core 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Platform.Client 5.41.150-freeze.2+025150dad2
Module: MT.Singularity.Platform 5.41.150-freeze.2+025150dad2
MAdmadialms RAT Ciim s il mvitn s T mml mdeiomim E A1 ACN furmnma TINACACNA=AT

Figure 408: Maintenance - Information: Client Modules

< Information M
Category

ScaleUpdateRate N

Name Value

Scale 1 111

Figure 409: Mainfenance - Information: ScaleUpdafeRate
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< Information M
Category
OptionBoardInformation N/ )
Name Value
Slot 1 Part Number 30726003
Slot 1 PCBAC Number 0030521649
Slot 1 Serial Number 0110069045410001
Slot 1 Hardware Version OE
Slot 1 Software Version V4.0.12
Slot 1 Manufacturer Date 2147
]
Figure 410: Mainfenance - Information: OptionBoardInformation
< Information i
Category
Hardwarelnformation N
Name Value
SMARC Part Number 30648170
Carrier Board Part Number 30677199

Figure 411: Maintenance - Information: Hardwarelnformation

Information for each cafegory can be exported fo an internal file, saved to the C:\Export folder, or fo an external

USB device. Refer to [Export » Page 310].
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4 Service and Maintenance

4.1

IND700

The ferminal is designed to provide years of dependable operation. However, METTLER TOLEDO recommends
that — as with any industrial measurement equipment — the terminal and the connected scale system be
serviced periodically. Timely, factory-specified maintenance and calibration by a METTLER TOLEDO service
technician will ensure and document accurate and dependable performance to specifications.

Application Software Activation

Application software such as ProWorks Multi-Tools can be regisfered and activated in two ways:
e From within the METTLER TOLEDO intranet

e From outside the METTLER TOLEDO intranet -- e.g., at a customer's sife

Terminal Serial Number

Before atfempting to activate application software, ensure that the terminal's serial number (in setup at
[Terminal > Device » Page 187]) does not show a mismatch. A mismatch may appear when the terminal's
firmware has been updated, for example.

1. Check that the displayed serial number corresponds fo the number on the ferminal's data plate:

METTLER TOLEDO | oK. oot iowastoro |

Figure 412: Terminal Data Plate Showing Serial Number

< Device

Terminal ID #1
Terminal ID #2

Terminal ID #3

Terminal Serial Number

69569416DZ

Figure 413: Terminal > Device Screen Showing Serial Number

2. Ifthe Terminal Serial Number field is editable, and shows a "Serial Number Mismatch" warning in red,
click on the field. If necessary, enter the correct serial number in the entry screen which displays.

3. Click on the check mark K at lower right.

4. Finally, click the check mark at lower right of the Device screen. The serial number will now appear as a
displayed item which cannof be edited.
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Software License key
When a software license is purchased, a license key envelope is provided.

Software License Key

METTLER TOLEDO

Figure 414: License Key Envelope

This envelope contains a card showing the license key, in five groups of characters separated by dashes.

Multi — Tools
IND700
Version 3.1.x

License Key

o |
LR R YL b R

nttps:i/activation. mt.com

-

METTLER TOLEDO

Figure 415: License Key Card

Save this card in a secure place. The Key will be required if the software needs to be re-activated, or moved fo
another ferminal (for example, when the original ferminal is no longer functional.)

For additional information on moving files fo and from the terminal, refer to [File Transfer » Page 348].

4.1.1 Activation from Within the METTLER TOLEDO Intranet

If the terminal is connected to the network inside the METTLER TOLEDO intranet, an automatic activation
procedure can be used:
1. Make sure that the IND700 is connected fo the network via an Ethernet connection.

2. Enfer setup and access Terminal > Licensing. The License Manager page will appear.

{ License Manager

State Name License Key Product

+  Add License

Figure 416: Licensing Manager

3. Click the =+ either in the menu bar, or in the license list pane. The Add License screen will appear.
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{  Add License

Mame

License Key

Figure 417: Add License Screen

4. Enter a name to associate with this license -- e.g. ProWorks Multi-Tools, or a ferminal identifier -- and the
License Key from the card.

{  Add License

MName

License Key

v

Figure 418: License Key Entered

5. Click the check mark atf lower right.

6. Click the Cloud/Key icon¢ in the menu bar. The Online License Activation screen will display. Enfer the
User Name and Password associated with the activation account, then click the check mark &

7. AlLicense Activation Successful message will display, The software is now activafed.
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< Information

License Activation
o Successful. All
Licenses are activated.

Figure 419: License Activation Confirmation Screen

8. The License Manager screen will now display the activated license.

<{ License Manager + &S th M

State Name License Key Product
v ProWorks Multi-Tools .. . e IND700 Lice

Figure 420: License Manager Showing Activated License

4.1.2 Activation from Outside the METTLER TOLEDO Intranet

If the IND700 is connected to a network outside the METTLER TOLEDO intranet, the activation procedure can be
carried out manually.

Before beginning the procedure, confirm that the correct server (depending on fransfer fool used) is active at
[Terminal > Security Options » Page 200] -- FTP, sFTP or Remote Deskiop.

1. Make sure the IND700 is connected fo the network via an Ethernet connection.
2. In setup, access Terminal > Licensing. The License Manager screen will display.

272 | Service and Maintenance IND700



{ License Manager

State MName License Key Product

4+ Add License

Figure 421: License Manager Screen

3. Click the =, either in the menu bar or in the license list pane. The Add License screen will display.

<{  Add License

Mame

License Key

Figure 422: Add License Screen

4. Confirm the enfry to refurn fo the License Manager screen.

5. Click the EXPORT icon f1 in the menu bar. A .lic (license) file will be exported to the terminal's hard drive
at C:\Export.

6. Access the terminal from a PC via the Ethernet connection, and use a fool such as UltraVNC to access the
Export folder.
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Mstory | > D1/19/24 13:20:47 - Connected...

Progress
Connected...

Figure 423: IND700 Export Folder

7. Copy the .lic file from the Export folder to the PC.
8. From a web browser on the PC, access the Activation Portal.

-0

METTLER TOLEDO Software Portal

Wwnoms 2 the Softweres fortal

For mors inkamation oo profley, tgning i snd seeting pusTecedy 1 the First B o

Figure 424: Activation Portal
9. Enfer the required user name and password.
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. 4

b’

Sign In

User name: | | |

Password:

reetrie |

Internal Authentication
Forgot Login? Reset password here

+ Go back to site

Figure 425: Activation Porfal Login

10. Click on the Activation item in the site's menu bar.

ACTIVATION PORTAL

Search this site

Home

METTLER TOLEDO Software Portal

Welcome to the Software Portal
For more information on profiles, signing in and resetting passwords see the First Steps Guide’,

Figure 426: Activation Link in Menu Bar

11. The Activation / Reactivation / System Transfer screen appears. Here, sofiware can be activated or
reactivated, or fransferred between systems.
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Figure 427: Activation Screen
12. Click the Choose File button, navigate to the folder containing the .lic file, select the file and confirm the
selection.

13. The server wil generafe an activation file with a .key suffix, and display a download link. Click the link to
download the file.

14. Using the ferminal access tool used in step 6, browse fo the terminal's C:\Import folder, and copy the .key
file from the PC into the folder. Close the fool.

v [ Locamacre il [E [C:] - Local Disk v|[  memorEmMacHme \
iC:y

Mame Size Modified Name

Size
welC:] Local Cisk L[ $Recyce.n] Eokder
L1 Desictop | CllBadap] Folder
L My Deauments | L[ Deviesl ekiawn | Fpidar
CI[ Metweork Favorites | [ Documents and Settings ] Folder
o [ :] e ek Ll Emport] Eolder
wir] Network e O import] Folder
wz] Ntk L[ mo7oaTocts | Foldar
TR | O meessent ) Foder
Ll moasiueg ] Folder
[ raoasaTocs | Folder
L[ kel ] Zoider
L[ Packages] Folder
Chirerfiogs ] Colder
[ Program Fles (x35) ] Foider
[ Progras Fies ] Spidar
Delete -> Ll Programbata ] Folder
L[ Recovery ] Folder
Mew Folder -2 | | [ Service ] Folder
L[ System Velume Informati,.. Folder

L[ temp ] Folder

Chifusers] Fokder

L[ wandows ] Folder

EI iberfil, sys L53Gh 01892024 15:17
(3] pagetie.sys 1.37Gh 01192024 15: 17
(5] wefoveap. sys 150Gk 01282024 1630

Farged Clase » 25 Fle(s) Folder(s)
History > DIf19/24 13:29:47 - Connected... w
Progress
Connected...

Figure 428: IND700 Import Folder

15. In the License Manager screen, click the Import icon 41
16. The terminal will read the .lic file and display a confirmation that software activation has been successful.
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< - Information

License Activation
o Successful. All
Licenses are activated.

Figure 429: Activation Confirmation

17. The License Manage screen will now display the activated license.

< License Manager + &S th th

State Name License Key Product
~./ ProWorks Multi-Tools . . . . IND700 Lice

Figure 430: License Manager Showing Activated License

4.2 Precautions

e READ this manual BEFORE operating or servicing this equipment and FOLLOW these instructions carefully.
e SAVE this manual for future reference.

Before service, disconnect power from this device.
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/\ WARNING

The protective ground connection must be checked after service work is
performed. Perform the check between the protective ground contact on the
power plug and the housing. This test must be documented in the service
report.

/\ WARNING

Only permit qualified personnel to service the equipment. Exercise care when
making checks, tests and adjustments that must be made with power on.
Failure to observe this precaution could result in bodily harm and/ or property
damage.

/\ WARNING

When this equipment is included as a component part of a system, the resulting
design must be reviewed by qualified personnel who are familiar with the
construction and operation of all components in the system and the potential
hazards involved. Failure to observe this precaution could result in bodily harm
and/ or property damage.

/\ WARNING

Before connecting/disconnecting any internal electronic components or inter-
connecting wiring between electronic equipment always remove power and wait
at least thirty (30) seconds before any connections or disconnections are made.
Failure to observe these precautions could result in damage to or destruction of
the equipment and/or bodily harm.

/\ WARNING

Observe precautions for handling electrostatic sensitive devices.

4.3 List of Tools Required

The following tools are required fo perform these procedures:

Soft cloth and mild glass cleaning solution
Voltmeter

Anti-static mat and wrist strap

Philips head screwdrivers

Flat blade screwdriver

Wrench kit

Nut driver with 7 and 8 mm sockets

4.4 Cleaning and Maintenance

Clean the terminal’s keypad and cover with a clean, soft cloth that has been dampened with a mild glass
cleaner.

Do not use any type of industrial solvent such as foluene or isopropanol (IPA) that could damage the
terminal’s finish.

Do not spray cleaner directly on the terminal.
Regular maintenance inspections and calibration by a qualified service technician are recommended.
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e The terminal is a rugged stainless sfeel enclosed instrument; however, the front panel is a polyester
covering over sensitive electronic switches and a lighted display. Care should be faken to avoid any
punctures fo this surface or any vibrations or shocks fo the instrument. Should the front panel become
punctured, ensure that steps are taken fo prevent dust and moisture from entering the unit until the terminal
can be repaired

4.4.1 Enclosure Gasket

In order to preserve the enclosure’s IP rafing, inspect the sealing gasket to ensure that it makes a good seal,
and does not have permanent indentations. Gasket lifetime is shortened by exposure to high temperatures. The
enclosure gasket should be inspected during any maintenance activity, and replaced if it becomes damaged or
brittle. Refer fo Spare and Replacement Parts.

Figure 431: Replacement Gasket
4.5 Maintenance

4.5.1 Run

Touch Run in the Maintenance options to open the Maintenance Run screen.

=D QO

Setup > Maintenance > Run

Scales Configure Backup
Application Run Restore
Terminal Diagnostics Software Update
Communication Reset

Maintenance Information

Figure 432: Mainfenance Run Screen

4.5.1.1 Backup

The system’s configuration can be backed up to a file stored either on the terminal’s hard drive, or on an

attached USB device. This means that:

 |f a master reset is performed, system configuration (except for metrological and calibration settings) can be
restored.

» A default setup can be shared to other IND700 ferminals, eliminating the necessity fo configure each
terminal individually.
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Touch Backup. The follow screen will appear.

< Backup

Target for Backup
Internal File
File

IND700__2021_09_10_0847

Directory
C:\Backup

From this screen, choose the Target for the backup (USB Memory or Internal File) and the File fo create.

The default filename takes the form IND700__YYYY_MM_DD_TTTT —i.e., with date and time appended. This
name can be modified by fouching the field and using the alphanumeric keyboard to enfer a new name.

The Directory area displays the target location; this cannot be modified, but once the file is stored on a USB
device it can be saved elsewhere and, if necessary, renamed.

Once the parameters are set, touch » to begin the backup process. Note that if USB Memory is selected, but
no USB device is aftached, the Run button will not work and the Directory line will show “No USB Memory
connected!”

4.5.1.2 Restore

Touch Restore. The following screen will appear.

< Restore

Target for Restore

Internal File v

File

Directory
C:\Backup

From this screen, choose the Target (Internal File, USB Memory) of the file from which a configuration is to be
restored, and then touch the File field to view a drop-down list of all configurations available in the selected
location. Directory displays the location from which the resfore file will be selected.

Note that if USB Memory is selected, but no USB device is attached, the Run button will not work and the
Directory line will show “No USB Memory connected!”
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4.5.1.3

4.5.2

IND700

Software Update

The Software Update screen includes Source, File and Directory areas. If Internal File is selected as the
Source, the Directory line will display the location where the system will look for the update file —a folder, \Hard
Disk\Update.

{ Software Update

Source

Internal File v

File

Directory

C:\Service

To update the software of the terminal, an upgrade package file with an .IPK extension is required.

Note: Install only package files that you have received directly from METTLER TOLEDO by download. Package
files of unknown source or package files sent by e-mail may be corrupted!

The ferminal performs a check on all components received in a package file, and ferminates the installation
process with an error message (such as checksum validation failed) in the event of inconsistencies.

Battery Replacement

When the main PCB battery runs low, the message center on the main screen will display a warning:

=[= & B

© Init zero could not be done 18.Apr.2023 15:09

A\ Low Battery. Call Service for replacement! 18.Apr.2023 15:09

Figure 433: Replace Battery Warning Message

Battery Replacement

When the IND700 main PCB battery is replaced, a back up of configuration and calibration
values is recommended, but not required.

To replace the battery:

1 Remove power from the terminal and open ifs enclosure.
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2 Locate the baftery on the main PCB. The following images indicate its location in the Wedge and Harsh
environment versions of the terminal.

awnm &

a |

Figure 434 Battery Location, Wedge'agp)'dnd Harsh Environment (boftom) Ehéiosures

3 Use a small flat blade screwdriver or other instrument to press the battery fo the right, as indicated by the
arrow in the image below.

Figure 435: Battery Removal

4 Install the replacement battery by placing it, positive side upward, in the battery holder, then pressing it fo
the left and info the slot until it is properly seated.

Close the ferminal's enclosure.

Restore power fo the ferminal.

Enter setup fo check that configuration and calibration settings have been retained.

If the tferminal has an active Ethernet connection, time and date will be set automatically. Otherwise, set the
terminal's date and time at [Setup > Terminal > Region > Sef Time and Date » Page 196].

0 N OO O
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4.5.3 Leveling Guidance

IND700

The Leveling Guidance feature is available to PowerDeck scale systems. To assure maximum weighing
accuracy and reliable calibration, it is important that floor scales are installed such that an approximately equal
dead load is placed on each load cell.

During factory calibration of a PowerDeck floor scale, the zero counts of each load cell (af a no-load condition)
are stored in the load cell along with other initial factory dafa. When a PowerDeck floor scale is first installed,
its accuracy is enhanced by ensuring that it is levelled so that the current cell counts match the sfored, factory
calibrafion values as closely as possible.

e The Leveling Guidance feature in IND700 ferminals provides a graphical comparison of the current counts
vs. the factory calibration counts stored in each load cell of a PowerDeck platform. This feature is provided
as a fool for the service technician during installation, and can be accessed in setup af Scale © > Leveling
Guidance. Level Guidance is available if the Application is set fo Floor in sefup af Scale n > ASM > Load
Cell > System.

» The installation guidance is valid only for platforms which include only the original, factory-installed load
cells. It should not be used for platforms in which one or more load cells have been replaced.

- Before accessing the Leveling Guidance feature, a bubble level should be used for initial leveling.

<{ Leveling Guidance

Figure 436: Leveling Guidance, 4 Load Cell Scale

The Leveling Guidance graphic display represents a PowerDeck floor scale and assumes that the load cells are
addressed as node 1 through 4 starfing with the corner where the home-run cable exits and moving in @
clockwise direction.

The counts displayed in the center of the graphic indicate how many counts the current reading is above or
below the stored factory value. The load cell with the largest negative count variance from the stored factory
value is highlighted — cell T in the example above. This indicates that this load cell should be shimmed first.

Acceptable count values depend on the resolution of the scale. For example, for a scale displaying 1,000
divisions, cell counts should be <5,000. For higher resolution scales, values such as <2,500 are required.

The display updates aufomatically once a second (1 Hz) as the count variances of each load cell change, so
shims can be added or subtracted in an attempt fo achieve an accepfable count variance. Due to the high
resolution of the raw count readout, it will not be possible to achieve exact equality between the raw count
values. An accepfable count variance is determined by the platform size, capacity and the number of
increments as defined in the platform installation manual.
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4.5.4 Master Reset
4.5.5 Troubleshooting and Error Codes

4.6 Filter and Search Tables and Logs

Maintenance and troubleshooting procedures offen require information found in the terminal's tables and logs.
For information on filters and searches, refer to [Table Functions: Filter, Export, Import, Clear » Page 307].

4.7 Disposal
In conformance with the European Directive 2012/19/EU on Waste Electrical and Electronic K

Equipment (WEEE) this device may not be disposed of in domestic waste. This also applies
to countries outside the EU, per their specific requirements.

Please dispose of this product in accordance with local regulations at the collecting poinf ]
specified for electrical and electronic equipment. If you have any questions, please contact

the responsible authority or the distributor from which you purchased this device. Should this

device be passed on to other parties, the content of this regulation must also be related.

4.8 Troubleshooting

4.8.1 Internal Diagnostic Testing
The IND700 provides several infernal diagnostic tests that are accessible in sefup mode.

1 From the home screen, open the main menu and select Enter Setup.

@ Terminal >
2] Login/Logout
{3y Enter Setup

L
Main Screen View

() Power - N

Figure 437: Main Menu

2 Touch Mainfenance.
3 Select Maintenance > Diagnostics.
4 Refer to [Diagnostics » Page 260] for details on the diagnostic options.

4.8.2 Alarm Codes and Messages
Alarms and alerts in the IND700 are indicated in two ways:
¢ In the [home screen message box » Page 14]
¢ Inthe IND700 [Error Log » Page 317]

The Error Log records all alert and action messages generated by the terminal. This log is helpful in diagnosing
and correcting problems and failures in the terminal. These alarms can help predict failure and frigger
maintenance action before the problem becomes severe enough to make the terminal unusable.

Users with Admin and Supervisor credentials can view the Error Log.
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4.8.2.1 Reading Alarm Codes

When an alarm is friggered, a message will display on-screen for the number of seconds defined in setup at

[Terminal > Display > Message Timeoutf » Page 188]. The message pop-up will disappear after the set timeout
period, but all errors can be reviewed if the Error Log is enabled in setup at [Maintenance > Configure > Enable

Logs » Page 244]. To view the error log, go fo [Maintenance > Configure > View Error Log » Page 248]. A
typical error log display is shown below:

< View Error Log

ID Log Time ™ Username Severity Error Code Scale
10 26.Jan.2024 11:20:22 Admin E 200 1
9 26.Jan.2024 11:20:22 Admin E 200 1
8 26.Jan.2024 11:20:22 Admin E 200 1
7 26.Jan.2024 11:20:21 Admin E 200 1
6 26.)an.2024 10:14:25 Admin I A10015

5 18.Jan.2024 11:19:57 Operator C 108 1
4 18.Jan.2024 11:19:57 Operator G 108 1
3 18.Jan.2024 11:19:57 Operator c 108 1
2 18.Jan.2024 11:19:57 Operator £ 108 2
1 18.Jan.2024 11:19:57 Operator € 108 1

Figure 438: Example Error Log View

Logging Errors
For errors to appear in the Error Log, that log must be enabled in setup af Maintenance >

Configure > Enable Logs.

Error records consist of the following:
e The ID of the Error Log record. This is a sequential number provided the Error Log database
» The Log Time at which the alarm occurred, or when it was read by the user
e The Username of the user logged in at the time the alarm occurred

* A Category, indicating the type of alarm on a scale of 110 5

e An Alarm Code ([Alerts and Alarms » Page 286]) which can be used for froubleshoofing, and by MT

Service

 |f more than one scale is configured in the terminal, the affected Scale willl also be indicated
e An alarm/alert Message, in the currently configured language, displayed fo the user in the home screen

message area

 The same Message in English, to facilitate alarm reporting

» A Detail, which contains additional information about the record -- for instance, whether the Log Time
represents the time when the alarm was triggered or when the user read it

Examples of Alarm Codes
Example Alarm Codes

11:02

den Support!

ID Log Time User Category Alarm Scale Message Message Detail
Name Code (English)
4 123.Jan.2024 | Admin 4 3333 1 Smartb Cat4 no.3 ' Smartb Cat4 no.3 read
11:18 action message  |action message
3 23.Jan.2024 |Admin 3 1234 2 Kontaktieren Sie | Contact support! | read

IND700
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ID |Log Time User Category Alarm Scale |Message Message Detail
Name Code (English)
2 23.Jan.2024 |Admin 3 3333 3 Die verherige Cannot remove detect
10:50 Anwen- previous appli- ed
dungsversion kann|cation version
nicht entfernt
werden.
1 23.Jan.2024  Admin 4 1234 1 Smartd Cat4 no3 | Smartb Catd no3 | defect
10:39 alert message alert message ed

4.8.2.2 Aleris and Alarms

This section provides a description of the alarm/alert [Categories » Page 2861, and a comprehensive [list of all
alarms and alerts » Page 2867 a user may encounter when operating the IND700.

4.8.2.2.1

Key to the Alarm and Alert List

In the alarms and alerts list, six aftributes are provided for each record:
¢ A numeric Alarm Code, as displayed in the Error Log

« A Category:
Alarm and Alert Categories
Icon Cat Type Description Result
ego
ry
5 Catastrophic | Wrong weight / equipment failure Alarm stops operating -- clearing the
failure alarm will not reset the condition. The
device must be repaired fo eliminate
the alarm.
4 [Imminent Wrong weight / equipment failure Alarm indicates that failure is
failure expected based on predictive imminent, within one week. The
algorithms and sensors, such as alarm can be reset but will recur each
temperature and humidity day until the cause is eliminated.
3 | Out of specifi- |Wrong operator actions or device /  |Alarm and log the event. Alarms are
‘? cafion application is operating out of specifi- only generated / transmitted at the
. cation request of the customer.
2 Predictive Routine test, calibrafion or preven- Alarm and log the event. Alarms are
alarm tative mainfenance must be only generated / fransmitted af the
undertaken request of the customer.
1 |Normal Unit is operating correctly No action is required. In practfice, the
J condition Category 1 alert is not displayed.

« An indicafion of whether this error will be stored in the Error Log, and whether the error can be read and
tfransmitted by SAI (the Standard Application Inferface)

* A message text, representing what a viewer sees on-screen when the alarm is triggered
e A suggested response, representing actions the user should take in response to the alarm

The response “Call MT Service” is included for alarms which occur rarely and are severe enough fo require
service intervention.

4.8.2.2.2

Alerts and Alarms

[tems shown in brackets {} are variables, such as a load cell identifier. Their value is supplied dynamically by

the terminal.
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Error Codes, Messages and Responses

Alarm | Category Log? SAI? Error Message Suggested Response

Code

0002 4 y y | The voltage of the ADC is foo |Call MT Service
low

0003 2 y y | Below Process Tolerance Add {0} pieces or close warning to abort

0025 3 y y  |Comparator {0} data source |Check scale communication
lost

0042 3 y y  |Implementation of interface |Cycle power, or call MT Service
{0} no registered

0058 3 y y Loading Alert Move load to platform center

0060 3 y y | Mainf: calibration expired Call MT Service

0064 3 y y | Mainf: metrology seal broken Call MT Service

0067 4 y y | Maint: zero failures Call MT Service

0068 4 y y | Mainf: zero commands Call MT Service

0069 5 y y  Memory error Call MT Service

0098 3 y y  |Scale Reset Failed Re-try reset, or call MT Service

0105 4 y y  |Scale settings validation Call MT Service
error

0112 3 y y  |Symmetry errors Call MT Service

0131* 2 y y | Validation Error Call MT Service

0146 4 y y | Zero Drift Errors Call MT Service

1001 5 y y  |Interface not registered: DIO |Call MT Service for replacement
and Scale interfaces

1001 4 y y |Interface not registered: all  |Call MT Service for replacement
except DIO and Scale
interfaces

1004 4 y y | Low battery Call MT Service for replacement

2011 b y n | Industrial Network not Check network connection or configuration
communicating

2012 5 y y | Scale error / Scale {0} not  |Check scale connection and setfings
responding

2013* 5 y y |Scale {0}: Invalid mixiure of |Check load cell types or check load cell
load cell types, or invalid serial number
load cell serial number

4043 3 n n  Zero component scale failed |Unload scales and retry

4043 3 n n | Zero Failed Check scale or call MT Service

4053 3 n n |Init zero could not be Make sure scale is empty on power up
performed

4054 3 y n |Tare failed Retry tare, or call MT Service

4063* 5 y y  Under Zero condition Check scale and fouch Zero key

4064 3 y y | Maint: scale overload Call MT Service

4075 2 y y | Mainf: calibration expired Call MT Service

5083 b y n | Pairing failed Check pairing or call MT Service

5084 3 y n | Scale {0} Automatic Infernal |Please inspect the connected weigh module
Calibration (FACT) Failed or call MT Service

6515 3 Y y | Symmetry error (low Call MT Service
deviation)

6515 5 y Y |Symmetry error (high Call MT Service
deviation)

* These alarm codes are subject to change.
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5 Appendices

5.1 Default Settings

The following tables indicate the default value for each configurable parameter in the IND700.

5.1.1 Scale - HSALC

288 | Appendices

HSALC Scale Settings
Parameter Default Value
Metrology
Approval| Not approved
GEO value 20
Lower temperature limit (°C)|-10
Upper temperature limit (°C) |40

Identification

Serial number

[blank: alphanumeric entry field]

Scale model

[blank: alphanumeric entry field]

Scale location

[blank: alphanumeric entry field]

Scale identification

[blank: alphanumeric entry field]

Capacity & Increments

# ranges

Single range

Primary unit

kg

Capacity 1

60

Resolution 1

0.02

Capacity 2 [if # ranges or infervals is 2]

[blank: numeric entry field]

Resolution 2[if # ranges or infervals is 2]

[blank: numeric entry field]

Capacity 3[if # ranges or intervals is 3]

[blank: numeric entry field]

Resolution 3[if # ranges or infervals is 3]

[blank: numeric entry field]

Blank over capacity (d)

5

Linearization and Calibration

Calibration

Calibration unit

kg

Linearity adjustment

Disabled

Test load 1

60

Test load 2 [if Linearity adjustment = 3]

[blank: numeric entry field]

Test load 3 [if Linearity adjustment = 4]

[blank: numeric entry field]

Test load 4 [if Linearity adjustment = 5]

[blank: numeric entry field]

Gain jumper

2 mvN

Span Adjustment

Test weight (kg)

0

Displayed weight (kg)

0

Step Calibration

Test load (kg)

60

CalFree

Cell capacity

0

Cell unit

kg

Rated cell output mV/V

3

Use zero

Calibrated

Estimated preload [If Use zero = Estimated]

0
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Parameter

Default Value

Preload unit [If Use zero = Estimated]

kg

Control Mode

[Display only]

Units

Secondary unit

kg

Host / auxiliary unit

kg

Startup unit

Primary unit

Zero

Starfup zero

Use last

Power up zero -range (%)
[if Startup zero = Capture new]

0

Power up zero +range (%)
[if Startup zero = Capture new]

0

Auto zero fracking

On

Auto zero range (d)
[if Auto zero tracking = On]

0.5

Blank under zero (d)

20

Push button zero

On

Push bufton zero —range (%)
[if Push button zero = On]

2

Push button zero +range (%)
[if Push button zero = On]

Tare

Startup tare

Use last

Auto fare mode

Off

Auto fare threshold (kg)
[If Auto fare mode = On]

0

Auto tare reset threshold (kg)
[If Aufo tare mode = On]

0

Chain fare mode

off

Auto clear fare

Off

Auto clear fare threshold (kg)
[If Auto clear tare = On]

0

Push button tare

On

Keyboard tare

On

Clear with zero

On

Filter

Low pass filter

Medium

Stability filter

off

Stability

Motion range (d)

0.5

No motion interval (seconds)

0.3

Timeout (seconds)

3

MinWeigh

MinWeigh mode

Off

MinWeigh value (kg)
[If MinWeigh mode = on]

0

Reset

[No configurable parameters]

Maintenance

Cell counts
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5.1.2
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Parameter

Default Value

Node n

[Display only]

Calibration values

Zero

0

Load 1 (k@)

60

Counts 1

6000000

Scale - POWERCELL

POWERCELL Scale Settings
Parameter Default Value
Metrology
Approval| Not approved
GEO value 20
Lower temperature limit (°C)|-10
Upper temperature limit (°C) 40

Identification

Serial number

[blank: alphanumeric entry field]

Scale model

[blank: alphanumeric entry field]

Scale location

[blank: alphanumeric entry field]

Scale identification

[blank: alphanumeric entry field]

Capacity & Increments

# ranges

Single range

Primary unit

kg

Capacity 1

60

Resolution 1

0.02

Capacity 2 [if # ranges or intervals is 2]

[blank: numeric entry field]

Resolution 2[if # ranges or intervals is 2]

[blank: numeric entry field]

Capacity 3[if # ranges or infervals is 3]

[blank: numeric entry field]

Resolution 3[if # ranges or intervals is 3]

[blank: numeric entry field]

Blank over capacity (d)

5

Linearization and Calibration

Calibration

Calibration unit

kg

Linearity adjustment

Disabled

Test load 1

60

Test load 2 [if Linearity adjustment = 3]

[blank: numeric entry field]

Test load 3 [if Linearity adjustment = 4]

[blank: numeric entry field]

Test load 4 [if Linearity adjustment = 5]

[blank: numeric entry field]

Gain jumper

2 mV/V

Span Adjustment

Test weight (kg)

0

Displayed weight (kg)

0

Step Calibration

Test load (kg)

60

CalFree

Cell capacity

0

Cell unit

kg

3

Rated cell output mV/V
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Parameter

Default Value

Use zero

Calibrated

Estimated preload [If Use zero = Estimated]

0

Preload unit [If Use zero = Estimated]

kg

Control Mode

[Display only]

Units

Secondary unit

kg

Host / auxiliary unit

kg

Startup unit

Primary unit

Zero

Startup zero

Use last

Power up zero -range (%)
[if Startup zero = Capture new]

0

Power up zero +range (%)
[if Startup zero = Capture new]

0

Auto zero tracking

On

Aufo zero range (d)
[if Auto zero tracking = On]

0.5

Blank under zero (d)

20

Push button zero

On

Push button zero —range (%)
[if Push button zero = On]

2

Push button zero +range (%)
[if Push button zero = On]

Tare

Startup tare

Use last

Auto tare mode

Off

Auto tare threshold (kg)
[If Auto tare mode = On]

0

Auto tare reset threshold (kg)
[If Aufo tare mode = On]

0

Chain tare mode

Off

Auto clear tare

off

Auto clear fare threshold (kg)
[If Aufo clear tare = On]

0

Push button fare

On

Keyboard tare

On

Clear with zero

On

Filter

Low pass filter

Medium

Stability filter

Off

Stability

Motion range (d)

0.5

No mofion interval (seconds)

0.3

Timeout (seconds)

3

MinWeigh

MinWeigh mode

off

MinWeigh value (kg)
[If MinWeigh mode = on]

0

Reset

[No configurable parameters]
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5.1.3
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Parameter

Default Value

Maintenance

Cell counts
Node n| [Display only]
Calibration values
Zero 0
Load 1 (kg)|60
Counts 1/6000000

Scale - Precision

Precision Scale Settings

Parameter Default Value
Metrology
Approval|Not approved
GEO value 19
Lower temperature limit (°C)|-10
Upper temperature limit (°C) |40
Ramp [Display only]

Identification

Serial number

[blank: alphanumeric entry field]

Scale model

[blank: alphanumeric entry field]

Scale location

[blank: alphanumeric entry field]

Scale identification

[blank: alphanumeric entry field]

Capacity & Increments

# ranges

Single range

Primary unit

kg

Capacity 1

12

Resolution 1

0.002

Capacity 2 [if # ranges or infervals is 2]

[blank: numeric entry field]

Resolution 2[if # ranges or infervals is 2]

[blank: numeric entry field]

Capacity 3[if # ranges or infervals is 3]

[blank: numeric entry field]

Resolution 3[if # ranges or intervals is 3]

[blank: numeric entry field]

Blank over capacity (d)

9

Linearization and Calibration

Autoprint calibration

Autoprint calibration

On

External calibration

[No configurable parameters]

3-point lin&cal [No configurable parameters]
5-point lin&cal [No configurable parameters]
Span adjustment
Weight for span adjustment| 12
Displayed weight for span adjustment| 12
Control mode| [Display only]
Control mode [Display only]
Units
Secondary unit [If Legacy mode = off]| None
Host / auxiliary unit [If Legacy mode = off]| None
Startup unit [If Legacy mode = off]| Primary
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Parameter

Default Value

Legacy mode

Version 2

Zero

Startup zero

Capture new

Power up zero -range (%)

2

Power up zero +range (%)

18

Center of zero

off

Auto zero fracking

On

Aufo zero range (d)
[if Auto zero tracking = On]

0.5

Blank under zero (d)

20

Push button zero

On

Push button zero —range (%)
[if Push button zero = On]

2

Push button zero +range (%)
[if Push button zero = On]

Tare

Startup tare

Clear

Auto tare mode

On

Auto clear fare

Off

Push button tare

On

Keyboard tare

On

Filter

Vibration filter

Standard

Process filter

Universal

Stability

Stability de’rec’rion\ Standard

MinWeigh

MinWeigh mode

Off

MinWeigh value (kg)
[If MinWeigh mode = on]

0

Reset

[No configurable parameters]

Diagnostics

Channels and parameters

[Display only]

Diagnostics block

Load cycle monitor

[Display only]

Overload cycle monitor

[Display only]

Shock load cycle monitor

[Display only]

Analog load cell fault detection

[Display only]

Zero deviation monitor

[Display only]

Temperature T monitor

[Display only]

Temperature gradient monitor

[Display only]

5.1.4 Application

IND700

Application Settings

Parameter

Default Setting

Memory

Alibi Enable

Alibi Memory fable

Enabled
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5.1.5
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Parameter Default Setting
Alibi Table
Alibi Table| [Table view]
Material table
Material Table| [Table view; editable]
Tare Table
Tare Table [Table view; editable]
Transaction Table
Transaction Table| [Table view]
ID Form

ID Form

[List view; editable]

Select Application

[List of available applications]| Disabled
Auto Start Application [Display only]
Terminal
Terminal Settings
Parameter \ Default Setting
Device
Terminal ID #1 | [Blank field]
Terminal ID #2| [Blank field]
Terminal ID #3|[Blank field]
Terminal Serial Number | [Display only]
Display
Backlight Timeout| Enabled
Backlight (minutes) 30
Screen Saver Enabled
Screen Saver (minutes)| 30
All Scale View Enabled
Auxiliary Display| Tare Active
Transaction Counter
Transaction Counter| Disabled
Allow Counter Reset | Disabled

[If Transaction Counter = Enabled]

Next Transaction Number
[If Allow Counter Reset = Enabled]

p—

Users

Table view; editable

Admin

Access Level

Administrafor

Default User

Disabled

Operator

Access Level

Operator

Default User

Enabled

Region

Language

User Language Selection

Enabled

Display Messages

English

On-Screen Keyboard

QWERTY
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Parameter

Default Setting

Exfernal Keyboard

Windows Default

Time and Datfe Format

Preview of Time and Date

[Display only]

Use 24-hour clock

Enabled

Display Seconds

Disabled

Show 2 Digit Month

Disabled

Show 2 Digit year

Disabled

Time Separator|:

Date Format

Day Month Year

Date Separator.

Set Time and Date

Time Zone

(UTC -05:00)

Hour : Minute

[Numeric entry fields]

Set Date

[Alphanumeric entry field]

Softkeys

Softkey Ribbon Editor

[Softkey array and Softkey row view; editable]

T

No text

Clear Messages

[No configurable parameters]

Security Options

Unified Write Filter

Enabled

Keyboard Filter

Enabled

External Mass Storage Blocking

Enabled

Enable Windows Deskfop

Disabled

Firewall

Enabled

Windows

Activate Windows Through Internet

[No configurable parameters]

Activate Windows Through Phone

[No configurable parameters]

[If DHCP = Disabled]

License
License active| [Display only]
Partfial product key| [Display only]
Update Now
Target Internal File
File [Dropdown list]
Directory| [Display only]
Licensing
License Monoger\ [List view]
5.1.6 Communication
Communication Settings
Parameter Default Setting
Ethernet
MAC Address [Display only]
DHCP| Enabled
IP Address| [Numeric entry field]
[If DHCP = Disabled]
Subnet Mask [Numeric entry field]
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5.1.7
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Parameter

Default Setting

Gafeway Address [Numeric entry field]
[If DHCP = Disabled]

Preferred DNS Server| [Numeric entry field]
[If DHCP = Disabled]

Secondary DNS Server [Numeric entry field]
[If DHCP = Disabled]

Intefaces

Interfaces\ [List view; editable]

Connections

Connections\ [Blank list view; editable]

FTP Server

FTP Server| Disabled

FTP Port| [Display only]

sFTP Server

SFTP Server| Disabled

Port| [Display only]

Remote Desktop Server

Remote Desktop Server\ Disabled

Output Templates

Template 1

[Default Templafe 1 configuration; editable]

Templates 2-10

[No configuration; editable]

Input Template

Preamble Length|O

Data Length

j—

Postamble Length O

Timeout| Enabled

Assignment Tare

Termination Char|CR

Maintenance

Maintenance Settings

Parameter Default Setting
Configure
Enable Logs
Change Log Enabled
Maintenance Log| Disabled
Error Log Enabled
View Change Log [Log view]
View Error Log [Log view]
Run
Backup
Target for Backup| Internal File
File| [Alphanumeric entry field; default filename =
product_serial
number_year_month_day_hour_minute]
Director| [Display only] C:\Backup
Restore

Target for Restore|Internal File
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Parameter

Default Setting

File

[Dropdown list showing all available backup files]

Director

[Display only] C:\Backup

Software Update

Source

Internal File

File

[Dropdown list showing all available update files]

Director

[Display only] C:\Service

Diagnostics

Network Test

IP Address

[Numeric entry keypad]

Ping Response

[Display only]

Touch Calibration

[Description of fest with RUN button]

Serial Port Loopback Test

Port

Mainboard (Serial Porf)

Test Status

[Display only]

DIO Test

Port

Mainboard Discrefe 1/0

DIO Status indicators

[Display only]

Reset

Scales

Disabled

Terminal

Disabled

Application

Disabled

Communication

Disabled

Maintenance

Disabled

Interfaces

Disabled

Master Reset

Disabled

Reset Calibration

[Avaiable if Master Reset = Enabled] Disabled

Information

Category

[Dropdown list] CountingService

List view

[Display only]

5.2 Table and Log File Structure

5.2.1

5.2.1.1

IND700

The IND700 terminal includes the following tables:

e Alibi Table

e Material Table

e Tare Table

 Transaction Table

This chapter defails the structure of each of these.

Memory Tables

Alibi Memory

Alibi memory stores transaction information in a preset format that is not changeable. Alibi memory can be
enabled or disabled in sefup at Application > Memory > Alibi Enable.

The Alibi memory stores up to 500,000 Alibi records in a battery-backed file as they occur. When this file is
full, new alibi data overwrites the oldest records in the table.
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The columns displayed in the Alibi Table vary depending on terminal configuration. Different columns will
appear depending on which application is in use.

<{  Alibi Table

Y th

Log Transaction Scale Gross Net Tare
1D Time Counter # Weight Weight Weii
7 06.Feb.2024 09:39:08 1 2.139 1.989 0
6 06.Feb.2024 09:38:51 1 2.140 1.990 0
5 06.Feb.2024 09:38:46 1 2.140 1.990 0
4 06.Feb.2024 09:37:09 1 2.140 1.990 0
3 06.Feb.2024 09:36:52 1 2.139 1.989 0
2 06.Feb.2024 09:36:11 1 2212 2.062 0
1 01.Feb.2024 20:12:45 1 0.000 0.000 0

Figure 439: Alibi Record Columns 1

< Alibi Table

cale Gross Net
Weight Weight

Tare
Weight

Calculated

Unit

Y

User
Data

2.139
2.140
2.140
2.140
2139
2212
0.000

1.989
1.990
1.990
1.990
1.989
2.062
0.000

Figure 440: Alibi Record Columns 2

0.150
0.150
0.150
0.150
0.150
0.150
0.000

kg
kg
kg
kg
kg
kg
kg

Not all columns are populated for each record. The data captured by the Alibi fable depends on the type of

operation being performed.

For details on Alibi Table searches, refer fo [Table Functions: Filter, Export, Import, Clear » Page 307]. For the

export of Alibi Table dafa, refer to [Alibi Table » Page 172].

5.2.1.2 Material Table

Correct configuration of the Material Table facilitates the use of the Applications. Depending on the currently
enabled application, different options will exist for a Record, and the record will appear in the Material Table

with its associated application listed.

The IND700 can store up to 100,000 material records.

Access the Material Table

The Material Table can be accessed in two ways:

 Access Setup > Application > memory > Material Table.
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 Touch the Material Table softkey [ from the Application Screen View.

Add New Material, No Application Selected
1. Open the Material Table
2. Touch the + icon in the header row.

3. The Add New Material screen will appear. This page includes four fields: ID, Name, Description and Tare
ID. When Valid entries have been made, fouch the confirmation check button at lower right of the screen fo
return fo the Application View screen.

<  Add New Material

ID

2

Description

Tare ID

Tare Name

Figure 441: Add New Material Screen
Add New Material Fields

ID ID is a number which simply indicates the record’s position (1, 2,...n) in the table.

Name An alphanumeric identification of the material (arficle or raw material)l This identification
is particularly useful when recalling Material records using a barcode scanner.

Description A descriptive name which will appear on the Application Screen View when the Material
Table record is loaded (if configured to display at Setup > Application > App Screen
View).

Tare ID [Optional] The numerical ID of a Tare Record associated with this item. If a valid Tare ID

is entered here, the name of Tare name will appear af the bottom of the screen. Tare can
also be taken manually while in the Application Screen View.

Add New Material, Application Selected

When an application has been selected (in the Select Application screen), additional fields appear in the Add
New Material screen, and dots appear at the left of the screen fo indicafe that additional parameters are
available on two or three pages. Touch a dot to display the second or third page.
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<  Add New Material

ID

2

Description

Tare Name

Figure 442: Add New Material, Application Selected

The additional pages show the selected application in the screen's header:

£ Add New Material (Classification)

Lower Limit 4

[ - - -
2 Classification Active
Invalid Data

Unit Lower Limit 5
g

Lower Limit 1 Lower Limit 6

Lower Limit 2 Lower Limit 7

Lower Limit 3

Figure 443: Add New Material Header Showing Selected Application

By default, the additional pages show only a slider used to activate the application for this material. Touch the
slider fo activate the application, and further fields appear. In the case of an 8-category Classification configu-
ration, one more additional page appears.
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Add New Material

Lower Limit 8

Upper Limit 8

Figure 444: Add New Material - Classification, Second Page

Material Table Record Units Field

The Unit field configured in a Maferial Table record is used in the application’s calculations
(e.g. for Average Piece Weight in Counting). This unit is not affected by the Primary Unit set
for the scale in ASM at Capacity & Increments (refer o chapter 2, Configuration, in the
IND700 Technical Manual or User's Manual). This permits the Application fo display a
result appropriate for the size of the item or material — for example, grams for small ifems,
kilograms for large ones — using the same scale.

Add New Material Fields by Application

Totalization APW The average piece weight of reference pieces can be included
in the Material Table record.
Note: APW can also be calculated from the Application Screen
View using the FIX 10 & and VAR 10 & softkeys.
Unit The weight unit for the APW.
Counting APW The weight, in the units defined, of a measured reference piece.
Unit The weight unit for the APW.

Fix 10 Softkey

Captures live scale weight to use as reference weight for 10
ifems.

Classification

Unit

The weight unif to be used for the classification operation.

Lower Limits 1-7

The number of fields depends on how many classes are
specified at Setup > Application > Classification.

Upper Limit The upper limit of the last defined class.
Manual Filling Target Value Target weight for Filling operation.
Unit Weight unit for Filling farget.
-Tolerance The type of value used here depends on the configuration of
+Tolerance the Filling applicafion -- Absolute, Deviation or Percentage.
Over/Under Target Value Target weight for Over/Under operation.
Unit Weight unit for Over/Under target.
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5.2.1.3
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If 3 zones selected:|-Tolerance (Under)
+Tolerance (Over)
-Tolerance (Under)
-Tolerance (Low)

+Tolerance (High)

+Tolerance (Over)

The type of value used here depends on the configuration of
the Filling application -- Absolute, Deviafion or Percenfage.

If 5 zones selected:

When the record is correctly configured, access the first Add New Material screen and touch the confirmation
check mark.

The Material Table will display, with the new record listed and its associated application/s indicafed in the
Application column. Note that the applicatfion is indicated only for active applications. Records which show no
Application may be associated with other applications. In the example below, the Counting application is
active.

Material Table

Name Tare ID Description Application

Cookies 5 Packet

Sand 1 Bags of sand Counting
Sugar

BB1

Granulated sugar

Ball bearings, 5mm Counting

Figure 445: Material Table View

Editing or Deleting a Material Table Record
Edit a Material Table Record

Access the Material Table. With the table displayed, touch the affected record and select the Edit .« icon from
the pop-up.

< Materijal Table
n+ 7 v

4 Canline

Figure 446: Material Table Options Popup

Tare ID Description Application

Configure the record as described above. All fields, including the ID number field, can be modified.
To save the changes, touch the check mark at lower right; the Material Table will display.
Managing Material Table Records

Refer to [Table Functions: Filter, Export, Import, Clear » Page 48] for details on filtering, exporting, importing
and deleting Material Table records.

Tare Table

The Tare fable in the IND700 ferminal can store 1,000 records. These records can can be recalled for use
during weighing operations, instead of manually enfering a tare value for each transaction. This recall function
is especially useful when certfain tare values are used repeatedly. When tofalization is enabled for the tare fable,
each time a transaction is completed using an activated fare ID, the selected weight value (gross or net weight)
is added to the total and the counter increments by one.
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5.2.1.3.1

IND700

For details on configuring a tare record and managing the tare table, refer to [Tare Table » Page 172].

Quick Access to a Tare Record

Tare Records Quick Access

The Tare Table softkey [r] must be assigned fo the homescreen in configuration at [Terminal
> Softkeys » Page 197].

A Tare record can be quickly recalled for use by a user with Admin login, by enfering Setup and accessing

Application > Memory > Tare Table. Hower, a quick access method available to Operator logins is to touch
the the Tare Table [7 softkey.

The Tare Table will display; use the up and down arrows to scroll through the table, or perform a table search
(XREF) to find the desired tare record.

Tare Table Y + il

Name Description Value Unit Low Limit

Box, small Small, cardboard 0.1 kg
Box, medium Medium cardboard box 0.2 kg
Box, large Large cardboard box 0.25 kg
P Box, small Small plastic box with lid 0.18 kg

P box, large Large plastic box with lid kg

Figure 447: Tare Table View
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Touch the desired record to display its confext menu.

Tare Table \[_1” + i‘| ['1] ﬁ

Name Description Value Unit Low Limit

Box, small Small, cardboard 0.1 kg

Box, m + @ /  |cardboard box 0.2 kg
Box, lar Large cardboard box 0.25 kg

P Box, small Small plastic box with lid 0.18 kg
P box, large Large plastic box with lid kg

Figure 448: Tare Record Context Menu

With the record selected, touch the OK v| icon.
The home screen will appear, with the weight in NET mode and the tare value displayed.

& @ 30,Jan_12?):gi
m'] Max60kgd=10g

-0.406.

0.46 kg PT >0< Net
PT 0
Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. 1D Form Material Table

Figure 449: Home Screen, Tare Loaded

5.2.1.4 Transaction Table

The Transaction Table is accessed in Setup af Application > Memory. It can be exported to an internal file
location as a .csv or .xml file, and then copied fo a network location for storage or analysis. Refer to [Table
Functions: Filter, Export, Import, Clear » Page 307] for defails on filtering and exporting the contents of the
Transaction Table.

This table logs a number of paramefers for each weighing fransaction performed on the terminal. A transaction
occurs when the scale TRANSFER function is executed directly from the front panel [I&d or any of the available
remote means (discrete input, Industrial Network, SICS command, etc.). The Transaction Table can be
accessed from the home screen if the TRANSACTION TABLE [g] softkey is assigned in setup at [Terminal >
Softkeys » Page 197]. The REPEAT TRANSACTION .2 function does not affect the Transaction Counter.
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Columns in the Transaction Table reflect various configuration settings in the terminal -- the contents of the
[Material » Page 298] and [Tare » Page 302] Tables, the configuration and use of [ID Forms » Page 69], and
the seftings applied to the [Transaction Counter » Page 189]. A typical fransaction record might include:

Transaction Counter serial number (if enabled)

Log Time, including date and time of day

Scale # for which the transaction was recorded

Gross, Net and Tare Weights

Tare type (T or PT)

User Name associafed with the fransaction

Material ID, if any

Material Name, if any (if ProWorks Multi-Tools is licensed)

Identifiers such as Lot, Bafch number, Shiff, efc., depending on how the ID Form is configured in sefup af
Application > ID Form. Each enabled field is included as a column, with the name assigned in configu-
ration

APW, pcs, Status, and other parameters associafed with a running application (if ProWorks Multi-Tools is
licensed)

The following images show the complete contents of a Transaction table, scrolled to the right fo reveal
additional columns.

{ Transaction Table Y M 1
Log ” Transaction Scale Gross Net Tare
Time Counter # Weight Weight Weight
06.Feb.2024 09:39:08 1 2139 1.989 0.150
06.Feb.2024 09:38:51 1 2.140 1.990 0.150
06.Feb.2024 09:38:46 1 2.140 1.990 0.150
06.Feb.2024 09:37:09 1 2.140 1.990 0.150
06.Feb.2024 09:36:52 1 2139 1.989 0.150
06.Feb.2024 09:36:11 1 2.212 2.062 0.150
01.Feb.2024 20:12:45 1 0.000 0.000 0.000

]

Figure 450: Transaction Table 1
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<  Transaction Table Y i

Tare Preset User Material Material

Weight Tare Unit Name ID Name Produc
0.150 PT kg Admin 1 Aluminum scrap 22
0.150 PT kg Admin 1 Aluminum scrap 22
0.150 PT kg Admin 1 Aluminum scrap 22
0.150 PT kg Admin 1 Aluminum scrap
0.150 PT kg Admin 1 Aluminum scrap
0.150 PT kg Admin 1 Aluminum scrap
0.000 kg Admin

Figure 451: Transaction Table 2

{  Transaction Table Y 1
Lot Operator Targe

Product Batch  Number  Shift ID pcs  APW __ Unit  Cont
22 43 2 1 104 Fillini
22 43 2 1 104 Fillin:
22 43 2 1 104 Filling
Fillini

Fillini

Fillini

Figure 452: Transaction Table 3
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<  Transaction Table ? LT] ﬁ

rator Target
pcs APW Unit Control Application Target Status

Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK

Figure 453: Transaction Table 4

Table Functions: Filter, Export, Import, Clear

Enabled tables include a number of functions, accessed by touching an icon in the table's header row.

The Alibi Table is read-only, and its contents can be < filtered and tf1 exporfed. Alibi data cannot be imported
4, records cannot be deleted, and the fable cannot be cleared fi. Once the Alibi Table has reached its
maximum capacity, the terminal begins fo overwrite the oldest data. To avoid loss of Alibi Table data, it is
recommended that an export schedule be implemented.

The contents of the Material Table and Tare Table can be filtered, exported to a file, imported from a file, and
cleared. The import function permits table contents to be configured outfside the ferminal, or shared befween
terminals performing the same function.

The contentsof the Transaction Table can be filtered, exported and cleared.

Exported table contfents are sfored on the terminal in the C:\Export folder. Datfa to be imported must be placed
in the C:\Import folder. For details on file fransfers in and out of the terminal, refer to [File Transfer »
Page 348].

Filter

For an account of the filter entry methods, refer to [Data Entry » Page 43].

Because it accumulates many records, the Alibi Table has a Filter function Y which filfers the visible records
depending on up to three conditions.
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Search Condition

The Search Condition fields permit the definition of three search criteria. The three filters screens are shown
below. Note the screen indicafor dots and up/down arrows at left.

< Filter
#1
Field Operator
Log Time W4 is equal N

. First Parameter

26.Jan.2024 00:00:00

Figure 454: First Table Filter Screen

The second and third Filter screens are shown with no Field selected. Filter #2 is shown enabled but not
configured. Filter #3 is shown disabled. The other filter options -- Operator and Parameter -- are not
accessible until a Filter Field is selected.

Figure 455: Second Table Filter Screen
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£ Filter

#3

Figure 456: Third Table Filter Screen

Field opfions are:

* None (filter not operational)

e ID

e Log Time

e Transaction Counter

e Scale #

e Tare Type

e Unit

The options provided by the Parameter value depend on the Field type selected. For example, if Scale # is
chosen, the Parameter field is a drop-down list of all available scales plus Sum Scale.

When a filter Field has been selected, the Operator field and a Parameter field becomes available -- two
Parameter fields, if in the range is selected as the Operator. Touch the Parameter field fo display its
associated enfry method. ([Data Entry » Page 43]). The Parameter entry dialog shown below is for a numeric
parametfer, in this case ID.

First Parameter

Figure 457: Example Filter Parameter Entry
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Other Field types are associated with other entry types. For example, if Log Time is selected under Field, the
Parameter field will display a calendar and Hour : Minufe input dialog.

4

Su

28
4
11
18
25
3

Hour : Minute

0

February 2024 4

Mo Tu We Th Fr Sa

29
5
12
19
26
4

30
6
13
20
27

o)

51
7
14
21
28
6

Figure 458: Calendar Dialog for Log Time Field Parameter

Parameter options are:
e isequal

e freater

e greater or equal

¢ less than

e inthe range

< Filter
#1
Field
1D

. First Parameter
Y 9
b 4
r/-_ A\
b

N

i 2 3
8§ 9 10
15 16 17
22 23 24
29 1 2
7 8 9

v

Operator

is equal

is equal

greater

greater or equal

less than

Figure 459: Filter Condition Operators

Export

All tables permit the export 1 of data. The export screen requires the selection of a File Type, and the choice of
a File Name. The default form of the filename has the form [terminal]_[Year_Month_Day]_[time]_[Table
name], but this can be modified by touching the File Name field to display an alphanumeric entry screen

([Data Entry » Page 437).
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{  Table Data Export

Directory
Internal Eile v C\Export\69569416DZ
File Type
Csv XML
File Name

IND700_2024 02_09_0813_Tare

Figure 460: Table Dafa Export Screen

Touch the blue check mark || to confirm the export and return to the Table view screen.

5.2.1.5.3 Import

The Material and Tare fables both permit data to be imported. Data for import fo a fable must be confained in a

file of the appropriate format, either .csv or .xml. Touch the Import icon t1 to display the Table Data Import
screen.

<{  Table Data Import

Import Directory

Internal File Ny C\lmport

IND700_2024 02 09 0813_Tare.csv N

Figure 461: Table Data Import Screen

Touch the blue check mark || fo confirm the import. The Table view screen will appear, with the new data
displayed.

5.2.1.5.4 Clear

To manage space in the terminal's memory, it may be necessary to clear a table. Before clearing a table, it is
recommended that a table export be performed. The dafa can be stored outside the terminal. This will prevent
unwanted dafa loss.
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When the clear icon @ is touched, a warning displays indicating that the entire table will be cleared.

Warning

Clear Entire Table?

X v/

Figure 462: Table Clear Warning

Touch the check mark to confirm the deletion, or the X fo return fo the table view.
Log Files

Scale Log Table

The Scale Log Table is accessed from the main menu under Terminal > Metrology.
For the contents of this table, refer to [Metrology » Page 46].

See also
& Accessing Terminal Information » Page 45

Pairing History File

The Pairing Hisfory File is accessed from the main menu, under Terminal > Metrology.
For the contents of this file, refer fo [Metrology » Page 46].

See also
& Accessing Terminal Information » Page 45

Change Log

The Change Log in the IND700 terminal file tracks all changes to shared data. The Change Log can be enabled
or disabled in setup at Maintenance > Configure/View > Change Log.

The Change Log file is a linear-type file that eventually becomes full if not reset. It will hold an estimated
30,000 records. When the file becomes 75% full, a warning message displays fo indicate the status. Another
message displays when the file is 90% full. If the file is not resef, it will continue fo store records until it is
100% full and a final 100% full message displays. Additional changes to shared data will not be recorded
until the file is reset.

IND700



IND700

An example of Change Log view is shown below. The second image shows the same view scrolled to the right

to display more columns of information, which include current and prior values for the modified item.

<

ID

View Change Log

Log Time ™

User Name

Configure

Y

Property Nami

48
47
46
45
44
43
42
41
40
39

12.Feb.2024 07:40:56
12.Feb.2024 07:40:50
12.Feb.2024 07:40:48
12.Feb.2024 07:40:41
12.Feb.2024 07:40:22
12.Feb.2024 07:40:15
12.Feb.2024 07:40:13
12.Feb.2024 07:40:03
12.Feb.2024 07:22:17
12.Feb.2024 07:22:02

Figure 463: View Change Log, 1

Admin
Admin
Admin
Admin
Admin
Admin
Admin
Admin
Admin
Admin

Sum5
Sum5
Sum 5
Sum 5
Sum5
Sum 5
Sum 5
Sum5
InputTemplates

Connections

PushButtonZer
PushButtonZer
PushButtonZer
PushButtonZer
PushButtonZer
PushButtonZer
PushButtonZer
PushButtonZer
InputTemplate

Connection Ad

Figure 464: View Change Log, 2

<{  View Change Log Y M
! Old Value P
‘oMode False 1
‘oMode True f
‘oMode False 1
‘oMode True f
‘oMode False 1
‘oMode True f
Updated MT.Singularity.Platform.InputTemplate.InputTemplateConfiguration P
ded !
ded \
ded P
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< View Change Log Y

New Value

True
False
True
False
True
False
wfiguration MT.Singularity.Platform.InputTemplate.InputTemplateConfiguration
MT.Singularity.Platform.Communication.ConnectionConfiguration
MT.Singularity.Platform.Communication.ConnectionConfiguration

MT.Singularity.Platform.Communication.ConnectionConfiguration

Figure 465: View Change Log, 3

« The Maintenance Log export file, generated by the Table Data Export option t*1, is named
Terminal_YEAR_MO_HR_MIN_LogName. Example: IND700_2024_03_12_1113_ErrorLog. The log file is
exported to the terminal's C:\Exporf\Terminal Serial Number folder.

¢ The log file is exported to the ferminal's C:\Expori\Terminal Serial Number folder. Using the ferminal's
serial number as the sub-folder name ensures that the listed log items are associated with the specific
terminal.

« The file can be exported in either .csv or .xml format. Refer fo [Table Functions: Filter, Export, Import, Clear
» Page 48] for details on table and log file exports, and [File Transfer » Page 348] for external fransfers of
files.

See also
& Table Functions: Filter, Export, Import, Clear » Page 48

5.2.2.4 Maintenance Log

The Maintenance Log fracks service operations performed on the equipment. MT Service and Validation
Agencies or those who audit for them will use this log. This log can contain up to 32,000 records.
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A typical log view is shown below, with a second screen showing the view scrolled fo the right fo display
additional information.

View Maintenance Log + Y ]'11
Log Time ™ Username Channel Cell Event Di
12.Feb.2024 06:46:04 Admin Scale2 23 M
12.Feb.2024 06:44:18 Admin Scale 23 M

Figure 466: View Maintenance Log, 1

<  View Maintenance Log -+ Y M
1annel Cell Event Description Status
cale2 23 MAINT. CALIBRATION TEST PASSED Successful
cale’ 23 MAINT. CALIBRATION TEST PASSED Successful

. _________________________________________________________________________|]
e
Figure 467: View Maintenance Log, 2

Overview

The maintenance log file is a ring-type file that overwrites the oldest record when is becomes full. The
mainfenance log file can hold a maximum of 2500 records. The maintenance log is recorded in File-system
and won't be lost after system power-off. The used size will be checked while new log is recorded. If the used
size is more than 75%, 90% or full, hint information will be thrown to System Line of Home Screen to inform
user to do backup and clear mainfenance log.
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Maintenance Log Record
The maintenance log format shows as below.

Field Data Type Length (bytes) Description

Date and Time u32 7 Year/Month/Day/Hour/Minute/Second
Username String 13 User String Name

Event Code us 1 Event code

Status String 8 Log String status

Operation

When Event identified by Event Code happens, a record is added info Maintenance Log. The Maintenance Event
Code, Event and related possible status are illustrated in the following table.

Event Code Event Description Status (String)
1 Calibration test failed. 1-n=failed at step n
2 Zero calibration performed. FAILURE, SUCCESS, Motion
3 Span calibration performed. FAILURE, SUCCESS, Motion
4 CalFree calibration performed. FAILURE, SUCCESS
8 Log file exported via FTP. MAINT, CHANGE, TACT (Action), ALIBI
9 Setup file exported - .dmt files exported via SUCCESS
FTP.
10 Metrology switch / electronic seal broken. SUCCESS
11 Calibration Expired. "1"=days
15 Added option component Manual text entry
16 Removed option component Manual text entry
17 Replaced component Manual text entry
18 Maintenance Log initialized. SUCCESS
\When Maintenance Log is Enabled,
Maintenance Log is Reset in Menu, this event
will be added.
Note: If Master Reset or Factory Reset is
detected while terminal is powered up, system
fry to add this event, but default maintenance
Log xrO103 is disabled, this event is not
added successfully.
19 Calibration values manually edited. SUCCESS
21 Set date or time. SUCCESS
22 Table exported. tare, target, cont, caltiw1, calfest]
23 Calibration test passed. SUCCESS
28 Successful zero command SUCCESS
55 Step calibration performed. SUCCESS, FAILURE
56 1-Point Test failed. 1-n = failed at step n
57 1-Point Test expired. "1"= Days
58 1-Point Test passed. SUCCESS
59 Walk Test failed. 1-n = failed af step n
60 Walk Test expired. "1" = Days
61 Walk Test passed. SUCCESS
62 Custom Named Event Test failed. 1-n = failed at step n
63 Custom Named Event Test expired. "1" = Days
64 Custom Named Event Test passed. SUCCESS
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Event ID 15, 16, 17 are added manually. Other Events are added automatically when the Events are triggered
by Operation described in Event Description.

» The Maintenance Log export file, generated by the Table Data Export option rt1, is named
Terminal_YEAR_MO_HR_MIN_LogName. Example: IND700_2024_03_12_1113_ErrorLog. The log file is
exported fo the terminal's C:\Expori\Terminal Serial Number folder.

 The log file is exported to the terminal's C:\Exporf\Terminal Serial Number folder. Using the ferminal's
serial number as the sub-folder name ensures that the listed log ifems are associated with the specific
terminal.

» The file can be exported in either .csv or .xml format. Refer to [Table Functions: Filter, Export, Import, Clear
» Page 48] for details on fable and log file exports, and [File Transfer » Page 348] for external transfers of
files.

See also
¢ Table Functions: Filter, Export, Import, Clear » Page 48
& File Transfer » Page 348

Error Log

The Error Log contains a list of all events and alarms that the ferminal has generated. Customers or technicians
can use this log fo trace operations, events and alarms fo aid froubleshooting. This log can confain up to
32,000 records.

A typical Error Log view is shown below. For further information about significant events which might be
recorded here, refer to [Alarm Codes and Messages » Page 2841].

<{  View Error Log Y M
ID Log Time ™ Username Severity Error Code Scale
5 09.Feb.2024 09:19:23 Admin £ A50001
4 08.Feb.2024 07:51:42 Admin C A50001
3 08.Feb.2024 06:57:38 Admin C A50001
2 18.Jan.2024 10:38:58 Admin C A70008
1 18.Jan.2024 10:36:02 Admin C A70008

Figure 468: Error Log View 1
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<  View Error Log Y M

r Code Scale Message Message (English) Detail
1001 No error occurred

1001 No error occurred

1001 No error occurred

1008 Scale 7 not responding.

1008 Scale 7 not responding.

Figure 469: Error Log View 2

« The Maintenance Log export file, generated by the Table Data Export option rt1, is named
Terminal_YEAR_MO_HR_MIN_LogName. Example: IND700_2024_03_12_1113_ErrorLog. The log file is
exported fo the terminal's C:\Exporf\Terminal Serial Number folder.

* The log file is exported to the ferminal's C:\Expori\Terminal Serial Number folder. Using the terminal's
serial number as the sub-folder name ensures that the listed log ifems are associated with the specific
terminal.

¢ The file can be exported in either .csv or .xml format. Refer to [Table Functions: Filter, Export, Import, Clear
» Page 48] for details on fable and log file exports, and [File Transfer » Page 348] for external fransfers of
files.

See also
¢ Table Functions: Filter, Export, Import, Clear » Page 48

Communications

This section is infended as a reference concerning only the structure and sefup of communication protocols
supported by the IND700 terminal.

Incorrect wiring of the communication circuits
The IND700 terminal or interface board can be damaged.
— Wire the communication circuits exactly as shown in Installation.

Serial Interface Parameters

The IND700 main PCB includes one standard 9-pin serial port connector, COM1. This standard port supports
RS232, RS422 and RS485 communications, and includes a +5V output and an isolated ground.

An additional serial port is available if a Precision scale interface is insfalled in the terminal. This 7-pin port is
labeled COMx. It supports RS232, RS422 and RS485 communications, but does nof include the +5V output
and ground pins.

For installation information concerning the optional COMx port, refer fo the IND700 Accessories Installation
Guide, 30753892,
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Character framing is programmable in the setup mode -- refer to [Configuration > Communication Setup >
Interfaces » Page 210] for details on selecting these parameters. Framing can be:
e 1 start bit

e 7 or 8 ASCII data bits (selectable)

e 0 or 1 parity bit (none, even, or odd)

e 1 stop bit

The baud rate can be configured from 4800 to 115.2K baud.

The IND700 ferminal uses software handshaking fo control data flow commonly referred to as XON/XOFF
handshaking. When a receiving device is getting information from an IND700 ferminal and cannof receive any
more in its buffer, it sends an ASCIl XOFF (13h) telling the IND700 terminal fo temporarily stop sending data
until its buffer clears.

When the device can receive more data, it sends an ASCII XON (11h) telling the terminal fo begin sending data
again. This process can occur as often as required by a receiving device.

The XON/XOFF method is the only type of handshaking supported by the IND700.
The terminal supports demand and confinuous output modes.

See also
& Configuration » Page 72
& Communication Setup » Page 208

Demand Output Mode

The demand oufput mode fransmits data only when the IND700 terminal receives a prinf request. Print requests
are sent to the ferminal when:

 The operafor presses the TRANSFER [ER butfon or the REPEAT TRANSACTION softkey 1.

» A discrete input selected as print is triggered.

e An ASCIl “P” is sent through a command input port.

e An Industrial Network command to print is received.

e The “Print” command shared data is triggered.

When triggered, data is fransmitted in a string programmed in the templafe editing portion of setup.

Demand mode is used typically when sending data to a prinfer or PC on a fransactional basis.

Output Templates

The IND700 provides ten fully customizable templates fo define a custom string of dafa to be fransmitted. A
template is used with a demand mode connection. In the setup of the ferminal, a template is tied fo an output
connection so that when that connection is triggered, the selected template and ifs current contents will be
fransmitted.

Template 1 is the Automatic Standard Template. Details about its operation can be found in the Operation
section ([Automatic Standard (Output) Template » Page 547) and in this section, below ([Automatic Standard
Template » Page 3217).

Each template can store up to 1,000 bytes of dafa. There is no warning if a femplate overflows this limit until
the template is saved. At this time, any information over the 1,000-byte limit will be lost. The InSite program
does track the size of the template as it is being built and provides an appropriate warning if the limit is
exceeded.

The table that follows defines how the 1,000 byfes are calculated.

Print Field Space Used

IND700 Data Field 8 characters

Special Character 4 characters + code (2 or 3 characters depending on the character)
String Field String length + quantity (1 or 2)

Justify a Field 2 characters + justify letter (L, R, C) + space limit (1, 2, or 3 characters)
Zero Fill a Field 2 characters + Z + space limit (1, 2 or 3 characters)

Repeat Character 5 characters + number (1, 2 or 3 digits for number of fimes repeated)
Line end <CR><LF> |7 characters
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The default Output Template 1 appears as shown below:

{ Template 1

Element Data

Type

v + 0 1 O

Alignment

# Chars

Date:
xd0103

1 String
SD Var
CR/LF
Time:

xd0104

String
SD Var
CR/LF
String User:

SD Var xd0171
CR/LF -

Material ID:

O |00 | Ny NN

o

String

Left 6

Exact

Left

Exact

Left

Exact

Left

Figure 470: Output Template 1, Default Configuration

Quantity I
1

1

Rows in a femplate can be dragged and dropped using a finger on the screen, to re-order the display of data.

In the image below, Row 8 is being dragged.

{ Template 1

Element Data

Type

v + 0 1 O

Alignment # Chars

Quantity

Date:
xd0103

1 String
SD Var
CR/LF
String Time:
SD Var xd0104
CR/LF -

User:

String
xd0171

SD Var Exact
CR/LF -

String Scale:

Left 6

Exact

Left

Exact

Left

1

1

Figure 471: Template 1, Re-Ordering Rows

As a general rule, the most efficient and least time-consuming way to create templates is to fake advanfage of
the [Automatic Default Template » Page 321] feature. This method does not require access to a list of Shared
Data Variables, as the system provides the correct values.

For additional information on configuring templafes, refer fo [Output Templates » Page 227].
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The IND700 features an AST (Automatic Standard Template) function which simplifies the preparation of
templates customized for particular uses and applications. Shared Data variables representing all available
information (which adds columns fo the [Transaction Table » Page 173]) are automatically added to Output
Template 1.

To create multiple Output Templates with different automatically-generated content, make the necessary
changes fo the terminal configuration, then access Setup > Communication > Output Templates > Template
1. Here, all the currently configured Transaction Table fields are automaticaly represented as rows in the table
(refer fo the five-screen example shown above).

Select the Copy icon @ at top left . From the Copy Template dialog, click the To dropdown list and select the
desired femplate.

Copy Template

From

1

Figure 472: Copy Template Dialog

Appendices

321



322 | Appendices

Click the Run icon P at lower left fo execute the copy, then use the left arrow at fop left twice to return fo the
Output Templates menu view. Template 2 is now shown as configured.

.51 @ 03.Aug.121r;§§

Setup > Communication > Output Templates

Scales Ethernet Template 1
Application Interfaces Template 2
Terminal Connections

Communication Output Templates

Maintenance Input Template

Figure 473: Output Templates Menu View, Template 2 Configured

This customized template -- in this case, Output Template 2 -- can now be used to determine the content and
format of the oufput from a Connection. Multiple connections can be configured and use for different appli-
cations using other output femplates.

<

Edit Connection

Part Ethernet Connection

Ethernet Server
Ethernet Port
Ethernet 1701
Assignment

Transfer
Trigger

Active Scale

Template

Template 2

Figure 474: Connection Configuration Screen Showing Templatae 2 Selected
Template 1 will continue to reflect changes made to the configuration of the weight display. These can then
copied fo another femplate.

Remember that templates can be Exported ™1 and Importedth, so that they can be kept safely outside the
IND700, and restored fo the same ferminal or shared with other ferminals. This option makes it very easy fo
standardize output data across multiple terminals.
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To access these options in an Output template, click the ellipsis see in the menu bar.

o @ B+
#Ii'l I'l'l Quantity

1

Figure 475: Output Templates Menu Bar, Import and Export Icons Displayed

See also
¢ Transaction Table » Page 173

Continuous Output Mode

The continuous output mode of the IND700can be used to continuously send weight dafa and scale status

information to a remote device such as a PC or a remote display.

Standard Continuous Output

Continuous mode can be assigned to COM1, COM2, COM3, COM4, COM5, COMG or Eprint. Checksum can be
enabled or disabled on any of these ports with confinuous output. A data string will be output approximately 20
times per second for baud rates above 4800 baud. A specific output rate can be set through a Shared Data

write to field csO121 (refer to the IND700 Shared Data Reference).

The format is fixed, except for baud rate, parity, data flow (XON/XOFF), and inferface type. The data consists of

17 or 18 byfes.

Non-significant weight data and fare data digits are fransmitfed as spaces. The confinuous output mode
provides compatibility with METTLER TOLEDO products that require real-time weight data.

The fable that follows shows continuous format output.

Status2 Indicated Weight3 Tare Weight4
Character |1 |2 3 4 5 6 7 8 9 |10 11|12 |13 14 15 |16 |17 18
Data STX|SWA |SswB SwC MSD - |- |- |- |LSDMS - |- |- |- |LSDCR CH
1 D 5 |K6

Notes on Continuous Output Format
e ASCII Start of Text character (02 hex), always fransmitted.
e Status words.

Status Word A Bit Definitions

Bits 2, 1, and 0

2 1 0 Decimal Point Location
0 0 0 XXXXX00
0 0 1 XXXXXO0
0 1 0 XXXXXX
0 1 1 XXXXX. X
1 0 0 XXXX. XX
1 0 1 XXX XXX
1 1 0 XX XXXX
1 1 1 X XXXXX
Bits 4 and 3

4 3 Build Code
0 1 X1
1 0 X2
1 1 X5

Bit 5 Always =1

Bit 6 Always =0
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Status Word B Bit Definitions

Status Bits Function

Bit O Gross = 0, Net = 1

Bit 1 Sign, Positive = 0, Negative = 1

Bit 2 Out of Range = 1 (Over capacity or Under Zero)

Bit 3 Motion = 1, Stable =0

Bit 4 Ib =0, kg = 1 (see also Status Byte 3, bits 0-2)

Bit b Always =1

Bit 6 Zero Not Captured = 1

Status Word C Bit Definitions

Weight Description

Bits 2, 1, and 0 -

Ib or kg, selected by Status Byte B, bit 4

grams (@)

mefric tons ()

ounces (0z)

troy ounces (ozt)

penny weight (dwt)

tons (ton)

— | = = =000 O0/O|N

custom units

Bit 3 Print Request = 1

Bit 4 Expand Dafa x 10 = 1, Normal = O

Bit 5 Always =1

Bit 6

Always =0

Continuous Template Output

If continuous template is selected as the assignment for a connection, a custom string of dafa can be
configured using one of the five available templates. When a continuous template output is selected, the output
rate depends on the size of the template and the baud rate selected. The rate varies from approximately once
per second up to approximately 20 fimes per second.

The table that follows shows the estimated output rafes of a 160-byte femplate.

Continuous Template Output Rate
Baud Rate Outputs / Second Baud Rate Outputs / Second
4800 8 38400 14
9600 10 57600 16
19200 12 115200 18

The template can include any combination of elements (IND700 Field Codes, ASCII characters, or print strings).
Note that the output rate may be adversely affected by transmitting a large template or selecting a slow baud
rafe.

The femplate is configured as explained at [Configuration > Communication Setup > Output Templafes »

Page 227], and this template has the same size restrictions as described above in the Output Templates
section of Demand Output Mode.
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CTPZ

The CTPZ input mode provides a method for a remote serial device fo trigger several basic functions when a
control character is sent to the IND700. Remote ASCII control characters and the terminal responses include:
e (- Clears the scale to gross mode

e T-—Tares the scale (causes a pushbutton tare)

e P —Initiates a print command

e/ —Zeros the scale

All other characters are ignored. ASCII control characters can be sent in upper- or lower-case.

Example: Initiate A Pushbutton Tare

1 Program the terminal for CTPZ input for a specific port.

2 Program the serial port parameters to matfch the other device.
3 Send the ASCII character “T”.

= A pushbutton tare is initiafed.

Standard Interface Command Set (SICS) Protocol

The IND700 terminal supports the METTLER TOLEDO Standard Inferface Command Set (MT-SICS), which is
divided info four levels (O, 1, 2, 3), depending on the functionality of the device. The IND700 terminal supports
parts of levels 0 and 1:

e MT-SICS level O — Command set for the simplest device

o MT-SICS level 1 — Extension of the command set for standard devices

A feature of this concept is that the commands combined in MT-SICS level O and 1 are identical for all devices.
Both the simplest weighing device and a fully expanded weighing workstation recognize the commands of MT-
SICS levels O and 1.

SICS communication is enabled by configuring the Assignment of a [connection » Page 215] as SICS.

Data Interface Configuration

Interface settings such as baud rate, number of data bits, parity, handshake protocols and connector pin
assignments are described in [Configuration > Communication Setup > Interfaces » Page 210].

Version Number of the MT-SICS

Each level of the MT-SICS has ifs own version number, which can be requested with the command |1 from level
0. The IND700 supports:
e MT-SICS level O, version 2.2x (except the ZI command)

e MT-SICS level 1, version 2.2x (except the D, DW and K commands)

Command Formats
Each command received by the scale via the data interface is acknowledged by a response of the device fo the
fransmitter. Commands and responses are data sirings with a fixed format.

Commands sent to the IND700 ferminal comprise one or more characters of the ASCII character set.
Commands are enfered only in uppercase.

» The parameters of the command must be separafed from one another and from the command name by a
space (ASCII 32 dec., in the examples shown in this section, a space is represented as _ ).

e Each command must be terminafed by CR LF (ASCII 13 dec., 10 dec.).

The characters CR and LF, which can be inputfted using the ENTER or RETURN key of most eniry keypads, are
not listed in this description. However, they are essential fo be included for communication with the terminal.

Example
Command fo tare the terminal: “TA_20.00_Ib” (The command terminator CR LF is not shown.)

Response Formats

All responses sent by the IND700 terminal to the fransmitter to acknowledge the received commands have one
of the following formats:

* Response with weight value
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e Response without weight value
* Error message

Format of the Response with Weight Value

ID Status Weight Value unit C, L
\ 1
12 1 10 1-3
characters character characters characters

Figure 476: Format of response with weight value

¢ |ID — Response identification
e __ —Space (ASCIl 32 dec.)
» Status — Status of the IND700 terminal. See description of the commands and responses.

¢ \Weight Value — Weighing resulf, which is shown as a number with 10 digits, including sign directly in front
of the first digit. The weight value appears right justified. Preceding zeroes are suppressed with the
exception of the zero to the left of the decimal point.

e Unit — Weight unit displayed.

¢ CR - Carriage Return (ASCII 13 dec.)
e LF - Line Feed (ASCII 10 dec.)
Example

Response with a stable weight value of 0.266 kg: S _S_ _ _ _ _ _ 0.256 _ kg
Format of the Response without Weight Value
ID Status Parameters C, L.
|
1-4 |
characters character

Figure 477: Format of response without weight value

e |D — Response identification

e _ —Space (ASCII 32 dec.)

« Status — Status of the IND700 terminal. See description of the commands and responses.
¢ Parameters — Command-dependent response code

¢ CR - Carriage Return (ASCII 13 dec.)

e LF - Line Feed (ASCII 10 dec.)
Format of Error Messages

D C, L
Figure 478: Format of error message
 ID — Error Identification
There are four different error messages. The identification always comprises two characters.

- ES — Syntax error
The ferminal has not recognized the received command.

— ET — Transmission error
The scale has received a “faulty” command, such as a parity error.

— EL - Logical error
The command is understood, the parameter is wrong.

— Internal Error
The command is understood but cannot be executed at this time.

¢ CR - Carriage return (ASCII 13 dec.)
e LF - Line Feed (ASCII 10 dec.)

Tips for the Programmer

This section contains tips for using the SICS protocol in the IND700 terminal.
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Command and Response

The dependability of application software can be improved by having the program evaluate the response of the
terminal to a command. The response is the acknowledgment that the terminal has received the command.
Reset

When establishing communication between the IND700 terminal and system, a reset command can be sent to
the ferminal to enable a start from a defermined state. When the ferminal or system is switched on or off, faulty
characters can be received or sent.

Quotation Marks (“ )

Quotation marks included in the command responses are used fo designate fields and will always be sent.

Commands & Responses MT-SICS Level 0

The IND700 terminal receives a command from the system computer and acknowledges the command with an
appropriate response. This section contains a detailed description of the command set in alphabetical order
with the associated responses. Commands and responses are closed with CR and LF. These termination
characters are not shown in the following description, but they must always be entered with commands or sent
with responses.

The commands of MT-SICS level O are available with even the simplest devices, which support the METTLER
TOLEDO Standard Interface Command Set. The commands are listed as follows:

10 Inquiry of all implemented MT-SICS commands
e |1 Inquiry of MT-SICS level and MT-SICS versions
12 Inquiry of balance data

I3 Inquiry of balance SW version and type definition number
e |4 Inquiry of serial number

e S Send stable weight value

e Sl Send weight value immediately

* SIR Send weight value immediately and repeat

e ZZero

e /I Zero immediately

* @ Reset (clear out serial buffer)

10 — INQUIRY OF ALL IMPLEMENTED MT-SICS COMMANDS
Command: 10 — Inquiry of all implemented MT-SICS commands

Response

0B O “I0” Level O “I0” command imple- [0BO“IM” Level O “IT” command imple-
mented menfed

0B O "12" Level O “12” command imple- [0BO"13” Level O “13” command imple-
mented menfed

0B O 14" Level O “I4” command imple- [0BO"“S Level 0 “S” command imple-
mented menfed

0B O "SI Level O “SI” command imple- 0B O “SIR” Level O “ SIR” command imple-
mented mented

I0BO“Z" Level 0 “Z” command imple- 0B O "@" Level 0 “@" command imple-
mented mentfed

0B 1 "SR’ Level 1 “SR” command imple- 0B 1T Level T “T” command imple-
mented menfed

0B 1TA” Level 1 “TA” command imple- [0B 1 “TAC" Level 1 “TAC” command imple-
mented mented

0B 1Tl Level 1 “TI” command imple-
mented

Error Response 10 | - Cannot execute command at this time.
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1T — INQUIRY OF MT-SICS LEVEL AND MT-SICS VERSIONS
Command: [T — Inquiry of MT-SICS level and MT-SICS versions

Response: 11 A _“" “2.2x" “2.2x" “n “=
No Levels fully implemented

2.2x Level O, version V

2.2x Level 1, version V2.2x

No MT-SICS 2 commands

No MT-SICS 3 commands

Error Response 11 _ | — Command understood, not executable at present.
Comments

¢ Inthe case of the MT-SICS level, only fully implemented levels are listed. In this case, neither level O nor
level 1 were fully implemented so the level is not specified.

* Inthe case of the MT-SICS version, all levels are specified even those only partially implemented.

12 — INQUIRY OF DATA
Command: 12 — Inquiry of data.
Response: | 2 _ A _“IND700 _ Standard _50.00 kg”

Response: | 2 _ A _ “IND700 _ 700Fill _50.00 kg”
e [IND700 - Model number of terminal

¢ Standard - Basic model with no special application software

e 70OFill - Senf when an IND700-Fill is queried

¢ 50.00 kg - Capacity and primary unit of the base connected fo the IND700

¢ Error Response 12 _ | — Command understood, not executable at present.

Comments

The number of characters of “text” depends on the application software and scale capacity.

I3 — INQUIRY OF SW VERSION AND TYPE DEFINITION NUMBER
Command I3: Inquiry of SW version number(s) and type definition number.
Response: I3 _A _“200.11"

e 2.00.11 - Firmware version of the IND700

¢ Error Response 13 _ | — Command understood, not executable at present.
Comment

The number of characters of “text” depends on the revision and device type.

14 — INQUIRY OF SERIAL NUMBER

Command: 14 — Inquiry of serial number.

Response: 14 _ A _ “text”

¢ Serial number as “text” (content of shared dafa xsO105 in IND700 terminal)

* Error Response 14 _ | — Command understood, not execufable at present.

Example

Command: | 4 — Inquiry of serial number

Response: | 4 _ A _"123456-6GG"

Comments

The serial number response is the content of the ferminal serial number as entered in the setup.

S — SEND STABLE WEIGHT VALUE

Command: S — Send the current stable net weight.
Response:

e S _S_ WeightValue _ Unit — Current stable weight value.
e S _ | —Weight value is in the current displayed units.

e S_+—IND700 in overload range.

¢ S_-—IND700 in underload range.
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Example

Command: S — Send a stable weight value.

Response: S _ S 100.00 _ kg. — The current, stable weight value is 100.00 kg.
Comments

The terminal will wait for up fo 3 seconds after receiving an “S” command for no-mofion. If motion does not
settle within this time, the command is aborted.

S| — SEND WEIGHT VALUE IMMEDIATELY

Command: SI — Send the current nef weight value regardless of scale stability.

Response:

e S_S_ WeightValue _ Unit — Stable weight value.

e S _ D _ WeightValue _ Unit — Non-stable (dynamic) weight value.

e S _|-The command is understood, cannot execute the received command at this time (scale currently
executing another command, such as tare).

e S_+—IND700 in overload range.

S _ - —IND700 in underload range.

Example

Command: SI — Send current weight value.

Response: S _ D 129.07 _ kg — The current weight value is unstable (dynamic) and is 129.07kg.
Comments

» The response to the command Sl is the last internal weight value (stable or dynamic) before receipt of the
command SI.

» Weight value is in the current displayed units.

SIR — SEND WEIGHT VALUE IMMEDIATELY AND REPEAT
Command: SIR — Send the net weight values repeatedly, regardless of scale stability.

Response:
e S _S_ WeightValue _ Unit — Stable weight value.

e S _ D _ WeightValue _ Unit — Non-stable (dynamic) weight value.

e S _|-The command is understood, cannot execute the received command at this time (IND700 ferminal
is executing another command, such as tare).

e S _+—IND700 in overload range.
e S _-—-IND700 in underload range.

Example

Command: SIR — Send current weight values at intervals.

Response:

e S_D_____ 129.07 _kg

e S_D_____ 129.08 _kg

e S_D_____ 129.09 _ kg

e S_D_____ 129.09 _kg

e« S_D_____ 114.87 _kg

e ...—The scale sends stable or non-stable weight values at intervals.
Comments

» SIR is overwritten and cancelled by the commands S, S, SR, and @.

e The number of weight values per second depends on the scale fype and will vary from approximately 6
(older IDNet bases) to approximately 50 (SICSpro bases).

« Weight value is in the current displayed units.

Z - ZERO
Command: Z — Zero the scale.
Response:

e Z _ A—The following then holds:
Scale is in gross mode
Zero setting performed, (stability criterion and zero sefting range complied with).
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e 7 _1-The command is understood, cannot execute the received command at this time (IND700 terminal is
currently executing another command, such as tare, or timeout as stability was not reached.)

e 7 _+— Upper limit of zero setting range exceeded.

e 7 _-—Lower limit of zero sefting range exceeded.

Example

Command: Z — Zero.

Response: Z _ A — Zero setting performed.

Comments

* If enabled in setup a tare value will be cleared during zero setting.

 The zero point defermined during switching on is not influenced by this command (the measurement ranges
remain unchanged).

« The duration of the timeout is approximately one second.

ZI - ZERO IMMEDIATELY
Commmand:
Z| - Zero the scale irrespective of stability

Response:
e ZI_D Zero setting performed under dynamic conditions

ZI_S Zero setting performed under stable conditions

e Z_| Command understood but not executiable

e Z_+ Upper limit of zero setting range exceeded

e Z_- Lower limit of zero setting range exceeded

Example

Command: ZI Zero immediately

Response: ZI_S Zero setting performed, scale was stable

Comments

e Tare memory is cleared during zero setting

* The zero point determined during switching on is not influenced by this command. i.e. the measurement
ranges remain unchanged

@ — RESET

Command: @ — Reset the scale to the condition found affer switching on, but without a zero setting being
performed.

Response: | 4 _ A _ “text” — Serial number of the scale, the scale is ready for operation.
Example

Command: @

Response: 14 _ A _“123456-6GG" — The IND700 terminal is reset and sends the serial number.
Comments

* All commands awaiting responses are canceled.

e The “reset” command is always execufed.

e Areset command received by the IND700 ferminal during the calibration and test procedure cannot be
processed.

5.3.5.7 Commands & Responses MT-SICS Level 1

The following commands of MT-SICS level 1 are available:

e D - Write to Terminal Display

e DW - Display Standard Weight Display

e K- Keyboard Monitoring

¢ SR - Send weight value on weight change (Send and Repeat)
e TA — Set tare value

e TAC — Clear fare value

e Tl —Tare Immediately
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D - WRITE TO TERMINAL DISPLAY

Command:

D D_"text” (" “ are required for proper command execution)

D “” (clears previously fransmitted text from the Data line)

Responses:

e D_A - Text appears unabridged, left-aligned in Data line just above the softkeys

e D_R-The end of the fext appears in Data line. The start of the text is cut off and marked by the symbol “*”.

e D_I—-Command is understood but cannot be executed af this fime.(the IND700 terminal is currently
execufing another command, such as tare, or fimeout as stability was nof reached.)

e D_L - Command understood, parameter wrong.

Example

Command: D_"HELLO”

Response: D_ A — “HELLO” appears in the Data line.

Note:The maximum number of characters of "text" visible in the Data line is 30. Above 30 characters,
beginning characters in the siring will be dropped represented with a “*”.
DW - DISPLAY STANDARD WEIGHT DISPLAY

Command: DW — Returns display fo previous seftings/status.
Responses:

* DW_A — Display showing previous settings/status.

e DW_I - Command understood, parameter wrong.

K - KEYBOARD MONITORING

Commands

e K_1 When a key is pressed, execute the corresponding function buf do not send the corresponding key
code

e K_2 When a key is pressed, do not execute the corresponding function and do net send the corresponding
key code

e K_3 When a key is pressed, do not execute the corresponding function but send the corresponding key
code

e K_4 When a key is pressed, execute the corresponding function and send the corresponding function code.

If the corresponding function cannot be executed immediately, the function code K_B_y for the start of the
function and K_A_y or K_|_y for the end of the function are sent

This behavior applies to taring, zeroing, calibrafing, testing, transferring, etc.
If a function cannot be executed, the function code K_I_y is sent
Responses

e K_A Command executed successfully

e K_I Command understood but not executable

» K_L Command understood buf not executable, wrong or missing parameter
Example for K_3 mode

Command K_3: Disable keyboard

K_A: K_3 mode enabled

K_C_2: Zero key pressed

K_C_4: Transfer key pressed

SR — SEND WEIGHT VALUE ON WEIGHT CHANGE (SEND AND REPEAT)

Command: SR

* SR _ PresetValue _ Unit — Send the current stable weight value and then confinuously after every weight
change greater or equal to the preset value a non-stable (dynamic) value followed by the next stable value,
range = 1d fo maximum load.

» SR —If no presef value is entered, the weight change must be af least 12.5% of the last stable weight value,
minimum = 30d.
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Response:
e S _S_ WeightValue _ Unit — Current, stable weight value. Weight change.

e S_ D _ WeightValue _ Unit — Non-stable weight value.
e S _S_ WeightValue _ Unit — Next stable weight value.

e S _|-The command is understood, the received command cannot be executed at this time (the IND700
terminal is currently executing another command, such as tare, or timeout as stability was not reached.)

¢ S _L-Command understood, parameter wrong.
e S_+—IND700 in overload range.
e S _--IND700 in underload range.

Example

Command: SR _ 0.50 _ kg — Send the current stable weight value followed by every load change > 0.50 kg.
Response:

e S_S_____ 100.00 _ kg — Scale stable.

e S_D_____ 115.23 _ kg — More than 0.50 kg loaded.

e S_S_____ 200.00 _ kg — Scale again stable.

Comments

e SR is overwriifen and cancelled by the commands S, SI, SIR, @ and hardware break.

« If, following a non-stable (dynamic) weight value, stability has not been reached within the fimeout interval,
the response “S _ 1 ” is sent and then a non-stable weight value. Timeout then starts again from the
beginning.

« The preset value must be entered in the first unit that is the weight unit displayed after the IND700 terminal
is swifched on.

T - TARE

Command: T — Tare a stable weight value

Response:

e T_S_WeightValue_Unit — Taring performed. Stability criterion and faring range comply with settings.

Current Tare weight value in current units is returned.

e T_I-Taring not performed (scale is executing another command, zero setting, or stability timeout
reached.)

e T_+— Upper limit of faring range exceeded.
e T_- — Lower limit of faring range exceeded.
Example
Command: T
Response: T _S
Comments

« The new tare weight value overwrites fare memory.

« The duration of the fimeout depends on the scale type and its seftings. If motion does not seftle within this
time, the command is aborted.

¢ Clearing tare value: See command TAC

TA — INQUIRE/ENTER TARE VALUE

Command:
e TA - Inquiry of tare weight value

« TA _Tare Preset Value _ Unit — Entry of a fare value.

Response:
e TA_A_TareWeightValue _ Unit — Current Tare weight value.

¢« TA_1-The command is understood, the received command cannot be executed af this time (the IND700
terminal is currently executing another command, such as zero setting).

¢ TA_L-Command understood, parameter wrong.

Example

Command: TA _ 10.00 _ kg — Load a preset tare of 10 kg.

Response: TA_A 10.00_k g — The IND700 accepts the 10.00 kg tare value.

100.00_kg — The IND700 accepts a tare value of 100.00 kg.
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Comments

» The existing tare will be overwritten by the preset tare weight value.

e The IND700 terminal will automatically round the inputted fare value to the current readability.
» The preset value must be entered in the current units.

TAC — CLEAR TARE VALUE
Command: TAC - Clear fare value.

Response:
e TAC _ A —Tare value cleared.
e TAC _ | —The command is undersfood, the received command cannot be executed at this time (the IND700

terminal is currently executing another command, such as zero setting, or timeout as stability was not
reached).

Tl — TARE IMMEDIATELY

Command: Tl — Tare immediafely, (store the current weight value, which can be stable or nonstable (dynamic),

as fare weight value).

Response:

e TI_S _ WeightValue _ Unit — Taring performed, stable tare value.

e TI1_D _ WeightValue _ Unit — Taring performed, non-stable (dynamic) fare value.

e TI_1-The command is understood, the received command cannot be executed at this time (the IND700
terminal is currently executing another command, such as zero setting.)

e TI|_L-The command is understood, the parameter is wrong.
e TI_+ - Upper limit of taring range exceeded.

e T1_-—Lower limit of faring range exceeded.

Example

Command: Tl — Tare.

Response: T1_D
Comments

* Any previous tare value will be overwritten by the new fare weight value.

e Even during a non-stable (dynamic) condition, a tare weight value can be determined. However, the tare
value defermined in this manner may not be accurate.

« The stored fare weight value is sent in the current units.

117.57 _ kg — The tare memory holds a non-stable (dynamic) weight value.

Commands & Responses MT-SICS Level 2

The following commands of MT-SICS level 2 are available:
* PRN — Initiate a prinfout/transfer

e R - Switch keyboard on or off

e SIH - Send net weight value in high resolution immediately

» SIRU — Send weight value with currently-displayed unit immediately, and repeat

SIS — Inquiry of the current net information with the currently-displayed unit and with status information
e SIU - Send weight value with currently-displayed weight immediately

*  SRU - Send weight value with currently-displayed unit on weight channel (send and repeat)
e ST — Send stable weight value after pressing transfer key

e SU - Send stable weight value with currently-displayed unit

e SV — Send stable net weight value

e SVI—Send net weight value immediafely

e SVIR — Send net weight value immediately and repeat

e SWU — Switch display unit

e SX - Send stable weight data

e SXI - Send weight dafa immediately

e U - Switch units
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PRN - INITIATE A PRINTOUT/TRANSFER

Command: PRN

Responses:

e PRN_A: Command executed successfully

e PRN_I: Command undersfood but not executable

Example

Command: PRN: Initiate printout/transfer

Response: PRN_A: Command executed successfully

Comments

« A printer must be correctly connected to an inferface, or a transfer destfinafion defined in sefup
« The printout can be configured in the Communication menu

» The PRN command has the same effect as the TRANSFER key 11

R - SWITCH KEYPAD ON OR OFF

Command: R

¢ RO — Swifch on IND700 keypad.

e RT - Switch off IND700 keypad.

Responses:

e RO _ A - Keypad enabled

¢ RT _A- Keypad disabled

Example

Command: R1 — Disable ferminal keypad and keyboard.
Response: R1 _ A — Keypad and keyboard disabled.
Comments

e By default and affer power-up the keypad is always enabled
* When the keypad is disabled, the terminal cannot be manually operated

SIH — SEND NET WEIGHT VALUE IN HIGH RESOLUTION IMMEDIATELY

Command: SIH

Responses:

e H_S_Weight value_unit: Stable net weight in high-resolution and in the unit currently set as Unit 1
e H_D_Weight value_unit: Dynamic net weight in high-resolution and in the unit currently set as Unit 1
e H_I: Command undersfood but not executable

e H_+: Scale in overload range

¢ H_-: Scale in underload raange

Example

Command: SIH

Respond: H_.S__ 1.99982 kg -- current net weight in high resolution is 1.99982 kg and stable
Comments

 Like SI command

e High resolution dafa i.e. highest possible resolution of the connected scale

SIRU — SEND WEIGHT VALUE WITH CURRENTLY-DISPLAYED UNIT IMMEDIATELY, AND REPEAT

Command: SIRU - like the [SIR command » Page 327], but send the weight value immediately with the
currently displayed unit, and repeat

Responses:

e S_S_Weight value_Unit: Current stable weigth in currently-displayed unit
S_D_Weight value_Unit: Dynamic (unstable) weight in currently-displayed unit
e S_I: Command understood but not executable

e S_+: Scale in overload range

e S_-: Scale in underload range
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SIS — INQUIRY OF THE CURRENT NET INFORMATION WITH THE CURRENTLY-DISPLAYED UNIT AND
WITH STATUS INFORMATION

Command:
Responses:

e SIS_A_Status_"Value"_Unit_Dec_Step_App_Info

Status -

SIS

refer to fable below

Value - net weight value
Unit - refer to table below
Dec - number of decimal places
Step - Display step
App - refer to table below
Info - refer to fable below
e S_I: Command understood but not executable

Status Information

Stable weight value

Dynamic weight value

Stable value below MinWeigh

Dynamic value below MinWeigh

Overload

Underload

oo wWwiN—= O
1l

Error, invalid

Unit Information

0 = g

1 = kg

2 = t

7 = Ib

8 = 0z

9 = Ib-0z

Approval State Information

0 = |Nof approved
1 = Approved, e=d
2 = |Approved, e=10d

Weight Information

Without fare

Net with weighed tare

Net with preset tare

Example
Command:

SIS

not approved, without tare

SIU — SEND WEIGHT VALUE WITH CURRENTLY-DISPLAYED WEIGHT IMMEDIATELY

Command:
Responses:

e S_S_Weight value_Unit: Current stable weight value in the currently-displayed unit
e S_D_Weight value_Unit: Dynamic (unstable) weight value in the currently-displayed unit

SIU

e S_I: Command understood but not executable

*« S +:Sc

ale in overload range
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e S_-: Scale in underload range

Example

Command: SIU

Response: S_.D__ 129.07_IborS_S 129.11_Ib-- The scale sends stable or unstable weight conti-
nously in the currently-displayed unit

SRU — SEND WEIGHT VALUE WITH CURRENTLY-DISPLAYED UNIT ON WEIGHT CHANNEL (SEND AND
REPEAT)

Inquiry Command: SRU_Preset value_Unit

Responses:

e S_S_Weight value_Unit: Current stable weight in the unit currently set as Unit 1
-- weight change --

S_D_Weight value_Unit: Dynamic (unstable) weight in the unit currently set as Unit 1
-- sfable --

S_S_Weight value_Unit: Next stable weight in the unit currently set for Unit 1

e S_I: Command understood but not executable

¢ S_L: Command understood but not executable, wrong or missing parameter

e S_+: Scale in overload range

e S_-: Scale in underload range

ST — SEND STABLE WEIGHT VALUE AFTER PRESSING TRANSFER KEY
Inquiry Command: ST

Responses:

e STAX

x = | Function inactive; do not send weight value when transfer key is pressed

0

x = | Function active until restart of the scale or the restart command is sent; weight will be sent when transfer
1 key is pressed

x = |Function permanently active, even after device is restarted; weight will be sent when fransfer key is

2 pressed

e ST_I: Command understood but not executable

Setting Command: ST_X, where x is as for response above
Response: ST_A -- Command executed successfully
Example

Command: ST_T -- Activate ST function

Response:
e ST_A -- ST function activated

-- Transfer key pressed --
e S. S 123.456_g -- current net weight is 123.456 ¢
Comments
¢ ST_0is the default seffing (function inactive)
 The duration of the fimeout depends on the scale type

SU — SEND STABLE WEIGHT VALUE WITH CURRENTLY-DISPLAYED UNIT

Command: SU -- like the [S command » Page 327], but send the current stable weight value with the
currently-displayed uniit

Responses:

e S_S_Weight value_Unit: Current stable weight value in currently-displayed unit
¢ S_I: Command understood buf not executable

e S_+: Scale in overload range

e S_-: Scale in underload range

Example

Command: SU
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Response: S_S 100.00_g -- the current stable weight value is 100.00 g

Comment
» The duration of the fimeout depends on the scale type

SV — SEND STABLE NET WEIGHT VALUE
Command: SV

Responses:
e SV_Weight value_Unit___HR value, where Weight value = net weight value, HR value = High resolution
net weight value

e SV_I: Command undersfood but not executable

e SV_+: Scale in overload range

e SV_-: Scale in underload range

Example

Commannd: SV

Response: SV 1.995_kg 1.9972 -- stable net weight is 1.995 kg, stable high resolution
weight is 1.9972 kgh

SVI — SEND NET WEIGHT VALUE IMMEDIATELY

Command: SVl

Responses:
e SV_Weight value_Unit___HR Value -- stable weight

e SVD_Weight value_Unit_D_HR value -- dynamic (unstable) weight
D: D if weight value dynamic, blank if stable
Weight value: Net weight value
HR value: High resolution net weight value

e SV_I: Command understood but not execufable

e SV_+: Scale in overload range

e SV_-: Scale in underload range

SVIR — SEND NET WEIGHT VALUE IMMEDIATELY AND REPEAT
Command: SVIR

Responses:
e SV__Weight value_Unit___HR Value

e SVD_Weight value_Unit_D_HR Value
D: D if dynamic weight, blank if stable
Weight value: Nef weight value
HR value: High resolution net weight value
e SV_I: Command understood but not execufable
e SV_+: Scale in overload range
e SV_-: Scale in underload range
Example
Command: SVIR
Response: SVD____ 0.826_kg___ D___ 0.8263
Respons: SV 0.876_kg 0.8764

Comment
 SVIR is overwriften, and hence cancelled, by all send commands and hardware breaks

SWU — SWITCH DISPLAY UNIT

Command: SWU -- switch to next display unit
Responses:

e SWU_A: Command executed successfully

e SWU_I: Command understood but not execufable
Comments
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The available units depend on
« The setting of unit 1, Unit 2 and Unit roll (On/Off)
¢ The approval status of the scale

SX - SEND STABLE WEIGHT DATA
Command: SX — Send the current stable weighing data.
Responses:

o SX_S_x1_y__x2_y__x3_y- Stable weight data where x1 = G _ GrossWeight, x2 = N _
NetWeight, x3 = T _ TareWeight, y = WeightUnits.

e SX _ |- Command not performed (scale is executing another command, zero sefting, or stability fimeout
reached).

e SX _ +—Scale in overload range. SX _ - — Scale in underload range.

Example

Command: SX — Send stable weight data.

Response: SX_S_G 15620 _kg _ _ _N______
kg_ — The current, stable gross, net and tare weight data is sent.

Comments

« The duration of the fimeout depends on the scale type and its seftings. If motion does not seftle within this
time, the command is aborted.

e The weight values are in the current displayed units.

SXI - SEND WEIGHT DATA IMMEDIATELY
Command: SXI — Send the current weighing data immediately regardless of scale stability.
Responses:

o SX_S_x1_y__x2_y__x3_y-_Current stable weight data where x1 = G _ GrossWeight, x2 = N _
NetWeight, x3 = T _ TareWeight, y = WeightUnits.

e SX_D_x1_y__x2_y__x3_y-_Current unstable weight data where x1 = G _ GrossWeight, x2 = N
_ NetWeight, x3 = T _ TareWeight, y = WeightUnits.

e SX_I—Command not performed (scale is executing another command).
e SX_ +—Scale in overload range.

e SX_-—Scale in underload range.

Example

Command: SXI — Send the current weighing data immediately.

Responses:

e SX_S_G6G______ 22220 _kg _ __N______ 22220 _kg _ _ _T__ _ _______ 0_kg_-
The current, stable gross, net and tare weight data is sent.

e SX_D_G______ 2520 _ton__N______ 2520 _ton_ _T______ 0.000_ton —The
current, unstable dynamic gross, nef and tare weight data is sent.

Comments

« The response to the command SXI is the last internal weight value (stable or dynamic) before receipt of the
command SXI.

e Weight value is in the current displayed units.

U - SWITCH UNITS

Command:

¢ U Switch fo main primary units

« U_Unit Switch fo specified units

Responses

e U _A-Units switched

e U _I-Command not performed (incorrect units specified)

Comments

« Units switching is limited to the current seftings for the primary and secondary units
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5.3.5.9 Commands & Responses MT-SICS Level 3

IND700

The following commands of MT-SICS level 3 are available:
* AMR - Readout Alibi data
* AR - Read Shared Data file
e AW - Write Shared Data file
e DY - Specify SmarTrac target value
[11 - Inquiry of model designation
e |14 - Inquiry/setting of ID3
* SNS - Inquiry/setting of the active scale
e STA — Preset tare weight value in the defined unit
e UPD - Update rate of host inferface

AMR - READOUT OF ALIBIT MEMORY DATA
Command: AMR_OPT

OPT definitions:

All Send all Alibi dafa

First Send the first (oldest) Alibi record

Last Send the last (newest) Alibi record

ID_x Send Alibi record number x

ID_x_y Send Alibi records numbers x fo y
DT_DD/MM/YYY Send alibi records from date DD/MM/YYY
SEP_x Define data separator (factory setting: “;*)
Responses:

*  AMR_A Command executed successfully
e AMR_I: Command understood but not executable

AR — READ SHARED DATA FIELD

Command: AR _ SDName — Read a specific shared data field.

Responses:

* AR _ A _ SDValue — Shared data field value returned (Content format is dependent on the shared data field
fype)

e AR _ | - Command not performed (invalid shared data field)

Example

Command: AR _wt0101 — Read displayed gross weight for scale 1.

Response: AR _A_ " _ 12.180" — The displayed gross weight value is returned.

Command: AR _ wx0131 — Read scale 1 motion status.

Response: AR _ A _ 0 — Scale 1 motion status returned.

Comments
» SDName is the shared data field name with a length of six A/N characters.

e String type SDValue fields returned are surrounded by quofe marks
» Array type SDValue fields are returned as a series of values separated by spaces
e Composite variables of the entire shared data block are not supported.

AW - WRITE SHARED DATA FIELD
Command: AW_SDName_SDValue - write to a specific shared data field

Responses:
* AW _ A — Written successfully to shared data field.

* AW _ | - Invalid shared data field.
e AW _ L — Shared data field cannot be wriften.
Example
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Command: AW _ wcO101 _ T — Pushbutton tare for scale 1.

Response: AW _ A —Scale 1 pushbutton tared.

Command: AW _aw0101 _ “HELLO” — Write the fext HELLO fo message table ID 1.
Response: AW _ A — HELLO is wriften into the message table ID 1.

Comments

e SDName is the shared data field name with a length of six A/N characters.

 String type SDValue fields have to be surrounded by quote marks.

« Array type SDValue fields have fo be formatted as a series of values separated by spaces.
e Composite variables of the entire shared data block are not supported.

e Only operator and supervisor level access SDName fields can be writfen fo.

DY - SPECIFY SMARTRAC TARGET VALUE

e DY _ TargetWeight _ Unit _ LowTol _ Unit _ HighTol _ Unit — Specify the active target and tolerance values
in weight units.

e DY _ TargetWeight _ Unit _ Tol _ % — Specify the active farget and percentage tolerance values.
e DY - Clear the active target and tolerance values fo zero.

Responses:

e DY _ A-Target and folerance values are set.

¢ DY _I-Command not performed (specified units are not valid).

Example

Command: DY _ 150 _Ib_ 12 _Ib_ 10 _ Ib — Set target = 150 Ib, low tolerance = 12 Ib and high tolerance
=10 Ib.

Response: DY _ A — Target and tolerance values are sef for the scale.

Command: DY _ 100 _kg _ 10 _ % — Set target = 100 kg and low / high tolerance =10 % of farget.
Response: DY _ A — Target and tolerance values are sef for the scale.

Comments:

« Weight units can only be specified in the primary or secondary units for the scale. Tolerance weight units
must match the farget weight units.

* % folerance can be entered provided it is enabled in SETUP as the appropriate target folerance fype.
 Target and tolerance entries must match displayed increment sizes.

111 - INQUIRY MODEL DESIGNATION

Command: 1T Inquiry of model designation of the weighing ferminal
Responses:

o |T1_A_"fext” Text represents the model designation

* |11_I The model designation cannot be transferred at present as another operation is faking place.
Example

Command: 11

Response:IT0_A_“IND700"

Comments

* The scale can display the device name

« The device name has a max. length of 40 characters

¢ The device name cannot be changed

114 - INQUIRY/SETTING OF IDENTIFICATION ID3
Command: 114 Inquiry of Identification 3

Response: IT4_A_"text” Text specified Identification 3
Sefting

Command: 114 _"text” Set the text for ID3

Responses:

e |T4_A: Identification 3 has been set
 I|dentification 3 cannot be set af present

* |denfification 3 is too long, or wrong parameter
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Comments
» The scale can display, transfer and print the identifications.
e Up to 40 characters can be entered

SNS - INQUIRY/SETTING OF THE ACTIVE SCALE
Inquiry Command: SNS

Inquiry Responses:

e SNS_x: x = active scale

e SNS_I: Command understood but not executable
Setting Command: SNS_x

e SNS_x: Sefs x as the acfive scale

Setting Responses

e SNS_A: Command executed successfully

e SNS_I: Command understood but not executable
e SNS_L_Command understood but not executable - wrong or missing parameter

STA - PRESET TARE WEIGHT VALUE IN THE DEFINED UNIT

Command

e STA_Weigh value_Unit: Presets a fare value in the defined unit

Responses:

e STA-A_Weight_value_Unit: Current tare weight value in the unit currently set under Unit 1
e STA_L: Command understood but not executable; reemote scale active or average weighing inactive
e STA_I: Comman undersfood but nof executable

Example

Command: STA_100.00_g -- sets a tare value of 100.00 grams

Response: STA_A_____100.00_g -- the scale has 100.00g in the tare memory
Comments

» The tare memory will be overwritten by the preset fare weight

e The input tare value will be aufomatically rounded by the scale fo its current readability
» If no unit is entered, the currently displayed unit will be used

 The taring range is specific fo the scale type

UPD - UPDATE RATE OF HOST INTERFACE

Command: UPD Query the host interface update rate

UPDD_<rate> Set the update rate

e UPD_A_<rate> Current host update rate

e UPD_I Command understood but not currently execufable (balance is currently executing another
command)

e UPD_L Command understood but not executable (incorrect parameter, efc.)

5.3.6 Remote Discrete 1/0 (ARM100)

The IND700 provides the ability fo expand its discrete input and output control options to include up to eight
ARM100 devices. This ability is required when more inputs and outputs are needed than are natively supported
by the IND700 mainboard and option boards. Depending on the application, it may be beneficial to have all
the 1/0 external to the terminal.

The communication link from the IND700 terminal to an ARM100 remote discrefe I/O module is an RTU-based
RS-485 communication protocol. During power-up, if remote discrete I/0 has been enabled communication
will be established between the IND700 and the remote modules. Any communication errors will be indicated
in the message box on the IND700 home screen.

This communication uses both the input and output portions of the port, so it cannot be shared with any other
connections. When "Remofe Discrete 1/0" is selected as the assignment for COM1 or COMX, the communication
paramefers are set autfomatically by the ferminal and cannot be changed from the front panel - they can only be
viewed.

The parameters include:

e Baud Rate: 115200
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¢ Data bits: 8

e Parity: Even

e Stop bits: 1

¢ Flow Control: None
¢ Interface: RS-485

After the ARM100 modules are wired per the defails in the ARM100 Installation Guide and the assignment is
programmed af Communication > Connections, the remote modules will be operational. When assigning
functions fo the remote discrete I/0 locations, the remote modules are addressed by 1.0.x for module #1, 2.0.x
for module #2, and so on. Each module provides four inputs and six dry-contact relay outputs.

For defails on ARM100 configuration in the IND700, refer to [ARM100 Inferface Configuration » Page 213].

Example
Tare assigned to discrete 1/0 input addresses 1.0.1.
This indicafes that when input #1 is furned on in the remote module #1, a tare will be taken.

ASCII Input

A bar code scanner or other ASCII device can be connected to a port in the IND700, and used as an input
device to enter ASCII data, using an ASCII Input connection type. When this input type is selected, the
assignment for the data received must also be specified at Communication > Templates > Input. Available
assignments include:

e IDI

e Keypad

e Tare

e TarelD

e Target ID

e Filling Material ID for Filling & Drum Filling
e Active Target.

As part of the programming for using the ASCII input, an input femplate must be configured. The template
feature permits removal of a preamble (preceeding characters) and a postamble (irailing characters) that are
not part of the desired data. Using these parameters in the setup of the input template, the number of characters
to be ignored before and affer the data are programmed. These must be the same for each data input string that
the IND700 receives.

An inpuf will be terminated after the receipt of the programmable “Termination Character” or a 1 second timeout

of no new characters received. At this fime, any input data that has been collected will be applied to the

assignment that has been selected. This could be an actual value such as a preset tare value or a response for

IDs, or it could initiate a look-up into the tare or target table by selecting Tare ID or Target ID.

The following notes apply fo how the ASCII input is handled through the input template:

« The Preamble Length selects how many characters should be skipped at the beginning of an input string
before the desired dafa.

¢ Data Length defines the maximum length of a string. All characters beginning affer the Preamble through the
Length selection will be used as the input.

¢ The Postamble length is the number of characters (before the Termination Character) that will be stripped off
the dafa stfring. All other dafa from the Preamble Length to the Termination Character minus the Postamble
Length will be used as the inpuf string. When using an input that is always the same fixed length, this field
would remain blank.

« The Termination Character is used to signal the end of the string input. It can be any ASCII control character.
If “None” is selected, the timeout feature will terminate the entry.

e Thereis also a 1 second fimeout feafure that fracks the amount of time between characters. If this 1 second
time is exceeded, the string will also be considered terminafed.

Example
Preamble of 2, Data length of 5, Postamble of O, Termination Character of <CR>, Input assignment of Tare.
Data received is: <STX>P001.5 kg<CR>

The preamble of 2 removes the <STX> and P characters. The next 5 characters of 001.5 are the actual data.
The postamble is set to O because the datfa field has already been filled so no characters have fo be removed.
The <CR> ferminates the input.
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This string would input 1.5 as a preset fare fo the IND700.

This same data could be obtained by programming a Preamble of 2, Data length of 8, Postamble of 3, Termi-
nation Character of <CR>. The Postamble length of 3 would remove the <space>kg from the data field since
they are the last 3 characters received in front of the <CR>.

Shared Data Access

All setup parameters, triggers and stafuses in the IND700 are stored and routed through Shared Data variables.

This is a system of memory mapping that permits remofe clients to send commands and receive dafa from the
terminal. In order to access the shared data variables in the IND700, a remote client must login to the Shared
Data Server. Access is provided through either the COM1 serial port or through the Ethernet port. Regardless of
the method used, the same access is provided and the login procedure is very similar. Up to 25 Shared Data
Server logins are supporfed by the IND700 -- a single connection using a serial interface, and multiple
connections using a TCP/IP Ethernet inferface .

Note that the Shared Data server does not support serial RS485 or USB connectivity.

Server connections are configured in setup at [Communication Sefup > Connections » Page 215], by selecting
SharedData as the connection's Assignment.

Shared Data Name Structure

Each SD variable includes a class, an instance and an affribute, and uses the following structure:

e Class: Example -- wt (dynamic scale weight)

e Instance: Example -- 01 (scale #1)

e Afiribute: Example -- 02 (Displayed Net Weight)

Mulfiple instances are indicated by dashes in place of the instance number -- for example, wi--02.

Shared Data Types
SD variables may take any of the following forms (where nn indicates the length of an array):

Shared Data Types

Label Data Type Description

2] Boolean Boolean fields are one-byte
integers, buf can only have values
ofOorl

By Byte One-byte integer

us Unsigned Short Two-byfe unsigned integer (double)

uL Unsigned Long Four-byte unsigned infeger (word)

F Float Single-precision floating point

D Double Double-precision floating point

ABy nn1 Array of Bytes Array of one-byte integers

ABI nn1 Array of Booleans Array of one-byte integers used asa
Boolean

S mm2 String A Unicode String, NULL ferminated.
Array of two-byte unsigned integers
(doubles)

AL nn1 Array of Longs Array of four-byte unsigned integers
(words)

Struct Structure Composite structure of the entire
block (multiple data types together)

For further detail on Shared Data variables and structures, refer to the IND700 Shared Data Reference,

30753890.

Commonly Used Shared Data Variables

This section lists Shared Data Variables most commonly used with the IND700 in its base configuration. For a
lisit of additional,. application-specific variables, refer to the IND700 ProWorks Multi-Tools User's Manual

(30753893).
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Share Data Variables in On-Screen Display

The Tare Table image below and the following fable illustrate the relationship between data in the terminal and

the corresponding Shared Data Variables.

1 2

Tare Table

3

Description

Unit Low Limit

Small blue

Sugar container

kg

Hopper 2

Water vessel 3
Within range tare
CB0O1

Figure 479: Data in Tare Table

Flour container

Small cardboard box

kg
kg
kg
kg

Example of Tare Table Elements Represented by Shared Data

Shared Data Name Shared Data Variable
1 Tare ID ws0027
2 Tare name ws0028
3 Tare description ws0029

Terminal Identification Shared Data
Terminal Identification Shared Data

xs0105 Terminal Serial Number
xs0106 Terminal ID1

xs0107 Terminal ID2

xs0108 Terminal ID3

xd0103 Current Date

xd0104 Time of Day

xs0103 Software ID

xp0101 Transaction counter
Scales Shared Data

wi0101 Gross weight, Scale 1
wi0102 Net weight, Scale 1
wt0103 Display Unit, Scale 1
ws0102 Tare value, Scale 1
wi0201 Gross weight, Scale 2
wit0202 Net weight, Scale 2
wt0203 Display Unit, Scale 2

IND700




IND700

ws0202 Tare value, Scale 2
wi0501 Gross weight, Sum Scale
wi0502 Net weight, Sum Scale
wi0503 Display Unit, sum Scale

ID Form Shared Data

When ID Form fields are configured, Shared Data variables are available both for the configuration of fields, and

for information added fo the fields.

ID Form

Name Status

Numeric Only

Preserve Prev. Value

Disabled
Enabled

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Lot Enabled
Enabled
Enabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Vendor
Order

Ident D
Ident E
Ident F
Ident G
Ident H
Ident1
Ident |

Figure 480: ID Form Configured with Three Data Fields

Enabled

Enabled

Enabled

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Each ID Form prompt has a Shared Data Variable associated with it:

prO131 Lott

pr0132 Vendor

pr0133 Order

prO134 ID Form 04 prompt
prO135 ID Form 05 prompt
pr0136 ID Form 06 prompt
prO137 ID Form O7 prompt
prO138 ID Form 08 prompt
pr0139 ID Form 09 prompt
prO14- ID Form 10 prompt
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When the ID Form is configured as shown above, fouching the ID from softkey [ will display all enabled fields.

ID Form

Lot

MAT-0OIL-7222

Vendor

3

Order

OR-2023-0921

Figure 481: ID Form, Three Fields Enabled

Information entered into the ID Form
Each field of information has a Shared Data Variable associated with it:

pa0101 MAT-0IL-7222

pa0101 3

pa0103 OR-2023-0921

pa0102 ID Form 04 response

pa0105 ID Form 05 response

pa0106 ID Form 06 response

pa0107 ID Form O7 response

pa0108 ID Form 08 response

pa0109 ID Form 09 response

pa0110 ID Form 10 response

DIO Shared Data

I/0 Pins Mainboard Scale 1 Scale 2
Input 1 dioo01 dio101 di0201
Input 2 dio002 dio102 di0202
Output 1 di0005 di0105 di0205
Output 2 di0006 di0106 di0206
Ethernet

The IND700 Ethernet port provides a 1000 Base-T connection for connection fo an Ethernet network. The
Ethernet port can be used for the following functions:

e Shared data access (described previously)
e Demand output

e Continuous output

e FTP

¢ Sending calibrafion alert emails

¢ Web Server access
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Ethernet communication is configured in sefup af [Communication > Ethernet » Page 209].

Ethernet Connection to A PC

The IND700 Ethernet port provides a way to interface a PC to the IND700 to download and upload files and
configuration information. To use the Ethernet port to fransfer templates or Shared Data, a properly configured
[Connection » Page 215] is necessary.

Ethernet Demand Output

If a demand output connection to Ethernet is made in the connections section of setup, a remote device may
“register” to receive the data through the Ethernet port. In order to do this, the remofe device must login fo the
shared data server and send the command to register for the data. The login can be any valid username and
password for the terminal.

When a user logs into the shared datfa server, he or she acquires the level of access for the username and
password used. All levels of users can receive a demand string.

If a demand output connection to EPrint is made in the Connections section of sefup, a remote device is not
required fo “register” with the Shared Data Server to receive the data through the Ethernet port. The data string
simply contains the assigned femplate’s information. The EPrint connection is made via the secondary TCP/IP
port at the user-defined port number (set up af Communication>Network>Port).

Register for the Demand Output

The “printout” command allows the client to define a Demand Print Stream as a callback field. The Demand
Print Streams include demand print (triggered by the scale) and custom triggers (friggers 1, 2, and 3). The

console print server sends a message to the client at each print output. Since print messages can span multiple

message blocks (depending upon size), the start of the print message has a <dprint> tag and the end of the
message has a </dprint > tag. After registering for the demand output, the client will receive the appropriafe
data stream. The “ctimer” command specifies the minimum time between repeafed callback messages. The
“xprinfout” command removes the registration from the terminal and the communication will stop.

The “xgroup all” command will also terminate any demand output registrations.
Sequence Example 1

1 Enfer the menu free of setup.

2 In the Connections sub-branch of the Communications branch of setup, create a connection for Demand
Output assignment to the Ethernet port triggered by Scale using Template 2.

3 Ensure that the IP and Gateway addresses are programmed properly.
Login to the shared dafa server from the client, (see “user” command in the Shared Data Server section).
5 Register to receive the demand data by enfering the “printout 1 command.

= The IND700 will acknowledge the registration with a message [00Gxxx~number PRINTOUT
streams=1]. Now, whenever a demand print is generated, the Template 2 data will be senf to the client.
00P004 <dprint>Scale 1
01:33:10
06/Sep/2005
17.08 Ib
17.08Ib T
0.00Ib N
</dprint>

The “xprintout” command allows the client to remove the print oufput callback registration thus stopping the
demand output.

o~

Sequence Example 2

1 Enfer the menu free of setup.

2 In the Connections sub-branch of the Communications branch of setup, create a connection for Demand
Output assignment to the Ethernet port triggered by Trigger 1 using Template 1.

3 Ensure that the IP and Gateway addresses are programmed properly.
4 Login to the shared data server from the client, (see “user” command in the Shared Data Server section).
5 Register to receive the demand dafa by enfering the “printout 1” command.
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= The IND700 will acknowledge the registrafion with a message [00Gxxx~number PRINTOUT
streams=1]. Now, whenever the custom trigger is initiated (by a programmed discrete input or Industrial
Network command), the Template 1 data will be sent to the client.
00PO04 <dprint> 17.08 Ib
17.081b T
0.00Ib N
</dprint>

The “xprintout” command allows the client to remove the print oufput callback registration thus stopping the
demand output.

Ethernet Continuous Output

If a confinuous outpuf type of connection fo Eprint is made in the connections section of setup, a remote device
is not required “register” with the Shared Data server, to receive dafa through the Ethernet port. The dafa string
simply contains the assigned continuous output or template information. The Eprint connection is made via the
secondary TCP/IP port at the user-defined secondary port number (configured in setup at Communication >
Network > Port).

If a continuous output or continuous template output connection to Ethernet is made in the connections section
of setup, a remote device may “register” fo receive the data through the Ethernet port. In order fo do this, the
remofe device must login fo the shared data server and send the command fo “register” for the data. The login
can be any valid username and password for the terminal.

When a user logs onfo the shared datfa server, they acquire the level of access for the username and password
used. All levels of users can receive a confinuous string.

Register for the Continuous Output

The “contout” command allows the client to define the confinuous output string as a callback field. The Console
Print Server sends a message to the client at each confinuous output. The continuous oufput message is either
in the Standard METTLER TOLEDO Confinuous Output format or in a confinuous femplate format. The “ctimer”
command specifies the minimum time between repeated callback messages. The “xcontout” command
removes the registration from the terminal and the communication will stop.

The “xgroup all” command will also terminafe any continuous output registrations.
Sequence Example

1 Enfer the menu free of setup.

2 In the Connections sub-branch of the Communications branch of setup, creafe a connection for Confinuous
Output assignment to the Ethernet port triggered by Scale.

3 Ensure that the IP and Gateway addresses are programmed properly.
4 Login to the shared data server from the client, (see “user” command in the Shared Data Server section).
5 Register to receive the confinuous data by entering the “contout” command.

= The IND700 will acknowledge the registration with a message [00Gxxx~number CONTOUT streams=1].
NQW, whenever a confinuous output siring is generated by the IND700, the data will be sent to the
500148 141364 236
800149 141354 236
30C150 141354 236
>

00C151 14! 354 236

The “xconfout” command allows the client to remove the continuous oufput callback registration thus stopping
the continuous output.

The output rate of a Confinuous type output over Ethernet is 20Hz by default. This rate cannot be modified
through the terminal setup menu. However, the output rafe can be modified by a Shared Data write fo a field in
the “cs” block of Shared Data. Please refer to the IND700 Shared Data Reference for specifics.

File Transfer

The IND700 can transfer files using a PC tool such as VNC, or an FTP (file transfer protocol) client. The VNC
method simplifies the process, because the VNC's File Transfer function permits the user to browse to the
appropriate folder on the IND700 and select the required file/s from a list.
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FTP Method

To access files in the IND700 via ftp, the client must login to the FTP server. Valid usernames and passwords
are entered as configured in setup at [Terminal > Users » Page 1907, and each username is assigned an
access level. All access levels can read files but only maintenance and administrator levels can write new files
to the ferminal. Refer fo [Terminal > Security Opfions » Page 200] to enable the FTP or sFTP server ports.

 fget (Shared Datfa server) or get (FTP) — All files can be read using this command.
e fput (Shared Data server) or put (FTP) — Only certain files can be downloaded back to the IND700 terminal.

VNC Method

VNC or an equivalent tool must be installed on a PC accessible to the IND700, and Remote Desktop Servet
enabled in the ferminal in setup at [Terminal > Security Options » Page 200].

With the terminal connected, click the file fransfer icon in the VNC fool menu bar, indicafed in the image below:

{  Table Data Export

Figure 482: VNC File Transfer Icon

When the file transfer icon is clicked, the transfer screen will display, with the local PC's contents displayed on
the left, the ferminal's on the right. In the image below, the folder containing the exported files has been
accessed, but the PC contents appear in their default state.

B File Transfer with < win-muupihfgden ( 192.168.86.213 ) - application mode > - UltraVNC - O X
~ LOCAL MACHINE V. [C:] - Local Disk w | REMCTE MACHINE A
C:\Export|63569416D7Y
Mame Size Madified Name Size Modified
wC] Local Disk IUVMNCDIR-69569416D2Z zip 862 bytes 02/09/2024 11:17
[ Desktop ] 4r.1 Falder
C[ My Documents ] IND7O0_2024_02_09_08L.. 184bytes  02/09/2024 11:14
[ Network Favorites ] IND700_2024_02_09_081... 184bytes  02/09/2024 11:17
e (] Metwork IND700_2024_02_15_071... 115bytes 02/15/2024 10:14
g [] Metwark
e [1:] Metwork 2= 2
<< Receive
Delete -=
Mew Folder -=
Rename -=
!
Minimize
Close

Forced Close = 5 File(s)Folder (s}

History > 02f15/24 10:26:43 - Connected... i

Progress

Connected...

Figure 483: VNC File Transfer Screen

Browse fo an appropriate location on the host PC, and click the <<Receive button at center.
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Exported File Names and Paths
The following list indicates the path for exportable files.

 File Names: All fable file names have the form IND700_YYYY_MM_DD_HHMM. The content type is added at
the end of this standard name.

« The contents of each exported file may include the entire set of table records, or a [filtered » Page 48] sub-
set.

¢ Exported files can be formatted either as comma-separated values (.csv) or XML (.xml)

File Name File Path File Content
_Alibi.csv or xml C:\Exporf\[Terminal Serial Records from [Alibi Table » Page 172]
Number]

_Maferial.csv or xml Records from Material Table (refer fo the ProWorks

Multi-Tools User's Manual for details)
_Tare.csv or xml Records from the [Tare Table » Page 172]
_Transaction.csv or xml Records from the [Transaction Table » Page 173]
_Changelog Records from the [Change Log » Page 246]
_ErrorLog Records from the [Error Log » Page 248]
IND700_[Terminal Serial  C:\Backup A [backup » Page 2517 of the terminal's configu-
Number]_YYY_MM_DD- ration, current at the date and time indicated in the
HHMM.mtbak filename.

File imports can be performed in the same way, for the following files types and at the listed IND700 C:\
locations:

File suffix File Path File Types

.mot C:\ToUpdate An update file for the scale interface's firmware

(Various) C:\Service Updates for Windows OS files; ProWorks licensing;
script file

.csv or .xml C:\Import Table and log files kept on a host PC

.mtbak C:\Backup Saved terminal configuration

FTP Example

The example describes how to upload the fare fable to a PC running Microsoft Windows, modify the file, and
then download it again fo the terminal.

The following procedures assume that the user has:

¢ A valid username and password for the IND700 terminal.

¢ The IP address of the IND700.

« Avalid network connection established between the client and the ferminal. Refer fo Ethernet Connection to
A PC.

Making the Connection

1. Open the command prompt window in the client PC and type ftp.

2. Press enter. The command line will show ftp>.

3. To open the FTP connection, fype open XXX.XXX.XXX.XXX nnan, where the XXX.XXX.XXX.XXX represents the
IP address of the IND700 terminal and nnnn represents the port number.

4. Press ENTER. The display will indicate that the service is ready and prompts for the user name.

5. Enfer a valid user name for the IND700. If the name is valid, the display will prompt for the password
associafed with that user.

6. Enter the password and press ENTER.
7. If the password is valid, the prompt line will display ftp>.

Copying files Via FTP

Use the following procedure to transfer files to and from the IND700 using fip. Not that by default files will be
copied to the folder location shown in the ftp prompt line.
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IND700

To download a file from the IND700:
1. Enter the command get filename.nnn, using the desired file name with its correct extension.
2. Press ENTER.

3. The file will be copied from the IND700 and the system will indicate that the command was executed
succesfully.

To upload a file fo the IND700:
1. Enter the command put filename.nnn, using the desired file name with its correct extension.
2. Press ENTER.

3. The file will be copied to the IND700 and the system will indicate that the command was executed
successfully.

File Transfer Using Other Software

Files can also be transferred via Ethernet between a host PC and an IND700 using a utility such as VNCViewer.

The file transfer feature will display an intuitive browser application, in which file locations can be found, and
one or more files selected and copied to or from the IND700.

@ vin-dimtfestgmé ( 192.168.86.34 ) - application mode — O ¥
192.168.86.34

12:05
25.5ep.2023

[
KR 2 Max 60 kgd=20g
3 . 9 8 kg
|
Material ID Material Name Start Thresh. Under Tol. Low Tol. High Tol.
Over Tol. Lot Vendor Order

[&)

ransaction Tabl

Figure 484: File Transfer Utility in VNCViewer

A%

Switch Scale

(3

Switch Units

Tare Table

A

Alibi Memory

Higher Res.

ID Form

@

Target
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When the file icon is clicked, a fransfer window will display on the PC.

B File Transfer with < win-d1mtfe5tgmé ( 192.168.86.34 ) - application mode > - UltraWNC — m}
| g
[€:] - Local Disk v || LOCAL MACHIME \ - ~ REMOTE MACHINE \
C:\Users\Halliday-1\Documents\IND700VF TP Test},
Mame Size Modified Mame Size Modified
D[ o] Folder ] Local Disk
FTP test. bt 0 bytes 09/25/2023 11:41 £ [Desktop]
L[ My Documents |
D [ Metwork Favorites |
Send =
<= Receive
Delete
New Folder
Rename
Minimize
Close
= 3 File(s)/Folder(s) Forced Close
History > 09/25/23 11:52:59 - Connected... i
Progress
Connected...

Figure 485: VNC File Transfer Window

In this window, files can be selected by clicking on them (CTRL-click fo select multiple files). Once the desired
files are selected and the correct destination folder displayed, click Send>> or <<Receive to copy the files
either to or from the IND700.

Note that, for such an application to work with the IND700, the Terminal > Security Options must be correctly
configured in [setup » Page 200]. Remote Desktop Server must be enabled.

GEO, ASCII and Control Codes

These sections contain codes for geographical setup of the terminal, and for characters used in terminal
communication.

GEO Codes

The Geo code feature provided in the weighing terminal permits adjustment by a METTLER TOLEDO service
technician due fo changes in elevation or latitude without reapplying test weights. This assumes that a
previously accurate adjustment was done with the Geo code set properly for that original location and that the
Geo code for the new location can be accurately defermined.

When a weighing terminal is fo be reinstalled at a different geographic location, gravitational and altitude
changes can be accounted for by the following steps.

Note that this procedure is not necessary if an on-site adjustment is performed.

Determining the Geo code value

There are fwo methods to determine the Geo code value for your location.

Method A

1 Go to www.welmec.org and find the Gravity Information page to obtain the g value (e.g. 9.770390 m/s?)
for your specific geographic location.
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2 Check the METTLER TOLEDO Geo code Table A to select the Geo code according fo your g value,
e.g. Geo code 20 should be applied if your g value is 9.810304.

Method B
— Use the METTLER TOLEDO Geo code Table B to defermine the Geo code for the new altitude and location

where the scale will be used.
The lafitude and height above sea level can be found using this link www.mapcoordinates.net/en.

Checking the Geo code value in the instrument
Comparing Geo codes

1 Compare the determined Geo code with the current Geo code setting of the weighing terminall.

2 If the two Geo code values do not match, call the METTLER TOLEDO service technician.
When the system is cerfified, a re-verification will be necessary.

Note
Using the Geo code value for calibration adjustment is not as accurate as re-applying certified test weights and
re-calibrating the scale in a new location.

Table A: Definition of METTLER TOLEDO Geo codes with g value

Geo code g value (m/s?>) Geo code g value (m/s?) Geo code g value (m/s*>) Geo code g value (m/s?)
0 9.770390 8 9.786316 16 9.802295 24 9.818326
1 9.772378 9 9.788311 17 9.804296 25 9.820333
2 9.774367 10 9.790306 18 9.806298 26 9.822341
3 9.776356 11 9.792302 19 9.808300 27 9.824351
4 9.778347 12 9.794299 20 9.810304 28 9.826361
5 9.780338 13 9.796297 21 9.812308 29 9.828371
6 0.782330 14 9.798295 22 9.814313 30 9.830383
7 9.784323 15 9.800295 23 9.816319 31 9.832396
Table B: Definition of METTLER TOLEDO Geo codes with geographic latitude and height
Height above sea level
m] 0 325 650 975 1300 1625 1950 2275 5600 2925 3250
Geographical latitude, -325 -650 -975 -1300 -1625 -1950 -2275 -2600 -2925 -3250 - 3575
North or South M o 1060 | 2130 3200 4260 5330 6400 7460 8530 9600 = 10660
-1060 -2130 -3200 -4260 -5330 -6400 -7460 -8530 -9600 - 10660 - 11730
0°0' - 5° 46' 5 4 4 3 3 2 2 1 1 0 0
(0.0°-5.77°
5° 46' - 9° 52" 5 5 4 4 3 3 2 2 1 1 0
(65.77° - 12.87°)
9° 52' - 12° 44" 6 5 5 4 4 3 3 2 2 1 1
(12.87°-12.73°%)
12°44' - 15° 6 6 6 5 5 4 4 3 3 2 2 1
(12.73°-15.1°)
15°6'-17° 10" 7 6 6 5 5 4 4 3 3 2 2
(16.1°-17.17°)
17°10'-19° 2' 7 7 6 6 5 5 4 4 3 3 2
(17.17°-19.03°%)
19°2' - 20° 45' 8 7 7 6 6 5 5 4 4 3 3
(19.03° - 20.75°)
20° 45' - 22° 22' 8 8 7 7 6 6 5 5 4 4 3
(20.75° - 22.37°)
22°22' - 23° 54' 9 8 8 7 7 6 6 5 5 4 4
(22.37° - 23.9°)
23°54' - 25° 21" 9 9 8 8 7 7 6 6 5 5 4
(23.9° - 25.35°)
25° 21" - 26° 45' 10 9 9 8 8 7 7 6 6 5 5
(23.35° - 26.75°)
26° 45' - 28° 6' 10 10 9 9 8 8 7 7 6 6 5
(26.75° - 28.1°)
28° 6' - 29° 25' n 10 10 9 9 8 8 7 7 6 6
(28.1° - 29.42°)

IND700 Appendices | 363



https://www.mapcoordinates.net/en

364 | Appendices

Height above sea leve

m] o© 325 650 975 1300 1625 1950 2275 5600 2925 3250
Geographical Iatitude, -325 -650 -975 -1300 -1625 -1950 -2275 -2600 -2925 -3250 - 3575
North or South Ml o 1060 | 2130 3200 4260 5330 6400 7460 8530 9600 = 10660
-1060 -2130 -3200 -4260 -5330 -6400 -7460 -8530 -9600 - 10660 - 11730
29° 25' - 30° 41" 1 n 10 10 9 9 8 8 7 7 6
(29.42° - 30.68°)
30°41' - 31° 56' 12 M 1 10 10 9 9 8 8 7 7
(30.68° - 31.93°%)
31°56' - 33° 9 12 12 1 1 10 10 9 9 8 8 7
(31.93° - 33.15%)
33°9'- 34° 21" 13 12 12 M n 10 10 9 9 8 8
(33.15° - 34.35°)
34°21' - 35° 31" 13 13 12 12 i} 1 10 10 9 9 8
(34.35° - 35.52°)
35°31'-36° 41" 14 13 13 12 12 M 1 10 10 9 9
(35.52° - 36.68°)
36° 41' - 37° 50" 14 14 13 13 12 12 1 1 10 10 9
(36.68° - 37.83°%)
37° 50' - 38° 58' 15 14 14 13 13 12 12 1 1 10 10
(37.83° - 38.97°%)
38°58' - 40° 5' 15 15 14 14 13 13 12 12 M 1 10
(38.97° - 40.08°)
40°5' - 41° 12" 16 15 15 14 14 13 13 12 12 M M
(40.08° - 41.2°)
41°12'-42° 19" 16 16 15 15 14 14 13 13 12 12 M
(41.2° - 42.32°)
42°19' - 43° 26' 17 16 16 15 15 14 14 13 13 12 12
(42.32° - 43.43°)
43° 26' - 44° 32' 17 17 16 16 15 15 14 14 13 13 12
(43.43° - 44.53°)
44° 32' - 45° 38' 18 17 17 16 16 15 15 14 14 13 13
(44.53° - 45.63°)
45° 38' - 46° 45' 18 18 17 17 16 16 15 15 14 14 13
(45.63° - 46.75°)
46° 45' - 47° 51" 19 18 18 17 17 16 16 15 15 14 14
(46.75° - 47.85°)
47°51' - 48° 58' 19 19 18 18 17 17 16 16 15 15 14
(47.85° - 48.97°)
48° 58' - 50° 6' 20 19 19 18 18 17 17 16 16 15 15
(48.97° - 50.1°)
50°6' - 51° 13" 20 20 19 19 18 18 17 17 16 16 15
(50.1° - 51.22°)
51°13' - 52° 22" 21 20 20 19 19 18 18 17 17 16 16
(51.22° - 52.37°)
52°22' - 53° 31" 21 21 20 20 19 19 18 18 17 17 16
(52.37° - 53.52°)
53°31'- 54° 41" 22 21 21 20 20 19 19 18 18 17 17
(53.52° - 54.68°)
54° 41" - 55° 52" 22 22 21 21 20 20 19 19 18 18 17
(54.68° - 55.87°)
55° 52' - 57° 4' 23 22 22 21 21 20 20 19 19 18 18
(55.87° - 57.07°)
57°4' - 56° 17" 23 23 22 22 21 21 20 20 19 19 18
(57.07° - 56.28°)
56° 17 - 59° 32" 24 23 23 22 22 21 21 20 20 19 19
(56.28° - 59.53°)
59° 32' - 60° 49" 24 24 23 23 22 22 21 21 20 20 19
(59.53° - 60.82°)
60° 49' - 62° 9' 25 24 24 23 23 22 22 21 21 20 20
(60.82° - 62.15°)
62°9' - 63° 30' 25 25 24 24 23 23 22 22 21 21 20
(62.15° - 63.5°)
63° 30' - 64° 55' 26 25 25 24 24 23 23 22 22 21 21
(63.5° - 64.92°)
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Height above sea level
[m] 0 325 650 975 1300 1625 | 1950 | 2275 | 5600 2925 3250
Geographical Iatitude, -325 -650 ~-975 -1300 -1625 -1950 -2275 -2600  -2925  -3250 | - 3575
North or South [ft] 0 1060 | 2130 3200 | 4260 5330 | 6400 | 7460 | 8530 9600 10660
-1060 -2130 -3200 -4260 -5330 -6400 -7460 -8530 -9600 - 10660 - 11730
64° b5' - 66° 24' 26 26 25 25 24 24 23 23 22 22 21
(64.92° - 66.4°)
66° 24' - 67° 57' 27 26 26 25 25 24 24 23 23 22 22
(66.4° - 67.95°)
67° 57' - 69° 35' 27 27 26 26 25 25 24 24 23 23 22
(67.95° - 69.58°)
69°35'-71° 21" 28 27 27 26 26 25 25 24 24 23 23
(69.58° - 71.35°
71°21'-73°16' 28 28 27 27 26 26 25 25 24 24 23
(71.35° - 73.27°)
73°16' - 75° 24' 29 28 28 27 27 26 26 25 25 24 24
(73.27° - 75.4°)
75°24'-77° 52" 29 29 28 28 27 27 26 26 25 25 24
(75.4° - 77.87°)
77° 52" - 80° 56' 30 29 29 28 28 27 27 26 26 25 25
(77.87° - 80.93°)
80° 56' - 85° 45! 30 30 29 29 28 28 27 27 26 26 25
(80.93° - 85.75°)
85°45'-90° 0' 31 30 30 29 29 28 28 27 27 26 26
(86.75° - 90.0°)
5.4.2 ASCII Standard and Control Codes
DEC = HEX Symbol DEC  HEX Symbol DEC  HEX Symbol DEC  HEX Symbol
0 00 NUL 64 40 @ 128 80 € 192 co A
1 01 SOH 65 41 A 129 81 193 Cl A
2 02 STX 66 42 B 130 82 , 194 c2 A
3 03 ETX 67 43 c 131 83 f 195 c3 A
4 04 EOT 68 44 D 132 84 196 c4 A
5 05 ENQ 69 45 E 133 85 " 197 C5 A
6 06 ACK 70 46 F 134 86 T 198 C6 £
7 07 BEL 71 47 G 135 87 I 199 c7 C
8 08 BS 72 48 H 136 88 g 200 c8 E
9 09 HT 73 49 | 137 89 %o 201 c9 E
10 0A LF 74 4A J 138 8A S 202 CA E
11 0B VT 75 4B K 139 8B ¢ 203 CB E
12 0C FF 76 4C L 140 8C CE 204 cC |
13 oD CR 77 4D M 141 8D 205 CD f
14 O SO 78 A N 142 8E VA 206 CE )
15 OF S| 79 AF 0 143 8F 207 CF i
16 10 DLE 80 50 P 144 90 208 DO )
17 11 DC1 81 51 Q 145 91 209 D1 N
18 12 DC2 82 52 R 146 92 210 D2 0
19 13 DC3 83 53 S 147 93 . 211 D3 0
20 14 DC4 84 54 T 148 94 . 212 D4 0
21 15 NAK 85 55 U 149 95 . 213 D5 0
22 16 SYN 86 56 Vv 150 96 - 214 D6 0
23 17 ETB 87 57 W 151 97 — 215 D7 X
24 18 CAN 88 58 X 152 98 - 216 D8 @
25 19 EM 89 59 Y 153 99 ™ 217 D9 U
26 1A SuB 90 5A Z 154 9A ) 218 DA U
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DEC HEX |Symbol DEC HEX Symbol DEC HEX | Symbol DEC HEX | Symbol
27 1B ESC 91 5B [ 1565 9B > 219 DB U
28 1C FS 92 5C \ 156 9C ® 220 DC U
29 1D GS 93 5D ] 157 9D 221 DD Y
30 1E RS 94 5E A 158 9E 7 222 DE b
31 1F us 95 bF _ 159 oF Y 223 DF B
32 20 96 60 160 AO 224 EO a
33 21 ! 97 61 a 161 Al i 225 El a
34 22 ! 98 62 b 162 A2 ¢ 226 E2 a
35 23 # 99 63 c 163 A3 £ 227 E3 a
36 24 S 100 64 d 164 A4 a 228 E4 o]
37 25 % 101 65 e 165 A5 ¥ 229 Eb ol
38 26 & 102 66 f 166 A6 | 230 E6 e
39 27 ' 103 67 g 167 A7 § 231 E7 c
40 28 ( 104 68 h 168 A8 ) 232 E8 e
41 29 ) 105 69 i 169 A9 © 233 E9 é
42 2A * 106 6A j 170 AA a 234 EA é
43 2B + 107 6B k 171 AB « 235 EB é
44 2C , 108 6C I 172 AC - 236 EC i
45 2D 109 6D m 173 AD 237 ED i
46 2E . 110 6E n 174 AE ® 238 EE i
47 2F / 111 6F 0 175 AF - 239 EF i
48 30 0 112 70 p 176 BO ° 240 FO o)
49 31 1 113 71 q 177 B1 + 241 F1 A
50 32 2 114 72 r 178 B2 2 242 F2 0
51 33 3 115 73 S 179 B3 8 243 F3 0
52 34 4 116 74 t 180 B4 244 F4 0
53 35 b 117 75 u 181 B5 U 245 F5 0
54 36 6 118 76 v 182 B6 1 246 F6 0
55 37 7 119 77 W 183 B7 247 F7 +
56 38 8 120 78 X 184 B8 s 248 F8 @
57 39 9 121 79 y 185 B9 ! 249 F9 u
58 3A 122 7A z 186 BA ° 250 FA a
59 3B ; 123 7B { 187 BB » 251 FB a
60 3C < 124 7C I 188 BC Va 252 FC U
61 3D = 125 7D 1 189 BD ) 253 FD y
62 3E > 126 7E ~ 190 BE % 254 FE b
63 3F ? 127 7F 191 BF ¢ 255 FF y

5.4.2.1 Control Characters

Symbol Definition Function

SOH Start of Heading A transmission control character used as the first character of a heading
of an information message.

STX Start of Text A fransmission control character that precedes a text and that is used to
terminate a heading.

ETX End of Text A transmission control character that ferminafes a text.

EOT End of Transmission |A transmission control character used to indicate the conclusion of the
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fransmission of one or more fexts.
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Symbol

Definition

Function

ENQ

Enquiry

A transmission control character used as a request for a response from
a remote station; the response may include station identification and/or
sfation status. When a “Who are you” function is required on the
general switched fransmission network, the first use of ENQ after the
connection is esfablished will have the meaning “Who are you” (station
identification). Subsequent use of ENQ may, or may not, include the
function “Who are you”, as determined by agreement.

ACK

Acknowledgment

A transmission control character transmitted by a receiver as an affir-
mative response to the sender.

BEL

Bell

A control character that is used when there is a need fo call for
atfention; it may control alarm or atfention devices.

BS

Back Space

A format effector that moves the active position one character position
backwards on the same line.

HT

Horizontal Tab

A format effector that advances the active position fo the next pre-
determined character position on the same line.

LF

Line Feed

A format effector that advances the active position fo the same character
position of the next line.

Vertical Tab

A format effector that advances the active position to the same character
position on the next pre-determined line.

FF

Form Feed

A format effector that advances the active position fo the same character
position on a pre-determined line of the next form or page.

CR

Carriage Refurn

A format effector that moves the active position to the first character
position on the same line.

SO

Shift Out / X-On

A control character that is used in conjunction with SHIFT IN and
ESCAPE fo extend the graphic character set of the code.

Sl

Shift In / X-Off

A control character that is used in conjunction with SHIFT OUT and
ESCAPE to extend the graphic character set of the code.

DLE

Data Line Escape

A fransmission control character that will change the meaning of a
limifed number of contiguously following characters. It is used exclu-
sively to provide supplementary data fransmission control functions.
Only graphic characters and fransmission control characters can be
used in DLE sequences.

DC1

Device Control 1 (oft.
XON)

A device control character that is primarily infended for turning on or
starting an ancillary device. If it is not required for this purpose, it may
be used to restore a device to the basic mode of operation (see also
DC2 and DC3), or for any other device control function not provided by
other DCs.

DC2

Device Control 2

A device control character that is primarily intended for turning on or
starting an ancillary device. If it is not required for this purpose, it may
be used fo set a device to a special mode of operation (in which case
DCT is used fo restore normal operation), or for any other device
control function not provided by other DCs.

DC3

Device Control 3 (oft.
XOFF)

A device control character that is primarily intended for turning off or
sfopping an ancillary device. This function may be a secondary level
stop, for example, wait, pause, stand-by or halt (in which case DCT is
used to restore normal operation). If it is not required for this purpose, it
may be used for any other device control function not provided by other
DCs.

DC4

Device Control 4

A device control character that is primarily infended for turning off,
stopping, or interrupting an ancillary device. If it is not required for this
purpose, it may be used for any other device control function not
provided by other DCs.

NAK

Negative Acknowl-
edgement

A fransmission control character transmitted by a receiver as a negative
response fo the sender.
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Symbol

Definition

Function

SYN

Synchronous Idle

A fransmission control character used by a synchronous transmission
system in the absence of any other character (idle condition) to provide
a signal from which synchronism may be achieved or refained between
data terminal equipment.

ETB

End of Transmit
Block

A transmission control character used to indicate the end of a frans-
mission block of data where data is divided into such blocks for trans-
mission purposes.

CAN

Cancel

A character, or the first character of a sequence, indicating that the data
preceding it is in error. As a result, this dafa is to be ignored. The
specific meaning of this character must be defined for each application
and/or between sender and recipient.

EM

End of Medium

A control character that may be used to identify the physical end of a
medium, or the end of the used portion of a medium, or the end of the
wanfed portion of data recorded on a medium. The position of this
character does not necessarily correspond to the physical end of the
medium.

SuB

Substitute

A control character used in the place of a character that has been found
to be invalid or in error. SUB is infended to be introduced by automatic
means.

ESC

Escape

A control character that is used fo provide additional control functions. It
alters the meaning of a limited number of contiguously following bit
combinations.

FS

File Separator

A control character used to separate and qualify dafa logically; its
specific

meaning has fo be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a file.

GS

Group Separator

A control character used to separate and qualify dafa logically; its
specific

meaning has to be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a group.

RS

Record Separator

A control character used to separate and qualify datfa logically; its
specific

meaning has to be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a record.

us

Unit Separator

A control character used to separate and qualify dafa logically; its
specific

meaning has fo be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a unit.
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